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Executive Summary 

AMASS is developing an integrated and holistic approach and supporting tools for assurance and 
certification of Cyber-Physical Systems (CPS). AMASS plans to achieve the mentioned approach by creating 
and consolidating the first European-wide open certification/qualification platform, ecosystem and 
community spanning the largest CPS vertical markets. In order to keep a consistent and cohesive vision, 
WP2 Reference Architecture and Integration emphasizes on a common set of requirements derived from 
WP1 and the state of the practice from the technical work packages (WP3-WP6). 

This deliverable D2.5 AMASS user guidance and methodological framework is released by the AMASS work 
package WP2 “Reference Architecture and Integration” and provides summary information about the 
global AMASS methodology and the usage of the AMASS Platform. Accordingly it is based on several 
previous AMASS deliverables, in particular D2.4 AMASS Reference Architecture (c) [6], D3.8 Methodological 
guide for architecture-driven assurance (b) [7], D4.8 Methodological guide for multiconcern assurance (b) 
[8], D5.8 Methodological guide for seamless interoperability (b) [9] and D6.8 Methodological guide for 
cross/intra-domain reuse (b) [10].  

The focus of this deliverable is the description of the process steps along the AMASS Platform and the 
usage of the features provided by the AMASS tools. Accordingly, the deliverable is a guidance and 
introduction for potential adopters of the platform. For more detailed information, a comprehensive user 
manual with detailed descriptions of the usage of the particular tools is added in Annex A: AMASS Platform 
User Manual. Also, Annex B: AMASS Platform Developers’ Guide provides a guide for the platform 
developers. 
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1. Introduction 

1.1 Background and Context 

Embedded systems have significantly increased in number, technical complexity, and sophistication, 
moving towards open, interconnected, networked systems (such as "the connected car" and the cloud), 
integrating the physical and digital world, thus justifying the term “cyber-physical systems” (CPS). This 
“cyber-physical” dimension is exacerbating the problem of ensuring safety, security, availability, robustness 
and reliability in the presence of human, environmental and technological risks. Furthermore, the products 
into which these Cyber-Physical Systems (CPS) are integrated (e.g. aircrafts) need to respect applicable 
standards for assurance and in some areas, the systems even need certification. The dimension of the 
certification issue becomes clear if we look at the passenger plane Boeing 787 as a recent example – it is 
reported in [1] that the certification process lasted 8 years and consumed 200.000 staff hours at the FAA, 
just for technical work. The staff hours of the manufacturer even exceeded this figure, as more than 1500 
regulations had to be fulfilled, with evidence reflected onto 4000+ documents. Although aircrafts are an 
extremely safety-critical product with many of such regulations, the situation in other areas (railway, 
automotive, medical devices, etc.) is similar. 

Unlike practices in electrical and mechanical equipment engineering, CPS do not have a set of standardised 
and harmonised practices for assurance and certification that ensure safe, secure and reliable operation 
with typical software and hardware architectures. As a result, the CPS community often finds it difficult to 
apply existing certification guidance. Ultimately, the pace of assurance and certification will be determined 
by the ability of both industry and certification/assessment authorities to overcome technical, regulatory, 
and operational challenges. A key regulatory-related challenge must be faced when trying to reuse CPS 
products from one application domain in another because they are constrained by different standards and 
the full assurance and certification process must be applied as if it was a totally new product, thus reducing 
the return on investment of such reuse decisions. Similarly, reuse is of vital importance in the same domain 
as well, when trying to reuse CPS products from one project to another. 

To deal with the multi-concern nature of present-day critical systems, the complexity due to the 
proliferation of assessment models and standards, and the presence of hardly interoperable tools, AMASS 
has defined and implemented a platform that supports those activities required for CPS assurance and 
certification. AMASS has been based on achievements in previous research projects such as SafeCer [2] and 
OPENCOSS [3], integrating and enhancing previous results and including new functionalities related to 
architecture-driven assurance (WP3), multi-concern assurance (WP4), seamless interoperability (WP5), and 
cross-domain and intra-domain reuse (WP6).  

AMASS has achieved to support openness of CPS’ technological solutions as a sustainable toolset 
architecture. To this purpose, the AMASS Reference Tool Architecture (ARTA) has established and enforced 
cross-domain and cross-project agreements on toolset architectures, methodological support, interface 
standards, and interoperability techniques. The ARTA has embodied a common set of tool functionalities, 
user interfaces and tool adaptors. This openness will allow any stakeholder of the assurance and 
certification process to perform a seamless integration of their activities (e.g., product engineering, 
external/independent assessment, and component/parts supply) into tool chains adapted to the specific 
needs of the targeted CPS markets.  

1.2 Scope of the Deliverable 

This deliverable D2.5 AMASS user guidance and methodological framework is released by the AMASS work 
package WP2 “Reference Architecture and Integration” and includes summarized and concise information 
about the global AMASS methodology provided by the AMASS Platform, which is a prototype 
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implementation demonstrating the capabilities and features of the AMASS Reference Tool Architecture 
(ARTA). In particular, D2.5 provides an overview of the particular process steps along the AMASS Platform 
as well as of the transversal information flow between the ARTA tools.  

Therefore, the deliverable is an introductory guidance for the usage of the platform. By referencing to 
other AMASS deliverables with detailed descriptions of the AMASS Platform and its components and 
methodologies, the deliverable may also serve as a point of entry for users and developers to the AMASS 
Platform. However, in order to be self-contained, the document aims to provide sufficient information to 
enable a technical understanding of the particular process steps along the AMASS Platform. For more 
detailed guidance of interested users, both a detailed User Manual and a Developers’ guide are added as 
annexes to this document (Annex A: AMASS Platform User Manual and Annex B: AMASS Platform 
Developers’ Guide). 

1.3 Relation to other AMASS Tasks 

The main objective of AMASS work package WP2 is the definition of the AMASS Reference Tool 
Architecture (ARTA), which extends the OPENCOSS [3] and SafeCer [2] conceptual, modelling and 
methodological frameworks for architecture-driven and multi-concern assurance, as well as for further 
cross-domain and intra-domain reuse capabilities and seamless interoperability mechanisms (based on 
OSLC specifications). 

This deliverable has been elaborated as part of the activities of task T2.3 AMASS User Guidance and 
Methodological Framework. T2.3 aims to elaborate a comprehensive view of the AMASS methodological 
framework (described in D2.4 [6]), including the steps of the proposed AMASS process and the interfaces 
between the steps. This includes the following activities: 

• Definition of the overall methodology with high-level definition of steps and roles along the overall 
process. 

• Review of existing tools and approaches with descriptions of how this is done in the context of 
AMASS. 

• Stimulation and support of interactions required between the technical WPs. 
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2. AMASS Reference Tool Architecture (ARTA) 

2.1 Overview of the AMASS Tool Platform Architecture  

AMASS has proposed the Common Assurance and Certification Metamodel (CACM) (see Sections 4 and 5 of 
D2.4 [6] for details) where concepts about assurance are included. The CACM extends the conceptual, 
modelling and methodological frameworks of OPENCOSS [3], SafeCer [2] and CHESS [4]. Based on this 
CACM, the AMASS Reference Tool architecture (ARTA) has been developed.  For more detailed information 
please refer to the deliverable D2.4 [6]. These two inputs, the CACM and the ARTA were the core to 
implement the AMASS Tool Platform.  

In the following sections, a short overview about the ARTA and the AMASS specific implementation of the 
ARTA, i.e. the AMASS Tool Platform or AMASS Platform, will be given. For more detailed information please 
refer to the deliverable D2.4 [6]. 

 

Figure 1. AMASS Reference (High-Level) Tool Architecture with responsibilities of the particular work packages  

The ARTA (Figure 1) specification describes how the AMASS building blocks run and operate in order to 
perform architecture driven, multi-concern assurance, and cross-and-intra-domain/concern assurance in an 
interoperable environment (see Section 2 of D2.4 [6]). The AMASS Platform basic building blocks include 
tools for specification of system components, specification of assurance cases such as structured 
argumentation trees, evidence management, and compliance management. In addition, the basic building 
blocks includes user access management and data management tools. 

AMASS has defined four pillars, which correspond to the specific project Scientific and Technical Objectives 
(STOs) summarized below:  

• Architecture-Driven Assurance (STO1): Explicit integration of assurance and certification activities 
with the CPS development activities, including specification and design. It provides support for 
system components composition in accordance with the domain best practices, guaranteeing that 
emerging behaviour does not interfere with the whole system assurance. 
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• Multi-concern Assurance (STO2): Tool-supported methodology for the development of assurance 
cases, co-assessment, and contract-based assurance, which addresses multiple system 
characteristics (mainly safety and security, but also other dependability aspects such as availability, 
robustness and reliability). 

• Seamless Interoperability (STO3): Open and generically applicable approach to ensure the 
interoperability between the tools used in the modelling, analysis, and development of CPS, among 
other possible engineering activities; in particular, interoperability from an assurance and 
certification-specific perspective, and collaborative work among the stakeholders of the assurance 
and certification of CPS. 

• Cross/Intra-Domain Reuse (STO4): Consistent assistance for intra- and-cross-domain reuse, or 
cross-concern, based on a conceptual framework to specify and manage assurance and certification 
assets.  

2.2 Description of the AMASS Platform Building Blocks  

Table 1 lists the different AMASS Platform functionalities grouped by STOs (see also Figure 1), including 
both the AMASS basic building blocks (blue highlighted) and the advanced functionalities (green 
highlighted).  

Table 1. Functionalities of the AMASS Reference Tool Architecture  

STO Functionality Group Description 

A
rc

h
it

e
ct

u
re

 D
ri

ve
n

 A
ss

u
ra

n
ce

 

System 
Component 
Specification 

This group provides features to allow the modelling of the system 
architecture specification, in particular, to allow the definition of components 
as reusable entities, and then the assembly of the components themselves, at 
any level of the hierarchical architecture, to build/decompose the system. 

System 
Architecture 
Modelling for 
Assurance 
 

This block contains the functionalities that are focused on the modelling of 
the system architecture to support the system assurance, which are:  

• Supporting the modelling of additional aspects (not already included in 
the system component specification) related to the system architecture 
that are needed for system assurance.  

• Tracing the elements of the system architecture model to the assurance 
case.  

• Generating evidence for the assurance case from the system 
architecture model or from the analysis thereof.  

• Importing the system architecture model from other tools/languages. 

• Functional Refinement. 

Architectural 
Patterns for 
Assurance 

Support for architectural patterns management. This approach helps 
designers and system architects when choosing suitable solutions for 
commonly recurring design problems while achieving component reuse.  

This block contains the functionalities that are focused on architectural 
patterns to support system assurance, which are: 

• Management of a library of architectural patterns. 

• Automated application of specific architectural patterns. 

• Generation of assurance arguments from architectural patterns 
application. 

The system component specification supports the specification and 
instantiation of parametrized architectures. Furthermore, having a contract 
associated to a specific architectural pattern allows deriving some 
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STO Functionality Group Description 

argumentation fragment automatically. The information regarding the 
implication of using this pattern is collected in a form of 
assumption/guarantee (i.e. PatternAssumption and PatternGuarantee). Even 
if the field of design pattern is large, AMASS focuses on applying its usage on 
safety-critical systems. Hence, the development of fault tolerance design 
patterns and its usage for different technologies (also known as technological 
patterns) are some of the addressed AMASS objectives. 

Contract-Based 
Assurance 
Composition  

This block, which is also known as Contract-Based Design for Assurance, 
introduces the functionalities that support the contract-based design of the 
system architecture, which provides additional arguments and evidence for 
system assurance. These functionalities also include:  

• Contract specification, i.e., specification of components’ assumptions 
and guarantees.  

• Contract-based reuse of components, i.e., a component reuse that is 
supported by checks on the contracts.  

• Generation of assurance arguments from the contract specification and 
validation.  

Requirements 
Support 

This block contains the functionalities that are focused on enriching the 
assurance case with advanced analysis to support the evidence of the 
assurance case. These functionalities are related to the requirements support: 

• Requirements formalisation into temporal logics. 

• Analysis of requirements’ semantics based on their formalisation into 
temporal logics. 

• Analysis of requirements based on quality metrics. 

• Safety requirement derivation based on Model-based Safety Analysis 
and the creation of the safety concept/definition of safety mechanisms: 
automatic creation of safety concept from safety contracts (Contract-
based Safety Engineering). 

V&V Activities This block contains the functionalities that are focused on enriching the 
assurance case concerning V&V activities to support the evidence of the 
assurance case. These functionalities include: 

• Contract-based verification, i.e. exploiting contracts to verify the 
architectural decomposition, to perform compositional analysis, and to 
analyse the safety and reliability of the system architecture. 

• Automated formal verification (model checking) of requirements on the 
system design. 

• Model-based specification of fault-injection and analysis of faulty 
scenarios with simulation or model checking for safety V&V. 

• Other techniques (e.g. Component Fault Trees from SysML models) for 
Model-based safety analysis. 

• Document generation. 
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STO Functionality Group Description 

M
u

lt
i-

co
n

ce
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 A
ss

u
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n
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Assurance Case 
Specification 
 

This group manages argumentation information in a modular fashion. It also 
includes mechanisms to support compositional assurance and assurance 
patterns management. 

Dependability 
Assurance 

This group contains the functionality for creating and structuring the multi-
concern assurance case argumentation in an understandable and 
maintainable way. This includes argumentations targeting various 
dependability attributes with support of argumentation patterns. 

System 
Dependability Co-
Analysis/Co-
Assessment 

This group provides functionalities for analysing different quality attributes 
while taking care of the inter-dependences between them. This is ideally 
realized by inherently combined Co-Analysis and Co-Assessment methods, 
which take care of the inter-dependencies within the method. On the other 
hand, multi-concern assurance can be implemented combining separate 
processes with mono-concern assurance methods by a workflow tool with a 
subsequent interaction point activity for treating the mutual dependencies 
between the quality attributes. 

Contract-based 
Multi-concern 
assurance 

This group comprises functionalities which contribute to assurance for 
multiple concerns by two kinds of contracts: on the one hand, component 
contracts, which target more than one quality attribute. On the other hand, 
argument contracts, which provide a means for realising a link between 
related assurance cases. 

Se
am

le
ss

 In
te

ro
p

e
ra

b
ili

ty
 

Evidence 
management 

This module manages the full lifecycle of evidence artefacts and evidence 
chains. This includes evidence traceability management and impact analysis. 

Tool Integration 
Management 

This module enables the exchange of data between engineering/assurance 
tools, e.g. between the AMASS Tool Platform and other tools developed by 
the AMASS partners. 

Collaborative 
Work 
Management 

This module allows different users to work at the same time with the same 
pieces of data, supporting the interaction of the different users. 

Tool Quality 
Assessment and 
Characterisation 

This module supports the specification and management of tool quality needs 
for CPS assurance and certification. It is currently supported by the 
Compliance Management functionality for Cross/Intra-Domain Reuse; i.e. tool 
qualification is managed as a specific case of compliance management, as it 
will be based on requirements from some assurance standard and their 
satisfaction will have to be declared. 

C
ro

ss
/I

n
tr

a-
D

o
m

ai
n

 R
e

u
se

 

Compliance 
Management 

Functionality related to the management (edition, search, transfer, etc.) of 
process and standards’ information as well as of any other information 
derived from them, such as interpretations about intents and mapping 
between processes and standards. This functional group maintains a 
knowledge database about “standards & processes”, which can be consulted 
by other AMASS functionalities. 

Reuse Assistant  The reuse assistance functionality concerns intra- and cross-domain reuse of 
assurance and certification assets. This module supports users to understand 
whether reuse of the assurance assets is reasonable or to determine what 
further assurance activities (engineering, V&V, or compliance activities) are 
required to justify compliance in the new scenario. 
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STO Functionality Group Description 

Semantics 
Standards 
Equivalence 
Mapping 

For analysis of semantics-based equivalence between standards, AMASS 
extends the OPENCOSS Common Certification Language (CCL) approach by 
leveraging the SafeCer ontology-based method for representation of 
standards. Automated means also allows performing an informed gap analysis 
of the standards and thus mitigates the risk of inappropriate reuse, when a 
given assurance asset might not appropriately match the requirements of the 
reuse context.  

Impact Analysis When an assurance asset is changed, the AMASS Platform shall indicate how 
the change impacts other related assurance assets.  

Process-related 
reuse via 
management of 
variability at 
process level 

Functionality related to the management of variability at process level. This 
functionality takes as input a process, which needs to be reconfigured, and 
the new selections desired by the user. As outcome, this functionality 
generates a new valid re-configuration of the process. 

Product-related 
reuse via 
management of 
variability at 
product level 

Functionality related to the management of variability at product level. This 
functionality takes as input a product (more specifically, an architectural 
specification), which needs to be tailored/reconfigured, and the new 
selections desired by the user. As outcome, this functionality generates a new 
valid re-configuration of the architectural specification.  

Assurance Case-
related reuse via 
management of 
variability at 
assurance level 

Functionality related to the management of variability at assurance case level. 
This functionality takes as input an assurance case, which needs to be 
tailored/reconfigured, and the new selections desired by the user. As 
outcome, this functionality generates a new valid re-configuration of the 
assurance case.  

Automatic 
generation of 
process-based 
arguments 

This functionality is related to the generation of structured arguments from 
process models. It supports the strengthening of the safety case via 
arguments that are aimed at explaining why a process is compliant. 

Automatic 
generation of 
product-based 
arguments 

This functionality is related to the generation of structured arguments from 
contract-based architectural specification. It supports the strengthening of 
the safety case via arguments aimed at showing why the product is expected 
to behave safely. 

 

2.3 AMASS Platform Tools Ecosystem 

The internal and external tools integrated in and available for the AMASS Platform are shown in Figure 2 
grouped along the aforementioned STOs. The STO Seamless Interoperability is not explicitly added as it is 
provided by the internal platform tools. The internal tools are blue highlighted whereas the external ones 
are depicted in blue. 

It is important to highlight the duplicity of the tools belonging to the AMASS Platform. The main reason 
behind is that the internal tools can be classified based on STO as well, thus they appear twice within the 
Figure 2.  CHESS is part of the AMASS platform while also contributes to the Architecture-Driven Assurance. 
The same concept applies to OpenCert and EPF-C being part of the AMASS platform while contributing to, 
for example, to Cross/Intra-Domain Reuse. 
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Figure 2. AMASS Platform Tools ecosystem 

AMASS Platform tools: 

• CHESS/Papyrus plugins are used to model UML/SysML diagrams and to perform contract-based 
design and different model-based analyses (https://www.polarsys.org/chess/start.html). These 
plugins are part of the AMASS Platform, which provides the user a single user interface hiding the 
complexity of the underlying tool architecture. For more information, please see D3.6 [11], D3.8 
[7], D4.6 [12], D4.8 [8]. 

• OpenCert is a product and process assurance management system to support the compliance 
assessment and certification of safety-critical systems. It supports assurance- and certification-
specific activities, e.g. digitalization of regulations, evidence management, compliance 
management or modular assurance case management (https://www.polarsys.org/opencert/). For 
more information, please refer to D6.6 [13] , D6.8 [10], D3.6 [11]  and D3.8 [7]. 

• BVR Tool is a series of Eclipse plugins that implement the BVR language. BVR is a language for 
enabling variability management in the context of safety-critical systems engineering. The BVR Tool 
supports feature modelling, resolution, realization and derivation of specific family members 
(https://www.amass-ecsel.eu/content/bvr-tool-amass). For more information, please refer to D6.6 
[13] and D6.8 [10]. 

• The Capra plugin allows to create and link assurance argument fragments and evidences or other 
traceability links. Capra is a dedicated traceability management tool that allows the creation, 
management, visualisation, and analysis of trace links within Eclipse. Trace links can be created 
between arbitrary artefacts, including all EMF model elements, all types of source code files 
supported by the Eclipse Platform through specialised development tools, tickets and bugs 
managed by Eclipse Mylyn, and all other artefacts for which an appropriate wrapper is provided. 
Capra is highly configurable and allows users to create their own traceability meta-model. 
(https://projects.eclipse.org/proposals/capra). For more information, please refer to D5.6 [14]  and 
D5.8 [9]. 

https://www.polarsys.org/chess/start.html
https://www.polarsys.org/opencert/
https://www.amass-ecsel.eu/content/bvr-tool-amass
https://projects.eclipse.org/proposals/capra
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• CDO is both a development-time model repository and a run-time persistence framework. Being 
highly optimized it supports object graphs of arbitrary size. CDO offers transactions with save 
points, explicit locking, change notifications, queries, transparent temporality, time travel, 
branching, merging, offline clones, fail-over clusters, automatic memory management, and more  
(http://www.eclipse.org/cdo/). For more information, please refer to D5.6 [14] and D5.8 [9]. 

• The Eclipse Process Framework (EPF) Composer, abbreviated EPF-C in this deliverable, provides a 
process-management platform based on SPEM [19] for authoring, maintaining and sharing 
development process frameworks between the various stake-holders of the software development 
organization. The outcomes of processes, which are represented in the EPF Composer as work 
products, provide evidence supporting process and product argumentation. These plugins are part 
of the AMASS Platform, which provides a single user interface hiding the complexity of the 
underlying tool architecture (https://projects.eclipse.org/projects/technology.epf). For more 
information, please refer to D6.6 [13] and D6.8 [10]. 

• ConcertoFLA is a CHESS plugin that implements a technique for qualitative dependability analysis 
For more information, please refer to D4.6 [12] and D4.8 [8].  
 

AMASS External Tools: 

• SAVONA is used for designing, specifying and verifying embedded systems (hardware & software). 
It combines model-based development methods with design-by-contract, enabling validation and 
verification of the system’s architecture at an early stage of development. In agile environments, 
SAVONA allows to quickly analyse the influence of requirement changes on the system´s integrity. 
In safety-relevant environments, required safety proofs can be integrated at an early stage. System 
architecture models are graphically created with an intuitive user Interface in SysML. Well 
readable, semi-formal contracts can be easily assigned to the specific system architecture and 
automatically validated through model checking (https://www.assystem-
germany.com/en/products/savona/). For more information, please refer to D3.6 [11] and D3.8 [7]. 

• OCRA, an external backend tool that interacts with the AMASS platform to provide contract-based 
analysis.  OCRA is a command-line tool for the verification of logic-based contract refinement for 
embedded systems. It supports the specification and analysis of component-based specifications of 
system architectures. Components are enriched with contracts specified in discrete or hybrid 
linear-time temporal logics. It runs in background or remotely via OSLC and the user does not 
interact with them directly (https://ocra.fbk.eu/). For more information, please refer to D3.6 [11], 
D3.8 [7] D4.3 [15], D4.6 [12] and D4.8 [8]. 

• nuXmv, an external backend tool that provides analysis for model checking and interacts with the 
AMASS platform. nuXmv is a new symbolic model checker for the analysis of synchronous finite-
state and infinite-state systems. nuXmv extends NuSMV along two main directions:  

o For the finite-state case, nuXmv features a strong verification engine based on state-of-the-
art SAT-based algorithms.  

o For the infinite-state case, nuXmv features SMT-based verification techniques, 

implemented through a tight integration with MathSAT51.  

It runs in background or remotely via OSLC and the user does not interact with it directly 
(https://nuxmv.fbk.eu/ , https://es.fbk.eu/tools/nuxmv/downloads/nuxmv-user-manual.pdf). For 
more information, please refer to D3.6 [11] and D3.8 [7]. 

• xSAP, a tool that provides model-based safety analysis, running in background or remotely via 
OSLC, so the user does not interact with it directly. xSAP is a tool for safety assessment of 

                                                           
1 http://mathsat.fbk.eu/  

http://www.eclipse.org/cdo/
https://projects.eclipse.org/projects/technology.epf
https://www.assystem-germany.com/en/products/savona/
https://www.assystem-germany.com/en/products/savona/
https://ocra.fbk.eu/
https://nuxmv.fbk.eu/
https://es.fbk.eu/tools/nuxmv/downloads/nuxmv-user-manual.pdf
http://mathsat.fbk.eu/


        

          AMASS AMASS User guidance and Methodological framework D2.5 V1.0 

 

 

 
H2020-JTI-ECSEL-2015 # 692474 Page 17 of 88 

 
 

synchronous finite-state and infinite-state systems. It is based on symbolic model checking 
techniques (https://xsap.fbk.eu/). For more information, please refer to D3.6 [11] and D3.8 [7]. 

• V&V Manager, a tool for requirements analysis and model checking, running in background or 
remotely via OSLC, so the user does not interact with it directly. For more information, please refer 
to D3.6 [11] and D3.8 [7]. 

• MORETO is an Enterprise Architect plugin which focuses on with Model-based Security 
Requirements Management Tool. For more information, please refer to D4.6 [12] and D4.8 [8]. 

• Simulink, a tool that can be used for specifying behaviour in its own formal or semi-formal 
language with the purpose of finally generating the runnable software source code. Models will be 
later imported in the AMASS platform. For more information, please refer to D3.6 [11] and D3.8 [7]. 

• AMT 2.0, a tool used to perform contract-based offline monitoring of cyber-physical systems. The 
results of the analysis will be imported into the AMASS Platform. For more information, please 
refer to D3.8 [7]. 

• Sabotage, a tool used to perform simulation-based fault-injection on Simulink models. The results 
of the analysis will be imported into the AMASS Platform. For more information, please refer to 
D3.6 [11] and D3.8 [7]. 

• SCADE Architect / SCADE Suite 

Ansys SCADE Architect is part of the ANSYS Embedded Software family of products, which provides 
a design environment for systems with high dependability requirements. It provides full support of 
industrial systems engineering processes, such as ARP 4754A, ISO 26262 and EN 50126 
(https://www.ansys.com/es-es/products/embedded-software/ansys-scade-architect ). This product 
features functional and architectural system modelling and verification in a SysML-based 
environment. 

Ansys SCADE Suite is the integrated design environment for critical applications spanning 
requirements management, model-based design, simulation, verification, qualifiable/certified code 
generation, and interoperability with other development tools and platforms. (http://www.esterel-
technologies.com/products/scade-suite/). 

For more information, please refer to D3.6 [11] and D3.8 [7]. 

• Enterprise Architect is a visual modelling and design tool based on the OMG UML. The platform 
supports the design and construction of software systems, modelling business processes, and 
modelling industry based domains (https://sparxsystems.com/products/ea/). For more 
information, please refer to D3.6 [11] and D3.8 [7]. 

• Medini Analyze, ANSYS Medini Analyze implements key safety analysis methods (HAZOP, FTA, 
FMEA, FMEDA) all in one integrated tool. It supports the efficient and consistent execution of the 
safety-related activities that are required by applicable safety standards. Medini Analyze is well 
integrated with other engineering tools and enables safety analysis based on design models by 
utilizing standards like SysML (https://www.ansys.com/es-es/products/systems/ansys-medini-
analyze). For more information, please refer to D3.6 [11], D3.8 [7], D4.6 [12] and D4.8 [8]. 

• RQA is a tool used to perform requirements quality analysis. The Requirements Quality Analyzer 
tool (RQA) allows you to define, measure, manage and improve the quality of the requirements' 
specifications. The results of the analysis will be imported into the AMASS Platform 
(https://www.reusecompany.com/requirements-quality-analyzer). For more information, please 
refer to D3.6 [11] and D3.8 [7]. 

• Safety Architect (SA) is a tool achieving risk analysis of complex systems using functional or 
physical architectures from usual modelling tools, for example SysML or UML based tools. From a 

https://xsap.fbk.eu/
https://www.ansys.com/es-es/products/embedded-software/ansys-scade-architect
http://www.esterel-technologies.com/products/scade-suite/
http://www.esterel-technologies.com/products/scade-suite/
https://sparxsystems.com/products/ea/
https://www.ansys.com/es-es/products/systems/ansys-medini-analyze
https://www.ansys.com/es-es/products/systems/ansys-medini-analyze
https://www.reusecompany.com/requirements-quality-analyzer
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functional or physical definition of the system, Safety Architect allows to perform a kind of local 
FMECA and automatically deducts the FTA corresponding to the identified feared events. The 
classical Fault Tree can be enriched with malicious events that could be caused by an attacker 
(https://www.all4tec.com/safety-architect). For more information, please refer to D4.6 [12] and 
D4.8 [8] . 

• Cyber Architect (CA) is a tool performing security analysis of complex system. Based on standards 
like EBIOS or PSSIE, Cyber Architect allows to create, customize and enrich your knowledge bases, 
perform your security analysis and automatically deduct the attack trees corresponding to the 
identified feared events (https://www.all4tec.com/cyber-architect). For more information, please 
refer to D4.6 [12] and D4.8 [8] . 

• FMVEA extends the well-introduced FMEA by security aspects and can be used in those phases of 
the lifecycle where a semi-quantitative FMEA is applicable. The FMVEA tool interfaces with the 
AMASS platform on the one hand with the SysML model provided e.g. with Papyrus, and on the 
other hand with the created safety and security requirements via ReqIF format, which can be 
imported in the AMASS Platform. For more information, please refer to D4.6 [12] and D4.8 [8] . 

• Papyrus SSE (Papyrus for Safety and Security Engineering) is a framework developed by CEA to 
support systems engineering from early phases of the development cycle. Papyrus SSE is 
customized according to the standards from where the fundamental concepts, requirements, and 
analysis methods are extracted and implemented. Papyrus SSE provides an environment to support 
several phases of systems design, ranging from requirements capturing up to the analysis 
(validation, verification, tests) of safety and security aspects. For more information, please refer to 
D4.6 [12] and D4.8 [8] . 

• WEFACT is a workflow engine whose goal is to support the entire engineering lifecycle of safety 
and/or security relevant systems based on pre-defined processes. To achieve this goal every 
project in WEFACT contains requirements, processes and workflow tools. For more information, 
please refer to D4.6 [12] and D4.8 [8] . 

• Knowledge Manager is a backend tool to manage all the knowledge related to a system by means 
of ontologies. Knowledge Manager (KM) allows to manage knowledge from the systems 
engineering point of view and to store, in a common System Knowledge Base, valuable information 
from requirements, models, system architectures and other documents. 
(https://www.reusecompany.com/knowledge-manager). For further information, please refer to 
D6.6 [13] and D6.8 [10]. 

2.4 Approach for Organising Projects and Models 

In general, there are two types of information managed by the AMASS platform tools: Project-independent 
information that can be used by various projects (e.g., models of generic Process and Standards) and 
Project-specific information (e.g., evidence and argumentation models). 

Assurance Project-independent information 

The AMASS platform provides two ways to define project-independent information, which can be re-used 
for several projects: 

1. Definition of Reference Framework models (RFM). 

The AMASS platform provides a dedicated OpenCert tool, name Reference Framework Editor, for 
the RFM modelling. The information modelled by the tool includes in particular regulations of 
standard(s) that are relevant for the projects of the considered application domain. Apart from the 
standards, also other general applicable regulations can be defined as basis for the later project 

https://www.all4tec.com/safety-architect
https://www.all4tec.com/cyber-architect
https://www.reusecompany.com/knowledge-manager
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definitions, e.g. general company specific regulations like SW process regulations. Reference 
Frameworks can be used to create Assurance Project Baselines by tailoring subsets of the RFM for 
individual Assurance Projects (see Assurance Project specific information below). 

The AMASS platform provides two options for the RFM definition: 

• Creation of a new Reference Framework Model or  

• Applying Equivalence Mapping from one (existing) Reference Framework to another (new) 
one; for that, an Equivalence Map Model has to be elaborated that defines equivalences 
between elements of the related standards’ RFMs.  

2. Definition of processes using the Eclipse Process Framework Composer (EPF-C) models. 

A library of process elements that can be re-used to assemble different processes can be defined by  
EPF Composer. In particular, process models required by the corresponding standard(s), but also 
general applicable company specific processes can be defined once to re-use them in the specific 
assurance projects, e.g. processes and process elements for the software design and 
implementation phase of this standard. 

 

Figure 3. Standard and Process Modelling 

Assurance Project specific information 

The Assurance Project specific information includes three main elements (see Figure 4):  

1. Baseline Configuration, i.e. a set of Assurance Baseline Models (ABMs). Each baseline model 
results from importing (copying) a Reference Framework model or an EPF Composer model and 
adding information about its selection in the current project (it answers to the question: Does a 
given Reference Framework model element apply to the current Assurance Project?).  

• A Baseline model represents what is planned to comply with in a specific Assurance 
Project, e.g. what standards prescribe for the specific Assurance Project. 

• An ABM can be created by Tailoring from a Reference Framework Model, i.e. the Baseline 
Model is a subset of the related Reference Framework Model. 
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• Several ABMs can be defined for an Assurance Project while only one is active at the same 
time. 

2. Permissions Configuration that supports the creation of Profiles to enable restricted access to 
AMASS functionality and data. 

3. Assurance Assets Package that includes: 

• Project-specific Artefacts models (as part of an Evidence Model), Argumentation models, 
Process models and System Architecture models. These four models represent what has 
been done in a specific Assurance Project.  

• The mapping of these four models with Baseline Models is modelled using the concept of 
Compliance Map (only artefacts so far). 

 

Figure 4. Assurance Project and System Component Specification structure 
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3. Process Guide  

3.1 Roles  

Figure 5 shows an overview of roles or actors for the ARTA, based on the stakeholders defined in D2.4 [6]. 
These roles can be grouped as Management, Engineers and Assessors, each involved in specific actions 
along the tool chains. Note that this is only a logical view.  

Organisations applying the AMASS platform may have a different naming for the particular roles below and 
also the responsibilities of the involved actors may change in detail for the particular processes.  

 

 

Figure 5. AMASS Tool Platform roles 

• The Project Manager is the role that works on a compliance and assurance-based project where a 
product (system or component) needs to be assessed as acceptably dependable (safety, security or 
other dependability properties). The Project Manager will use an implementation of the ARTA (e.g. 
the AMASS Tool Platform) to check the status of the project's goals within the planned budget, 
time, and resources. The Project Manager should have rights to read and write in a specific 
Assurance Project and give access to the it to the different members of the team (Assurance 
Engineers).  

• The Assurance Manager is responsible to show compliance with a particular standard and argue 
the safety/security of the product in an Assurance Case or demonstrate the properties of a 
component or system that are required for an Assurance Case. The Assurance Manager will use the 
ARTA platform to plan, structure, view, review and assess the system structure and arguments or 
modules, sometimes by composing pre-existing arguments, and reusing arguments and evidence 
relating to reusable components. The Assurance Manager should have rights to read and write in a 
specific Assurance Project, the Reference Frameworks folder and give access to the different team 
members of an Assurance Project (Assurance Engineers).  

• The IT Manager is responsible for maintaining the AMASS Platform resources. He/she is responsible 
to register all users that will have access to the AMASS Platform. 



        

          AMASS AMASS User guidance and Methodological framework D2.5 V1.0 

 

 

 
H2020-JTI-ECSEL-2015 # 692474 Page 22 of 88 

 
 

• The Development Engineer is an actor involved in the execution of development activities. 
Different kinds of engineers may be involved in the application of the AMASS Open Tool Platform: 
The Process Engineer is a subtype of a Development Engineer, who is in charge of defining the 
development processes and ensure the process is being followed. Note that Figure 5 above is not 
claiming to be exhaustive and depending on the organisation there may be further roles and sub-
roles e.g. Product-development Engineer, Systems Engineer and System Safety. 

• The Assurance Engineer is the role responsible for executing activities for safety and security 
design, analysis, V&V and assurance e.g., create and/or collect the evidence to demonstrate that 
the product is acceptable safe/secure. An Assurance Engineer can be split into Safety and Security 
Engineer roles. Furthermore, other roles such as V&V Engineer can be considered part of this 
group (cf. Section 3.6). The Assurance Engineer should have rights to read and write in a specific 
Assurance Project. 

• The Assurance Assessor is responsible for assessing the adequacy of the evidence and assurance 
‘package’, in terms of demonstrating the safety/security of the system under consideration. An 
Assurance Assessor can be Organisation-Internal or Independent Assessor. In case the assessor is 
an internal Assurance Assessor, he/she should have read access to all the Assurance Projects of the 
company. When the assessor is external to the company, for example it is delegated by the 
authorities, then he/she should only have read access to a specific Assurance Project. 

3.2 Overall Process Description 

Figure 6 gives an overview about the general process stages for Assurance Projects supported by the 
AMASS Tool Platform. For each stage, the ARTA provides comprehensive functionality to perform the 
particular process steps related to an Assurance Project, whose usage is described in detail in the 
subsequent sections.  

Not all stages and steps should be performed for each project. In particular the first two stages (“Standards 
Compliance Definition” and “Process Reusability definition”) are project independent and only need to be 
performed once, so the outcome and data provided for these steps could be re-used for multiple projects.  

 

Figure 6. Process stages for an Assurance Project in the AMASS Platform 

In order to provide a more comprehensive view of the AMASS platform capabilities and reduce the tooling 
complexity, a Dashboard has been implemented within the platform. Figure 7 shows an excerpt of the 
mentioned Dashboard and categorizes the functionalities that will be described in the following sections of 
this document. When an arrow is selected, its associated  functionalities exploit and a description of what 
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and who should perform the associated tasks is provided. For more information, please refer to Section 3 
“Dashboard Overview“ of the Annex A. It must be noted that the list of assigned roles might slightly vary 
among organisations. 
 

 Activities Roles 

 

Project Independent Activities: 
Capture, digitalise, store and 
retrieve standard compliance 
knowledge. 

Assurance Manager (e.g. Safety 
Manager) 

Process Engineer 

 

 

Project Independent Activities: 
Specify Reusable Compliant 
Process and validate process 
reusability. 

Assurance Manager (e.g. Safety 
Manager) 

Process Engineer 

Assurance Engineer: 

• Safety Engineer 

• Security Engineer 

 

Define the scope of compliance for 
a project, project compliance 
lifecycle, reuse possibilities and 
compliance means. 

Assurance Manager (e.g. Safety 
Manager) 

Process Engineer 

 

Define the system Architecture, 
elicit system Requirements, define 
and validate component Contracts, 
and execute Safety/Security 
Analyses. 

Systems Engineer  

Assurance Engineer: 

• Safety Engineer 

• Security Engineer 

• V&V Engineer (e.g. Formal 
Verification Engineer) 

 

Define argumentation using 
compliance arguments and 
product arguments.  
Resolve Safety/Security trade-off, 
and link to System Architecture. 

Assurance Manager (e.g. Safety 
Manager) 

Process Engineer 

Assurance Engineer: 

• Safety Engineer 

• Security Engineer 

• V&V Engineer  

Systems Engineer 

 

Project Artefacts 
Artefact Traceability 
Process Execution 
Compliance Maps 

Assurance Manager 

Assurance Engineer 

Process Engineer 

Figure 7. Overview of the AMASS Dashboard steps, activities and roles 

Further, the current application of the process stages and the related AMASS platform functionality is 
dependent on the specific conditions of each organisation and of each specific project, e.g. tools and 
processes already established in the applying organisation, the kind of the particular Assurance Project, the 
application domain, etc. Since the ARTA has been developed as an open platform, existing tools can be 
integrated, and the platform can be tailored to the specific requirements of each organisation and each 
project.  

  

Standards compliance 

definition 

Process Reusability 

definition 

Assurance Project 

Definition 

System Design 

Analysis and V&V 

Assurance Case 

Management 

Evidence 

Management 
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3.3 Standards Compliance Definition 

Figure 8 below gives an overview of the steps required for the definition of Assurance Projects as well as 
their relations and proposed sequences along the definition process.  

The red boxes are project independent activities, i.e. these steps have to be performed once and the 
corresponding definitions can be re-used for multiple specific Assurance Projects. This includes the 
definition of the one or several Reference Frameworks for the standards that are relevant for the 
Assurance Project (“Standards Compliance Definition” upper left red box) as well as the definition of 
reusable processes (“Process Reusability Definition” upper right red box). For the specific Assurance 
Projects, these general definitions have to be tailored to baseline configurations and to project specific 
models for artefacts, arguments, processes and system architectures (“Assurance Project Definition” lower 
blue box).  

The particular steps for each of these boxes are described in the Sections 3.3, 3.4, and 3.5 of this document. 

  

Figure 8. Overview of the steps of the “Standards Compliance Definition” process stage (red frame) in the context of 
the overall Assurance Project Definition 

3.3.1 Reference Framework creation  

Standards, regulations, certification advisory circulars and so on are managed similarly as Reference 
Frameworks. This information that is managed by the AMASS Platform tools includes project-independent 
information that can be (re)used by various projects, e.g. models of standards or generic processes.  
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Thus, the first activity to be executed to apply the AMASS approach is to create a Reference Assurance 
Framework (Reference Framework) for each standard that the intended projects have to be compliant with 
D6.8 [10]. The Process Engineer role in charge of this activity should be an expert in the standards, 
compliance and certification processes. This responsibility could also be assigned to an assurance manager. 
For example, a safety manager who creates the reference framework and models the knowledge coming 
from a certain functional safety standard such as IEC 61508. The Reference Framework(s) are later used for 
specifying baselines and equivalence maps (Section 3.5.2). The Reference Frameworks contains: 

• Reference Standards’ requirements to fulfil 

• Reference Activities to execute, and  

• Reference Artefacts to manage.  

Reference Artefacts (e.g. results of risk analysis, reviews or testing but also system specifications or source 
code) can be linked to Reference Standards’ requirements and to Reference Activities (input/output), which 
enable the specification of the Reference Artefact intents. For instance, in EN 50128, Software Design 
Specification is a Reference Artefact, Component Design is a Reference Activity, and “test cases and their 
results shall be recorded, preferably in machine readable format for subsequent analysis” (clause 7.6.4.5.a) 
is a Reference Requirement for the Software Integration Test Report. Reference Artefacts, Activities, and 
Requirements can be decomposed into others. 

A Reference Framework can further contain information about the Reference Roles that might be involved 
in a safety/security-critical system’s lifecycle (e.g., designer), about the Reference Techniques that might be 
used to execute Reference Activities and create Reference Artefacts (e.g., formal methods), and the 
applicability of the above elements (e.g., a given Reference Technique can be recommended for a given 
Safety Integrity Level in EN 50128). A Reference Artefact can also have Reference Artefact Attributes (e.g., 
test outcome; passed or failed) and be linked to other Reference Artefacts by means of Reference Artefact 
Relationships (e.g., Design Description satisfies Software Requirements Data). 

There are two ways to create a Reference Framework (RF): 

• by entering a new Reference Framework model,  

• by using Equivalence Maps to match elements of a source RF to the target RF model.  

In this step, we focus on the definition of a new RF model. The steps for the creation of an RF model are 
summarised below (for more information, please refer to Section 5. “Standards Modelling” of the AMASS 
Platform User Manual (Annex A). For the usage of Equivalence Maps, refer to Section 3.3.2 and to Section 
5.3 “Creating Equivalence Maps” of the Annex A.  

For modelling a new RF (and editing an existing one), the AMASS Platform provides the “Reference 
Framework Modeller” wizard, which can be used to model the regulations of Standards (see Figure 9). In 
order to set up a new Reference Framework model, a new RF diagram has to be created by starting the 
corresponding wizard of the tool. Then, the RF model can be further defined and edited by the following 
views (see also Section 5.2 “How to edit a Reference Framework model” of the Annex A):  

1. The Repository Explorer shows the contents of the repository. 

2. The Outline shows the elements of the model and permits its edition. 

3. The Diagram Editor permits the graphical modelling of a subset of concepts of the Reference 
Framework. 

4. The Palette is a toolbox with the concepts of the RF model (e.g. activities, Artefacts, Roles) and the 
connections between them to add to the diagram.  

5. The Properties allows to edit the properties of model elements. In particular, some RF model 
elements cannot be edited graphically (e.g. RefRequirements or RefApplicability tables). These 
model elements can be edited by using the Properties view. 
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Figure 9. Reference Framework editor 

The OpenCert tool inside then AMASS Platform allows managing different views of a model through a set of 
diagrams (multi-diagrams from a Reference Framework model). Once an RF model is available, a new 
diagram view can be created, and special edition functionalities are available, i.e. drag and drop concepts 
from the model to the diagram, hide a concept for a diagram (without deleting it from the model) and 
deleting it from the model (for all diagrams). 

3.3.2 Map Knowledge from Different Standards 

To perform Cross Standard reuse, an Equivalence Map model must be created between the source and the 
target standard models, which defines equivalences between assets of different standards (artefacts, 
activities, requirements, techniques). The activities for Cross Standard reuse are shown in Figure 10, in 
which domain experts both for the source and target standards need to be involved.  

According to the AMASS analysis, there are four main principles that should be taken into consideration 
when reusing artefacts across standards (see also Section 3.2.2 of D6.8 [10] for detailed information):  

1. The intent of a certification or assurance artefacts must be taken into account when aiming at its 
reuse. 

2. Maps must be established between the source standard (reuse from) and the target one (reuse to). 

3. Project compliance must be determined (by means of maps). 

4. Needs and gaps resulting from certification artefact reuse must be determined. 
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Figure 10. Sub-activities related to the Preparation of Cross Standard Reuse [10] 

The Reuse View provides information on the reuse opportunities as result of the equivalence relationships 
(see Section 6.6.1 “Cross-Project Reuse View” of the Annex A). Once the user such as a safety engineer 
selects the Assurance Assets to be reused, the reuse operation itself can be executed. This activity also 
requires a strong collaboration between safety/security managers, process engineers and safety/security 
engineers, who need to understand the reasoning behind. Furthermore, this requires them having quite a 
strong domain knowledge what helps on dimensioning the impact of the reuse. The module for Compliance 
Gap Analysis allows AMASS users to look at the reuse post-conditions identified in the Equivalence Map 
Model. The mapping between elements of the standards can be fully, partial or not possible (see also 
Section 3.1.1 of D6.8 [10]).  

The element types that may be used for equivalence mapping are Artefacts, Activities, and Requirements. 
The acceptability of the reuse needs to be argued in terms of the overall assurance objectives indicated by 
a standard: i.e. what needs to be demonstrated for assurance and compliance in the target context. 
Equivalence maps are also necessary between the Baseline of an Assurance Project and the Reference 
Framework(s) of the standard according to which a system must be assured.  

It is possible to create Equivalence Maps in two ways, by using the editor or by using a tailored 
functionality: 

1) To create Equivalence Maps using the editor, two CDO resources must be loaded first, i.e. the 
Reference Framework Model (.refframework) and the Mapping Model (.mapping). After, it is 
possible to create and define Equivalence Maps for activities, artefacts, requirements, roles and 
techniques.  

2) To create Equivalence Maps using the tailored functionality, a dedicated functionality is provided in 
the Properties view of the Baseline (i.e. the “Mapping Set” window). This window automatically 
saves the mappings when checking or unchecking elements of the target Baseline tree. Filtering can 
be applied to limit the elements. Elements can then be checked/unchecked to be part of the 
Equivalence Map between a source and a target Reference Framework (see also Section 5.3 
“Creating Equivalence Maps” of the Annex A for further information). 
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3.4 Process Reusability Definition  

The AMASS variability management approach provides support for Cross Project reuse and Cross Standard 
reuse. These activities should be linked with the AMASS Process Reusability Definition (red frame in Figure 
11), to derive the different configurations. For these steps, Process engineers and Assurance engineers are 
needed. It might be that depending on the organisation, the process engineer role is carried out by an 
assurance manager whose responsibility is to ensure the compliance of a process to a certain standard. 

 

Figure 11. Overview of the steps of the “Process Reusability Definition” process stage (red frame) in the context of the 
overall Assurance Project Definition 

In the context of the AMASS project, the BVR Tool is integrated with EPF Composer, CHESS Toolset and the 
OpenCert Tool to enable the management of process families, component specification lines and assurance 
case lines. 

In this section, variability management of families of processes is in focus. The other families can be treated 
in a similar manner. For detailed information, see Section 12.1 “Engineering of Process Lines” of the AMASS 
Platform User Manual (Annex A). 

3.4.1 Specify a Compliant Process (Baseline model) 

The Process Engineer is expected to model a process plan (Base Model) by using the EPF Composer tool. 
Such plan can be reused/re-configured in different contexts (similar project, same domain but different 
criticality level, similar project different domain/standard, similar project different but overlapping concern, 
etc.). For further details, see Section 4 “Process Modelling with EPF-C” of the Annex A. 
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3.4.2  Reconfigure/Tailor a Compliance Process 

To do that, the Process Engineer is also expected to use the three BVR Tool editors (VSpec, Resolution, and 
Realization) (see Figure 12) to model respectively the VSpec, a sort of Feature Model (a set of mutually 
constrained common and variable features characterizing the family of processes and organized in a tree-
like representation); the Resolution, a model in which the feature inclusion/exclusion is specified; and the 
Realization, a model which specifies the fragment substitutions, needed to concretise the new 
configuration by adding/removing features from the Base Model. For further details, see Section 12.1.2 
“Creation of a BVR Model” of the Annex A. 

3.4.3 Validate Reusability of a Reconfigured Process 

The BVR Tool also includes a checker to guarantee the validity of the desired reconfiguration. Thus, the 
Assurance Engineer/Assurance Manager can use the checker for validation purpose. For further details, see 
Section 12.1.3 “Process Variability Management with the BVR Editors” of the Annex A. The resulting model 
for the process plan is the input for the project specific process described in Section 3.5.5.  
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Figure 12. Project Reusability Definition - focus on process information 
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3.5 Assurance Project Definition 

The Assurance Project Definition is the first project-specific stage along the AMASS workflow (red frame in 
Figure 13 below). The phase includes several steps, which are described in the subsequent sections. 

 

Figure 13. Overview of the steps of the “Assurance Project Definition” process stage (red frame) in the context of the 
overall Assurance Project Definition 

3.5.1 Create Assurance Project 

When an Assurance Manager, the responsible for the product and process assurance, starts working with 
the AMASS Platform, the first step to achieve is the Assurance Project creation. Assurance Managers can 
maintain the lifecycle of projects by creating Assurance Projects, they should have knowledge of the 
standards as well as a safety/security background or both. The creation of An Assurance Project is achieved 
by adding a new file of type “Project” with a unique project name (see Section 6.1 “Creating an Assurance 
Project and Baseline” of the Annex A). 

An Assurance Project has three main elements: 

• Baseline Configuration: a Baseline Configuration has a set of Baseline Models. Each Baseline model 
results from importing (copying) a Reference Framework model or an EPF Composer model and 
adding information about its selection in the current project (i.e. it answers to the question: Does a 
given Reference Framework model element apply to the current Assurance Project?). A Baseline 
model represents what is planned to comply with, in a specific Assurance Project. 

• Permissions Configuration. It supports profile creation to enable restricted access to AMASS 
functionality and data. 

• Assurance Assets Package. This is a pointer to some project-specific Artefacts models, 
Argumentation models, Process models and Architecture models. These four models represent 
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what has been done in a specific Assurance Project. The mapping of these four models with 
Baseline Models is modelled using the concept of Compliance Map. 

An Assurance Project can have multiple Baseline Configurations, Permissions Configurations and Assurance 
Assets Packages, whereby only one is active at once. 

An Argumentation model can be automatically generated (see also Section 3.7.3 and Section 9.2.2 
“Creating a Diagram at the Project creation time” of the Annex A), based on selected standard parts of a 
standard. For that, the Assurance Manager can choose to select the related Reference Framework (the 
standard) and assign it to the project (for the creation of a Reference Framework see 3.3.1). Further, the 
criticality and/or applicability level that the project has to accomplish can be defined. The mandatory parts 
of the standard to comply with the selected levels will be automatically added, and also the other parts of 
the standard that don’t have relation with any criticality or applicability will be added. The Assurance 
Manager can also select directly the contents of the standard that will be applied to the project (tailoring of 
the standard) and a Baseline will be generated as result.  

• After the steps above, the Assurance Project appears in the project browser and it is stored in a 
database, accessible by all the people involved in the project and with access to it. The Assurance 
Project is composed by four folders:Assurance Project folder with project information 
(.assuranceproject model), the baseline information (.baseline model with diagram) and the 
mapping model (mapping.model ) to store the compliance mapping information; 

• Argumentation folder for storing the argumentation models; 

• Evidence folder for saving the evidence models; 

• Process folder for the processes execution. 

By default, the Assurance Project is related to all the automatically generated models, the Baseline and 
Mapping models in the active BaselineConfig and the Argumentation model in the active AssetsPackage. 
This Assurance Project information can be edited by the Assurance Manager and also new models related 
to the Assurance Project can be added.  

3.5.2 Define Compliance Baseline 

Baselines are subsets of Standards to be applied in a specific Assurance Project. Baseline Models are 
created by tailoring of Reference Frameworks, i.e. by importing a Reference Framework model and 
selecting elements for the current project. Thus, a Baseline defines the elements of a Reference Framework 
model that have to be applied to the current Assurance Project. An Assurance Project can include several 
Baseline Models (i.e. a Baseline Configuration) while only one can be active at the same time. 

Baseline Models can be added to an Assurance Project along with its creation (see also Section 3.5.1 and 
Section 2.4) or can be created on request by a dedicated wizard. For each new Baseline, a name must be 
provided, and the related Assurance Project must be selected (see Section 6.2 “Creating or updating a 
Project Baseline” of the Annex A). The following steps describe the generation of a Baseline Model: 

• Select the desired Reference Framework model to be used as source for the generation of the 
baseline. 

• A tree appears presenting the contents of the Reference Framework, where it can be checked that 
the nodes of the tree will be applied to this baseline.  

• After finishing the editing, the new Baseline and argumentation models are added to the Assurance 
Project model and stored in the appropriate Assurance Project Folders. 

• A new Baseline can also be created by modifying an existing one and storing it with a new name. 
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The elements of the Baseline can be edited by selecting the Baseline and then selecting the particular 
elements in the elements tree presented by the editor. Alternatively, Baseline Model diagram can be 
edited by a graphical editor (only applicable for EPF-C models). For more details, see Section 6.3 “Editing a 
Project Baseline” in the Annex A. 

3.5.3 Cross Standard Reuse 

The main objective of this step is to enable the reuse of the assurance/certification related data (e.g., 
Assurance Cases) and work products (e.g. a design specification) in order to minimise the repetition of 
assurance/certification related activities if a product is developed for more than one target domain or 
standard.  

Two main capabilities of the AMASS Cross Standard reuse approach have been described in this document, 
i.e. Compliance Mapping (Section 3.5.6) and Equivalence Mapping (Section 3.3.2). 

Concerning Evidence, the reuse may include results from conducting assurance (e.g., safety) related 
activities and procedures as well as applying same methods or tools. If the Evidence of having conducted 
such activities is sufficient, there is no need to repeat them when reusing the component. Evidence can be 
classified into immediate (design artefacts describing the product technically), direct (verification results on 
product level), and indirect (process level). Figure 14 shows schematically the activities for the Cross 
Standard reuse of Evidence. 

 

Figure 14. Sub-activities related to the Cross Standard Reuse of Evidence 

For reusing Cross Standard Evidences, Equivalence Maps are required between the Reference Framework 
of the source project and the Reference Framework of the target project. Accordingly, the source project 
must have an Evidence Model.  

The Cross Standard reuse functionality can be accessed by the “Cross Standard” function in the Properties 
view of the target Assurance Project (see also Section 6.5 “Cross Standard Reuse” of the Annex A). If the 
target project has no Evidence Model, it can be generated automatically based on the contents of the 
target Assurance Project Baseline. In this case, for each Base Artefact in the target Baseline, one Artefact 
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Definition with one Artefact will be included in the target Evidence Model. The Evidence Model will be 
assigned to the target Assurance Project and also the Compliance Maps between the Baseline and the 
Evidences will be automatically created. If the target model already has an Evidence Model, the Process 
Engineer/Assurance Manager is asked if he/she wants to use it as destination model of the source Artefacts 
to reuse.  

After the steps above, the Cross Standard window will be opened (see Figure 15), which provides three 
zones: 

• The left zone shows information about the target project, in particular a tree with the target Baseline 
contents. Baseline elements can be selected in the tree to show related Compliance Map information 
and a tree with the contents of the target Evidence Model.  

• The middle zone displays Equivalence Map information. It includes controls to select the Equivalence 
Mapping model and the Equivalence Map Group, as well as the Equivalence Map details of the target 
Baseline and its post-conditions in a list. 

• The right zone presents information about the source project, in particular a tree with the contents 
of a selected source Baseline as well as the Compliance Map information of the source Baseline and 
the contents of the source Evidence Model. 

 

Figure 15. Cross Standard window 

The Process Engineer /Assurance Manager can obtain detailed information of any element displayed in the 
trees. The target Evidence Model, can be edited directly in a popup window. Further, new Compliance 
Maps between the target Baseline and the target Evidence Model can be created by using the tailored 
Compliance Map functionality (see also Section 3.3). 

If the Equivalence Model and the Equivalence Group of the source project have been selected, it is possible 
to select the target Baseline element that will receive the Evidences to be reused and its Compliance and 
Equivalence Map information will be displayed in the trees. The Process Engineer/Assurance Manager can 
now select Artefacts from the source project that should be copied to the target project. The source 
repository configuration information inside the Artefact Model Object, the Resource objects of the checked 
source Artefacts and the repository files related to these resources will be copied to the target Evidence 
Model as well as selected post-conditions. 
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For detailed information about the steps above, see Section 6.5 “Cross Standard Reuse” of the Annex A and 
Section 3.2 of D6.8 [10]. 

3.5.4 Cross Project Reuse 

Reusing process information from already defined projects is another capability of the AMASS Platform in 
order to reduce development efforts, i.e. reusing models from a source Assurance Project to a target 
Assurance Project.  

The workflow in Figure 16 shows a way to develop reusable processes (see also Section 2.1 of D6.8 [10]). As 
initial step, relevant standards are identified or, alternatively, an existing engineering process is selected. 
Based on this selection, the reusable generic base process is developed. It includes all activities, which 
might be necessary and all available methods. With the deviation to an Assurance Project specific process, 
a reduction takes place. All activities, which are not supposed to be part of this specific process are 
removed. A check is necessary to be sure that the assumptions for the reused activities are valid for the 
new project. If the validation is passed, the project specific process, which reuses parts of the generic base 
process, is ready for execution. During the process execution, the Process Engineers/Assurance Managers 
must deal with some variabilities mainly caused by some product specific decisions. 

 

Figure 16. Sub-activities related to Cross Project reuse development [10] 

As for the Cross Standard reuse (see Section 3.5.3) the AMASS platform provides a dedicated function to 
manage the Cross Project reuse, i.e. to copy models from a source Assurance Project in a target Assurance 
Project (also the related diagrams will be copied to the target project if existing). Only source Evidence 
Models associated to the active Assets Package can be reused, because evidences are not related to any 
other model of the project, or all the Baselines associated to the active Baseline Configuration and all the 
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Evidence, Argumentation and Process models of the active Assets Package could be reused. In this second 
option all the models will be cloned to assure the integrity of the data, for example, a Baseline could be 
related with argumentations, evidences and/or processes and in this way, we are sure all the related 
information is copied avoiding inconsistencies. 

The Process Engineer/Assurance Managers must select the source project to display the models of the 
related Baseline Configuration and the active Asset Package. Two alternative preferences for reuse are 
possible:  

• Reuse only selected source Evidence Models associated to the active Assets Package, because 
evidences are not related to any other model of the project, or  

• Copy all the Baselines associated to the active Baseline Configuration as well as all the Evidence, 
Argumentation and Process models of the active Assets Package. In this second option all the 
models will be cloned to assure the integrity of the data.  

It is also possible to reuse models from one source Assurance Project to a target Assurance Project using a 
specific view called “Reuse”. This view is particularly useful to reuse a subset of model elements, which can 
be selected manually by the user (e.g. Assurance Manager). For detailed information about the steps 
summarized above see Section 6.6 “Cross Project Reuse” of the Annex A. 

3.5.5 Model Project Specific Process 

For the modelling of processes the AMASS Platform provides two tools: 

• the Eclipse Process Framework Composer (EPF-C) [18], used to model processes during the 
planning phase and 

• the Eclipse RCP application WEFACT, which is an external tool whose database is independent of 
the AMASS platform database (see D4.8 [8]). WEFACT is used to model processes during the 
execution phase. 

For creating and defining processes in the EPF Composer, the Authoring perspective of the tool is used, 
which enables the access to the Method library, the configuration and the element/modelling space of the 
processes. The Method Library is the structure used by EPF Composer to organise the contents related to 
the modelling of process. The library is composed of a set of plug-ins and configurations. Plug-ins are 
containers of process related information, while a configuration is a selection of the contents of the library 
to be shown in the Browsing perspective. 

The modelling of a process mandated by a certain standard is done by the modelling of a delivery process 
(see also Sections 4.4 and 9 of [18]). Before the modelling of the delivery process, it is necessary to analyse 
the standard and derive the process elements (tasks, roles, work products and supporting material) that 
will be part of the process. Then a new delivery process can be created in the Processes folder of the 
plugin, which opens a form for the modelling of the process with several tabs for definitions of tasks, work 
breakdown structure, team allocation, work product usage and consolidated view, as shown in Figure 17. 
The work breakdown structure is used to describe the structure of the work.  

The work can be decomposed by breaking down the process to phases (a number of activities representing 
a part of the overall process), iterations of phases and activities (summary tasks). Additionally, milestones 
can be added, i.e. points in the process in which specific work products are released. As mentioned above, 
it is possible to re-use process elements defined in the Content Packages to assemble processes. EPF-C 
enables also the modelling of processes using UML-Style Activity Diagrams (Section 4.4.5 of [18]).  
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Figure 17. Modelling of a process in EPF Composer 

The EPF Composer fully supports the reuse modelling capabilities of the SPEM 2.0 (Software & Systems 
Process Engineering Metamodel) standard [19]. Therefore, it is possible to define a library of process 
elements (i.e. roles, tasks, work products or guidance) that can be re-used to assemble different processes 
[19]. Section 4.2 of the EPF Composer manual [18] provides guidance in the definition and reuse of the 
process elements. In order to model contents related to a process, a method library as well as method 
plugins can be both created and imported. For detailed information, see also Section 4 “Process Modelling 
with EPF-C” and Section 6.11 “Import models into Assurance Projects” of the Annex A.  

A further feature of the EPF Composer is the modelling of reusable process patterns, which can be used as 
building blocks to assemble larger capability patterns and delivery processes (see Sections 4.4 and 9 of 
[18]). The process models modelled via the EPF Composer can be transformed into models compatible with 
the OpenCert tool by exporting XML files from EPF Composer and importing them in OpenCert (see Section 
4.3 “Modelling of Reusable Process Patterns” of the Annex A).  

For sake of clarity, it should be recalled that EPF Composer can be used for compliance management. More 
specifically, process compliance can be modelled in EPF Composer using a similar procedure to the one 
presented in [24]. In order to apply this, three separate plugins can be created, in particular, capturing 
standard requirements, modelling process lifecycle (i.e., content elements and process) and mapping 
standard requirements. Details regarding the usage of EPF Composer for compliance management can be 
found in Section “Appendix A: Standard Modelling and Compliance in EPF-C” of the AMASS Platform User 
Manual (Annex A). 

The second tool applied in AMASS for the modelling of processes is WEFACT which provides the following 
main features (for more information, please refer to D4.8 [8]): 

• selecting a project or creating a new one, 

• defining users and roles, 

• importing requirements (currently from a DOORS database) or defining them in WEFACT, 

• defining activities to be performed by the workflow engine, 
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• assigning activities to requirements and to tools, thus supporting traceability, 

• executing these activities (by invoking the tools), 

• setting the fulfilment status of the requirements to PASS or FAIL, depending on the result of the 
activities. 

These basic features are complemented by the following functionalities: 

• definition of user accounts and user authorization, 

• importing process models created in EPF-C (the imported activities form then the basis for the V&V 
activities in WEFACT), 

• assigning tools; a list of tools is maintained in WEFACT and individually assigned to V&V activities, 

• traceability. 

Figure 18 summarizes the functions of WEFACT as well as its interfaces.  

 

Figure 18. Typical use of WEFACT in AMASS [8] 

3.5.6 Compliance Monitoring 

A map type applied by AMASS for Cross Standard and Cross Project reuse (see also Sections 3.5.3 and 3.5.4) 
is the Compliance Map. Compliance Mapping is the mechanism by which the system indicates that an asset 
(an activity of the process, a requirement, an analysis…) has been executed in compliance with the 
corresponding standard or regulation. Accordingly, this mapping specifies how the information of an 
Assurance Project (i.e., its body of Assurance Assets) complies with its Baseline. Compliance Maps can be 
fully, partial, or no mapping. By mapping an artefact to a Reference Artefact selected for a Baseline, the 
intent of the artefact has to be indicated. 
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The Compliance Maps of the source Assurance Project will typically fully comply with its Baseline. This 
Baseline will correspond to a template, which is used in the project. For example, a Baseline from a 
Reference Framework for DO-178C will have software requirements data as an Artefact to provide, and an 
Assurance Project can have a single artefact that maps to the Software Requirements Data. Nonetheless, 
an Assurance Project can also manage, structure, or group its artefacts in a different way as a standard 
indicates, but still being compliant. For example, an Assurance Project could have more than one artefact 
for its Software Requirements Data, such as high-level requirements specification and low-level 
requirements specification. Each of these artefacts would partially map to the Software Requirements 
Data. 

Compliance maps for the target Assurance Project can be derived from the compliance maps of the source 
project. For Cross Standard reuse, the likelihood of derived full maps is low due to the differences that 
usually exist between standards. The assurance information of the source project fulfils the requirements 
of its baseline and this baseline has been generated from a specific Reference Framework (both belonging 
to the source domain for the Cross Standard reuse). The target Assurance Project will have a different 
baseline and Reference Framework, thus different requirements to fulfil. Nonetheless, some Reference 
Requirements can be similar or equal. For example, an artefact that complies with EN 50128 Software 
Requirements Specification will partially map to the DO-178C Software Requirements Data. 

In the AMASS Platform, it is possible to create Compliance Maps in two ways, by using the editor or by 
using a tailored functionality (see Section 6.4 “Editing Compliance Maps” of the Annex A): 

• To create Compliance Maps using the editor, four CDO (Connected Data Objects) resources have to be 
loaded first, which have to be part of the Baseline Configuration and Assets Package of the Assurance 
Project: the Artefact model (.evidence), the Process model (.process), the Argumentation model (.arg) 
and the Mapping model (.mapping). The Artefact model, Process model and Argumentation model 
must be part of the active AssetsPackage of the project while the Map Group of the Mapping model 
must be part of the active Baseline Configuration of the project. After, it is possible to create and define 
Compliance Maps for activities, artefacts, requirements, roles and techniques.  

• To create Compliance Maps using the tailored functionality, a dedicated function (“Mapping Set”) is 
available in the Properties view of the Baseline (see Figure 19). The “Compliance Map” form 
automatically saves the mappings when checking or unchecking elements of the target Baseline tree. 
Filtering can be applied to limit the elements. Elements can then be checked/unchecked to be part of 
the Compliance Map between a source and a target Reference Framework.  

It is possible to monitor the compliance status of the assurance project’s active Baseline by the 
“Compliance Mapping” table. To access this window the “Mapping Table” button on the properties view of 
the Base Framework element of a Baseline must be pressed using the tree view editor (see Figure 19). By 
default, all the Baseline elements that have a Compliance Map are shown in the table. Filtering by several 
criteria can be applied to limit the elements shown in the table. For each base element (a row in the table) 
it is possible to double click in one element of the target list to access to detailed information of the select 
target element. 
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Figure 19. Access to the Compliance Mapping Table  
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3.6 System Design, Analysis and V&V  

This stage comprises some specification steps, in particular the specification of the system architecture 
model following the system requirements, and a set of contracts to define assumptions and guarantees for 
a component. Based on this, several steps of analysis and V&V can be performed. For the latter, partly also 
external tools are integrated by interfaces to the AMASS platform.  

Figure 20 summarizes the particular steps required for the “System Design, Analysis and V&V” stage. This 
workflow includes actions that form the basis of architecture-driven assurance from a multi-concern point 
of view. To do so, the user guidelines described in D3.8  [7] and D4.8 [8] have been merged. Sub-sections 
3.6.1 to 3.6.8 are related to the steps depicted in Figure 20, while sub-section 3.6.9 elaborates on the 
artefacts that can be collected once each of the steps has been executed.  

Concerning roles, it is important to highlight how certain activities require a stretch collaboration between 
them. This might be the case for “Specify System Requirements”, “Specify System Component Definition”, 
“Specify Contracts to Components (Functional Refinement)” and “Specify component’s nominal and error 
behaviours”. The same applies to “Requirements early validation” which can be shared among different 
Assurance Engineers such as safety, security and formal verification engineer (i.e. a V&V engineer 
specialised in formal methods). The use of italics in the figure stands for the refinement of the Assurance 
Engineer. For example, Safety Engineer, Security Engineer, V&V Engineer or Formal Verification Engineer 
are considered as part of this group. Depending on a specific organisation or company, this classification 
and nomenclature could slightly differ. For further information on this nomenclature and associated steps, 
please refer to the deliverable D3.8 [7]. 
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Figure 20. Overview of the steps for the “System Design, Analysis and V&V” process stage 

3.6.1 Specify System Requirements - Requirements Early Validation 

System requirements can be created by using the SysML Requirement diagram, which can be added in the 
model explorer (right click on CHESS RequirementView package). After, the palette can be used to create 
Requirement entities (see also Section 7.2 “Create Requirements” of the Annex A). Papyrus also supports 
the import of requirements from different sources, e.g. Excel files or ReqIF models.  

Further, requirements can be created in the MORETO tool (Model-based Security Requirements 
Management Tool) (see also Section 3.8 of D4.6 [12]). MORETO is an Enterprise Architect (EA) plugin, which 
supports modelling security requirements applying to nodes in a network. The tool features security 
requirements analysis, allocation, and management using SysML/UML models. It is applicable to any 
system that can be modelled in SysML/UML (e.g. cyber-physical production systems CPPS). The tool is 
implemented in Enterprise Architect MDG technology and supports manual as well automatic security 
requirements generation and allocation. The interface between MORETO and CHESS/Papyrus is 
accomplished with the ModelBus tool (see also Section 3.8.2 of D4.6 [12]). 

MORETO provides a model editor but can as well import (EA conformant) SysML models. The models, 
which capture system facts in layers of abstraction (External Layer, Intermediate Layer, and Internal Layer), 
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are exploited for security analysis and documentation. The model editor allows seamlessly navigating 
through layers with different level of detail. MORETO supports Security Analysis on high level as well as on 
technical level, and requirements can be generated manually or automatically (see Figure 21). 

 

Figure 21. Options for requirements generation in MORETO [12] 

For creating security requirements manually, MORETO provides the Security Requirement Diagram, where 
the security engineer can specify a particular security requirement, and use a drag and drop mechanism to 
assign it to the respective element in the model. As an alternative MORETO allows the import of csv files. 

MORETO offers two different ways for security requirements automatic generation: 

• Patterns are a feature provided by Enterprise Architect to generate a set of components which are 
integrated to solve an abstract problem. The security engineer can modify the pattern elements to 
meet the specific demands. 

• Scripts executed in Enterprise Architect have access to the currently open model and are a 
powerful tool for querying and updating the model in situations that would otherwise require time 
consuming and repetitive GUI tasks. 

The security requirements automatic generation is based on expert knowledge encoded in MORETO usually 
based the prescriptions of standards. For realizing the standards, patterns were used with MORETO in 
AMASS; currently implementations for IEC 62443 [38] and IEEE 1686 [52] are available. 

MORETO supports the system modelling process in four different diagrams: 

• Block Definition Diagram (BDD) for network element. 

• Internal Block Diagram (IBD) for detailed modelling. 

• Dataflow Diagram (DFD) for threat Modelling.  

• Requirement diagram for security requirements. 
 
Early validation of requirements written in natural language can be performed by using the Requirement 
Quality Analyser (RQA) tool, integrated with the AMASS Platform, to analyse the quality of the 
requirements with respect to the given measures of interest (see Section 3.2.4 of D3.8 [7]). 

3.6.2 Specify System Component Definition 

This step and the following steps summarise the usage of the support of the Papyrus and CHESS to model 
the system architecture, with focus on contract-based design, and the modelling of the links between the 
architecture and assurance related information, allowing to put the basis for the AMASS approach for 
Architecture-driven Assurance. 

A CHESS project and model can be created by using the dedicated CHESS wizard. In particular the folder 
where the model and other artefacts are stored is created. A CHESS model is a Papyrus 
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UML+SysML+MARTE model coming with a predefined set of packages/views and with the CHESS profile 
automatically applied on it, to allow modelling of contracts, dependability and real-time concerns. The 
CHESS profile and tool can also be used to exploit different analysis at system level, and to apply the CHESS 
model driven methodology for the design, analysis and implementation of critical SW systems. The 
application of the CHESS methodology for SW development is not mandatory in the context of the AMASS 
solution. More information about the CHESS methodology can be found at [4].  

The CHESS editor is actually a customisation of the Papyrus editor, offering a set of features on top of the 
CHESS model. To have an overall understanding of the Papyrus environment, e.g. regarding the different 
views, commands, diagrams, please refer to the Papyrus user guide [5]. In particular, a SysML Block 
Definition Diagram (BDD) and Internal Block Diagram (IBD) can be created and edited, which can be used to 
model the system components definition and their functional refinement, by using blocks, ports and the 
connections (see also Section 7.1 “Create a CHESS Project, Model and Diagrams” of the Annex A). 

 

Figure 22. Hierarchical view of the system decomposed into sub-components and contracts 

CHESS/Papyrus also supports the definition and instantiation of architectural patterns in the context of the 
system of interest. In particular CHESS comes with a library of architectural patterns that can be applied 
during the refinement of the system architecture (in particular in the context of a given Internal Block 
Diagram) as solution to a recurring design problem and to cover specific requirements, for instance related 
to safety or security. CHESS architectural patterns also come with a set of information about the properties 
that can be inherited by the application of the patterns themselves; these properties can serve as the basis 
for assuring that the application of the architectural pattern adequately addresses the problem that is 
trying to solve. 

3.6.3 Specify Contracts to Components (Functional Refinement) 

A Contract specification defines assumptions and guarantees for a component, i.e. the contract for a 
component defines the assumed behaviour of the environment and the behaviour to be guaranteed by the 
component where contracts properties represent formalized system component requirements. Contracts 
can be created directly in a Block Definition Diagram (BDD) and in a Class/Component Diagram (see also 
Section 7.6 “Create a Contract” of the Annex A). Alternatively, it is possible to create a Contract without the 
need to create its graphical representation from a BDD. For that, a ContractEditor can be used by selecting 
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the corresponding element in the Model Explorer View or in the graphical editor. Once a model component 
that has a contract has been decomposed, it is possible to refine it by editing its properties.  

FormalProperties, which play the role of Assumption and Guarantee in a Contract, can be created manually 
by using the dedicated tool in the Contracts palette. A FormalProperty can be created in a BDD/Component 
diagram and as a FormalProperty in a Contract. FormalProperties can be edited by selecting the 
FormalProperty from the Project Explorer View, or by selecting its graphical element from the BDD. 
FormalProperties can be assigned as Assume or Guarantee to a given Contract. For more information, refer 
to Sections 7.4 “Create Formal Properties” to 7.7 “Specify Assumption and Guarantee for a Contract” of the 
Annex A. 

  

Figure 23. Editing the Contract’s Assume and Guarantee 

3.6.4 Specify Component´s nominal and error behaviour 

For a given system component, both the nominal and faulty behaviour can be defined. The nominal 
behaviour of component can be provided by using UML State Machine diagrams. The component 
behaviour specification models the implementation of the component, which must be validated w.r.t. the 
contracts attached for the component itself (see also Section 3.6.3 “Contracts specification”). 

The faulty behaviour for a component can be provided by using the CHESS dependability profile (see also 
Section 7.12 “Specify Component Behaviour (nominal and faulty)” of the Annex A). Several possibilities 
exist in CHESS to model the faulty behaviour of a component. For instance, faulty behaviour can be 
modelled in a dedicated state machine stereotyped with ErrorModel. The following information can be 
provided through an ErrorModel state machine: 

• Initial state: represents the “healthy” state of the component. 

• Errors: UML State, with the «ErrorState» stereotype. 

• Internal faults: UML Transitions, with the «InternalFault» stereotype, connecting the initial state 
and an error state, including also a time to fault occurrence (time distribution). 

• Internal propagations: UML Transitions, with the «InternalPropagation» stereotype, including a 
delay (time after which the propagation occurs), a weight (the relative probability of occurrence) 
and externalFaults (a Boolean expression on the occurrence of external faults, i.e. failures incoming 
on input ports of the component); 

• Failures: UML Transitions, with the «Failure» stereotype, including the failure mode(s) under which 
the failure manifests itself on the port(s) of the component. 

Once defined, the ErrorModel state machine can be attached to a given component by stereotyping the 
component with «ErrorModelBehaviour» (see Figure 24). 
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Figure 24. Example assignment of an ErrorModel to a ErrorModelBehavior 

3.6.5 Functional Early V&V  

The AMASS Platform supports the integration of external V&V tools (e.g. OCRA, nuXmv, xSAP). There are 
two approaches to access the AMASS V&V functions, which are summarised hereunder. For further 
information, refer to Sections 7.17 “Setup External V&V Tools” to 7.22 “Perform Model Checking on 
Component Behaviour” of the Annex A. 

Functions accessible via the CHESS Model Explorer view or the corresponding graphical representation in 
the diagram editor 

• Check of Contract Refinement  

For a model component that has a (decomposed) contract, it is possible to refine the properties of the 
contract. For a Component selected in the Model Explorer, the contract refinements considered will be 
the ones associated to the selected component and the ones associated to its sub components. This 
operation includes recursively all the contracts along the subcomponents, from the root to the leaves 
of the system. Further information in Section 7.18 “Perform Check of Contract Refinement” of the 
Annex A. 

• Check of Component Implementation on Contracts 

This check verifies that the state machines defined in the model satisfy the related contracts. The 
contracts and state machines considered will be the ones associated to the selected component and 
the ones associated to its sub components. This operation includes recursively all the contracts and 
state machines along the subcomponents, from the root to the leaves of the system. Further 
information in Section 7.19 “Perform Check of Component Implementation on Contracts” of the Annex 
A. 

• Consistency Check of Formal Properties 

This validation is done by checking whether a specific guarantee of a contract satisfies the assumption 
of another contract. The properties available to check will be the assumptions and guarantees of 
contracts owning to the selected component and to its sub components. This operation includes 
recursively all the properties from the root to the leaves of the selected component. In particular, the 
consistency non-redundancy, and realizability of Formal Properties will be checked. Further 
information in Section 7.21 “Perform Consistency Check of Formal Properties” of the Annex A. 

• Model Checking on Component Behaviour 

The components behaviour to check will be the behaviour of the selected component and the 
behaviour of its sub components. This operation includes recursively all the behaviours from the root 
to the leaves of the selected component. Further information in Section 7.22 “Perform Model Checking 
on Component Behaviour” of the Annex A. 
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Validation of Strong and Weak Contracts 

An important issue for Architectural-driven Assurance, besides the connection of the system elements with 
assurance elements, is the introduction of strong and weak contracts to support out-of-context reasoning 
and component reuse across a variety of environments. While strong contracts must hold in all 
environments, the weak ones are environment specific, i.e. the weak contracts offer additional information 
about the specific context where the weak assumptions are to be met. Prior to performing the refinement 
check using strong and weak contracts, we create contracts and allocate them to the component types 
(they represent out-of-context components). At the component type level, we indicate if a contract is 
strong or weak. 

When the component type is instantiated in a particular system to a component instance, all the strong, 
and a subset of weak contracts can be identified as relevant in the particular system in which the 
component is instantiated. Identifying those relevant weak contracts can be done manually at the 
component instance level. The relevant weak contracts imply that the assumptions of those contracts have 
been met, and that they will be included in the corresponding assurance case argument. The relevant 
contracts whose assumptions have not been validated are also included in the argument, but with a 
counterexample associated with the goal assuring the contract satisfaction. 

We use the Contract Refinement Analysis (OCRA) command in CHESS to transform the CHESS model into 
an Othello System Specification (.oss) file readable by OCRA, which then runs the OCRA refinement check 
and outputs the results. Since the .oss format does not explicitly distinguish between strong and weak 
contracts, but treats all the contracts as strong, the weak contracts need to be accordingly transformed to 
strong contracts for the .oss format.  

To perform the refinement check with strong and weak contracts, we first create a 
ContractRefinementAnalysisContext in the DependabilityAnalysis view the platform that should be 
analysed can be selecteed. To run the refinement check by considering all the contracts the attribute 
checkAllWeakContracts needs to be set to true.  If the checkAllWeakContract attribute is set to false, the 
refinement check will be performed such that the selected weak contracts on the component instance level 
will be treated equally as the strong contracts in the generated .oss file. In this case we need to either 
manually ensure that we do not select contradictory weak contracts, or automatically select the relevant 
weak contracts by running the Validate Properties (OCRA) command. 

 The “Validate Properties” (OCRA) command will check validity of each weak contract assumption and 
identify which weak contract assumptions are met in the given system. Upon running the weak contract 
assumption validity check, the contract status is updated accordingly, and those contracts are automatically 
selected in the corresponding component instance. Now it is possible to run the refinement check with the 
flag checkAllWeakContracts set to false without it prompting an inconsistency error. It should be noted that 
a limitation of the Validate Property command is that it can be executed only with a discrete-time 
specification; hence the usage of continuous variables or operators in the contracts disables the validity 
property check. 

For further instructions check on the following sections from the AMASS Platform User Manual (Annex A): 
7.10 “Associate a Contract to a Block/Component” and 7.20 “Perform Consistency Check of 
Assumption/Guarantee Formal Properties”. 

V&V Manager  

The V&V Manager allows distribution of the verification and validation tasks to multiple servers. Depending 
on the selected model elements and on their context (e.g. the availability of the associated models) and on 
the available verification servers and verification tools, the V&V Manager supports the decision making 
about the V&V activities that shall be performed. For that, V&V Engineer must select formal properties and 
interface requirements from the file system and then V&V Manager sends it to the verification servers. The 
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V&V tools implemented on the verification servers return the V&V Results. Further details in Section 7.23 
“V&V Manager” of the Annex A. 

3.6.6 Analyse multi-concern trade-offs 

Parallel to process-related assurance assessment, product-related co-assessment is used to determine the 
effectiveness of functional safety measures and functional security measures with respect to their safety 
and security objectives. The safety and security objectives can be specified by the requirements. 
Assessment methods include verification, validation, and testing. The results of the assessment can be used 
for safety and security argumentation in Assurance Cases. 

For such co-assessments for Safety and Security Assurance, the ConcertoFLA tool and other external tools 
that are integrated in the AMASS Platform can be used (for detailed information refer to D4.3 [15]): 

• ConcertoFLA 

System dependability co-analysis can be performed via ConcertoFLA [20], which enables safety and 
security engineers to decorate component-based architectural models specified in CHESSML with 
dependability-related information, execute Failure Logic Analysis (FLA) techniques, and get the results 
back-propagated onto the original model. CHESSML is an extension of SysML used in the CHESS toolset 
to enable component-based systems design. The dependability modelling is supported by SafeConcert, a 
subset of CHESSML, which allows the modelling of the failure behaviour for system components and so 
model-based dependability analysis, like failure propagation or state-based analysis. In particular, the 
safety (e.g., fault, error and failure) and security properties (e.g., attack, vulnerability and threat) can be 
modelled using the above-mentioned subset of CHESSML – a FLA can be conducted to generate the 
multi-concern failure propagation paths. Moreover, these multi-concern failure propagation paths can 
be transformed to generate a multi-concern fault tree automatically (see Section 3.5.3 of D4.8 [8] for 
detailed steps to conduct the co-analysis and automatic generation of the multi-concern fault tree). 

• WEFACT 

The workflow engine WEFACT supports the entire engineering lifecycle of safety and or security relevant 
systems based on pre-defined processes (see also Section 2.3.5 of D4.8 [8]). To achieve this goal, every 
project in WEFACT contains Requirements, Processes and Workflow Tools. Figure 25 shows the WEFACT 
user interface. 

 

Figure 25. WEFACT user interface example after importing a process model 
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WEFACT is an (independent) Eclipse RCP application, which operates on a PostgreSQL database. As 
WEFACT is an external tool, this database is independent of the AMASS platform database. 

In the context of multiconcern co-analysis, the workflow engine WEFACT can be used to “construct” 
multiconcern co-analysis by combining e.g. a safety and a security analysis tool in a common workflow. 
Figure 26 shows the workflow of such a combined multiconcern analysis. 

 

Figure 26. Multiconcern analysis implemented with separate tools as a WEFACT workflow 

The separate analysis processes hand their result (e.g. safety and security requirements) over to the 

Interaction point2 activity, where the result is analysed w.r.t. contradictions and – in case of 
inconsistencies - the workflow leads back to the previous analysis process (red dotted arrows) to repeat 
the analysis activity with modified preconditions.  Potentially, several such iterations can be necessary. 
At the end, when no more conflicts are identified in the Interaction point, the workflow continues via 
the green “OK” arrow. 

• FMVEA tool 

The Failure Modes, Vulnerabilities and Effects Analysis (FMVEA) is a method for supporting a combined 
safety and security analysis (see Section 2.3.3 of D4.8 [8]). The method tries to cope with the problem 
that the risk of safety threats can be calculated as a quantitative value based on the stochastic failure 
probability, but there is no comparable numeric value that can be given for security hazards because 
many existing vulnerabilities are yet unknown and there is no analytic method available to determine 
the attack probabilities. FMVEA therefore adds a traditional semi-quantitative security assessment 
approach, namely Microsoft’s STRIDE classification scheme, to the classical safety-oriented method 
FMEA (Failure Modes and Effects Analysis). 

Figure 27 shows the browser-based user interface of the model editor, which allows to create the 
system model to be analysed, including the quality attribute specific properties of the model elements. 
The FMVEA tool interfaces with the AMASS platform on the one hand with the SysML model provided, 
e.g. by Papyrus, and on the other hand with the created safety and security requirements (ReqIF 
format), which can be imported in the AMASS Platform. 

 

                                                           
2 The term “Interaction point“ is used in the AQUAS project https://aquas-project.eu/ . 

https://aquas-project.eu/
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Figure 27. User Interface of the FMVEA model editor 

The analysis is based on rules, which are defined in the FMVEA Rules Editor. Typically, a predefined rules 
database is used, which was previously created based on the requirements from standards. Rules can 
refer to safety or security goals, but basically any concern can be addressed. This allows implementing 
deliberate combinations of multiconcern analyses in a single tool. 

Based on the rules, the FMVEA Analysis can be started with the respective push button, and the risk 
assessment is performed automatically. Finally, as a feature currently (Oct. 2018) under development, 
the requirements for the (safety/security/etc.) mitigation measures shall be created.  

• Safety Architect 

Safety Architect is integrated in the AMASS platform - CHESS tool, as external tool, to support safety and 
security analysis (see Section 2.3.6 of D4.8 [8]). Indeed, the CHESS system architecture and 
dependability profile can be imported in Safety Architect, and the safety and security viewpoint already 
available in Safety Architect can be applied to describe the way failures and security threats are 
propagated inside the system architecture. Then the tool can automatically generate safety and security 
co-analysis artefacts, such as propagation trees (fault tree extended with malicious events) or FMVEA 
tables (classical FMEA with vulnerability events), see also [27][28]. 

3.6.7 Validation of Safety Properties (Safety Analysis) 

The Safety Analysis features provided by the AMASS platform are summarised hereunder. For more 
detailed information refer to Section 3.3 of D3.8 [7]. 

• Simulation-based Fault Injection 

Fault injection emerges as a way to perform a simulation-based safety analysis at the same time that helps 
verifying and validating the safety of a certain design. The systems engineer/safety engineer starts by 
modelling the system architecture with its corresponding components e.g. in Papyrus/CHESS. After, 
traditional safety analysis techniques (e.g. FMEA) and fault injection are put together in order to perform a 
combined analysis of the system. The simulation-based fault injection process starts by importing the 
CHESS and its associated Simulink model to the Sabotage fault injection framework. This allows 
configuring the fault injection experiments in the Eclipse-based Sabotage editor.  

The complete process works as follows: first, information regarding the CHESS and the associated Simulink 
models are imported to the Sabotage editor. After selecting the system model under test (golden or fault 
free), the faulty system under test needs to be created. To do so, the safety engineer/safety verification 
engineer includes as many faults as he/she wants in the editor to create what in the fault injection field is 
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called the Fault List (see Figure 28). This includes the Fault Target, Fault Injection Trigger, Fault Duration 
and Fault Model. This allows completing information regarding where to inject a fault, which failure mode 
needs to be reproduced (fault model) and the faulty values. 

 

Figure 28. Creating the faulty system in Sabotage (Fault List) 

The definition of the Fault List allows calling the fault injector to generate the corresponding faulty system 
under test in Simulink. In detail, the Saboteur blocks, which are extra Simulink blocks reproducing the 
failure effect of a component, are included in the inputs of some blocks of the Simulink model, which 
reproduce a failure effect on a component and visualize its effects.  

Fault injections can complete early in the development process the behaviour of the fault propagation, 
which makes up the component fault tree structure. While the system architecture or the derivation of the 
failure mode are linked to the system architecture, other values such as the fault injection triggering  time 
and fault duration have no interconnection with the CHESS/SAVONA environment for now and need to be 
set by the user. For further information see also Section 3.3.1 of D3.8 [7]. 

Figure 29 presents the integration methodology to unify the current fault injection approach with 
component-based design and the inclusion of monitors in the component outputs. 
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Figure 29. Integration workflow: from contract-based design to the generation of saboteurs and monitors 

The next step after filling the Fault List is to right click on the Sabotage model and click on “Create Faulty 
System”. This step creates a Matlab code file automatically ready for creating the Golden and Faulty 
Simulink model files. The last step is to right click again on the Sabotage model and click on “Run Faulty 
System”. This action will open Matlab/Simulink tool, create the aforementioned files, run all the 
simulations and visualise the results. The created simulation traces can be analysed by AMT 2.0 in order to 
check if the guarantees still hold when assumptions are violated. 

Thus, the combination of simulation-based fault injection, together with the contract-based approach and 
the insertion of monitors allows an early safety assessment. 
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Figure 30. Integration of contracts, fault injection simulations and monitors for an early safety assessment 

• Contract-based Fault Tree Generation 

The contract-based safety analysis identifies the component failures as the failure of its implementation in 
satisfying the contract. When the component is composite, its failure can be caused by the failure of one or 
more subcomponents and/or the failure of the environment in satisfying the assumption. As result, this 
analysis produces a fault tree in which each intermediate event represents the failure of a component or its 
environment and is linked to a Boolean combination of other nodes; the top-level event is the failure of the 
system component, while the basic events are the failures of the leaf components and the failure of the 
system environment. 

To execute the contract-based safety analysis, a component can be selected in the Model Explorer View or 
the corresponding graphical representation (in the diagram editor). The contracts considered will be the 
ones associated to the selected component and the ones associated to its sub components (see Section 
7.24 “Generate Contract-based Fault Tree” of the Annex A). This operation includes recursively all the 
contracts along the subcomponents, from the root to the leaves of the system. 

• Model-Based Safety Analysis 

The faulty behaviour for a component can be defined through a state machine in the CHESS dependability 
profile («ErrorModel» stereotype). In the error model, the information about the error states can be 
provided. For a given error state, the effect upon a property of the component, and so the effect on its 
nominal behaviour, can be also provided by using pre-defined effects. 

Once the system architecture has been provided, by means of components definition and their nominal 
and error models, the fault tree generation can be obtained by invoking the xSAP symbolic model checker 
through the CHESS environment. After execution of the analysis, the fault tree is automatically shown in a 
dedicated panel at the frontend.  

Thanks to the interface between the AMASS Platform (CHESS tool) and the Safety Architect tool [39] 
developed in the context of AMASS project, the CHESS system architecture model and dependability profile 
can be imported in Safety Architect as an external tool. Then, the Safety and Security Co-analysis viewpoint 



        

          AMASS AMASS User guidance and Methodological framework D2.5 V1.0 

 

 

 
H2020-JTI-ECSEL-2015 # 692474 Page 54 of 88 

 
 

already available in Safety Architect can be applied to generate safety and security co-analysis artefacts 
such as Propagation trees (fault trees extended with malicious events) or FMVEA tables (Failure Modes, 
Vulnerabilities and Effects Analysis), i.e. a classical FMEA/FMECA tables extended with vulnerability events, 
see also Section 3.6.6. 

Together with Safety Architect, other external tools such as Medini Analyze and Papyrus for Safety provide 
safety analysis capabilities as well. For further information, please refer to D4.8 [8]. 

3.6.8 Validation of Security Properties (Security Analysis) 

The Security Analysis features provided by the AMASS Platform are summarised hereunder.  

• Cyber Architect 

Cyber Architect© from ALL4TEC is an external tool in the AMASS Platform. It is a security analysis and risk 
assessment tool based on the EBIOS method (Expression des Besoins et Identification des Objectifs de 
Sécurité - Expression of Needs and Identification of Security Objectives) used to assess and treat risks.  The 
tool implements the five modules of EBIOS method (Module 1 - Study of the context, Module 2 - Study of 
the feared events, Module 3 - Study of threat scenarios, Module 4 - Study of the risks, and Module 5 - Study 
of the control). For more detailed information refer to Section 2.3.6 of D4.8 [8]. 

An example of security analysis and risk assessment in Cyber Architect for the Remote Terminal Unit (RTU) 
of AMASS CS1 (Industrial and Automation Control Systems – IACS) is presented Figure 31. 

 

Figure 31. CS1-RTU architecture Security Analysis in Cyber Architect 
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Cyber Architect is not directly linked to the AMASS platform-CHESS tool, but it is indirectly linked via the 
interoperability between CHESS and Safety Architect. A Systems/Safety Engineer can first import a system 
model from the CHESS tool to the Safety Architect tool for safety analysis. Then, thanks to the bridge 
between Safety Architect and Cyber Architect, the Systems Engineer/Security Engineer can import security 
analysis artefacts, such as threats or vulnerabilities, from Cyber Architect into Safety Architect for Safety 
and Security Co-analysis and Co-assessment. For example, this usage scenario (US) can be applied to the 
US2 of CS1: perform safety and security co-analysis (see also Section 2.1.7 of D1.1 [14]). 

• MORETO 

MORETO (Model-based Security Requirement Management Tool) is a tool for security requirements 
analysis, allocation, and management using modelling languages such as SysML/UML. MORETO has been 
developed by AIT Austrian Institute of Technology, at the centre for Digital Safety and Security, as an 
interface to CHESS/Papyrus provided in context of the AMASS project. It offers the versatility of modelling 
processes in various SysML diagrams. MORETO is an Enterprise Architect (EA) plugin for managing the IEC 
62443 security standard. EA is a visual modelling software and design tool based on UML provided by Sparx 
Systems [25]. MORETO is reliable and flexible to model safety & security requirements suited to different 
components and system architectures. For more detailed information refer to Section 3.8 of D4.6 [12]. 

For the security analysis process, the MORETO tool has been applied in the AMASS CS1 (Industrial and 
Automation Control Systems – IACS) on a simple network diagram example as shown in Figure 32. 

 

Figure 32. Sample of a network diagram 

MORETO scans all the components and generates a list of security requirements based on IEC 62443 
standard for each modelled element separately. Many security gaps have been detected by the MORETO 
tool; however, Figure 33 illustrates a list of security requirements for gateway and switch devices. 

Network Elements ControlValues

Switch 1
User

Internet

Router 1 Router 2 Web ServerSwitch 2
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Figure 33. List of IEC 62443 security requirements for gateway and switch devices in the MORETO tool 

As illustrated in Figure 33, there is a list of security requirements for the gateway device which include 
network segmentation, session integrity, session lock, auditable events, and other relevant security 
standards. The security engineer can check the contents of each of the generated security requirements by 
double-clicking on any one of them. Then, MORETO opens a new sub-form which has a full description of 
the security requirement based on the documentation of IEC 62443 standard. 

Finally, MORETO creates a comprehensive report, describing the security gaps which are identified, and the 
security requirements that have been selected to cover these gaps. 

• Papyrus for Security analysis 

Papyrus for Security (Papyrus4Security) is a risk assessment tool that deploys several profiles to support 
security-oriented analyses of UML/SysML based models, e.g. from the CHESS tool. More specifically, the 
tool has been customised to support the security risk analysis of information technology, cyber-physical 
and industrial systems. It supports techniques and methods that cover several phases: modelling and 
analysis of feared events (including requirements), threats scenarios, vulnerabilities and countermeasures, 
attack trees, and risks calculation. The referred analyses are supported in compliance with the following 
standards: 

• ISO 27001/27005, for the security risk management of information technology systems [31] 

• ISO 15408, the evaluation criteria for information technology security [32] 

• IEC 62443, targeting the security of industrial automation and control systems [33] 

• EUROCAE ED-202 [37] and ED-203 [38], for the airworthiness security process and methods, 
respectively. 

In addition, a dedicated module allows to formally validate the effectiveness of security countermeasures 
based upon security test cases. For more detailed information refer to Section 3.5.1.2 of D4.8[8]. 

Figure 34 illustrates the main phases supported by the framework. The phases correspond to the workflow 
that a security engineer can follow in order to cover a full cycle of the risks assessment and the system 
securing processes. As Papyrus4Security is a Papyrus plugin, it offers seamless interoperability to the 
AMASS Platform. 
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Figure 34. Papyrus4Security supported analyses 

3.6.9 Collect artefacts 

Analysis results obtained from the analysis mentioned in the previous sections must be collected and 
stored as artefacts in the Evidence Model (see Section 3.8), to be later linked to the Assurance Case. Table 1 
in D3.8 [7] summarizes the kinds of artefacts that can be made available.  

As additional features, CHESS supports automatic generation of documentation summarizing the modelling 
of the system components and the verification, validation, and analysis results; this artefact can also be 
used as evidence to show the fulfilment of some process activities execution. 
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3.7 Assurance Case Management 

Figure 35 summarizes the steps and functions that are provided by the AMASS Platform for Assurance Case 
Management. This may require involvement of several experts (roles): an Assurance Manager can create 
Assurance Cases, where reference activities and reference requirements are automatically transformed 
into Claims for the argumentation. This can be further enhanced and detailed and by the Process Engineers, 
Systems Engineers and Assurance Engineers involved in the project.  To finish with, the assurance engineer 
will proceed to their final validation. 
 

 

Figure 35. Overview of the steps for the “Assurance Case Management” process stage 

3.7.1 Create Assurance Case Structure 

Argumentation Diagrams for Assurance Cases can be created locally as files in the workspace or can be 
stored in a database for working in a cooperative and distributed way. Before creating Argumentation 
Diagrams for Assurance Cases, some preferences can be defined to select the related directories for the 
argumentation modules and argumentation patterns templates, e.g. stored from previous argumentation. 

When a new Assurance Project is created (see also 3.5.1) a new argumentation is created automatically by 
applying a transformation to the baseline, where 

• reference activities are transformed to claims,  

• reference requirements are transformed to claims, 

• reference artefacts are transformed to an information element (property type marked as 
“solution”); if a reference activity has sub activities, an asserted inference relationship is created 
with the claim of the top activity as source and the claim transformed from the sub activity as 
target, 
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• when a reference activity has reference requirements, an asserted inference relationship is 
created, with the claim transformed from the reference activity as source and the claim 
transformed from the requirement as target. 

For creating additional Argument Diagrams as files manually or on the database, the corresponding wizards 
in the OpenCert tool can be used (“Arg Diagram to Repository”, “Arg Diagram to File”) and the diagram is 
created by adding the folder and the name of the diagram (see also Section 9.2 “Creating and Saving a 
Diagram” of the Annex A).  

The platform supports also the use of GSN pattern diagrams for arguments, i.e. generic arguments, which 
can be re-used for several argumentations or projects. The steps to create an Argumentation Pattern are 
the same as for other Argumentation Diagrams, while the Patterns need to be stored on dedicated places 
designed by the preferences. Once created, the argumentation diagrams can be instantiated to 
Argumentation Diagrams (see also Section 9.4 “Patterns” of the Annex A). 

Argumentation Diagrams can be connected to Artefacts in an Evidence Model by linking the context, 
solution or justification elements of the related Artefacts in the Evidence Model (see Section 9.3.3 
“Connecting an Argument Diagram to Artefacts” of the Annex A). 

3.7.2 Develop Claims and Links to Evidence 

All diagrams can be edited by selecting them on the project folder in the “Package Explorer” tab. Several 
editing features are provided. In particular, nodes and relationships (links) can be added to the diagram 
from a palette. The “relationships” include all the links between the different nodes. The nodes implement 
the graphical Goal Structuring Notation (GSN), while the Structured Assurance Case Metamodel (SACM) 
representation is internally used. See also Section 9.3 “Editing Functions” of the Annex A for an overview of 
available GSN elements and its representation in the extended SACM metamodel used in CACM.  

The following node types are available: 

• Goal 
These elements have the graphical notation as Goals on GSN and are stored as Claims in the CACM 
metamodel. The identifier property indicates uniquely the goal on the argumentation.  

• Assumption 
Assumptions are stored in CACM as a claim with assumed property as true. It references the 
assumption concept and has the same graphical notation assumptions in GSN. It indicates an 
assumption in relation to a goal. 

• Strategy 
This element has the same graphical notation as strategies on GSN but it is stored as Argument 
Reasoning in CACM. The identifier property indicates uniquely the element on the argumentation.  

• Justification, Context and Solution 
The Information Element Citation concept stored in CACM has different graphical notations 
depending on the concept which is referencing. The property “Type” could have the values: 

o Justification: references the justification concept and has the same graphical notation as 
justifications in GSN. It justifies the validity of a claim. 

o Context: references the context concept and has the same graphical notation as contexts in 
GSN. It indicates the context of a claim. 

o Solution: references the evidence concept and has the same graphical notation as solutions 
in GSN. It supports the validity of a claim. 

• Argumentation Modules 
This element has the same graphical notation as the argument modules on GSN. They are used 
when the assurance argumentation is done in a composable way.  
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All diagram elements can also be copied, pasted and deleted. Further, it is possible to set up multi-diagrams 
from an Argumentation model to manage different views of a model through a set of diagrams. Once a 
model is available, a new diagram view can be created, and special edition functionalities are available: 

• Drag and drop concepts from the model to the diagram. 

• A selected concept can be hidden for this view. This option does not delete the concept from the 
model. 

• A selected concept can be deleted i.e. the concept is deleted from the model permanently. If this 
deleted concept is included in another diagram file, it will be marked by an icon to show that it 
does not exist anymore. 

The next workflow, extracted from deliverable D4.8 [8], depicts the different steps on how an Assurance 
Case is created from scratch is illustrated.  

 

Figure 36. Workflow for Assurance Case development steps  

3.7.3 Derive Process-based Arguments  

According to the AMASS vision regarding compliance management (see Section 7 of D6.3 [26]), compliance 
can be shown via Mapping tables, argued about or proved. In this section, argumentation is in focus. More 
specifically, the argumentation is used to argue about fulfilment of the process-related requirements given 
in the standards, i.e. compliance of processes (representing plans) against standards.  
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In this context, the EPF Composer tool is used for modelling the definition of processes representing plans 
while the OpenCert Tool is used for visualizing the generated process-based arguments (i.e. Argumentation 
model and diagram). The arguments are derived directly from the Process models. To prevent a fallacious 
derivation of arguments, a common type of fallacy (Key-evidence omission) is detected before enabling the 
generation.  

The Fallacy Detection plugin takes as input the process and standard requirements and validates whether 
the process contains the sufficient information corresponding to the key evidence for supporting the 
specific requirements. In case of omitted crucial evidence detail, some feedback is provided regarding 
detected fallacies and recommendations to resolve them. Once the Process model has been modified 
based on the provided recommendations, the Process-based Argument Generator plugin takes the 
modified process as an input and transforms it into arguments (model and diagram). After completion of 
the transformation process, the generated argument model and diagram are stored locally in a new project 
named “Argumentation” as well as in the corresponding destination assurance case in the CDO Repository 
under the “ARGUMENTATION” folder.  

For further information about the steps summarized above see Section 3.4.1 of D6.8 [10]. 

3.7.4 Linking Architecture and Assurance Case Elements 

One important result of the architecture-driven assurance is the possibility to have an adequate traceability 
between the Assurance Case and the architectural entities, e.g. to allow the Systems or the Safety Engineer 
and the Assurance Manager/Assessor to easily navigate all the available information. The approach of 
contract-based design proposed in AMASS plays an important role on this aspect; e.g. the Assurance Case 
has to elaborate on each Safety Contract validity and upon the composition of contracts (derived from the 
composition of the associated components).  

Contracts and FormalProperties can be linked to Assurance Case entities, in particular to Claims and 
Artefacts. The following traceability links have been identified as useful (see also Section 7.28 “Managing 
links between Architecture and Assurance” of the Annex A): 

• Contract and Assurance Case Package, the latter owning the Assurance Case entities related to the 
contract. 

• Contract and Assurance Case Agreement, the latter owning the arguments about how the 
assumptions of a contract are fulfilled in the context of the system. 

• Contract and Assurance Case Claim, the latter elaborating on the contract itself, e.g. that the 
contract is derived from some analysis or is based on some specification. 

• System component and Argumentation element, the latter owning all the assurance case fragment 
information related to the associated component. 

• Contract and Evidence, the latter supporting the contract statement, in particular its guarantee, 
e.g. by using some verification/test result 

Evidences associated to a contract can then be reused and referred from the Assurance Case. 

Some of the aforementioned links are automatically managed in case of argument fragment generation; for 
the parts of the Assurance Case not currently supported by such automatism, the links have to be created 
manually by using the Capra tool support, so by selecting the entities to be traced in the corresponding 
editor (e.g., an Evidence in the Evidence editor and a Contract in the CHESS editor) and by creating the link 
through the Capra traceability view. For further information, please refer to Section 7.28.3 “Traceability 
View” of the Annex A. 

In addition to the aforementioned links between the architecture and Assurance Case related elements, 
traceability links should also be provided between the system model and the executed process, the latter 
also modelled in the OpenCert tool e.g. as an evidence model listing all the artefacts to be produced 
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according to a given standard/process step; these relationships can then be reused to support the 
demonstration of the compliance of the architecture with respect to a given process. The links to the 
executed process can be also manually managed by using the Capra tool support. For further information, 
please refer to Section 7.28.2 “Manage traceability links with Capra” of the Annex A. 

3.7.5 Develop Component Arguments and Assumptions 

Assurance Cases can be developed for systems, but there are some arguments specifically for components 
behaviour. As it has been described in Section 3.6.3, during the development of a component in the system 
architecture design, different assumptions on the context and some guarantees on the functional 
behaviour are done. This is achieved annotating the CHESS model by the Systems Engineer. Safety Engineer 
and Security Engineer should both ensure that the assumptions on the context and the assertions on the 
functional behaviour are correct and complete. 

When the component is instantiated in a system, the assumptions on the context can be validated. This is 
done on the step “Validate Component Arguments & Assumptions” and the appropriate argument 
fragments are generated. It is important to notice that if the system models (in CHESS) do not include the 
annotations about the assumptions and guarantees, the arguments fragment will not be generated, and 
the related argumentation should be manually included in the Assurance Case.  

This activity should be done in parallel with the “Develop Claims and Links to Evidence” step. It links with its 
workflow before the check argument modules integration step. For further instructions, please refer the 
Section 7.7 “Specify Assumption and Guarantee for a Contract” of the Annex A. 

3.7.6 Validate Component Argument Assumptions 

Assurance Case argument assumptions are unsupported statements that are connected to an argument 
goal/statement and the entirety of the argument supporting that goal/statement. For such a 
goal/statement to be valid, the associated assumptions must be valid as well. In Architectural-driven 
Assurance, the Assurance Case argument is modularized such that each component in the architecture has 
its own argument-fragment. The argument assumptions stated on such an argument-fragment represent 
the component argument assumptions. For the claims about such a component to be valid, the related 
argument assumptions need to be validated as well. To achieve that, we utilize the tight connection 
between the component specification in CHESS and the Assurance Case elements in OpenCert.  

CHESS through its integration with the OCRA verification engine allows for validation of component 
contract assumptions against the specification of other components in the system. To validate the 
component argument assumptions, we need to ensure that all of the argument assumptions are also 
captured in the corresponding component contracts. Validating the component contracts and linking the 
architecture with the Assurance Case elements ensures that each of the component argument assumptions 
is supported by a claim from another component’s argument-fragment. 

For further instructions, please check the Section 7.7 “Specify Assumption and Guarantee for a Contract”, 
the Section 7.10 “Associate a Contract to a Block/Component” and the Section 9.5 “Generating Argument 
Fragments” of the Annex A. 

3.7.7 Manage Multiconcern Trade-off Analysis 

For finding a balanced and optimized combination of different, potentially contradictory measures targeted 
at different quality attributes, multiconcern trade-off analysis is required. 

Two approaches have been investigated in AMASS: 
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(1) Contract-based trade-off analysis in parameterized architectures, and 

(2) Contract-based trade-off analysis with the Analytical Network Process. 

Approach (1) is based on the parameterized architectures developed in WP3, which allow design space 
exploration w.r.t architectural choices. The trade-off analysis functionality checks which functional and 
non-functional properties hold in the different configurations. A prototypic implementation based on 
CHESS has been provided. More details can be found in D4.3 [15]. 

Approach (2) uses the Analytical Network Process (ANP) to analyse the impact of failures and cyber-attacks 
on the overall safety and security of the system, and this information is used as a basis for system 
modification. The approach derives quantitative attack rates from comparing information from 
vulnerabilities and exploits the database with the minimum security levels defined to be fulfilled for SIL1-4 
in standards. This allows a quantitative approach for comparing safety risks to cybersecurity risks. An early 
prototypic implementation based on the tool TimeNet4.4 and Excel has been provided. More details can be 
found in D4.3 [15]. 

As mentioned above, both approaches have reached an early prototypic stadium and are therefore not 
timely enough mature for evaluation in the case studies. So, at the time of publication of this document 
(November 2018), no detailed guidance can be given yet. 
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3.8 Evidence Management  

The workflow provided by the AMASS platform for Evidence Management is summarized in Figure 37. In 
general, evidences are specified and managed by Evidence Models. Within this model, objects for Artefacts 
and Artefact Models can be created. Further functionality is related to the collection and handling of the 
assurance evidences of an Assurance Project, the artefact’s traceability and finally the executed processes.  
 

 

Figure 37. Overview of the steps for the “Evidence Management” process stage 

3.8.1 Create an Evidence Model  

Evidence Management includes the collection and handling of the assurance evidences of an Assurance 
Project. When managing assurance evidence, the first step is usually to determine what evidences must be 
provided. Afterwards, the Evidence Artefacts must be collected and might also have to be evaluated and 
traced to other Artefacts.  

In AMASS, Evidences are managed by Evidence Models. Accordingly, the OpenCert tool within AMASS 
Platform provides a wizard to create a new model of type Evidence Model (see Section 10.1 “Define 
Artefact Repository Preferences” of the Annex A). Within this model, objects for Artefacts and Artefact 
Models can be created (see sections below).  

3.8.2 Create and Define Artefacts 

To create Artefacts, the corresponding Artefact Model must be selected in the Resource Set, then the new 
Artefact can be added as a child element of the model. Afterwards, the Artefact can be defined by the user 
(see also Section 10.2 “Artefact Definition” of the Annex A):  

• Base information of the Artefact: name, id, description, version, associated artefacts file name, etc. 
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• Resources: resource files associated to the artefact as child elements of the Artefact definition (on 
a local or remote repository). 

• Properties: after the CDO resource property model (.property) has been loaded, the properties of a 
selected artefact can be added and defined.  

• Artefact evaluation: references to the Assurance Asset evaluations that specify the outcome of 
evaluating the artefact. 

• Assurance Asset Events: references to the Assurance Asset events related to the lifecycle of the 
artefact can be added and defined. 

A further feature is the impact analysis for Artefacts, which informs different users such as an assurance 
engineer or manager about the impact of the changes in one Artefact that affect others taking into account 
the relations between the modified and the impacted artefacts. If the impacts are accepted, new assurance 
assents events are generated for the modified and impacted Artefacts. 

3.8.3 Evidence Data Exchange 

The AMASS Tool Platform can exchange data with external tools in different ways. A general overview of 
the tool interoperability results for seamless interoperability in AMASS is presented in Figure 38. The data 
imported into the AMASS Platform can be used as evidence in an Assurance Project: to support claims in an 
Assurance Case, to show that the information needed for compliance with a standard has been collected, 
etc. 

In more specific terms, the AMASS Platform can exchange data with other tools for Evidence Management 
purposes in the following ways: 

• The evidence artefacts can be linked to files in a SVN repository, thus e.g. the change history of the 
files is available in the AMASS Platform. 

• The OSLC-KM technology lets users import into an Evidence Model data about a wide range of 
artefacts managed by engineering tools and by general-purpose ones, such as logical system 
models (e.g. SysML in MagicDraw), physical system models (e.g. created with Simulink), and system 
information specifications created with Excel and Word. 

• The results from V&V of different artefacts that external tools, such as V&V Manager (by HON), 
OCRA (by FBK), WEFACT (by AIT), and VERIFICATION Studio (by TRC), provide,can be stored in the 
AMASS Platform (e.g. as artefact evaluation data in an Evidence Model) and support the 
demonstration of the fulfilment of the expected properties of the artefacts. 

• The Assurance Project data can be used to generate reports (e.g. compliance reports) in Word 
format. 

• The data stored in an OpenCert database, managed with the CDO technology and including 
evidence data, can be accessed through a specific API. 

Further data exchange is possible, although it might not be targeted at evidence data exchange. This 
includes data exchange in Papyrus and CHESS with system modelling tools (SAVONA, Rhapsody, RSA…) and 
system analysis tools (Safety Architect, Cyber Architect…). 
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Figure 38. Overview of tool integration possibilities in AMASS 

3.8.4 Manage Artefact Traceability 

Traceability can be defined as the degree to which a relationship can be established between two or more 
products of a system’s lifecycle (aka artefacts), especially products having a predecessor-successor or 
master-subordinate relationship to one another. A trace can be defined as a specified triplet of elements 
comprising a source artefact, a target artefact and a trace link associating the two artefacts, where the 
source artefact is the origin of the trace, the target artefact is the destination of the trace, and the trace 
link is the specified association between the pair of artefacts (see also section 3.10 of D5.1[16]).  

Traceability between different artefacts is an important aspect for seamless interoperability in AMASS (see 
Section 3.1.2 of D5.8 [9]). In particular, it must be ensured that all the information managed as a result of 
the seamless interoperability is consistent and coherent with regard to the applicable assurance standards. 
As safety engineering life-cycle artefacts are frequently the result of various and not integrated tools, 
seamless traceability represents a serious challenge. Within AMASS, such challenge is tackled by providing 
solutions aimed at overcoming the gaps between the different types of artefacts managed by safety 
engineering tools and general-purpose tools. 

• The OpenCert tool let users such as the assurance engineer or manaer specify relationships 
between artefacts to specify evidence traceability in Evidence models. The information about the 
relationships can be enriched with the data about what is the impact on the target artefact when 
the source one is modified or revoked. Two relationships are also already explicitly supported in 
OpenCert: Evolution_Of (precedentVersion) and Composed_Of (artefactPart) (see descriptions 
below). 

• The Capra tool follows the approach of point-to-point integration with only partial data import. It 
provides a modular framework for tracing. Everything besides a small generic core is 
interchangeable and any number of new trace target types can be defined in new Eclipse plugins. 



        

          AMASS AMASS User guidance and Methodological framework D2.5 V1.0 

 

 

 
H2020-JTI-ECSEL-2015 # 692474 Page 67 of 88 

 
 

There is a conceptual overlap between tracing to external sources and evidence management as 
the items being traced in a safety case will often (but not always) be used as evidence. It is 
recommended to trace the appropriate evidence objects, if those are available, for several reasons. 
Firstly, tracing with evidence gives the traced artefact its semantics, which is important for safety 
assessments. Secondly, evidence can be updated to a new version by repeating the process that 
created the artefact. This can be helpful for impact analysis. Finally, it removes redundancies from 
the model as only one type of artefact or evidence wrapper needs to be created (i.e. only one 
artefact is created and later referenced/linked). 

Possible relationships between Evidence Artefacts include: 

• Constrained_By: a relationship of this type from an artefact A to an artefact B documents that 
artefact B defines some constraint on artefact A, e.g. source code can be constrained by coding 
standards. 

• Satisfies: a relationship of this type from an artefact A to an artefact B documents that artefact A 
realisation implies artefact B realisation too, e.g. a design specification can satisfy a system 
requirement. 

• Formalises: a relationship of this type from an artefact A to an artefact B documents that artefact A 
is a formal representation of artefact B, e.g. a Z specification can formalise a requirement 
specification in UML or natural language. 

• Refines: a relationship of this type from an artefact A to an artefact B documents that artefact A 
defines artefact B in more detail, e.g. a low-level requirement can refine a high-level requirement. 

• Derived_From: a relationship of this type from an artefact A to an artefact B documents that 
artefact A is created from artefact B, e.g. source code can be derived from a system model when a 
source code generator is used. 

• Verifies: a relationship of this type from an artefact A to an artefact B documents that artefact A 
shows that artefact B properties are true, e.g. model checking results can verify a requirement. 

• Validates: a relationship of this type from an artefact A to an artefact B documents that artefact A 
shows that that artefact B properties can be regarded as valid, e.g. a test case can validate a 
requirement. 

• Implements: a relationship of this type from an artefact A to an artefact B documents that artefact 
A corresponds to the materialisation of artefact B, e.g. source code can implement an architecture 
specification. 

3.8.5 Create Executing Process Models 

Executing process models can be created by importing EPF Composer information into OpenCert (see also 
section 3.5.5 above). EPF Composer can be used for modelling the definition and planning of processes. 
This is mainly intended for planned processes, e.g. a delivery process. We can get benefit of the EPF 
Composer process information to create a first view (which can evolve during an assurance project) of 
process models in OpenCert by importing EPF Composer information. Specifically, the transformation 
process takes a delivery process modelled in EPF Composer and generates an evidence model and a 
process model in OpenCert. For detailed information about the process model transformation refer to the 
Section 10.9 “Executing Process Management” of the Annex A. 

Alternatively, it is possible to create processes in OpenCert, in particular for post-planning phases. For that, 
OpenCert provides a wizard, named “Assurance Process” wizard, which can be used to create a model of 
type “Process Model”. Once the Process Model has been created, the user could define its activities. For 
detailed information, please refer to the Section 10.9 “Executing Process Management” of the Annex A. 
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3.8.6 Manage Compliance of Processes and Artefacts 

“Manage Compliance of Process and Artefact” links the input and/or output Work products related to the 
Activities of the process in execution with the existing Artefacts stored in the Evidence model and connects 
them to the standards requirements in relation with Artefacts, Requirements and Activities.  

Details on how to do these activities using the AMASS Tool Platform is explained in the Section 10.9.3 
“Specify Compliance between Processes and Artefacts” and in the Section 6.4.2 “Compliance Map using a 
tailored functionality” of the AMASS Platform User Manual (Annex A). 
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4. Examples of Usage Scenarios 

4.1 Usage Scenario 1: Architecture Refinement  

The context of this scenario is to support the system architecture design/refinement, allowing the reuse 
and improvement of system assurance, therefore this scenario could be part of the usage scenarios 2 and 4 
described below.  

The different responsible roles already depicted in different workflows such as Figure 20, should go through 
the following phases: 

1. Requirements (for instance available in DOORS) written in natural languages are validated by using 
the quality metrics checks provided by Requirements Quality Analyzer. Once the desired level of 
quality is reached, requirements are stored in a Baseline and evidences about the quality are 
produced by the Requirements Quality Analyzer tool. For example, Systems Engineer, Safety 
Engineer, and V&V Engineer can take part during these activities and the upcoming 2, 3, 4 and 5. 

2. The informal requirements allocated to system components are formalized into LTL formal 
properties. Such expressions refer to the elements of the system component interface. 

3. Contracts are created from the available formal properties and assigned to the components. 

4. System components with high complexity are decomposed by using fine-grained components 
(parts); this is a top-down or bottom-up process. The implementation of a composite component is 
completely delegated to its parts. The interfaces of the composite component must be 
realized/required by the parts. Sub-Requirements are associated to the parts. Components parts 
are connected together via their interfaces. 
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Figure 39. Example of component decompositions 

5. Along the system components decomposition, the refinement of the contracts is also modelled. 
Contracts refinement follows the requirements refinement. Indeed, a contract is implicitly linked to 
the formalized requirements (via its assumption and guarantee formal properties). 

 

Figure 40. Contract refinement view in CHESS 
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6. Contract-based verification of refinement is applied to validate the contracts (and the 
requirements) decomposition. If the refinement is not correct, then contracts/requirement must be 
changed, and the analysis re-executed. If the refinement is correct, implementation details can be 
provided for the leaf components (see following step). This activity can be performed, for instance, 
by a V&V engineer specialised in formal methods-based verification. 

7. Component’s nominal behaviour is provided for the leaf components by using State Machines. This 
can be carried out by the systems engineer. 

8. Functional early verification is performed by a V&V engineer: contract-based verification of state 
machine is executed in CHESS to verify that the behavioural specification provided for a component 
is compliant with the contract specification attached to the component itself. If the result is not 
correct, then the state machine definition must be reviewed. It has to be noted how many safety 
standards required that a different person, who is not the previously mentioned systems engineer, 
performs the verification process. 

9. When the functional specification has been validated, model-based safety analysis is performed by 
the safety engineer. Information about the error model behaviour of a given components is 
provided in CHESS. By using the components definition and their nominal and error models, the 
fault tree is obtained by invoking the xSAP symbolic model checker through the CHESS 
environment. According to the fault tree analysis results, safety measure can be adopted, for 
instance to remove single point of failures. CHESS support for architectural pattern is used here, so 
a given pattern solving the safety needs can be instantiated in the current architecture.  

10. To further verify the safety of the design, fine-grained models of the system components 
behaviours are provided in Simulink and information available in CHESS related to the components 
error models can be used to perform simulation-based fault injection by calling the Sabotage 
framework from the AMASS Platform. The results can be used as feedback by CHESS in order to 
refine the architecture, for instance by identifying additional safety measure. This can be done, for 
example, by a safety engineer or a safety verification engineer. 

11. The aforementioned safety analyses are re-executed by the safety engineer until a sufficient level 
of safety is reached, to be finally reported in the Safety Case. 

12. Then associated argumentation fragments are automatically generated for example by the safety 
engineer. This will be part of the whole system assurance case and to manage traceability links 
(automatically generated for the aforementioned fragments) between system architecture, 
assurance case and evidences produced by the used analysis. Thus, together with the safety 
engineer, the safety manager could also have a big relevance on executing this step and peer-
reviewing (validating) the generated argumentation fragments. 

Possible usage scenario alternatives/extensions (please see D3.8 [7] for a full list of capabilities): 

• Usage of formal semantic analysis of formal properties, to assure the quality of the requirements 
(point 3 above). 

• Usage of semi-formal language/templated for contracts specification in SAVONA and import it in 
CHESS (covers point 3 and 4 above) 

• Import existing architecture models in CHESS (e.g. Rhapsody, Medini, Safety Architect, MORETO) 
(covers point 2 and 5 above) 

• Usage of weak-strong contracts, to better support component reuse, and related analysis (extends 
point 4 above) 

• Usage of model-checking to verify properties on the state machine, to further check the goodness 
of the functional specification (extends point 7 above). 
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4.2 Usage Scenario 2: Process & Product Configuration and Compliance 

In this scenario, when configuring a new product, e.g. as a product upgrade, engineers need to comply with 
both product-related requirements and process-related ones. Thus, the reconfiguration may affect not only 
the product but also the process to develop the new configuration. This is particularly evident if a change in 
the product implies a change in the criticality level. This scenario can be better enacted if systematic reuse 
support is available. 

Variability management at product and process level can support the above situation via the integration 
of the BVR Tool with EPF Composer and the CHESS toolset, all part of the AMASS Tool Platform. 

1. An engineer should first investigate if family-oriented engineering management is appropriate, 
evaluating its benefits by e.g., adopting the measurement framework proposed in D6.3 [26] for 
evaluating the benefits of family-oriented process engineering. This step might require a tight 
collaboration among systems, safety, security and process engineers. 

2. If the evaluation is positive, the engineer could use the BVR tool to model a variability specification 
(VSpec) model including the product and process dimensions and solving their interdependencies in the 
Resolution model. The product related variability modelling can be related to the different roles  
involved in Section 3.6, while the process variability is assigned to, for example, the process engineer 
Next, two new configurations would be generated, for the product and the process, via the Realization 
model. Finally, a EPF-C model would be returned for the new process configuration and a CHESS 
component model for the new product architectural specification. 

3. Once the two new configurations (new product specification and new process specification) are at 
disposal, process compliance could be argued via a new process-based argument, which could be 
generated automatically from the new (reconfigured) process model via the plugin that implements and 
extends MDSafeCer. To proceed to the validation of the generated arguments, a review performed by 
the safety manager would be recommendable.   Another possibility could be to consider the ripple 
effects of the changes in process and product on the corresponding family of arguments. In this case, 
the engineer should not only configure simultaneously process and product but also the new 
arguments. This can be done with the integration of BVR with the Assurance Case editor of OpenCert. 

4. Regarding the product, Product safety could be argued by generating a new argument from the new 
product specification via the integration of CHESS, OpenCert, and OCRA tools. After generating the new 
argument, a review performed by the safety manager would be highly recommended as well.     



        

          AMASS AMASS User guidance and Methodological framework D2.5 V1.0 

 

 

 
H2020-JTI-ECSEL-2015 # 692474 Page 73 of 88 

 
 

 

 

 

 

Figure 41. Reconfiguration & Validation of the new process derived from the Base-model 
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4.3 Usage Scenario 3: Toolchain for System Specification and Quality 
Assessment 

Toolchains play a major role in CPS assurance & certification. CPS engineering is supported by different 
tools and with different purposes: system analysis, specification, V&V, etc. Data from the tools of a 
toolchain can be necessary in the AMASS Tool Platform for assurance & certification purposes, a tool can 
need data from another for a different task, e.g. requirements data for quality analysis, and data from a 
tool can be used as assurance evidence. Therefore, means to enable data exchange between different 
tools, including the AMASS Platform, are necessary. 

This scenario corresponds to the situation at which a company is developing a CPS or CPS component and 
different tools are used for system specification and design, including the AMASS ones (Papyrus, CHESS…). 
This scenario could be done in parallel with the rest of the usage scenarios.  

Tool users can be from the company or from others with whom data is exchanged (e.g. suppliers or 
customers), and the AMASS Platform is used as main support for assurance & certification-specific activities 
(compliance management, evidence management, etc.). The company aims to be able to seamlessly 
manage all the data from the different tools. Figure 42 shows a general Engineering & Assurance workflow 
for the scenario, and Figure 43 the tools selected for the scenario, as an example of a concrete toolchain. 

 

Figure 42. Engineering & Assurance workflow 
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Figure 43. Selection of tools for the scenario 

In this scenario: 

1. The Assurance Manager (e.g. Safety Manager in the context of ISO 26262) creates and configures 
an Assurance Project, including the selection of the reference framework (e.g. an ISO 26262 one), 
the specification of the baseline, the creation of argumentation, evidence, and process models, and 
the link of evidence artefacts with files in a SVN repository. 

2. For requirements specification, the Systems Engineer in collaboration with Safety and Security 
engineers can use different tools and requirements data from different tools, such as DOORS, PTC 
Integrity, Excel, and Word, and even and Papyrus/CHESS. For requirements data exchange, ReqIF is 
a standard for exchange that Papyrus can use. Ad-hoc connectors can be used too. 

3. Papyrus/CHESS is the system modelling tool proposed by AMASS, but others exist and are used in 
practice; by major vendors (e.g. Rhapsody, RSA, MagicDraw, Simulink…) as well as by AMASS 
partners (e.g. SAVONA, Medini Analyze…). The Systems, safety and security engineers might need 
to import data from these tools to the AMASS ones. 

4. The Assurance Engineer (e.g. Safety or Security engineers) needs to confirm that the quality of the 
artefacts is sufficient for assurance & certification. Therefore, the quality must be analysed, e.g. 
regarding artefact completeness, consistency, and correctness. Verification Studio, by TRC, 
supports the analysis based on metrics. The tool exploits OSLC KM as technology for tool 
interoperability, which enables the connection to a wide range of tools and thus quality analysis to 
a wide range of system artefact types. It is even possible to create OSLC KM-based connectors from 
XML files with Verification Studio by manually specifying the mapping between the XML format and 
the data structure managed in Verification Studio. 

5. For traceability management, the Assurance Engineer and Assurance Manager can use the 
OpenCert evidence editor as the default tool to trace evidence artefacts. Capra is also used as an 
extension mechanism in the AMASS Tool Platform. Traceability Studio, by TRC, supports some 
advanced features. 

6. For data import into an Assurance Project, OSLC KM supports the import of several artefact types. 
The Assurance Manager can also import quality data to evidence models of an Assurance Project 
from Verification Studio. 

7. Finally, Assurance Project data can be exported as a Word document and via CDO API. 
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4.4 Usage Scenario 4: Safety & Security Co-Assessment  

In this scenario, when developing a CPS or CPS Component, safety and security engineers need to ensure 
the functional safety and security of the products. This need affects the following activities for multi-
concern assurance: 

• Co-Assessment: Functional safety and security standards both should be digitalised. There are two 
options in the AMASS Tool Platform: 

1. The Assurance Manager (expert in standards compliance) could use the OpenCert tool to model 
both standards into two different reference frameworks. Once the two referenceFrameworks are 
created, the Assurance Manager should create equivalenceMappings to identify those areas where 
both standards are compatible. There could be a situation where both Safety Manager and Security 
Manager should agree on the equivalences. An Assurance Engineer could also benefit from the 
Reuse feature since those Artefacts declared as equivalent during the previous step, could be 
reused to comply also the second standard. In other words, a safety engineer could benefit from a 
previously generated security artefact (created by a security engineer) and reuse it as a safety one.  

 

Figure 44. Excerpt of the equivalence mappings between IEC 61508 (safety) and ISA 62443 (security) 

2. A Safety Manager, Security Manager or Process Engineer could use EPF-C to on one hand to 
model the different standards and define a combined process. Both, referenceFrameworks and 
process will be imported into OpenCert to continue the compliance process. The compliance 
process can be also continued within EPF Composer, via launching the process-based 
argumentation, which may argue about process compliance. 

• Co-Design: During the product development process the Safety Engineer and the Security Engineer, 
both at different times or together, should include in the design safety and/or security requirements. 
Those requirements (1) could come from the standards and then be refined into technical 
safety/security requirements or (2) could be derived from the design and the risks and vulnerabilities 
identified.  

Then, the technical safety/security requirements are translated into safety mechanisms and security 
controls to be included in the design. To do so, the engineers will include the information into the 
architecture models using the CHESS tool of the AMASS Tool Platform. It is highly recommendable to 
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use formal languages for the properties (by using the OCRA tool). The Assurance Engineer should 
define the contracts to check those formal properties. It is possible to mark the contracts depending 
the concern (safety, security …). 

• Co-Analysis: Once the design is done, dependability analysis could be performed by the Assurance 
Engineer. Different analysis can be done such as: 

o Model-based Safety Analysis or Contract-based safety analysis (e.g. using xSAP feature or the 
Medini Analyze external tool) performed by the safety and security engineers. 

o Safety Analysis (e.g. using the ConcertoFLA CHESS feature or the Safety Architect external tool) 

o Security Analysis (e.g. using the Cyber Architect external tool) 

o Model Failures Modes Vulnerability & Effects Analysis (e.g. using the FMVEA external tool, see 
Figure 27). 

The main decisions and results from these activities can be the basis for Assurance Case development. 
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5. Conclusions 

This deliverable D2.5 AMASS user guidance and methodological framework is intended to provide an 
introduction and a guidance to potential users of the AMASS Tool Platform, which is a prototype 
implementation demonstrating the capabilities and features of the AMASS Reference Tool Architecture 
(ARTA). The document has been organized into five parts: 

• A short introduction to the ARTA with summarized information about the global AMASS 
methodology and the AMASS Tool Platform, including an overview of the platform architecture, the 
relevant building blocks and functionalities as well as some background information (Section 2); 

• A process guide providing a concise overview of the particular process steps along the AMASS Tool 
Platform and the actors involved in assurance processes as well as the functionality of the ARTA 
and its usage (Section 3); 

• Usage Scenarios which describes in a short and concise way how to apply the methodology 
described in this document in specific scenarios such as architecture refinement, process & product 
configuration and compliance, toolchain for system specification and quality assessment and safety 
& security co-assessment (Section 4); 

• A comprehensive manual for users of the platform describing in detail the application and usage of 
the particular tools and functions of the system (Annex A); 

• A developers’ guide where developers can find the source code installing instructions, step by step, 
in order to set up their workspaces (Annex B). 

Where required, the document includes references for further information, in particular to other (public) 
AMASS deliverables with detailed descriptions of the AMASS Tool Platform and its particular components 
and methodologies. Accordingly, the target groups addressed by this deliverable are potential developers 
of an assurance platform following the ARTA approach, users of AMASS Tool Platform, and interested 
decision makers of industrial domains with critical assurance requirements (e.g. automotive or aviation). 
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Abbreviations 

ABM Assurance Baseline Models 

AMASS Architecture-driven, Multi-concern and Seamless Assurance and Certification of 
Cyber-Physical Systems 

ANP Analytical Network Process 

API Application Programming Interface 

ARP Aerospace Recommended Practice 

ARTA AMASS Reference Tool Architecture 

BDD Block Definition Diagrams 

BVR Base Variability Resolution 

BVR-T BVR Tool 

CA Cyber Architect 

CACM Common Assurance & Certification Metamodel 

CCL Common Certification Language 

CDO Connected Data Objects 

CFT Component Fault Tree 

CHESS Composition with Guarantees for High-integrity Embedded Software Components 
Assembly 

CHESSML CHESS Modelling Language 

CPS Cyber-Physical System 

CS Case Study 

DFD Dataflow Diagram 

EA Enterprise Architect 

EBIOS Expression des Besoins et Identification des Objectifs de Sécurité 

EMF Eclipse Modelling Framework 

EN European Norm 

EPF Eclipse Process Framework 

EPF-C Eclipse Process Framework Composer 

FAA Federal Aviation Administration 

FLA Failure Logic Analysis 

FMEA Failure Modes and Effects Analysis 

FMECA Failure Mode and Effects and Criticality Analysis 

FMEDA Failure Modes Effects Diagnostic Analysis 

FMVEA 

FTA 

Failure Modes, Vulnerabilities and Effects Analysis 

Fault Tree Analysis 

GUI Graphical User Interface 

GSN Goal Structuring Notation 

HAZOP HAZard and OPerability study 

IACS Industrial and Automation Control Systems 

IBD Internal Block Diagram 

ISO International Organization for Standardization 

KM Knowledge Manager 

LTL Linear Temporal Logic 
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MARTE Modelling and Analysis of Real Time and Embedded systems 

MDG Model Driven Generation 

MORETO Model-based Security Requirements Management Tool 

OMG Object Management Group 

OSLC Open Services for Lifecycle Collaboration 

RCP Rich Client Platform 

ReqIF Requirements Interchange Format 

RF Reference Framework 

RFM Reference Framework Model 

RQA Requirement Quality Analyser 

RTU Remote Terminal Unit 

SA Safety Architect 

SACM Structured Assurance Case Metamodel 

SIL Safety Integrity Level 

SMT Satisfiability Modulo Theory 

SPEM Software & Systems Process Engineering Metamodel 

STO Scientific and Technical Objectives (of AMASS) 

STRIDE Spoofing, Tampering, Repudiation, Infofrmation disclosure, Denial of service, 
Elevation of privilege 

SVN Subversion 

SW SoftWare 

SysML System Modelling Language 

UMA Unified Method Architecture 

UML Unified Modelling Language 

US Usage Scenario 

V&V Verification & Validation 

XML eXtended Markup Language 
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Terms and Definitions 

This Glossary only includes concepts and terms related to the design of the AMASS tools. It e.g. does not 
cover concepts and terms specific to the application domains addressed in AMASS (automotive, space, 
etc.). 
 

Concept Description 

Actor A person in a certain role or different system interacting with the system of 
interest  

AMASS Platform The AMASS platform is a Tool Platform supporting the assurance and certification 
activities of CPS. 

API An application programming interface (API) is a specification intended to be used 
as an interface by software components to communicate with each other. An API 
may include specifications for routines, data structures, object classes, and 
variables. 

Application The term application is a shorter form of application program. An application 
program is a program designed to perform a specific function directly for the user 
or, in some cases, for another application program. Applications use the services 
of the computer's operating system and other supporting applications. The 
formal requests and means of communicating with other programs that an 
application program uses is called the application program interface (API). 

Architect  The person, team, or organization responsible for designing systems architecture. 

Architectural 
description (AD) 

A collection of products to document an architecture. 

Architecture  The fundamental organization of a system embodied in its components, their 
relationships to each other, and to the environment, and the principles guiding its 
design and evolution. 

Architecture 
Viewpoint 

An Architecture Viewpoint is a set of conventions for constructing, interpreting, 
using and analysing one type of Architecture View. A viewpoint includes model 
kinds, viewpoint languages and notations, modelling methods and analytic 
techniques to frame a specific set of Concerns. Examples of viewpoints: 
operational, systems, technical, logical, deployment, process, information. 

Architecture View An Architecture View in an architecture description that expresses the 
Architecture of the System of Interest from the perspective of one or more 
Stakeholders to address specific Concerns, using the conventions established by 
its viewpoint. 

Artefact An artefact is the data that is produced as part of a development or certification 
activity. 
An artefact is a piece of information that is produced, modified, or used by a 
process. Artefacts are the tangible products of the project, the things the project 
produces or uses while working towards the final product. Artefacts are used as 
input by workers to perform an activity, and are the result or output of such 
activities. In object-oriented design terms, as activities are operations on an 
active object (the worker), artefacts are the parameters of these activities. 

Example: Artefacts may take various shapes or forms: 

• A model, such as the Use-Case Model or the Design Model  

• A model element, i.e. an element within a model, such as a class, a use case 
or a subsystem 

• A document, such as Business Case or Software Architecture Document  

• Source code  
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• Executables 

Assurance Asset An Assurance Asset models any asset from assurance projects whose qualities 
and lifecycle can be recorded and analysed (e.g., an Artefact or an Activity) 

Certification Certification is the activity of issuing a certificate. 

The purpose of certification is to make a testament on the quality of a system 
component regarding certain aspects. The information on how the testament was 
done and which aspects were considered, are contained in a certificate. 

Example: Certification can be done at different levels: 

• In system certification a certificate on the entire system is issued e.g. by a 
certification authority. 

• In component certification a certificate on the individual component is 
issued e.g. by the component developer. 

Component A basic building-block for systems with well-defined interfaces, behaviour and 
explicit context dependencies only.  
A component can be deployed independently. That is, it implements a clear 
function. 
A component can be composed with other components into systems, sub-system 
or new components.  
A component can exist in the form of software or hardware or a combination of 
both. 

Concern A Concern is any interest in the system. The term derives from the phrase 
"separation of concerns" as originally coined by Edsgar Dijkstra. Examples of 
concerns: (system) purpose, functionality, structure, behaviour, cost, 
supportability, safety, interoperability. 

Environment Every System exists in its Environment. A System acts upon that Environment and 
vice versa. A System's Environment determines the range of influences upon the 
system. Environment is intended in the widest possible sense to include 
developmental, operational, technical, political, regulatory, and all other 
influences which can affect the architecture. 

Evidence Assurance Evidence corresponds to artefacts that contribute to developing 
confidence in the dependable operation of a system and that can be used to 
show the fulfilment of the criteria of an assurance standard. Examples of artefact 
types that can be used as assurance evidence include risk analysis results, system 
specifications, reviews, testing results, and source code. Those artefacts that 
correspond to assurance evidence can be referred to as evidence artefacts. The 
body of assurance evidence of an assurance project is the collection of evidence 
artefacts managed. A chain of assurance evidence is a set of pieces of assurance 
evidence that are related, e.g. a requirement and the test cases that validate the 
requirement. Assurance evidence traceability is the degree to which a 
relationship can be established to and from evidence artefacts. Impact analysis of 
assurance evidence change is the activity concerned with identifying the potential 
consequences of a change in the body of assurance evidence. 

Qualification The post-development activity to determine if a component is suitable for use in 
a system being developed under certification-related requirements. 

Qualification applies to components which have not been developed according to 
the framework imposed by a certification standard. To allow reuse of these 
components they have to be qualified, that is, reasoning has to be applied to 
demonstrate that they are safe enough for their intended use in the new system.  

Related terms: Certification 
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Note: Qualification is not applicable for development of so called out-of-context 
components since the latter are still developed within a framework imposed by a 
certification standard. That is, they are subject to certification not qualification. 

Stakeholder Stakeholders are individuals, groups or organizations holding Concerns for the 
System of Interest. Examples of stakeholders: client, owner, user, consumer, 
designer, maintainer, auditor, certification authority, architect. 

System A collection of components organized to accomplish a specific function or set of 
functions. The term system encompasses individual applications, systems in the 
traditional sense, subsystems, systems of systems, product lines, product families, 
whole enterprises, and other aggregations of interest. 

System lifecycle The activities occurring during a period of time that starts when a system is 
conceived and ends when the system is no longer available for use, is 
decommissioned and is disposed. 

Tool Platform Collaborative development environment of a tool chain that supports the 
engineering (development, V&V, maintenance) and certification of systems such 
as safety-critical embedded systems. 

Tool Platforms are set of services to a community enabling it to pool Intellectual 
Property, Methodology, Components or Services, in accordance with a specific 
architecture, in order to avoid duplicate efforts when developing, maintaining, or 
using them. 

Use case  A detailed description of how an actor uses the system (what responds by what 
input). Use cases are often described in UML and text.  
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Annex A: AMASS Platform User Manual 

The AnnexA_AMASS-Platform-User-Manual.pdf file contains the User Manual of the AMASS Tools 
Platform. In this manual the user can find installing instructions of the AMASS Platform, an overview of the 
Dashboard, a description of the Platform environment and of all the Platform functionalities.  

Functionalities are presented, starting from the creation of models representing standards and company-
specific processes, creation of standard processes with EPF-C, modelling the System Component 
Specification, creation of Contracts and Architectural Patters, generation of Assurance Projects and the 
associated Baseline (subset of Standards to be applied in a specific Assurance Project), managing Evidences 
related to an Assurance Project, managing the Compliance of the Projects with the standards to comply 
with and creation of Argumentations.   

Other functionalities such as the web reports provided by the AMASS Platform are also detailed in this 
manual. Finally, it is explained how to connect the Platform with some external tools. 
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Annex B: AMASS Platform Developers’ Guide 

The AnnexB_AMASS-Platform-Developers-Guide.pdf file contains the Developers’ guide of the AMASS 
Platform implementation. In this document, the developers can find the source code installation 
instructions, step by step, in order to set up their workspaces to improve and implement new 
functionalities to the OpenCert, CHESS, Papyrus, and EPF-C tools. Also, installation instructions for the 
Polarsys OpenCert Tools Platform Server are included. 

This document has been elaborated as a Fast Developer Guide. Further questions must be directed to the 
AMASS implementation team. 
 



This deliverable is part of a project that has received funding from the ECSEL JU under grant agreement No 692474. 
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Executive Summary 

This document is a user manual of the AMASS Platform. In this manual the user can find installing 
instructions of the Polarsys OpenCert Tools Platform, an overview of the Dashboard, a description of the 
platform environment and of all the platform functionalities.  

Functionalities are presented, starting from the creation of models representing standards and company-
specific processes, creation of standard processes with EPF-C, modelling the System Component 
Specification, creation of Contracts and Architectural Patters, generation of Assurance Projects and the 
associated Baseline (subset of Standards to be applied in a specific Assurance Project), managing Evidences 
related to an Assurance Project, managing the Compliance of the Projects with the standards to comply 
with and creation of Argumentations.   

Other functionalities such as the web reports provided by the Polarsys OpenCert Tools Platform are also 
detailed in this manual. Finally, it is explained how to connect the Platform with some external tools. 
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1. Introduction 

The Polarsys OpenCert Tools Platform is an extensible tool platform designed to facilitate, manage, align 
and support the activities necessary to ensure security and compliance with the standards of critical cyber-
physical systems, seeking to reduce costs and Times of these complex processes. 

The Polarsys OpenCert Tools Platform allows the management and digitalization of normative spaces 
through the modelling of the norms and facilitates the traceability of the activities, requirements and 
artifacts defined by the norms through the life cycle of the critical system development. It also allows the 
management and modelling of arguments, which are a structured way of justifying (as convincingly as 
possible) that a system is safe for a particular application in a given context. In addition, it helps engineers 
to assess where they are with respect to the obligations that must be fulfilled by the normative spaces. 

The Polarsys OpenCert Tools Platform1 is composed of a set of tools providing the functionalities described 
in the AMASS deliverable D2.4 “AMASS Reference Architecture (c)” [1]. The platform has been built upon 
three pre-existing toolsets: 

• Tools from the pre-existing OpenCert project (Polarsys Platform)2. 

• Tools from the CHESS Project (Polarsys Platform)3. 

• Tools from the EPF (Eclipse Process Framework) Project4. 

                                                             
1 https://www.polarsys.org/opencert/  
2 Further information about the OPENCOSS toolset can be found at www.opencoss-project.eu and 
https://www.polarsys.org/projects/polarsys.opencert  
3 Further information about CHESS toolset can be found at https://www.polarsys.org/chess/  
4 Further information about the EPF toolset can be found at http://www.eclipse.org/epf/  

https://www.polarsys.org/opencert/
http://www.opencoss-project.eu/
https://www.polarsys.org/projects/polarsys.opencert
https://www.polarsys.org/chess/
http://www.eclipse.org/epf/
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2. Installation of the Polarsys OpenCert Tools Platform Client 

The following sections describe how to install the different toolsets of the Polarsys OpenCert Tools Platform 
Client, which has been built upon three pre-existing toolsets: 

• OpenCert toolset, that has been designed to follow a client-server architecture approach: 

o OpenCert server - installed in a central host machine.  

o One or many OpenCert clients - each of which installed on specific user machines. 

• CHESS toolset, that also follows this approach. 

• EPF-C toolset, that is deployed in an Eclipse standalone version. 

If you want to set up an own dedicated Polarsys OpenCert Tools Platform Server, please refer to the AMASS 
Platform Developers’ Guide [18]. 

2.1 Download Bundle 

To install the Polarsys OpenCert Tools Platform Client, download the bundle using the link below for 
Windows 64 bits and unzip it into your hard disk. 

https://www.polarsys.org/opencert/ 

It is required that the Java Environment 1.8 is installed in the computer. 

For those clients that are behind proxies, it should be considered that the Polarsys OpenCert Tools Platform 
Client makes use of ports 2036 and 8080 for communications.  

2.2 Client Configuration 

To use the Platform, execute the eclipse.exe file and introduce or select a folder that will be used as 
workspace. 

 

Figure 1. Select the workspace menu 

The first step after the installation process is to configure the connection settings with the CDO repository 
where all the models generated using the platform will be stored. This information must be introduced in 
the Model Repository Preference page inside the OpenCert category. Go to the menu “Window  
Preferences” to open this window. 

https://www.polarsys.org/opencert/
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Figure 2. Preference menu 

 

Figure 3. Model Repository Configuration Page linked to a common repository 

The information to introduce is: 

• Server IP: The IP of the centralised CDO Server (e.g. amass.tecnalia.com).  

• Server Port: The port used by the running CDO Server. Consider that if the client is behind a proxy, 
the port 2036 must be open, otherwise the communication will fail. 

• Repository name: The name of the repository where all the data will be stored (read only). 

• Protocol: The protocol used to connect to the CDO Server.  
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After introducing this data, the “OpenCert” Perspective can be used to connect to the server and view the 
data of the configured repository. To open it, go to the menu “Window → Perspective → Open Perspective 
→ Other”.  

 

Figure 4. OpenCert Perspective 

If the provided connection settings with the repository are incorrect or the server is not running, this view 
will display either an error (see Figure 5, or the Repository Explorer view without any content. To solve it, 
check that the server is running (e.g. using the web page http://amass.tecnalia.com:8080) and the 
configuration settings are correct, ensure the communication ports (2036 and 8080) are open, close the 
Repository Explorer view and open it again (“Window → Show View → Other → Opencert → Repository 
Explorer”).  

 

Figure 5. Repository Explorer content with configuration error  

2.3 Deleting Repository Contents 

To delete a folder and its contents, right click over it and left click the “Delete” menu. 

http://amass.tecnalia.com:8080/
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Figure 6. Delete repository folder 

If the following error message is shown when deleting a folder, it is necessary to delete manually the 
contents of the folder one by one, and finally delete the folder. 

 

Figure 7. Error message during delete folder operation 

To delete a model, right click over it and left click the “Delete” menu. 

 

Figure 8. Delete model menu 
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3. Dashboard Overview 

In order to provide a more comprehensive view of the Polarsys OpenCert Tools Platform capabilities and 
reduce the tooling complexity, a Dashboard has been implemented5. This Dashboard represents a workflow 

with the main features of the Platform and can be accessed from the Project Explorer View, using the  
button or through the “Open Activity Explorer” context menu. 

    

Figure 9. Access to the Dashboard  

The main page of the Dashboard (see Figure 10) shows an excerpt of the different stages (Sections, 
represented by arrows) and steps (Activities) to be performed for an Assurance Project in the Polarys 
OpenCert Tools Platform.  

 

Figure 10. General workflow of the Dashboard 

                                                             
5 The dashboard is a feature under development at the time of writing this document (November 2018). 
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Clicking over an arrow or a tab (see Figure 10), gives access to the contents of a certain Section (see Figure 
11). Each Section has its own page with the related steps linked to a concrete functionality in the Polarys 
OpenCert Tools Platform (a wizard, a window, etc.). Activities are grouped in categories.  

 

Figure 11. Contents of a Dashboard Section page 

The Polarys OpenCert Tools Platform functionality related to an Action is invoked when the user clicks over 
the Action name (see Figure 12). All these functionalities are explained in the next sections of this 
document. 

 

Figure 12. Clicking on an Action inside a Dashboard section 
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The Dashboard sections that are currently being implemented are shown in Figure 14. For each of them, an 
internal reference to its corresponding section in this User Manual has been indicated. 

 

5 Standards Modelling 

 

6 Assurance Project Management 

 

4 Process Modelling with EPF-C 

 

7 System Component Specification 

 

9 Assurance Argumentation Management 

 

10 Evidence Management 

Figure 13. Overview of the Dashboard sections 

 

Standards 
compliance definition
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4. Process Modelling with EPF Composer 

The purpose of this part of the manual is to provide an overview of the EPF Composer functionalities that 
are relevant for the compliance management building block and cannot be seen as a replacement of the 
official manual of this tool [6].  

The functionality of the EPF Composer is organized in two views, the Authoring perspective (opened by 
default in the EPF Composer) and the Browsing perspective. The goal of the Authoring perspective is to 
provide functionality to formally model process element and processes, while the goal of the Browsing 
perspective is to present the contents modelled of the Authoring perspective. So, most of the work of the 
user will take place in this last perspective. 

Figure 14 shows a screenshot of the Authoring Perspective in the EPF Composer. In this perspective we can 
distinguish three parts, the Method library (left top of the workbench), the Configuration (left bottom of 
the workbench) and the Process element/Process modelling space (right part of the workbench) that in this 
case, it is showing the modelling of a delivery process.  

 

Figure 14. The Authoring Perspective 

The Method Library is the structure used by EPF-C to organize the contents related to the modelling of the 
process. The library is composed of a set of plug-ins and configurations. Plug-ins are containers of process 
related information, while a configuration is a selection of the contents of the library to be shown in the 
Browsing perspective. 

In order to open the Browsing perspective, we select “Windows → Open perspective → Browsing”. This 
perspective is merely for presentation purposes and the contents modelled in the Authoring perspective 
are classified in the Configuration view. If you click one of the elements in the Configuration view, the 
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content window depicts detailed information of the process or process element. In this case, it is depicted 
the Work Product Usage of the capability pattern: ECSS-E-ST-40_LifeCycle_Pattern. 

 

Figure 15. The Browsing perspective 

The Section 4.1 of the EPF-C user manual [6] provides a detailed explanation of the different workbenches 
available in the EPF Composer. 

4.1 Modelling of reusable process elements 

The EPF Composer fully supports the re-use capacities of the SPEM 2.0 standard [7]. Therefore, it is possible 
to define a library of process elements that can be re-used to assemble different processes. Section 4.2 of 
the EPF Composer manual [6] provides guidance in the definition and re-use of the process elements. In 
this section, we show a small example of the standard ECSS-E-ST-40C. Specifically, we will model process 
elements for the section 5.5 “Software design and implementation” of this standard. 

In order to model contents related to a process, we firstly create or import a method Library and later we 
create Method plug-ins or import an existing one (Section 6 of EPF-C user manual [6]). You can create as 
many plug-ins as you need; in our case we create/import four method plug-ins (see Figure 14): 
compliance_modelling, ecss-e-st-40c_lifecycle, ecss-e-st40c_mappings and ecss-e-st40c_standard. 

The creation of the contents for the process is made in the Content Packages of the plug-in (see Figure 14). 
In Section 4.2.3 of the EPF-C user manual [6], we can find a detailed tutorial for this. Figure 16 shows all the 
content packages defined for the plug-in that will be used to model the process depicted in the standard 
ECSS-E-ST-40C. As in the case of the plug-ins, it is recommendable to have different packages to organize 
the contents. Inside each package, we have different folders that will be used to model Roles, Tasks, Work 
Products and Guidance. By just right-clicking one of the folders, we can create a new process element (i.e. 
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role, task, work product or guidance) and the edition panel for it opens automatically. Sections from 4.2.4 
to 4.2.9 of the EPF-C user manual provide information about how to define the different process elements 
in EPF Composer. In this section, we will focus on the definition of the task “Definition and Documentation 
of software unit tests” and the tool mentor “Eclipse Tool Mentor”. 

 

Figure 16. Content packages of the ecss-e-st-40c_lifecycle 

In order to create a new task, we right click the Tasks folder of a content package and select “New → Task”. 
Then, a form will be automatically opened (see Figure 17) that will be used to add information about the 
task. The form is composed by different tabs: Description, Steps, Role, Work Products, Guidance, 
Categories and Preview. In the different tabs of the form, you can enrich the definition of your process 
element (in this case a task) by adding other process elements (i.e. roles, work products…) and providing 
additional information like descriptions, alternatives in the use of the process element, etc.  

The “Description” tab is common to all the elements that can be defined in EPF-C and is used to give a 
name to the element and to add detailed information. The naming conventions of EPF-C distinguish 
between the Name of an element (“definition_and_documentation_of_software_unit_tests”) and the 
Presentation name (“Definition and Documentation of software unit tests”). The Name of an element is 
mainly used in the Authoring perspective, while the Presentation name is used in the Browsing Perspective 
and in the generated website.  
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Figure 17. “Description” tab of the form for modelling a Task 

In the “Steps” tab (see Figure 18), it is possible to add the different steps that compose the task. Steps are 
added by clicking the button “Add…”, can be deleted using the “Delete” button and their order can be 
modified using the buttons “Up”, “Down” or “Order”. Additionally, we can provide a description of the step 
in the field “Description”. 

 

Figure 18. “Steps” tab of the form for modelling a Task 
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In the “Roles” tab (see Figure 19), all the roles involved in the execution of the task are added. EPF-C 
distinguish between Primary performer and Additional Performers. You can add an already defined Role 
(see Section 4.2.5 of EPF-C manual [6]) in the corresponding category by clicking the button “Add…”. 

 

Figure 19. Roles tab of the form for the modelling of a Task 

In the “Work Products” tab, it is possible to add work products that are input, optional input or output of 
the task. While in the “Guidance” tab, supporting material for the execution of the tasks like tool mentors, 
white papers or guidelines are added. In the “Categories” tab, categories are used to classify tasks in 
different disciplines.  

Finally, in the “Preview” tab (see Figure 20), we can see the result of our modelling work. This preview 
shows how this element will be presented in the Browsing perspective and in the generated website. It is 
interesting to note that all sentences in blue are links to process elements and process. So, it is possible to 
navigate between the different elements related to our task by simply clicking in the corresponding link. 
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Figure 20. “Preview” tab of the form for the modelling of a Task 

In certification processes, tools are an important element in the undertaken of an activity. So, in this 
section, we will explain how tools are modelled in the EPF Composer. This is done in two parts, the 
definition of a Tool Mentor in the Guidance package and a Tool in the Standard Category folder of our plug-
in.  

Tool mentors represent how to use a specific tool to accomplish some piece of work, in the context of, or 
independently from, a task or activity. They are modelled in the Guidance folder of a Content Package. So, 
we right click in the Guidance folder and select “New → Tool Mentor”. Then, a form similar to the Task for 
the modelling of a form will appear in which we can add Description and Guidance to this process element 
and see a preview of it. In order to add a tool mentor to a task, we select the “Guidance” tab of the task, 
click the button “Add…” and a dialog will appear (see Figure 21) in which we can select the tool mentor. 
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Figure 21. Dialog for the selection of Guidance elements in the context of a Task. 

Finally, tool mentors should be linked to tools. In order to define a tool, we click in the Standard Category 
package of our plug-in, right-click in the Tools folder and select “New → Tool”. Then, a form similar to the 
form for the tasks will appear (see Figure 22) in which we can add Description, Tool Mentors, Guidance and 
have a preview of our modelled tool. In the Tool Mentor tab, we can add our Tool Mentor by clicking the 
“Add…” button. 

 

Figure 22. Creation of a tool and “Tool Mentors” tab in the EPF Composer 
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4.2 Modelling of processes mandated by standards 

The modelling of a processes mandated by standards is done by the modelling of a Delivery process. 
Section 4.4 and Section 9 of the EPF-C manual [6] provide detailed instructions on how to accomplish this 
task. Previous to the modelling of the delivery process, it is necessary to analyse the standard and derive 
the process elements (tasks, roles, work products and supporting material) that will be part of our process. 

In order to create a new delivery process, we right click in the package Delivery Process of the Processes 
folder of our plug-in and select “New→ Delivery Process” (see Figure 23). Then, a form for the modelling of 
the process will appear with the “Description” tab (as in the case of the Task) and other tabs specific for 
process modelling: “Work breakdown Structure”, “Team allocation”, “Work Product usage” and 
“Consolidated View”. 

 

Figure 23. Creation of a new delivery process in the EPF Composer 

The “Work Breakdown Structure” tab is used to describe the structure of the work. The work can be 
decomposed by using the following elements: Activity, Iteration and Phase. Additionally, we can model 
Milestones, which are points in the development process in which specific work products are released, and 
we can add tasks by means of Task Descriptors. All these elements can be added in this tab by right clicking 
in the process (see Figure 24). If we right click in one of these elements and select “Show properties view”, 
we can add additional information to this process element like supporting material, descriptions or work 
products delivered in the Milestone. 
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Figure 24. Modelling of the Work breakdown structure of a delivery process 

As stated in the introduction of this section, it is possible to re-use process elements defined in the Content 
Packages to assemble process. This can be done in two ways. The first method is by dragging the specific 
task from the content package and dropping it in the process. The second method is by right clicking in the 
process and select “New → Task Descriptor”. Then, we right click in the Task Descriptor that has been 
created and select “Show Properties View”. In the “General” tab of the Properties View, we click the 
button “Link Method Element…” and a dialog appears in which we can select the Task to re-use. Once a 
task is added to a delivery process, all its related process elements (i.e. work products, roles, …) are added 
to the process automatically (see Figure 25). 

 

Figure 25. Properties view in a Milestone 
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The “Team Allocation” tab shows the roles that are involved in the different activities of the delivery 
process. It can also be used to add roles defined in the content packages to activities using the same 
procedure described for tasks. Additionally, in this tab we can define a Team Profile as it is described in 
Section 9.4 of the EPF-C Manual [6]. The “Work Product Usage” tab has the same role as the “Team Profile” 
tab but specific for Work Products. Finally, in the “Consolidated View” tab, we can see how Task, Roles and 
Work Products are involved in the Activities of the Process (see Figure 26). 

 

Figure 26. Consolidated View of the Delivery Process ECSS-E-ST-40_LifeCycle 

EPF offers the possibility of modelling a process using UML-Style Activity Diagrams as it is described in 
Section 4.4.5 of the EPF-C Manual [6]. To open this view, in the “Work Breakdown Structure” tab of the 
delivery process, we right click in the process and select “Open Activity Diagram”. The main purpose of this 
view is to model how activities are done (order, parallelism) in the delivery process (see Figure 27). 

 

Figure 27. Activity diagram of a delivery process 
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4.3 Modelling of reusable process patterns 

Capability patterns are a special type of process for a key area of interest, such as a discipline or a best 
practice. They can be used as building blocks to assemble larger capability patterns and delivery processes. 
Sections 4.4 and 9 of the EPF-C manual [6] provide detailed information about how to define and use 
capability patterns in the EPF Composer. The modelling of the work that is contained in a Capability Pattern 
can be done using the same method followed for the Delivery Process. So, we provide an overview about 
how to use a capability pattern in this section. 

In order to add a capability pattern to a process or other capability pattern, we right click in the process or 
activity in which we want to add the pattern and select “Apply Pattern”. As it is depicted in Figure 28, we 
have three options: Copy, Extend and Deep Copy. Specific details of the differences between these ways of 
application of the patterns are described in Section 9.7 of the EPF-C manual [6]. In a few words, the main 
difference between Copy (or Deep Copy) and Extend is the type of relationship between the original 
capability pattern and the pattern which is placed in the process. When we select any of these options, a 
dialog to select the capability pattern appears. 

 

Figure 28. Adding a capability pattern in a delivery process 

When a capability pattern is copied (or deep copied) in a delivery process or other capability pattern, all the 
information of the process contained in the pattern (i.e. activities, roles, milestones) is automatically 
added. We can modify this copied capability pattern to meet the requirements of the delivery process. So, 
we can add tasks, modify a role or rename an activity, just to mention a few. These modifications do not 
affect to the original capability pattern. On the other hand, if we apply the pattern using the Extend option, 
a link is set between the original capability pattern and the extended capability pattern (this is highlighted 
in EPF-C using green letters as it is depicted in Figure 29). So, we cannot modify this extended capability 
pattern and additionally, any modification in the original capability pattern will be propagated to its 
extensions. This is particularly useful to update a family of delivery processes for a domain.  
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Figure 29. Extended Capability Pattern 
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5. Standards Modelling 

Users can use the Reference Framework Editor to model Standards (IEC 61508, ISO 26262, DO-178C, EN 
50126, and the like) or any Regulations (either as additional Requirements or model elements in a given 
model representing a Standard or a new Reference Framework). Each Reference Framework model can be 
also mapped to other Reference Framework models by using the concept of Equivalence Map. 

5.1 Create a Reference Framework model 

In order to create a new Reference Framework model, follow the next steps: 

• From the File menu, choose “New → Other…” (see Figure 30) 

 

Figure 30. New Reference Framework model 

• In the Wizard dialog, open the OpenCert category, select “Refframework Diagram”, and press the 
“Next >” button (see Figure 31). 

 

Figure 31. Wizard Reference Framework model 

• In the New Refframework Diagram dialog, select or enter the parent folder, the name of the 
diagram to be created, and press the “Next >” button (see Figure 32). 
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Figure 32. New Refframework Diagram 

• In the New Refframework Domain model page, select or enter the same name as in the previous 
step as parent folder, enter the name of the diagram to be created, and press the “Finish” button 
(see Figure 33). 

 

Figure 33. New Refframework Domain Model 

5.2 How to edit a Reference Framework model 

After completing the Refframework Diagram creation wizard, the perspective of the tool will be opened 
which is composed by five views (see Figure 34): 

1. The Repository Explorer shows the contents of the repository. 

2. The Outline shows the elements of the model and allows its edition. 

3. The Diagram Editor allows the graphical modelling of a subset of concepts of the Reference 
Framework. 



 

         AMASS AMASS Platform User Manual V1.0 

 

H2020-JTI-ECSEL-2015 # 692474 Page 42 of 295 
 

4. The Palette is a toolbox with the concepts of the model and the connections between them to add 
to the diagram. 

5. The Properties view allows to edit the properties of the element of the model selected. 

 

Figure 34. Refframework editor perspective 

5.2.1 Add concepts to the diagram 

To add concepts to the diagram, left click in a category Object of the palette and move the cursor over the 

diagram zone. This cursor  appears if it is possible to add this object in the target diagram location 

according to the modelling rules (Reference Framework metamodel), if not this other  will appear. 

A figure representing the concept will be displayed in the diagram. 

5.2.2 Add links between concepts 

To add a link between concepts, select it from the Connections category of the palette. This cursor  
appears if this object can be the origin of the connection, according to the modelling rules (Reference 

Framework metamodel), if not this other  will appear. Maintain the left mouse clicked, the cursor will 

become , and move to the destination object. The same icons will appear if the destination is correct or 
not. 

5.2.3 Edit properties 

Some model elements from the Reference Framework cannot be edited graphically (RefRequirements, 
RefApplicability tables, among others). These model elements can be edited by using the Properties view (). 
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If the Properties view is not visible, you can open it by using the contextual menu “Show Properties View” 
of the figures (see Figure 35). 

 

Figure 35. Show properties view 

5.2.4 Create multi-diagrams from a Reference Framework model 

The tool allows managing different views of a model through a set of diagrams. Once a model is available, a 
new diagram view can be created and special edition functionalities are available as follows: 

1. Thanks to the Outline view, it is possible to drag and drop concepts from the model to the diagram. 

2. Once a concept has been selected, it can be hidden through the “Delete from diagram” option 
available in the contextual menu. This option does not delete the concept from the model. 

3. Once a concept has been selected, it can be deleted through the “Delete from model” option 
available in the contextual menu. This option deletes the concept from the model permanently. If 
this deleted concept is displayed in another diagram files, it will be shown with a cross icon in the 
upper right corner to show that it does not exist anymore (see Figure 36). 

 

Figure 36. Deleted concept shown in a diagram 

Once a model is available, a new diagram view can be created following the procedure below. 

 

 

 

 

 

 

Type the name of the 
exiting refframework 
model created 
previously and click the 
“Finish” button (Figure 
39).  

Select “New”  
“Other…” from the 
File menu of 
eclipse 

Select “Refframework 
Diagram to Repository” in 
the Opencert category 
and click the “Next” 
button (see Figure 37). 

Select the same folder of the 
exiting refframework model to 
store the new diagram. Then type 
the name of the diagram to be 
created and click the “Next” button 
(Figure 38). 
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Figure 37. Refframework Diagram wizard (I) 

 

Figure 38. Refframework Diagram wizard (II) 
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Figure 39. Refframework Diagram wizard (III) 

After that, the diagram is ready for edition.  

5.2.5 Regenerating a broken diagram 

The same procedure explained in the previous section is also useful to regenerate a broken diagram, in 
other works, a diagram that showed an error when loading, normally because a graphical element is 
referencing a model element that has been deleted using the non-graphical editor. As step by step 
reminder: 

1. Create an empty diagram using the “Refframework Diagram to Repository” wizard giving a new 
name to the diagram and selecting the same folder where the refframework model is stored (see 
Figure 40). 
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Figure 40. Regenerating a broken diagram (I) 

2. Type the name of the existing refframework model (see Figure 41). 
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Figure 41. Regenerating a broken diagram (II) 

3. Drag and drop elements from the outline view to generate their graphical representation in the 
diagram as shown in the Figure 42. 

 

Figure 42. Regenerating a broken diagram (III) 

5.2.6 Non-graphical editor 

As an alternative to the graphical Editor, the Reference Framework model can also be edited by using a 
Tree View Editor. To do so double click over the file created together with the Diagram file (extension: 
xxx.refframework) as shown in the Figure 43. 
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Figure 43. Model tree editor 

It is also possible to use the Outline view to create new model elements, as shown in Figure 44.  

 

Figure 44. Edit model from Outline 
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5.3 Creating Equivalence Maps 

It is possible to create Equivalence Maps in two ways:  

• by using the editor, or 

• by using a tailored functionality for it. 

5.3.1  Equivalence Map using the editor 

To create Equivalence Maps using the editor, it’s necessary to load two CDO resources: the reference 
framework model (.refframework) and the mapping model (.mapping). 

So, click the editing window and select “Load Resource” in the context menu (see Figure 45).  

 

Figure 45. Load Resource  

Then, select the refframework model and the mapping model by cliking the “Browse Repository” button to 
obtain the URI of any model stored in the repository (see Figure 46 and Figure 47). 
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Figure 46. Load Resource Reference Framework  

 

Figure 47. Load Resource Map Group  
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It is possible to create equivalence maps for activities, artefacts, requirements, roles and techniques. First, 
select the object in the tree, then select the “ActivityEquivalence Map” tab and click the “Add” button (see 
Figure 48). 

 

Figure 48. Activity Equivalence Map 

Finally, enter the information requested in Figure 49: 

  

Figure 49. Equivalence Map 
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If the user adds as target of the equivalence an element of the source refframework, this target element 
will be considered as postCondition. The postConditions are mandatory extra activities, not included in the 
standard, that must be performed in case of reusing the target element from an Assurance Project based in 
the target refframework in another Assurance Project based in the source refframework using the Cross 
Standard functionality that will be explained in the section 6.5. 

5.3.2 Equivalence Map using a tailored functionality 

To create Equivalence Maps using the tailored functionality, first of all, it is necessary to click the “Mapping 
Set” button on the Properties form of the reference framework using the tree view editor (not available 
using the diagram editor) as shown in Figure 50. This window (see Figure 51) automatically saves the 
mappings when checking or unchecking elements of the target refframework tree. 

 

Figure 50. How to create an Equivalence Map 

 

Figure 51. Equivalence Map form 
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The Equivalence Map form is organized in three zones: 

• The left zone shows the actual reference framework and loads the type of elements for which we 
want to make the equivalence maps, by default activities.  

• The middle zone allows to make different filters like: 

o Filter Mapping Model lists all the mapping models stored in the database. It will be 
necessary to select one of them and one group model. It’s also possible to create a new 
map group by clicking the “New group” button. 

o Filter Map Element. It is possible to create equivalence maps for activities, artefacts, 
requirements, roles and techniques. When these filters change, the information showed by 
the reference framework also changes. For example: 

▪ If the “Requirement” filter is selected only the requirements of both refframeworks 
will be shown (see Figure 52): 

 

Figure 52. Equivalence Map, select map element (I) 

o Filter Equivalence Map. This filter allows making different equivalence maps for the same 
refframework element. 

o The mapping information must also be introduced in the middle part by the user; this 
information is the ID, the name, the type and a justification text. 

• The right zone shows two lists and a combo box.  

o The combo box shows all the database refframeworks to select the reference framework 
that will be the target of the equivalence map to create. 

o The upper list loads the elements, according to the filter selected, of the refframework 
chosen in the combo box that will be the target of the equivalence map to create. 
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The lower list displays the full content (not filtered) of the source refframework that will be postConditions 
in case of reusing (see Figure 53). The postConditions are mandatory extra activities, not included in the 
standard, that must be performed in case of reusing the target element from one Assurance Project based 
in the target refframework in another Assurance Project based in the source refframework using the Cross 
Standard  functionality that will be explained in the section 6.5. 

If the user double-clicks any element of this list, the source refframework could be modified to create a 
new element to be used as postconditions (the “Save” button must be clicked to save the changes). 

 

Figure 53. Equivalence Map with Postcondition. 

For making an equivalence map follow the next steps (see Figure 54). This window saves automatically the 
mapping information): 

1. Select a mapping model and a map group (or create it if needed). 

2. Select the target reference framework. 

3. Select the filter map element. 

4. Select the element from the source reference framework. 

5. Select or create the equivalence map and introduce the mapping information (ID, name, type and 
justification). 

6. Check or uncheck the element from the target reference framework. 

7. Create the postconditions if needed and check or uncheck the postconditions elements. 
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Figure 54. Steps for making an Equivalence Map 

5.4 Creating Applicability Tables 

To create Applicability Tables (the naming is to cover various standards, for IEC 61508 derived standards 
would be Recommendation Tables) such as this one in Figure 55: 

 

Figure 55. Applicability Table ISO 26262 

For ISO26262 and IEC 61508 standards, select the desired “Requirement” from the Standard, go to the 
“RequirementApplicability” tab (to go to a Requirement Form, select the Activity which contains the 
Requirement, and double click on the Requirement properties): 

 

Figure 56. Requirement Applicability Table ISO 26262 
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Then add rows by defining the target Method (technique) and select the Criticality Level and the 
Recommendation level (see Figure 56). 

Note: The user must first create Criticality Levels (SIL) and Recommendation Levels (++, +, o, or others as 
required) by clicking on the Diagram (in some blank space) to see the Properties of the RefFramework 
model element (the Standard). 

In the case of the DO-178C standard, to create Applicability Table such as the next Figure 57: 

 

Figure 57. Applicability Table DO-178C 

It is necessary to perform two steps: 

1. First, define the applicability table for the activities: select the desired “Activity” from the Standard 
and go to the “ActivityApplicability” tab. 

Then, add rows by defining the target Requirement, select the Criticality Level and the 
Recommendation level (see Figure 58). 

 

Figure 58. Activity Applicability Table DO-178C 
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2. Second, to define the applicability table for the requirements: select the desired “Requirement” 
from the Standard and go to the “RequirementApplicability” tab. 

Then, add rows by defining the target Artefact, select the Criticality Level and the Recommendation 
level (see Figure 59). 

 

Figure 59. Requirement Applicability Table DO-178C 

In summary (see Figure 60): 

 

Figure 60. Summary Applicability Table DO-178C 
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6. Assurance Project Management 

Users can maintain the lifecycle of projects by creating Assurance Projects. An Assurance Project can have 
multiple Baseline Configurations, Permissions Configurations and Assurance Assets Packages, but only one 
is active at once. 

6.1 Creating an Assurance Project and Baseline 

To create a new Assurance Project, go to the menu “File → New → Project” or use the button  in the 
top bar, and select “New Assurance Project” inside the OpenCert category (see Figure 61). 

 

Figure 61. New Assurance Project wizard 

The first page of the wizard (see Figure 62) allows to select the folder that will contain the Assurance 
Project, to enter the name of the Assurance Project and to choose if the user wants to automatically 
generate an Argumentation model based on the standard parts selected in the next wizard page. 
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Figure 62. Assurance Project name page 

The next page of the wizard will show in the left side the list of reference framework models (the standard) 
in the whole repository. Select the desired refframework and its contents will be shown at the bottom right 
list in the form of a checkable tree for the generation of the baseline.  

If the user wants to create an Assurance Project to accomplish with a certain criticality and/or applicability 
level, s/he can select them from the upper right lists and the mandatory parts of the standard to comply 
with the selected levels will be automatically selected, as well as the other parts of the standard that don’t 
have relation with any criticality or applicability level (see section 5.4 Creating Applicability Tables). The text 
“**** Selected in Assurance Project Generation Wizard ****” will be added to the description of the 
selected criticality and/or applicability levels in the generated baseline model. 

The user can also select directly the contents of the standard that will be applied to the new project by 
using the bottom tree. 

After giving a name to the baseline and clicking the “Finish” button, the project information generation 
process will start (this process could take several seconds). It is mandatory to give a name and select at 
least one concept (see Figure 63). 
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Figure 63. Reframework selection 

Next, the new project will be displayed in the Repository Explorer (see Figure 64).   

 

Figure 64. Assurance Project structure 
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The project is composed of four folders: 

• Argumentation folder for storing the argumentation models. An argumentation model (with 
diagram) is generated automatically based on the baseline’s selected entities. (For more details, 
see section 9.2.2). 

• Assurance Project folder that has the project information in .assuranceproject model, the baseline 
information in .baseline model (with diagram) and the .mapping model to store the compliance 
mapping information. 

• Evidence folder for saving the evidence models. 

• Process folder for the process execution. 

To edit the Assurance Project information double click over the model and its editor will appear (see Figure 
65). By default, the Assurance Project is related all the models automatically generated, the baseline and 
mapping models in the active BaselineConfig and the argumentation model in the active AssetsPackage.  

To generate new models related to an Assurance Project, for example an evidence model, select the right 
folder (EVIDENCE following with the example) of the Assurance Project as destination for the new model 
and update manually the Assurance Project model to reference the new models inside the project 
(AsssuranceAssets following with the example). 

 
Figure 65. Assurance Project editor 

6.2 Creating or Updating a Project Baseline 

To create a new Assurance Project Baseline or update an existing one, select the menu “File → New → 

Other…” or use the arrow in the right of the  button in the top button bar, and select “Other…” (see 
Figure 66). 
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Figure 66. Other kind of projects option 

Then, choose the “Creates or Updates Baseline” wizard behind the OpenCert category (see Figure 67). 

 

Figure 67. Creates or Updates Baseline wizard 

The first page of the wizard requests the selection of the Assurance Project Model to update (see Figure 
68). 
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Figure 68. Selection of the Assurance Project to update 

The following steps are exactly the same as for the generation of a new Assurance Project. 

Select the desired reference framework model to be used as source for the generation of the baseline in 
the left list, then its contents will appear in the bottom right list in form of a checkable tree for the 
generation of the baseline. Select the nodes of the tree that will be applied to this baseline, or use the 
upper right lists to select automatically baseline elements according to the checked criticality and 
applicability levels, and give a name to the baseline taking into account that if the given name is the same 
as a previous existing baseline, the contents of the previous one will be replaced with the information 
selected and the same will occur with the argumentation model. 

Finally, click the “Finish” button to generate the new baseline and argumentation models that will be added 
to the Assurance Project model and stored in the appropriate Assurance Project folders (see Figure 69). 
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Figure 69. Assurance Project with new baseline 

6.3 Editing a Project Baseline 

To edit the baseline information double click over the baseline model and its View editor will be shown. 

The not selected elements will be displayed in the upper tree with a different icon (see Figure 70). 

 

Figure 70. Baseline editor 

The baseline model can also be edited by means of a graphical editor (see Figure 71), to use it double click 
in the .baseline_diagram model. The way of using this editor is exactly the same as the refframework editor 
explained in the section 5.2. 
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Figure 71. Baseline graphical editor 

6.4 Editing Compliance Maps 

It is possible to create Compliance Maps in two ways: 

• by using the editor, or 

• by using a tailored functionality for it. 

6.4.1 Compliance Map using the editor 

To create Compliance Maps using the editor, we must load four CDO resources: the Artefact Model 
(.evidence), the Process Model (.process), the Argumentation Model (.arg) and the Mapping Model 
(.mapping).  

It is important to remind that these models must be part of the active BaselineConfig and AssetsPackage of 
the Assurance Project, in other words, 

• The Artefact Model, Process Model and Argumentation Model must be part of the active 
AssetsPackage of the project (see Figure 72). 

• The Map Group of the Mapping Model must be part of the active BaselineConfig of the project (see 
Figure 73). 
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Figure 72. Assets Package active 

 

Figure 73. Active Baseline Config  
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So, click the editing window and select “Load Resource” in the context menu (see Figure 74). 

 

Figure 74. Load Resource (I) 

Alternatively, select the menu option “Baseline Editor → Load Resource…” (see Figure 75). 

 

Figure 75. Load Resource (II) 

Then, select the resource model browsing the repository by clicking the “Browse Repository” button (see 
Figure 76 and Figure 77). 
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Figure 76. Load Resource Evidence, Process or Argumentation model  

 

Figure 77. Load Resource Mapping model  

It is possible to create compliance maps for activities, artefacts, requirements, roles and techniques. To do 
so, first select the object in the tree, then select the “Compliance Map” tab and click the “Add” button (see 
Figure 78). 
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Figure 78. Artefact Compliance Map 

Finally, enter the information requested in Figure 79. 

 

Figure 79. Compliance Map 

Remember that the Map Group must be part of the active Baseline Config of the project (see Figure 73). 
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6.4.2 Compliance Map using a tailored functionality 

To create Compliance Maps using a tailored functionality, first of all, it is necessary to click the “Mapping 
Set” button on the Properties view of the Baseline using the tree view editor (not available using the 
diagram editor) as shown in Figure 80. This window automatically saves the mappings when checking or 
unchecking elements of the target baseline tree. 

 

Figure 80. How to create a Compliance Map 

 

Figure 81. Compliance Map form 

The Compliance Map form (see Figure 81) is organized in three zones: 
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• The left zone shows the actual baseline and loads the type of elements for which we want to make 
the compliance maps. By default, activities.  

• The middle zone allows to make different filters like: 

o Filter Mapping Model lists all the mapping models stored in the database. It will be 
necessary to select one of them and one group model. It’s also possible to create a new 
map group by clicking the “New group” button. This map group must be part of the active 
Baseline Config of the project. 

o Filter Map Element. It’s possible to create compliance maps for activities, artefacts, 
requirements, roles and techniques, and the allowed maps are: 

▪ BaseArtefact  →  Artefact 

▪ BaseRequirement  →  Artefact , Claim or Activity 

▪ BaseActivity  →  Activity 

▪ BaseRole  →  Participant 

▪ BaseTechnique  →  Technique 

When the filter Map Element changes, the information showed by the reference 
framework also changes. As example see Figure 82 with the “Artefact” filter selected. 

 

Figure 82. Compliance Map, select map element 

Remember that these models must be part of the active Assets Package of the project. 

o Filter Compliance Map. This filter allows making different compliance maps for the same 
element. 

• The right zone shows the list of models, depending on the map filter, stored in our database. We 
should select one of them. This selected model will be the target of the compliance map to create. 

For making a compliance map, follow the next steps: 

1. Select a mapping model and a map group. 

2. Select the target reference framework. 

3. Select the filter map element. 

4. Select the element from the source reference framework. 

5. Select o create the compliance map. 

6. And for last, check or uncheck the element from the target model. 
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6.4.3 Compliance Mapping Table 

The Compliance Mapping table allows monitoring the compliance status of an Assurance Project’s active 
baseline with the possibility of filtering by several criteria.  

To access this window, it is necessary to click the “Mapping Table” button on the properties view of the 
Base Framework element of one Baseline using the tree view editor (see Figure 83) (not available using the 
diagram editor). 

 

Figure 83. How to access the Compliance Mapping Table 
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Figure 84. Mapping Table window 

The Compliance Map Table window (see Figure 84) is organized in two zones: 

• The upper part has some controls to allow filtering. It is possible to filter by criticality level, 
applicability level, map model, a map group of the selected map model, a type of element that 
could be mapped and the mapping type. The “Not Defined” option is to include in the table all the 
elements of the baseline that have not mapping established. In this way, it is possible to see the 
compliance Gap. It is necessary to click the “Search” button to start the search process based in the 
filter options selected. 

• The bottom part shows three controls: 

o The Compliance Mapping Table that shows all the baseline elements that accomplish with 
the searching criteria selected by the user. By default, all the baseline elements that have 
compliance map are shown in the table. 

o A text box that shows the Compliance Map Justification introduced for the base element 
selected in the bottom left table with a simple left click. 

o A list that shows all the target elements of the base element selected in the table with a 
simple left click (see Figure 85).  
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Figure 85. Showing the target list of the Base element selected  

Double clicking in any element of the table will give access to the Compliance Map tailored functionality 
(see Figure 86), explained in the previous 6.4.2 section, to create or modify the compliance map 
information of the double-clicked element. 

 

Figure 86. Compliance editor accessed via the Compliance Mapping table 

Finally, it’s possible to double click in one element of the target list to access to detailed information of the 
selected target element (see Figure 87).  
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Figure 87. Compliance map target element details accessed from the Compliance Mapping table 

6.5 Cross Standard Reuse 

The objective of the Cross Standard reuse functionality is to facilitate reusing the evidences from a source 
Assurance Project of a certain standard in a target Assurance Project of another standard. It is mandatory 
that the target Assurance Project is based in a refframework with equivalence maps with the refframework 
in which the source Assurance Project is based and, logically, the source project must have an Evidence 
Model.    

To access this functionality, open the target Assurance Project model and click the “Cross Standard” button 
on the Properties form of the Assurance Project element of the model (see Figure 88). 
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Figure 88. Cross Standard button 

If the target project does not have an evidence model, a confirmation message will be displayed asking the 
user for confirmation to create it (see Figure 89).  

If the user agrees, a new evidence model will be generated automatically based in the contents of the 
target Assurance Project baseline (for each BaseArtefact in the target baseline, one Artefact Definition with 
one Artefact will be included in the target evidence model). The evidence model will be related with the 
target Assurance Project and the compliance maps between the baseline and the evidences are 
automatically created. After this data generation process, the cross standard window will be opened.  

If the user refuses to create and evidence model, the data is not created, and the cross standard window is 
not opened because it is mandatory to have an evidence model as destination model of the reuse. 

 

Figure 89. Message to create a new evidence model  
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If the target model already has an evidence model, the user is asked if s/he wants to use it as destination 
model of source Artefacts to reuse (see Figure 90). If the answer is “YES” the existing evidence model will 
be used as the target model of the reuse and the cross standard window will be opened. If the answer is 
“NO” the previously explained message will appear (see Figure 89).  

 

Figure 90. Message to use an existing evidence model  

The Cross Standard Reuse window is organized in three zones (see Figure 91): 

• The left zone shows information about the target project. At the top, the URL of the target 
Assurance Project, below a tree with the target Baseline contents, below the Compliance Map 
information of the selected target baseline element and the contents of the target Evidence model 
in another tree.  

• The middle zone displays equivalence map information. It includes controls to select the 
Equivalence Mapping model and the Equivalence Map group, displays the Equivalence Map details 
of the target baseline element selected and its postconditions in a list (to see the ID, Name and 
description one postcondition must be selected). 

• The right zone presents information about the source project. At the top, the URL of the source 
Assurance Project, below a tree with the source Baseline contents, below the Compliance Map 
information of the source Baseline element selected and the contents of the source Evidence 
model. 

The user can obtain detailed information of any element displayed in the trees in a popup window by 
double-clicking over it. In the case of the target evidence model, the model can be edited directly in the 
popup window and the changes will be saved after clicking the “Save target evidences” button. 

Also, it is possible to create new Compliance Maps between the target baseline and the target evidence 
model by clicking the “New CM” button connected with the tailored Compliance map window explained in 
section 6.4.2. 
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Figure 91. Cross Standard Reuse window 

The user must choose the source project of the reuse by clicking the “Search” button, then the source 
baseline and the evidence model tree will be loaded. After this, the user must select the equivalence model 
and the equivalence group. The next step is to select the target base element that will receive the 
evidences to be reused and its compliance and equivalence map information will be loaded, highlighting in 
green its target elements in the trees. Finally, the user must select the target Artefact and click the “Reuse” 
button to start the copy of the checked source Artefact/s to the target selected Artefact (only one target 
Artefact can be selected).  

 

Figure 92. Cross Standard reuse window with base element selected 

As an example, the Figure 92 shows that the selected BaseArtefact “ArtfA” of the target project “Project2” 
has a Compliance Map with the target Artefact “Artefact version 1” of the evidence model of the target 
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project. Also, it has an Equivalence Map, inside the map group “MG-Artefacts”, with the source baseline 
BaseArtefact “Artf1” of the source Assurance Project “Project1” and as postcondition the BaseActivity 
“Extra Activity caused by reusing” (the equivalence maps are created at refframework level and are copied 
to the baselines during the Assurance Project generation process). The source BaseArtefact “Artf1” has a 
Compliance Map with the target Artefact “Artefact 1” of the Evidence Model of the source project. 
Therefore, the “Artefact 1” is a good candidate to be reused, according to the existing equivalence and 
compliance mapping information, and appears checked and highlighted in green.  

This window checks the integrity of the data before starting the copy process and inform to the user about 
this. Examples in the Figure 93. 

  

 

Figure 93. Cross Standard information messages about integrity 

If the user wants to copy artefacts without equivalence between them, the confirmation message in Figure 
94 is displayed. 

 

Figure 94. Reuse not equivalence artefacts confirmation message 

Finally, if the integrity checks succeed, another confirmation message is displayed showing a summary of 
the data that will be copied (see Figure 95). 

 

Figure 95. Cross Standard final confirmation message 

If the user selects to continue, the copy process will start. The source repository configuration information 
inside the Artefact Model Object, the Resource objects of the checked source Artefacts and the repository 
files related to these resources will be copied to the target evidence model. Additionally, the 
postconditions will be selected in the target Baseline Model. 
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6.6 Cross Project Reuse 

The objective of the Cross Project reuse functionality is reusing models from one source Assurance Project 
to a target Assurance Project, the diagrams will also be copied to the target project if they exist.  

This functionality allows reusing only the selected source evidence models associated to the active Assets 
Package, because evidences are not related to any other model of the project, or all the baselines 
associated to the active Baseline Config and all the evidence, argumentation and process models of the 
active Assets Package. In this second option all the models will be cloned to assure the integrity of the data, 
for example, a baseline could be related with argumentations, evidences and/or processes and in this way, 
we are sure that all the related information is copied avoiding inconsistencies.  

To access this functionality, open the target Assurance Project model and press the “Cross Project” button 
on the Properties form of the Assurance Project element of the model (see Figure 96). 

 

Figure 96. Cross Project button 

Then, select the source project (see Figure 97) and its models will be displayed in the window. As said 
before, only the models related to the active Baseline Config and active Assets Package of the source 
Assurance Project will be shown.  
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Figure 97. Cross Project: Source project selection  

By default, the “Copy Baseline models” option is selected (see Figure 98), this means that all the modes of 
the source assurance project will be copied to the target project. In this way we ensure that the integrity 
between the copied models remains (an element of a model of one type can refer to an element of a model 
of another type). 

It is also possible just to copy evidences from the source to the target project. For this, uncheck the “Copy 
Baseline models” control and select the desired models to copy from the evidence model list. The evidence 
model is not related to the other kind of models, therefore not integrity problems will arise after the copy 
(see Figure 99). 
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Figure 98. Cross Project: Copy all models  

 

Figure 99. Cross Project: Copy only evidences 
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To start the copy process, click over the “Reuse” button. In case of copying all the models, the information 
message in Figure 100 will be displayed to clarify that the active Assets Package and Baseline Configuration 
of the target process will be changed. In case of reusing evidences, this message will not be displayed. 

 

Figure 100. Cross Project information message 

When the copy process ends, a message window will be shown. 

In the next screenshot (Figure 101) we can see, boxed in red, the new models that have been copied and 
the new information added to the target Assurance Project model.  

 

Figure 101. Cross Project reuse result 

6.6.1 Cross Project Reuse view 

It is also possible to reuse models from one source Assurance Project to a target Assurance Project by using 
a specific view called “Reuse”. This view is particularly useful to reuse a subset of model elements, which 
can be selected manually by the user. The Reuse View also allows users to filter specific subset of an 
evidences model elements by different criteria instead of selecting them manually. 

To open the Reuse view, select the menu entry “Windows → Show View → Reuse”. This view is also 
integrated in the set of OpenCert views and will be opened when the OpenCert perspective is activated 
(see Figure 102). 
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Figure 102. Cross Project “Reuse” view 

The procedure to perform Cross Project reuse with the “Reuse” view is as follows (see Figure 103): 

1. Select the Target (Assurance) Project and the Source (Assurance) Project from the respective drop-
down lists at the top of the Reuse View. 

2. Once the Source Project is selected, a set of associated models are shown in the four lists below. 
Select the models to be reused by using the check option. The lists include the following four types 
of models: 

a. Baseline models (name extension .baseline) 

b. Evidence models (name extension .evidence) 

c. Argumentation models (name extension .args) 

d. Process models (name extension .process) 

The list of models corresponds only to the active models (Baseline Configuration and Assets 
Package elements from the Source Project with the active option checked). 

3. Double click over any model to open its corresponding editor (see Figure 103). 

4. Open the “Tree with Check Boxes” tab of the opened model to select the model elements that will 
be reused. 

Important note: Since there is a bug in the application, and while the issue has been solved, it is 
necessary to close and re-open the “Reuse” View to see this tab. 

5. Finally press the “Reuse” button to start the copy of data from the source project to the target 
project. 
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Figure 103. Using the “Reuse” view 

The Reuse View allows users to search a specific subset of Evidence Model elements through a context 
menu (see Figure 104) using two reuse discovery approaches. The first one is related to OSLC-KM module 
and the second one related to Elastic Search. 

 

Figure 104. Context menu to choose a search technology 

The user can search reusable assets in the selected evidence model according to a text and/or a selected 
critically level and an input text (the applicability level is not used). The Elastic Search Engine will only use 
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the input text as search criteria and the OSLC-KM will use the input text and the selected criticality levels 
specified by the standard to which the source project is compliant with.  

If the option “Modify selection according to results” is activated, the elements to reuse will be selected 
automatically according to the results of the search, modifying the previous subset of selected model 
elements (see Figure 105). 

 

Figure 105. Window to introduce the search parameters 

Before searching in an Evidence Model using Elastic Search, it is mandatory to index its contents (see Figure 
106).  Before indexing, it’s necessary to configure the Indexing Preferences as shown in the Figure 107 (Port 
9200 must be open). 
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Figure 106. Menu for Elastic Search indexing  

 

Figure 107. Preferences for Elastic Search indexing 
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Also, before using the OSLC-KM approach, it is mandatory to index its contents. For this purpose, an option 
to index a project of the CDO Repository is available at the top menu (see Figure 108). 

 

Figure 108. Menu for OSLC-KM indexing 

Click the menu entry “OSLC-KM → Index CDO Project” and select the project to index (see Figure 109). 

 

Figure 109. Selecting a CDO project to index 

If the process has no errors, a confirmation message will show up (see Figure 110). 

Note: This functionality requires Internet access and no firewall restrictions for the outgoing traffic 
through the Port 9999. So, if the process reports a failure, please ensure that there are no firewall 
restrictions that may block this procedure.  
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Figure 110. Confirmation message after indexing the CDO project 

The results are shown with a colour code (see Figure 111): 

• In green. The previously selected asset, either by the user or by a previous search, is a good 
candidate for reusing according the introduced searching criteria.  

• In red. The previously selected asset, either by the user asset or by a previous search, does not 
comply with the introduced searching criteria and therefore should be unselected to avoid its 
reuse. 

• In yellow. The previously not selected asset, by the user asset or by a previous search, is a good 
candidate for reusing and therefore should be selected to be reused. 

   

Figure 111. Results of a search (the figure at the right with the Automatic selection option active) 

6.7 EPF to OpenCert Transformation 

As described in Section 4, EPF-C can be used for modelling the definition and planning of processes. 
OpenCert also allows users to model processes (see Sections 10 and 10.9) but looking at post-planning 
phases. We can get benefit of the EPF process information to create a first view (which can evolve during 
an Assurance Project) of process models in OpenCert by transforming EPF information into OpenCert. 
Specifically, the transformation process takes a delivery process modelled in EPF-C and generates an 
evidence model and a process model in OpenCert. Models of the EPF Composer are described according to 
the UMA metamodel [11], while process and evidence metamodels are part of CACM. The main mappings 
between these metamodels are described in Table 1 and Table 2. 

A Delivery Process in EPF-C is contained in the metamodel class ProcessComponent which provides 
additional information to the process description like its version, authors or team profiles required for the 
execution of the process. The generated ProcessModel only contains information described in the context 
of the ProcessComponent. The user does not explicitly require creating a ProcessComponent in the EPF 
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Composer; they are automatically created each time a delivery process or capability pattern is created. 
Moreover, they are invisible in the tool. 

Table 1. Main mappings between UMA and CACM Process 

UMA CACM Process 

ProcessComponent ProcessModel 

TaskDescriptor Activity 

Activity Activity 

CapabilityPattern Activity 

RoleDescriptor Person 

Guideline Technique 

Practice Technique 

ToolMentor Tool 

RoleSet Organization 

TeamProfile Organization 

WorkProductDescriptor Artefact 

CACM and UMA distinguish between Artifact definition and Artifact usage by means of the use of 
corresponding metaclasses (Artefact and ArtefactDefinition in CACM, and Artifact and 
WorkProductDescriptor in UMA). However, the semantic of these concepts is slightly different in both 
metamodels. In the case of CACM, ArtefactDefinition is a template of a work product involved in an activity, 
and Artefact represents one specific work product involved in the activity that uses that template. On the 
other hand, in UMA, Artifact is an element that belongs to the Method Content package (i.e. the library of 
reusable process elements) and WorkProductDescriptor is an instantiation of an artifact in the context of 
an activity. In order to match these concepts, we focus the transformation in WorkProductDescriptor (see 
Table 2). So, from a WorkProductDescriptor it is generated an ArtefactDefinition and an initial version of 
Artefact. 

Table 2. Main mappings between UMA and CACM Evidence 

UMA CACM Evidence 

ProcessComponent ArtefactModel 

WorkProductDescriptor ArtefactDefinition 

WorkProductDescriptor Artefact 

6.7.1 EPF Process to OpenCert Process 

Transformation of EPF Process to OpenCert Process is performed from ProcessComponent (Delivery 
Process) from the EPF Composer. To generate the Process Model and Evidence Model, the following steps 
must be performed: 
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Figure 112. Initiating process generator plugin 

1. Invoke the Process and Evidence Models Generator plugin by clicking on the (modelled) Delivery 
Process, in particular, by selecting “Transformation → Generate Process and Evidence Models” 
option, as shown in Figure 112.  

2. Select the previously created Assurance Project folder from the CDO Repository and press the “OK” 
button, shown in Figure 113. Please note that the CDO Repository should have already been 
configured (see Section 2.2). 

 

Figure 113. Selecting assurance project 
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3. A dialog is displayed to inform that the transformation process has finished successfully, listing the 
locations where the generated models have been stored (see Figure 114). 

 

Figure 114. Transformation successfully completed 

4. The generated models are stored in the corresponding destination Assurance Project in the CDO 
Repository under “PROCESSES” and “EVIDENCE” folder (see Figure 115). 

 

Figure 115. Generated Process Model 

6.8 Creation of a Mapping Model 

The management of Mapping must be done through the creation of a new model of type “Mapping 
Model”. 

In order to generate a new Mapping Model, the following steps need to be done: 

• Select the menu entry “File → New → Other” (see Figure 116). 
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Figure 116. New Property Model Menu File → New → Other 

• In the Wizard dialog, open the OpenCert category, select “Mapping Model” and click the “Next >” 
button (see Figure 117): 

 

Figure 117. New Mapping Model (I) 

• Enter o select the parent folder, the resource name and click the “Finish” button (see Figure 118). 
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Figure 118. New Mapping Model (II) 

Once the Mapping Model has been created, the first item is presented to the user (see Figure 119). 

 

Figure 119. Mapping Model 
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6.9 Map Group Edition 

6.9.1 Add a Map Group 

It is possible to add Map groups to a Mapping Model in two ways: 

• Select the model element, press the right button of the mouse and select the contextual menu 
“New Child –> Map Group” (see Figure 120). 

 

Figure 120. Add a new Map Group (I) 

• Or, select the model element, and press the icon button  in the “Base” tab (see Figure 121). 

 

Figure 121. Add New Map Group (II) 

After these actions, in the Properties zone, the framework presents several fields to describe the new map 
group (see Figure 122): 

• Id: Map group identifier 

• Name: Map group name 

• Description: Map group description 
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Figure 122. Map Group properties 

6.9.2 Delete a Map Group 

To delete a map group: 

• Select the Map Group, press the right mouse button and select the contextual menu “Delete” (see 
Figure 123). 

 

Figure 123. Delete Map Group (I) 

• Or select the branch Model that contains the Map Group to delete, select the Map Group and click 

the icon button  (see Figure 124). 
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Figure 124. Delete Map Group (II) 

6.10 Map Edition 

6.10.1 Add a Map 

It is possible to add maps to a Mapping model in two ways: 

• Select the model element, press the right button of the mouse and select the contextual menu 
“New Child –> Map” (see Figure 125). 

 

Figure 125. Add New Map (I) 

• Or, select the model element, and click the icon button  in the “Base” tab associated to the 
label Map Model (see Figure 126). 
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Figure 126. Add New Map (II) 

After these actions, in the Properties zone, the framework presents several fields to describe the new map 
(see Figure 127): 

• Id: Map identifier. 

• Name: Map name. 

• Map Group: Map Groups associated to the map.  

• Type: Map type: full, partial o not map. 

 

Figure 127. Map properties 

6.10.2 Delete a Map 

To delete a map: 

• Select the map, press the right mouse button and select the contextual menu “Delete” (see Figure 
128). 
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Figure 128. Delete Map (I) 

• Or select the branch Model that contains the Map to delete, select the Map and press the icon 

button  associated to the label “Map Model” (see Figure 129). 

 

Figure 129. Delete Map (II) 

6.11 Import Models into Assurance Projects 

It is possible to import models from different assurance assets stored locally into an existing Assurance 
Project. To achieve that, open the .assuranceproject model in the models edition area within the Properties 
view and locate the “Import from file” button (see Figure 130).  
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Figure 130. Assurance Project editor with the “Import from file” button 

After clicking the “Import from File” button, a new window will appear (Figure 131). Select the type of 
model to be imported (Argumentation Model, Evidence Model or Process Model) and the source, i.e. 
where the file is located in the computer. By default, the imported model will have the same name as the 
file unless the user decides to change it in the “Destination model” text field.  

 

Figure 131. Import from File window 
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The models will be imported in the actual Assurance Project in the respective folders, i.e. the 
Argumentation Model in the ARGUMENTATION folder, the Evidence Model in the EVIDENCE folder and the 
Process Model in the PROCESS folder.  

Note: the diagram part associated with the model will not be imported, just the model. It can be 
visualized in the respective tree view editors. 

6.12 Transformation of the Requirements of a Standard from EPF 
Composer to Baseline Model OpenCert 

Standards provide the guidance, in the form of processes to be followed during the development of safety-
critical systems. EPF Composer is used for the modelling of the requirements of a standard (see Figure 132), 
planning of processes (see Section 4) and basic compliance via a mapping (see Figure 133). Detailed 
information for requirements modelling and compliance mapping is described in Appendix A. Standard 
Modelling and compliance in EPF. 

 

Figure 132. Modelling Requirements 

OpenCert allows the users to model baselines. Instead of creating the baseline model in OpenCert from 
stretch, a first view of the model can be achieved by transforming requirements modelled in EPF Composer 
into OpenCert. The requirements transformation takes the requirements modelled in EPF Composer as 
“Practices” under the Content Package (see Figure 132) and generates the baseline model. The main 
mapping rules for baseline generation are as follows:  

• Content Package of EPF Composer is mapped into Base Framework 

• Requirements (modelled as practices) are mapped into Base Activity  

• Requirements (modelled as sub-practices) are mapped into Sub Activity  

• Requirements (modelled as sub-sub-practices) are mapped into Requirements  

• Id, name and description of requirements are mapped into Id, name and description. 

However, we are working on the transformation from mapping requirements (i.e., compliance information) 
to the other elements of the Baseline Model. In that case, if the compliance management has been 
performed in EPF Composer, no compliance mapping will be required to be done in OpenCert, hence saving 
time and effort. 
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Figure 133. Mapping Requirements 

To generate the Baseline Model, the following steps need to be performed: 

1. Invoke the Baseline Generator plugin by clicking on the Content Package, in particular, by selecting 
the “Transformation → Generate Baseline Model” option, as shown in Figure 134. 

 

Figure 134. Transformation of Requirements into Baseline Model 

2. Select the target Assurance Project from the CDO Repository using the “Browse” functionality (see 
Figure 135). Please note that the CDO Repository should have already been configured (see Section 
2.2) and the Repository Explorer must be opened. 

 

Figure 135. Browsing Target Assurance Project in CDO repository  
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3. A dialogue is displayed to inform that the transformation process has finished successfully (see 
Figure 136). Press the “OK” button to finish the generation process. 

 

Figure 136. Transformation Completed 

4. Figure 137 and  Figure 138 show the generated Baseline Model and Diagram respectively.  

 

Figure 137. Generated Baseline Model 
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Figure 138. Generated Baseline Diagram 
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7. System Component Specification 

This section documents the usage of the Papyrus and CHESS support to allow the modelling of the system 
architecture, with focus on contract-based design, and the modelling of the links between the architecture 
and assurance related information, allowing to put the basis for the AMASS approach for architecture-
driven assurance. 

7.1 Create a CHESS Project, Model and Diagrams 

A CHESS project (i.e. the folder where the model and other artefact are stored) and a model can be created 
by using the CHESS dedicated Eclipse wizard (“File → New → Others → CHESS…”).  

Please note that currently CHESS projects/models cannot be created in a CDO checkout but only as 
folder/file in the current workspace. 

A CHESS project is basically a Papyrus project customized with the CHESS nature. 

It is possible to change the style of the CHESS diagrams going to the main menu “Window → Preferences -> 
Papyrus → CSS Theme”, and then selecting the current theme. It is recommended to use the “CHESS 
theme”. 

A CHESS model is a Papyrus UML+SysML+MARTE model coming with a predefined set of packages/views 
and with the CHESS profile automatically applied on it, to allow modelling of contracts, dependability and 
real-time concerns.  

A CHESS profile and tool can also be used to exploit different analysis at system level, and to apply the 
CHESS model driven methodology for the design, analysis and implementation of critical SW systems. The 
application of the CHESS methodology for SW development is not mandatory in the context of the AMASS 
solution; more information about the CHESS methodology can be found at the CHESS web site6. 

The CHESS editor is actually a customization of the Papyrus editor, offering a set of features on top of the 
CHESS model. To have an overall understanding of the Papyrus environment, so for instance regarding the 
different views, commands, diagrams, please check the Papyrus user manual available online7. 

Below are some examples of SysML Block Definition Diagram (BDD in Figure 139) and Internal Block 
Diagram (IBD in Figure 140) which can be used to model the system hierarchical architecture, i.e. blocks, 
ports and connections. Appendix C. CHESS Supported Basic Types itemizes the supported basic types.  

                                                             
6 https://www.polarsys.org/chess/  
7 https://wiki.eclipse.org/Papyrus_User_Guide 

https://www.polarsys.org/chess/
https://wiki.eclipse.org/Papyrus_User_Guide
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Figure 139. Block Definition Diagram example 

 

Figure 140. Internal Block Diagram example 

CHESS also supports architectural patterns for system architecture definition; see Section 7.11 for more 
information about architectural patterns definition and instantiation. 

7.1.1 Import CHESS project from a Git repository 

To import an existing CHESS project from a Git repository: 

• Select the “Git Perspective” 

• In the Git Repositories View, chick on “Add an existing Git repository” 
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• Select the imported repository, right click and “import projects”. 

Note: Be sure to have installed eGit8. 

7.2 Create Requirements 

System requirements can be created by using the SysML Requirement diagram. On the “Model Explorer” 
view, right click on “CHESS RequirementView package” and create a SysML Requirement diagram. Use the 
palette to create Requirement entities. 

Papyrus also supports the import of requirements from different sources, e.g. Excel files or ReqIF model; 
more about this support can be found at [15]. 

7.3 Create a FunctionBehavior 

FunctionBehavior represents an uninterpreted function that can be used in formal properties, contracts, 
and state machines. To create a FunctionBehavior element: 

• In the Model Explorer View, select the owner of the FunctionBehavior. 

• Right click “New Child → Function Behavior → as OwnedBehavior” 

• Select the created element and in the Property View - “UML” tab, set the name of the 
FunctionBehavior. 

• In the “UML” tab, go to the owned parameters area and click on add elements to create the 
input/output parameters of the function (see Figure 141). 

 

Figure 141. “UML” tab of the selected FunctionBehavior element. 

                                                             
8 http://download.eclipse.org/egit/updates  

http://download.eclipse.org/egit/updates
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7.4 Create Formal Properties 

Formal properties (i.e. the entities which play the role of Assumption and Guarantee in a Contract) can be 
created manually by using the dedicated tool in the “Contracts” palette.  

It is also possible to package a FormalProperty in a Contract by creating the former directly in the latter. 

To create a FormalProperty in a Block Definition Diagram (BDD)/Component diagram: 

• Select FormalProperty from the Contract palette and click on the BDD 

o Give a proper name to the FormalProperty 

To create a FormalProperty associated to a specific component (i.e. the owner of the FormalProperty), in a 
Block Definition Diagram (BDD)/Component diagram: 

• Select FormalProperty from the Contract palette and click on the specific component in the BDD 
o Give a proper name to the FormalProperty 

To create a FormalProperty packaged in a Contract: 

• Select FormalProperty from the Contract palette and click on the Contract 

o Give a proper name to the FormalProperty 

To specify a concern to the FormalProperty: 

• Select the FormalProperty from the Model Explorer View or its graphical representation 

• Select the FormalProperty stereotype in the Property View – “Profile” tab 

• Set to the “concern” attribute one of the available values (Security, Safety, Performance, 
undefined). 

If the FormalProperty is not used to define contracts, but to describe for example a possible scenario, it can 
refer to ports and parameters of sub-components of sub-components (e.g. the FormalProperty can refer to 
the port “subcomp.block.subBlock.port”). To enable this aspect, select the FormalProperty, then in the 
Property View – Advanced – Visibility -  select “Private”. 

7.5 Edit a Formal Property 

To edit a FormalProperty: 

• Select the FormalProperty from the Project Explorer View or select its graphical element from the 
BDD. 

• Open the tab “PropertyEditor+” in the Property View and write the formal property in OCRA 
Language (Appendix B. OCRA Language to define Formal Properties and Contracts). Pressing CRTL + 
SPACE it is possible to have a list of supported keywords of the OCRA Language to define the formal 
property. If the owner component is set correctly, the content assist can suggest also the 
input/output ports and the attributes of the owner component to type. Moreover, it notifies 
whether a typed word does not belong to a keyword/port/attribute, see Figure 142. 
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Figure 142. Property Editor with content assist 

To associate an expression to the FormalPropertyas shown in Figure 143: 

• Select the FormalProperty. 

• In the “UML” tab of the Properties view, edit the current value of the “Specification” field and 
provide the expression in the “Value” field. 

 

Figure 143. Creating a Formal Property 

Use the formalize property of the FormalProperty stereotype, available in the “Profile” tab of the Property 
View, to link the requirements formalized by the current FormalProperty (see Figure 144). 
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Figure 144. Formalizing Requirements 

7.6 Create a Contract 

Contracts can be created in a BDD and in a Class/Component Diagram. 

To create a Contract: 

• Open a BDD/Class diagram. 

• Select “Contract” from the Contracts palette and click on the diagram. 
o A popup appears to choose if a new contract must be created or if an existing one must be 

instantiated (see Figure 145). 

o Give a proper name to the Contract. 

 

Figure 145. Popup to create a new contract or instantiate an existing one 

Alternatively, it is possible to create a Contract without the need to create its graphical representation from 

a BDD: 
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• Select the component to assign the contract. The element can be selected in the Model Explorer 
View or in the graphical editor. 

• Open the “ContractEditor+” tab in the Property View, type the name of the contract in the “new 
contract's name” text field and click the “Add Contract” button (see Figure 146). A popup appears 
to choose if a new contract must be created or if an existing one must be instantiated. 

 

Figure 146. The Add Contract button in the ContractEditor 

7.7 Specify Assumption and Guarantee for a Contract 

To specify an Assume (or Guarantee) FormalProperty for a given Contract: 

• Select the Contract, open the “Profile” tab in the Properties View and set the Assume (or 
Guarantee) attribute of the Contract stereotype to the (previously created) FormalProperty. 

The Assumption and the Guarantee properties for a given Contract can also be specified through the 
dedicated “ContractEditor+” tab in the property editor (see Figure 147). To be able to use the 
“ContractEditor+” tab: 

• Select the Contract to edit, or 

• Select the Block/Component and then select the ContractProperty (see below) from the 
ContractList in the “ContractEditor+” tab. 

 

Figure 147. Editing the Contract’s Assume and Guarantee 

7.8 Parameterized Architectures 

7.8.1 Set the multiplicity of the elements 

It is possible to set the multiplicity of FlowPorts and sub-components to express a list of elements with the 
same type.  

To set the multiplicity of the selected element: 

• In the Property View – “UML” tab, in the multiplicity area, click on “Switch editors”, see Figure 148. 
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• In the LowerValue Specification and in the UpperValue Specification, click on “Create new object” – 
“LiteralString”, see Figure 149. 

• In the “Value” text area, write the expression that expresses the number of elements (e.g. “5” or 
“numSubComp + 4” where numSubComp is a declared flowport). 

 

Figure 148. Switch editors to set the multiplicity 

 

Figure 149. Select LiteralString for both LowerValue and UpperValue Specification 

7.8.2 Modeling parameterized architecture 

To parameterize an existing architecture, perform the following steps: 

• Create the parameter: In the Model Explorer View or in the BDD Editor, create a static FlowPort. 
The static attribute can be set to “true” in the “SysML” tab of the Properties view. 

• Give an assignment to the parameter (optional step). In the Model Explorer View or in the IBD 
Editor, select the owner of the parameter, create the “DelegationConstraint” element and set a 
value or an expression to the parameter. 

• Give a constraint to the parameter (optional step). In the Model Explorer View, select the owner of 
the parameter, create the “Constraint” element and write a boolean expression in the OSS 
language. 

7.8.3 Instantiating the parameterized architecture 

Note: for this functionality OCRA must be available, go to Section 7.17 to setup OCRA.  

To instantiate a parameterized architecture, perform the following steps: 

• Select the root component of the parameterized architecture: Select the root component (in the 
“Model Explorer” view) or the corresponding graphical representation (in the diagram editor) and 
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open the menu using the right-button of the mouse. Select “Instantiate the parameterized 
architecture”, then a wizard appears.  

• Select the parameters used in existing instantiated architecture (optional step).  

• Assign a value to each parameter, see Figure 150. This step may require more iteration; a 
parameter may depend on another parameter, so the latter needs to be set first.  

• Import the instantiated architecture into the project, see Figure 151. Select the destination package 
on the right side of the wizard page. 

 

Figure 150. Wizard to set the parameters of the parameterized architecture 

 

Figure 151. Last page of the wizard to import the instantiated architecture into the current project 

7.9  Perform Trade-off Analysis 

After having instantiated some architectures as explained in Section 7.8, it will be possible to compute the 
Trade-off Analysis on the instantiated configurations.  

This analysis allows to execute a certain check on all the selected configurations and get the results in a 
view that simplifies the comparison between them. 

To run the Trade-off Analysis perform the following steps: 

• Select the root component of the parameterized architecture (in the Model Explorer View) or the 
corresponding graphical representation (in the diagram editor). 

• Right click and go to “CHESS → Trade-off Analysis” (see Figure 152). 
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• A popup will appear, allowing to select the check to run on the selected configurations (see Figure 
153). At least two configurations should be selected. At the moment, only the Check Contract 
Refinement check can be applied to the configurations. 

• A popup will appear, allowing to select the time model of the architecture. 

 

Figure 152. Trade-off Analysis command 

 

Figure 153. Parameters of the Trade-off Analysis 

The results of the analysis will be displayed in a special view called “Trade-off”, as seen in Figure 154. 

The type of executed check is displayed in the upper-left cell of the table. On the other columns the 
contracts found in the analysed configurations are reported.  

The first row of the table reports the concerns specified on the assumption/guarantee formal properties of 
each contract. In case of different concerns, they will be both reported. 

Each following row of the table reports the results of the check on that specific configuration, making it 
easy to visually compare them. To get a detailed report of the check, double-click on a line and the view will 
be switched to the Contract Refinement trace for that configuration. 
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Figure 154. Trade-off Analysis results 

7.10 Associate a Contract to a Block/Component 

To associate a Contract to a Block/Component the following actions need to be performed: 

• Create a ContractProperty inside the Block/Component (see Figure 155). The ContractProperty acts 
as a special attribute of the Block/Property. 

• Type the just created ContractProperty with the Contract by using the “UML” tab in the Properties 
View. 

 

Figure 155. ContractProperty 

The ContractProperty stereotype comes with the attribute “ContractType” which can be used to set the 
Strong or Weak property of the Contract associated to the architectural entity (Sljivo, Gallina, Carlson, & 
Hansson, November 4-7, 2013)9. 

                                                             
9 While the strong assumptions and guarantees must be satisfied always in order for component to be used, the weak 
pairs offer additional information in some specific contexts where besides the strong assumptions, the weak 
assumptions are to be met as well. 
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7.10.1  Selection of weak contract for Block/Component instances 

While a Strong contract associated to a Block/Component (must) hold for all the instances of the 
Block/Component, a Weak contract associated to a Block/Component can hold for a given instance of the 
Block/Component if the environment where the instance is placed met the assumption. So, for a given 
instance it must be possible to specify the set of weak contracts specified for the typing Block/Component 
(if any) which holds for the instance. To do so, the following steps must be performed: 

• Select the Block/Component instance in the SysML Internal Block Diagram / UML Composite 
Structure Diagram. 

• Apply the ComponentInstance stereotype to the instance. 

• Select the “Contract” tab in the Properties editor (see Figure 156): The “Contract” tab shows the 
strong and weak contract inherited by the classifier typing the instance. In particular the Weak 
Contract area can be used to check the weak contracts that hold for the current instance. 

 

Figure 156. “Contract” tab for instances 

The information about the weak contracts which hold for the given instance is automatically set in the 
“WeakGuarantees” attribute of the “ComponentInstance” stereotype. 

7.10.2  Contract Refinement 

Once a model component that has a contract has been decomposed, it is possible to define the contract’s 
refinement. The refinement of a contract can be specified following these steps (see Figure 157): 

• Select a ContractProperty of a Block 

• Right click and select “Contract → Set Contract Refinement”. 
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Figure 157. Set Contract Refinement Command 

• In the new dialog window select the Contract Properties from the list (see Figure 158). In case 
the multiplicity of the Aggregation is defined, the “Range” field allows to specify which 
subcomponents refine the contract. This dialog window shows the Contract Properties in the 
format: InstanceName.ContractProperty. This allows the selection of instance-based Contract 
Properties (instead of type-based). 

 

Figure 158. Refinement Selection 

Be sure that the Aggregation kind of the instances is set to composite as shown in the bottom-
right part in the Figure 159. This is required to let “Set Contract Refinement” command to 
work properly. 
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Figure 159. Composite Aggregation 

• The information about the refinement is set in the “RefinedBy” attribute of the “ContractProperty” 
stereotype of a Block and available in the “Profile” tab of the Property view (see Figure 160): 

 

Figure 160. Contract Refinement 
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7.11 Architectural Patterns 

The CHESS tool includes a library of design patterns to be instantiated in a given CHESS model. It is also 
possible to create new patterns and so different libraries. 

7.11.1 Instantiate an architectural pattern into the system architecture 

A given pattern, defined in the CHESS library or defined in a given Papyrus project available in the current 
workspace, can be instantiated into a given system architecture definition. A pattern represents “virtual” 
components instances connected and collaborating in a given way; the goal of the pattern application 
process is to finally identify the actual components instances that will play the roles of the virtual 
component instances defined by the pattern. For this reason, a given pattern in CHESS is applicable in the 
context of a composite Block, where owned component instances are available, or can be created. 

Note: in order to use the patterns instantiation feature, the CHESS constraint “Cannot apply further 
profiles in the model” has to be disabled; for the current AMASS platform, this can be done by using the 
CHESS preferences page available from the main Eclipse menu “Window → Preferences”. 

In concrete, an architectural pattern can be instantiated in a given CHESS model by applying the following 
steps: 

1. Open the CHESS model where the pattern must be applied. 

2. Open the ModelExplorer view, right click the CHESS root model entity and select: 

2.1. Import Registered Package to load the CHESS library, or 
2.2. Import Package from User Model to load the available Papyrus project 

3. In the ModelExplorer select a system component where the component instances playing the 
pattern roles will be identified/created; right click and select “CHESS → DesignPatterns → Select 
and Apply a Design Pattern”. A dedicated wizard is shown (see Figure 161 and Figure 162). 

4. Select the pattern to instantiate from the Available Patterns lists (this list is initialized with the 
patterns library/projects that have been imported in step 2) and click “Apply”. 

5. Bind the information available in the pattern into the current system model. 

Figure 161 shows the role binding dialog available for the Triple Modular Redundancy pattern. The 
upper part shows the roles defined by the pattern, while the lower part shows the available 
candidates for binding in the system under design. Candidate matching simply relies on the meta-
model kind, i.e. components match components, components parts to components parts, ports to 
ports, connections to connections; dedicated binding dialogs are available for each kind of meta-
model entity by using the "Next" button of the main dialog window. In order to declare a binding, 
select a pair in the upper and the lower part of the dialog, respectively and then click on the 
"Create mapping" button.  

Note: A design pattern describes a set of roles that elements play in a pattern. In many cases, 
elements that play a certain role do already exist in the application model. Therefore, it is 
important to identify these and declare a binding to a role in the pattern (i.e. a role binding). This 
information is used to determine which elements of a pattern need to be copied/created into the 
application and which don't. 

6. Click “Finish”; patterns entities (types, ports, instances, connectors) which have not been manually 
mapped to system entities are automatically created in the model, and dependencies between 
system model entities and pattern ones are created and stored in the CHESS system model under a 
dedicated PatternApplication entity (see Figure 163). Component instances playing a part in the 
pattern are tagged as <<PatternRole>> which stores the information of the applied pattern. 
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Figure 161. Design Pattern selection 
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Figure 162. Design Pattern instantiation wizard 
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Figure 163. Pattern Application 

7.11.2 Define a new architectural pattern 

Patterns are stored in Papyrus projects; it is recommended to use dedicated Papyrus projects for patterns 
definition, so to keep system components and patterns models separated and be able to share the latters 
without the need to share the formers. It is possible to use the same Papyrus project to define and store 
different patterns or split the patterns in different Papyrus projects. 

To create a new pattern, create or open a Papyrus model; in case of a new model, apply the registered 
profile “CHESS Design Pattern” to the model itself (select the CHESS model in the Model Explorer Papyrus 
view, open the “Profile” tab in the Properties view and select the “Apply Registered Profile” command). 

The structure of a pattern is shown in the Figure 164 taken from the Papyrus Model Explorer View; the 
Triple Modular Redundancy pattern coming with the CHESS library is taken as example (see Figure 165).  

 

Figure 164. Pattern structure 
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Figure 165. Pattern Structure, Composite Structure Diagram 

The pattern itself is UML Collaboration stereotyped as Pattern (from the PatternsProfile profile coming with 
CHESS). A role is a UML Property defined as CollaborationRole.  

To create a new pattern: 

1. (optional but recommended) Create a new UML Package (from the ModelExplorer) to contain all 
the elements of the new profile. 

2. (optional) Create a Class Diagram (from the ModelExplorer). 

3. Create (from the ModelExplorer or from the Class Diagram Palette) UML Class elements to be used 
as type for the roles of the pattern (see Channel and Voter Blocks for the TMR example) 

4. Create a UML Collaboration (from the ModelExplorer) and stereotype it as <<Pattern>>.  

5. Set the values of the stereotype properties (from the “Profile” tab of the Eclipse Properties View). 
Indeed, Pattern stereotype comes with a list of attributes through which it is possible to declare the 
functional and extra functional (safety, security, performance) properties that can defined for the 
current pattern and reused across pattern instantiation; for instance, when the pattern is 
instantiated in a given system architecture, it is possible to reuse the aforementioned properties to 
support specific claim about system properties. 

6. Create (from the ModelExplorer) a Composite Structure Diagram (CSD) for the UML Collaboration. 

7. Create Property elements inside the CSD (from the CSD Palette/Model Explorer) and set their type 
to the appropriate UML Class created at 2. 

8. Set each Property element as CollaborationRole (from the CSD Palette). 

9. Add Ports and Connectors to the CSD elements (from the CSD Palette/Model Explorer). 

7.12 Specify Component Behaviour (nominal and faulty) 

Nominal behaviour of a component can be provided by using UML State Machine diagrams. Please contact 
Intecs if you want to know about the kind of information that can be provided for the nominal behaviour to 
enable integration with xSAP verification tool for automatic fault tree generation. 

Local attributes to use only in UML state machine diagrams are created as follows: 

1. In the Model Explorer View, select the owner component of the local attribute. 

2. Right click “New Child → Property”. 
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3. Select the Property (that represents the local attribute) and in the Property View – “UML” tab set 
the name and the Type of the element.   

Faulty behaviour for a component can be provided by using the CHESS dependability profile. 

Several possibilities exist in CHESS to model the faulty behaviour of a component. 

For instance, faulty behaviour can be modelled in a dedicated state machine stereotyped with ErrorModel; 
the ErrorModel represents a particular kind of state machine containing information about faults, errors 
and failure modes and their propagation internal to a given component. 

Once defined, the ErrorModel state machine can be attached to a given component by stereotyping the 
component with ErrorModelBehaviour. 

The ErrorModelBehavior stereotype comes with the errorModel attribute, which has to be used to 
reference the actual ErrorModel state machine to be attached to the component (see Figure 166). 

 

Figure 166. ErrorModel behavior 

The following information can be provided through an ErrorModel state machine: 

• Initial state 

o It represents the “healthy” state of the component 

• Errors 

o UML State, with the «ErrorState» stereotype 

• Internal faults 

o UML Transitions, with the «InternalFault» stereotype 

▪ connecting the initial state and an error state 

▪ occurrence – time to fault occurrence (time distribution) 

• Internal propagations 

o UML Transitions, with the «InternalPropagation» stereotype 

▪ delay – time after which propagation occur 

▪ weight - relative probability of occurrence 

▪ externalFaults – Boolean expression on the occurrence of external faults (i.e., failures 
incoming on input ports of the component) 

• Failures 

o UML Transition, with the «Failure» stereotype 

▪ mode – the failure mode(s) under which the failure manifest itself on the port(s) of the 
component 

The possible propagation paths between components may be enriched with dependability information.  

Propagation may occur when functional relations exists between two components (so the components are 
connected through their ports via UML Connectors). 
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By default, it is assumed that immediate and deterministic propagation will occur through these paths. 
Different behaviour may be specified using the Propagation stereotype, the latter extending the UML 
Connector with the following attributes (Figure 167): 

• prob – probability that propagation occurs 

• propDelay – delay after which propagation occurs (time distribution) 

 

Figure 167. Propagation path between two components 

7.12.1  Fault injection with probability 

As seen before, the faulty behaviour for a component is provided through a state machine, the latter 
tagged with the «ErrorModel» stereotype defined in the CHESS dependability profile. 

In the error model, the information about the error states can be provided by using the «ErrorState» 
stereotype. Then, for a given error state, the effect upon a property of the component, and so the effect on 
its nominal behaviour, can be also provided by using pre-defined effects: 

• StuckAt: models the effect of being stuck at a fixed value. 

• StuckAtFixed: models the effect of being stuck at a fixed random value. 

• Inverted: models the effect of being stuck at the inverted last value.   

• RampDown: models the effect of decreasing the value of a property by a certain value. 

Configuring the «ErrorState» stereotype it is possible to assign a probability for the fault to happen.  

As an example, the state machine shown in Figure 168 represents an error model. In particular, in case of 
an internal fault, the component enters in an error state where the property “energy” is fixed at 0 value. 
The probability for this fault to happen is set to 0.05. 

 

Figure 168. An ErrorModel state machine with probability 

7.13 Manage Analysis Contexts 

Analysis contexts are used in CHESS to collect information about a given analysis to be run; an analysis 
context is used at least to refer to the set of entities that must be considered for the analysis. If needed, the 
analysis context can be used to provide analysis specific configuration parameters. 

Analysis context can be created in the CHESS Dependability View by using class diagrams. 
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7.14 Perform Fault Tree Analysis 

Once the system architecture has been provided, by mean of components definition and their nominal and 
error models, the Fault Tree Analysis (FTA) can be obtained by invoking the xSAP symbolic model checker 
through the CHESS environment.  

To obtain the fault tree, perform the following steps: 

• Select a package from the Model Explorer View. 

• Right click on the package and go to “CHESS → Architecture Verification → Fault Tree Analysis 
(FTA)” (see Figure 169). 

• A popup will appear. From the list, select the Analysis Context from which the analysis has to be 
started and click “OK”. 

• A popup will appear to select the time model of the architecture. Only discrete is supported at the 
moment. 

 

Figure 169. FTA command 

Once the analysis is executed, the fault tree is automatically shown in a dedicated panel in the frontend; 
see Figure 170 as an example of resulting fault tree. Then the fault tree can be examined, in particular the 
minimal cut-set and so the basic fault conditions which can led to the top-level failure. If probabilities 
where specified for the faults to happen, they will be computed and reported in the resulting tree. 
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Figure 170. Fault Tree Analysis result 

7.15 Perform Failure Mode and Effect Analysis 

Along with the fault tree generation (see Section 7.14), it is possible to generate the Failure Model and 
Effect Analysis (FMEA) table. FMEA is obtained in a similar mode as the fault tree analysis: 

• Select a package from the Model Explorer View. 

• Right click on the package and go to “CHESS → Architecture Verification → Failure Mode and 
Effect Analysis (FMEA)”. 

• A popup will appear. From the list, select the Analysis Context from which the analysis has to be 
started and click OK. 

• A popup will appear to select the time model of the architecture. Only discrete is supported at the 
moment. 

Once run, the resulting table is visualized in a specific view inside CHESS, see Figure 171. 
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Figure 171. The FMEA table 

7.16 View Status of System Architecture 

CHESS provides a hierarchical view that shows the decomposition of the system component into sub-
components. It shows also the contracts assigned for each component. The system is graphically 
represented as the top element of the view, see Figure 172. 

To show the view, go to “Window → Show View → Hierarchical Model View”. 

 

Figure 172. Hierarchical view of the system decomposed into sub-components and contracts 

CHESS also provides a hierarchical view that shows the contracts with their refining contracts. The weak 
contracts are graphically represented as a document with a “W” on top, see Figure 173. 

To show the view, go to “Window → Show View → Contract Refinement View”. 



 

         AMASS AMASS Platform User Manual V1.0 

 

H2020-JTI-ECSEL-2015 # 692474 Page 129 of 295 
 

 

Figure 173. Contract Refinement View 

A report about contracts status with respect to the assurance can be also generated through CHESS; from 
the Model Explorer View coming with Papyrus/CHESS, right click and select “Validation → CHESS → 
Validate Contracts for Assurance”, then issues with the defined contracts are reported in the Model 
Validation view as shown in Figure 174. 

 

Figure 174. Validating contracts status 

7.17 Setup of External V&V Tools 

In the subfolder of the bundle \V&VTools, there are builds of the V&V tools. 

To enable the tools that are available locally: 

• Go to “Window → Preferences → Model Checking → Tools”, see Figure 175. 
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• For each V&V tool (OCRA, nuXmv, XSap) 

o Click on “Browse…” and set the path of the executable 

e.g. CHESS_directory\V&VTools\OCRA\Ocra-win64.exe 

• Click on “Test”, to verify that the tool is compatible with CHESS. 

To get access to V&V Tools that are exposed as web services via OSLC: 

• Click on the check box “OSLC Enabled”. 

• Set the URL of the service catalogue. 

• Set the path of the service catalogue. 

• Click on “Show services catalogue” to verify that the web service exposes the V&V tools. 

 

Figure 175. The preferences window to configure the V&V tools 

7.18 Perform Check of Contract Refinement 

To verify that the contract refinements are done correctly, perform the following steps: 

• Select a component (in the Model Explorer View) or the corresponding graphical representation (in 
the diagram editor). The contract refinements considered will be the ones associated to the 
selected component and the ones associated to its sub components. This operation includes 
recursively all the contracts along the subcomponents, from the root to the leaves of the system. 
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• Perform the check contract refinement: right click on the selected component, then go to “CHESS 
→ Functional Verification → Check Contract Refinement on selected component” (see Figure 
176). 

 

Figure 176. Perform the check of the contract refinements  

7.19 Perform Check of Component Implementation on Contracts 

To verify that the state machines defined in the model satisfy the contracts, perform the following steps: 

• Select a component (in the Model Explorer View) or the corresponding graphical representation (in 
the diagram editor). The contracts and state machines considered will be the ones associated to 
the selected component and the ones associated to its sub components. This operation includes 
recursively all the contracts and state machines along the subcomponents, from the root to the 
leaves of the system. 

• Right click on the selected component, then go to “CHESS → Functional Verifications → Check 
Contract Implementation on selected component” (see Figure 177). 
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Figure 177. Perform the check implementation based on contracts 

To verify that the behaviour of the entire system defined in the model satisfies all the contracts, perform 
the following steps: 

• Select a root component (in the Model Explorer View) or the corresponding graphical 
representation (in the diagram editor). The contracts and state machines considered will be the 
ones associated to the selected component and the ones associated to its sub components. This 
operation includes recursively all the contracts and state machines along the subcomponents, from 
the root to the leaves of the system. 

• Right click on the selected component, then go to “CHESS → Functional Verifications → Check 
Composite Contract Implementation on selected component”. 

7.20 Perform Consistency Check of Assumption/Guarantee Formal 
Properties 

This validation is done by checking if a specific guarantee of the contract satisfies the assumption of 
another contract. To verify the formal property, perform the following steps: 

• Select a component (in the Model Explorer View) or the corresponding graphical representation (in 
the diagram editor). The properties available to check will be the assumptions and guarantees of 
contracts belonging to the selected component and to its sub components. This operation includes 
recursively all the assumptions and guarantee properties from the root to the leaves of the 
selected component. 

• Right click on the selected component, then go to “CHESS → Validation → Check Validation on 
Assumption/Guarantee Properties on selected component” (see Figure 178).  

• A popup appears to set the parameters of the command (see Figure 179, see [12] for more details). 
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Figure 178. Perform the consistency check of assumption/guarantee formal properties 

 

Figure 179. Validation Property parameters 

7.21 Perform Consistency Check of Formal Properties 

In Section 7.20 it is described how to check assumptions and guarantees formal properties. Similarly, a 
validation can be done to all the formal properties of a component. To verify the formal property, perform 
the following steps: 

• Select a component (in the Model Explorer View) or the corresponding graphical representation (in 
the diagram editor). The properties available to check will be the formal properties belonging to 
the selected component and to its sub components. This operation includes recursively all the 
properties from the root to the leaves of the selected component. 

• Right click on the selected component, then go to “CHESS → Validation → Check Validation on 
Assumption/Guarantee Properties on selected component” (see Figure 180).  

• A popup appears to set the parameters of the command (see Figure 179, see [12] for more details). 
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Figure 180. Perform the consistency check of formal properties 

7.22 Perform Model Checking on Component Behaviour 

To execute the model checking, perform the following steps: 

• Select a component (in the Model Explorer View) or the corresponding graphical representation (in 
the diagram editor). The components behaviour to check will be the behaviour of the selected 
component and the behaviour of its sub components. This operation includes recursively all the 
behaviours from the root to the leaves of the selected component. 

• Right click on the selected component, then go to “CHESS → Functional Verification → Model 
Checking on selected component” (see Figure 181).  

• A popup appears to set the parameters of the command (see Figure 182, see [13] for more details). 

 

Figure 181. Perform the model checking of system behavior 
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Figure 182. Model Checking parameters 

7.23 V&V Manager 

An alternative approach to the verification activities described in the sections 7.19 7.20 7.21 7.22 is the 
usage of the V&V Manager. Depending on the selected model elements and on their context (e.g. the 
availability of associated models) and on the available Verification Servers and verification tools the V&V 
Manager supports the decision making about which V&V activities shall be performed. 

The user has to select contracts from the model and then V&V Manager sends them to Verification Servers, 
where are V&V tools that return the V&V Results. 

As for the planned GUI the invocation of the V&V Manager is to be performed by the following steps (see 
Figure 183): 

• Select a component (in the Model Explorer View) or the corresponding graphical representation (in 
the diagram editor). The contracts considered will be the ones associated to the selected 
component and the ones associated to its sub-components. This operation includes recursively all 
the contracts along the subcomponents, from the selected element to the leaves of the system. 

• Right click on the selected component, then go to “Validation → V&V Manager”. 

 

Figure 183. Invoke the V&V Manager 
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7.24 Generate Contract-based Fault Tree 

The contract-based safety analysis identifies the component failures as the failure of its implementation in 
satisfying the contract. When the component is composite, its failure can be caused by the failure of one or 
more subcomponents and/or the failure of the environment in satisfying the assumption. 

As result, this analysis produces a fault tree in which each intermediate event represents the failure of a 
component or its environment and is linked to a Boolean combination of other nodes; the top-level event is 
the failure of the system component, while the basic events are the failures of the leaf components and the 
failure of the system environment. 

To execute the contract-based safety analysis, perform the following steps: 

• Select a component (in the Model Explorer View) or the corresponding graphical representation (in 
the diagram editor). The contracts considered will be the ones associated to the selected 
component and the ones associated to its sub components. This operation includes recursively all 
the contracts along the subcomponents, from the root to the leaves of the system. 

• Right click on the selected component, then go to “CHESS → Safety Analysis → Contract-based 
Safety Analysis on selected component” (see Figure 184). 

When the analysis is completed, the fault tree is shown. The representation is the same as the ones used 
for the Model-based Safety Analysis, see Figure 170, but with the probabilities set to 0. 

 

Figure 184. Dedicated menu to perform the compute the contract-based fault tree 

7.25 Import an OCRA File 

CHESS is able to import an architecture described in the OCRA language [12], contained in a .oss file. 
Components will be generated, along with their structural description (ports, contracts, refinements, 
connections, etc.) and imported in the selected package. In Section 7.26 it will be described how to 
automatically generate diagrams for the imported components. 

To import a OCRA file, perform the following steps: 
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• From the Model Explorer View, select the SystemView package or create a sub package below it. 

• Right click on the package, then go to “CHESS → Basic Operations → Import <<SystemView>> 
components from .oss file” (see Figure 185). 

• Select a file with .oss extension and click “OK”. 

 

Figure 185. Import of an OCRA file 

The import feature allows to reimport an OCRA file: if the selected package already contains some 
components, they will be updated to reflect the content of the new OCRA definition. BDD and IBD diagrams 
will be updated accordingly. See Section 7.26.1 to get more details on diagram updates. 

7.26 Automatic generation of Block Definition and Internal Block 
Diagrams  

The canonical way to add elements to a model is by editing diagrams, e.g., creating a Block Definition 
Diagram and adding components and relations graphically through the use of the Palette. But it is also 
possible to edit the model from the Model Explorer View, right clicking and adding children. In the latter 
case, no diagrams are created or updated. In general, changes in the diagrams are reflected in the model, 
but changes in the model are not reflected in the diagrams. 

CHESS offers the possibility to automatically generate BDDs and IBDs starting from the model.  

To create a BDD, perform the following steps: 

• Select a package from the Model Explorer View. The package should be the SystemView package or 
one of its sub packages. 

• Right click on the package and go to “CHESS → Basic Operations → Create the BDD diagram for 
the selected package” (see Figure 186). 

• A new BDD diagram will be created and added to the model. Graphical components will be 
automatically arranged. 

Similarly, right clicking the package, it is possible to create the IBDs for all the components of that package. 
To obtain the diagrams, select “CHESS → Basic Operations → Create the IBD diagrams for all the package 
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components” (raw version). Differently from the BDD creation, no automatic arrange will run on the 
diagrams. See Section 7.26.2 to run the automatic layout on a specific diagram. 

 

Figure 186. Creation of a BDD from the Model Explorer View 

To create a single IBD for a single component, perform the following steps: 

• Select the component from the Model Explorer View or the corresponding graphical representation 
(in the BDD diagram editor). 

• Right click on the component and go to “CHESS → Basic Operations → Create the IBD diagram for 
the selected component” (see Figure 187). 

• A new IBD diagram will be created and added to the component. Graphical elements will be 
automatically arranged. 

 

Figure 187. Creation of a IBD from a BDD diagram 

It should be noted that multiple diagrams could be created for a single component or package. They do not 
substitute the already existing diagrams. 
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7.26.1  Update of diagrams 

As stated before, it could happen that the diagrams and the model are not aligned. As an example, the 
creation of a port in a BDD is reflected in the model inside the Model Explorer View, but the IBD diagram of 
that component will not be affected.  

To improve the usability, CHESS allows to update BDD and IBD diagrams. Perform the following steps: 

• Select the diagram to be updated and click anywhere on the background. Do not select a graphic 
element. 

• Right click and go to “CHESS → Basic Operations → Update the current BDD (or IBD) diagram” (see 
Figure 188). 

 

Figure 188. Update of a BDD diagram 

The diagram will be updated according to the model present in the Model Explorer View. To give emphasis 
on elements that have been added to the diagrams, they will be depicted in particular positions. New 
components will be displayed in the upper-left corner while new ports will be displayed in the lower-left 
corner. The diagram can be later automatically arranged as explained in the next sub section. In Figure 189 
it is possible to see an IBD diagram with two new added elements.  

 

Figure 189. An IBD diagram after the update 
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7.26.2  Auto layout of diagrams 

When the BDD and IBD diagrams are generated, a routine will automatically rearrange the graphic 
elements. If a user does not like the layout, he/she can manually move the elements. 

There are cases where the user may need to force the auto layout to run again, i.e., after the update of the 
diagram. It can be done right clicking on the diagram and selecting “Layout Selection” or clicking on the 
icon in the upper-left corner, as seen in Figure 190. 

 

Figure 190. Auto layout of a diagram 

7.27 Generate Documentation 

CHESS can generate a document summarizing the model architecture and the results of various analyses 
executed on the model. Output format is an HTML document or a LaTeX source code. 

The generated document is composed by two main sections: Components and V&V Results; an example can 
be seen in Figure 191.  

The first section describes the structure of the model: it includes the diagrams that are not associated to a 
specific component, such as the Block Definition Diagram, and a subsection for each of the components. 
Each subsection contains: 

• Name of the component and its type 

• Diagrams (Internal Block Diagrams, nominal and error State Machine Diagrams) 

• Table of input ports with name and type 

• Table of output ports with name and type 

• Table of subcomponents with instance name and type name 

• Table of interface assertions 
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• Table of refinement assertions 

• Table of connectors between ports 

• Table of contracts 

• Table of contract refinements 

• Table of uninterpreted functions 

• Table of parameters 

• Table of parameters assumptions 

 

Figure 191. Part of a generated report 

The second section of the report lists the results of the checks and analyses run on the model. An example 
can be seen in Figure 192. Reported analyses are the ones executed on the totality of the model, i.e., on the 
root component (stereotyped with «System»). To run an analysis that should be reported in the 
documentation, it should be run from a specific menu at package level. Details will be explained later in this 
subsection. 

Reported analyses are the following: 

• Properties Validation 

• Assume/Guarantee Properties Validation 

• Check Contract Refinement 

• Check Contract Composite Implementation 

• Model Checking 

• Fault Tree Analysis 

• Failure Modes and Effects Analysis 
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Figure 192. Analysis results section of the generated report 

To automatically generate the documentation, perform the following steps: 

• Select the root component (in the Model Explorer View) or the corresponding graphical 
representation (in the Diagram editor). It is also possible to select the whole package in the Model 
Explorer View. The information used to generate the documentation will be related to the selected 
component and to its sub components. This operation includes recursively the information from 
the root to the leaves of the selected component. 

• Right click on the selected component, then go to “CHESS → Safety Case → Document Generation 
→ Generate documentation on selected component”. 

• A popup appears to select the folder that will contain the document and the diagrams. 

• A popup appears to set the options related to the format of the document and to the style of the 
diagrams (see Figure 193). 

Analyses that should be reported in the documentation, i.e., executed on the root component, are grouped 
in a specific menu. To execute them, perform the following steps: 

• Select the package containing the architecture from the Model Explorer View. 

• Right click and go to “CHESS ->Architecture Verification”. 

• Select one of the available analyses to be run on the root component of that package. 

It is possible to select any component from the model and generate the report. In this case, no results from 
the root-level analyses will be reported in the documentation as they are valid for the whole model only. 
Analyses executed on subcomponents will not be reported either. 
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Figure 193. Popup to set the preferences of the generated document 

7.28 Managing Links between Architecture and Assurance  

According to the AMASS component meta-model specification (see AMASS D3.3 [2]), Contracts and 
FormalProperty can be linked to Assurance Case entities, in particular to Claim and Artefact, the latter 
created through the Polarys OpenCert Tools Platform (see sections 9 and 10). 

Traceability links between the following entities have been identified as useful: 

• Contract and Assurance Case Package, the latter owning the assurance case entities related to the 
contract. 

• Contract and Assurance Case Agreement, the latter owning the arguments about how the 
assumptions of a contract are fulfilled in the context of the system. 

• Contract and Assurance Case Claim, the latter elaborating on the contract itself, e.g. that the 
contract is derived from some analysis or is based on some specification. 

• System component and Argumentation element, the latter owning all the assurance case fragment 
information related to the associated component. 

• Contract and Evidence, the latter supporting the contract statement, in particular its guarantee, 
e.g. by using some verification/test result. 

• Analysis Context and Evidence, to link the context that has been analysed (e.g. system elements, 
specific analysis parameters values) to the obtained results. 

Some of the aforementioned links are automatically managed in case of argument fragment generation; for 
the parts of the assurance case not currently supported by such automatism, the links have to be manually 
manager, by using a dedicated view in the CHESS editor or by using the generic Capra facilities (see 
following sub-section). 

In addition to the aforementioned links between the architecture and assurance case related elements, 
traceability links should also be provided between the system model and the executed process, the latter 
also modelled in OpenCert e.g. as an Evidence Model listing all the artefacts to be produced according to a 
given standard/process step; these relationships can then be reused to support the demonstration of the 
compliance of the architecture with respect to a given process. The links to the executed process can be 
manually managed by using the Capra facilities described in section 7.28.2. 

Note: The kind of traceability links treated in this section are stored in a local traceability model which is 
automatically created and maintained in the current workspace. 

7.28.1  Manage traceability links with CHESS 

Different kinds of relationships have been identified between CHESS and assurance case/evidence models 
(see D3.3 [2] for more details). 
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In particular, Contract has the following relationships: 

• supportedBy: Artefact [0..*] 

Allows to model that a Contract statement, in particular its guarantees, can be supported by 
artefacts (e.g. the latter referring some verification results). 

• claim: Claim [0..*] 

Allows to further clarify a contract statement; e.g. that the contract is derived from some analysis 
or is based on some specification. 

• agreement: Agreement [0..*] 

The agreement owns the arguments about how the assumption of a contract are fulfilled in the 
context of the given system. 

FormalProperty has following relationships: 

• claim: Claim [0..*] 

Allows to map the guarantees of the contract to claims.      

Allows to associate a claim (e.g. GSN away goal) to each of the contract’s assumptions. 

Component and Block are extended with the following relationship: 

• referenceArgumentation: ArgumentationElement 

The arguments associated to the block instance. 

AnalysisContext is extended with the following relationships: 

• artefact: Artefact [0..*] 

Allows to associate the artefact produced by the analysis that have been invoked through the 
analysis context. 

The aforementioned relationships can be managed by using a dedicated View coming with CHESS, named 
OpenCert, which in turns make uses of the Capra traceability support to store and retrieve the information 
about the traces.  

Assurance case/evidence model entities to be traced have to be selected from a CDO repository which have 
been checked-out in the Eclipse Project Explorer view; to perform this check-out perform the following 
steps: 

1. In the Eclipse CDO Repositories view, connect to the existing remote AMASS repository owning the 
assurance case entities. In the New Repository wizard (see Figure 194) set the proper value for the 
Host and Port attributes, according to the Polarys OpenCert Tools Platform server configuration, 
then click “Finish”. 
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Figure 194. Connecting to the AMASS Repository 

2. Right click on the just created Remote Repository and select “Checkout” (see Figure 195).  

Once the CDO repository has been checked-out and opened, it is possible to navigate it in the 
Project Explorer view, and so to retrieve the model and so the assurance/evidence-related entity to 
trace. 

 

Figure 195. CDO Repositories view 
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Then, to create the link with a CHESS entity: 

1. Select the entity in the CHESS model to be linked. 

2. Open the “OpenCert” tab in the Properties view. This tab shows the relationships that can be 
created. 

3. Pin the Properties view (see Figure 196). 

 

Figure 196. OpenCert tab for the Contract 

4. Drag the assurance related entity (Claim, Artefact, Agreement, ArgumentationElement) from the 
Project Explorer view to property area of the “OpenCert” tab (see Figure 197). 
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Figure 197. Associating a Claim to a Contract 

5. A link is created in the traceability model (managed by Capra). To delete the link, select the entity 
in the “OpenCert” tab and click on the “Delete” button available on the right of the “OpenCert” tab. 

6. Double click the assurance related entity in the “OpenCert” tab to select the corresponding entity 
in the ProjectExplorer. 

Note: the aforementioned support about the creation/navigation/delete of links between 
Contract/FormalProperty and Claim/Artefact (the latter available through CDO) works with CDO or file-
based Papyrus model.  

In case of usage of file-based Papyrus models, if the checkout of the AMASS repository is deleted from the 
workspace and created once again later, it is possible that the links already created between contracts and 
assurance entities cannot be retrieved in the “OpenCert” CHESS tab. In this case the following procedure 
has to be performed on the Papyrus.uml model file: 

1. Make sure you have the Papyrus “Di view” deselected: 

a. From the ProjectExplorer View, click on the top-right arrow, choose “Customize View…” 
command and from the AvailableCustomizations view make sure that the “Di view” is not 
selected.  

2. Select the checkout from the ProjectExplorer view, in the Properties view check the value for the ID 
property. 

3. Make sure the CHESS model is not currently open with the Papyrus graphical editor. From the 
ProjectExplorer view, right click on the .uml model file and select “CHESS → Synchronize with CDO 
checkout”. 
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4. In the SynchronizeWithCDOCheckout window write the ID of the checkout you want to work with 
and press “OK”. 

7.28.2  Manage traceability links with Capra 

Capra traceability tool, together with its AMASS extensions, can be used to manage links (the one 
introduced in the previous section and additional generic links) between system model and assurance 
entities. 

In particular the following steps have to be performed: 

1. Open the “Capra Create Trace Links” tab in the Properties View. 

1.1. If not available, select the aforementioned Capra view from the “Windows → show view → 
Capra” menu entry. 

2. Select the CHESS model entity to trace in a given diagram (for instance a Block in a Block Definition 
Diagram) or in the Model Explorer View 

2.1. Right click and select “Capra → Add to trace sources”. 

3. Select the target entity to trace in its given model or diagram (for instance a Claim in a Claim diagram 
or model, file or CDO based). 

3.1. Right click and select “Capra → Add to trace targets”. 

4. Use the button in the Capra trace links view to create the trace (see Figure 198) 

 

Figure 198. Capra Create Trace Links View  
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7.28.3 Traceability view 

As explained in the previous section about the CHESS editor support for traceability management, trace 
links can be created, seen and deleted by using the CHESS OpenCert property view. 

As alternative, traces existing for a given element (architectural or related to Assurance Case/Evidence 
Model) can be checked and also removed by using the “Traceability View”. If not already available, the 
“Traceability View” can be activated in the Properties View by selecting the 
“Window→ShowView→Other…→CHESSTraceability View” command. 

For the given current selection, e.g. a CHESS Contract or Block in a CHESS Block Definition Diagram or a 
Claim in an OpenCert Assurance diagram, the “Traceability View” shows in a tree-like manner the links 
currently defined in the traceability model. Available links can be selected and deleted by using the 
“delete” button. Navigability for traced entties is also enabled through the “Traceability View” by double 
clicking the entities themselves; for instance it is possible to double click a CHESS component entity listed in 
the “Traceability View” to automatically open the corresponding CHESS model. 

An additional view is available from Window→ShowView→Other…→PlantUML”; this view shows in a 
diagrammatic way the traceability links defined for the entitiy currently selected. 

7.29 CHESS CDO support 

The CHESS tool offers support for creating a CHESS project into CDO and export/import features to copy 
CHESS projects from file-based to CDO and viceversa. 

It is worth nothing that only model editing facilities are available for a CHESS project stored in CHESS CDO, 
so the analysis support is available for file-based projects only. 

To create a CHESS project under CDO: 

1. Checkout and open a CDO repositories in the Project Explorer view 

2. Right click the CDO checkout folder in the Project Explorer and select “New → CHESS Model 
(CDO)”. 

To load a CHESS file-based project into a CDO repository select “CHESS → CDO → export to CDO” and fill 
the wizard fields related to the CHESS project to export and the CDO destination. 

To copy a CHESS CDO project into the current workspace, select “CHESS → CDO → import from CDO” and 
fill the wizard fields related to the CHESS project to import, available in CDO, and the workspace 
destination. 
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8. System Dependability Co-analysis  

This section describes the usage of papyrus CHESS to model the architectural specifications and perform 
dependability co-analysis along with the generation of multi-concern fault tree.  

8.1 Specify Failure Behaviour of CHESS System Components 

The failure behaviour of a component can be defined by applying “FLABehavior” stereotype to that specific 
component. This failure behaviour is specified via Failure Propagation Transform Calculus (FPTC) rules. The 
FPTC rules provide input/output failure behaviour of a component, where a failure on input port is mapped 
to the failure on the output port. Figure 199 shows a component with “FLABehavior” stereotype and FPTC 
rules specifications.  

 

Figure 199. Failure Behaviour specification of a component 

8.2 Specialize Failure Behaviour of Component for Security Concern 

To further specialize the failure behaviour “ErrorModelBehavior” stereotype is assigned to the 
components.  The specialization is performed through defining a state machine diagram for the component 
stereotyped as “ErrorModel”. Using this state machine, the error states and the transitions are modelled. 
These transitions are stereotyped as “Attack” and “Vulnerability” to specify the security attack exploiting a 
vulnerability of the component. Figure 200 shows the “ErrorModel” stereotyped state machine with 
“Attack”, “Vulnerability” and “Failure” stereotyped transitions. The kind of attack and vulnerability are 
provided under the attack and vulnerability stereotype respectively. 
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Figure 200. Specialization of Failure Behaviour for Security Concern 

8.3 Invoke ConcertoFLA and Generate Fault Tree  

ConcertoFLA analysis is invoked from the CHESS menu entry titled as “Failure Logic Analysis (Concerto-
FLA)”, as shown in Figure 201, to calculate the failure propagation paths. The multi-concern fault tree is 
generated from the CHESS menu entry titled as shown in Figure 201.  

 

Figure 201. Invoking Failure Logic Analysis and Fault Tree Generation 
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9. Assurance Argumentation Management 

9.1 Preferences 

Set some configuration Parameters in “Window  Preferences  OpenCert  Argumentation” (see 
Figure 202). 

In the section, you can define parameters required by the Argumentation diagram editor. 

The parameters which can be defined are below: 

• Modules directory preference. This folder contains all argumentation modules stored from 
previous argumentation. 

• Patterns directory preference. This folder contains all argumentation patterns templates. 

• Patterns CDO directory preference. This folder contains all argumentation patterns templates 
stored at the repository. 

• Modules CDOdirectory preference. This folder contains all argumentation modules stored from 
previous argumentation at the repository. 

These folders are Eclipse Projects that should be created previously. 

  

Figure 202. Argumentation Preferences 

9.2 Creating and Saving a Diagram  

It is possible to create and save a diagram in two ways. Either by creating Assurance Cases locally in the 
workspace (this is done specifically when creating argument patterns which are described in Section 9.4) or 
by using the Assurance Cases that are stored in a database which let the users work in a cooperative and 
distributed way.  
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9.2.1 Creating a new diagram 

In File Format 

To create a new file-based argumentation diagram, follow the procedure below and generate a new 
diagram in the project folder. 

 

 

 

 

 

Figure 203. File-based Argumentation Diagram wizard (I) 

 

Figure 204. File-based Argumentation Diagram wizard (II) 

Enter the name of the diagram 
to be created and click the 
“Finish” button (see Figure 
204) 

. 

Select “New”  
“Other…” from the 
File menu of eclipse  

Select “Arg Diagram to File” 
in the OpenCert category 
and click the “Next” button 
(see Figure 203). 

Select the folder to 
store the new 
diagram (see Figure 
204) 
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In Database Format 

To create a new database-based argumentation diagram, follow the procedure below and generate a new 
diagram in the project folder. This allow the user to work in a collaborative manner. 

 

 

 

 

 

Figure 205. Database-based Argumentation Diagram wizard (I) 

 

Figure 206. Database-based Argumentation Diagram wizard (II) 

Enter the name of the 
diagram to be created and 
click the “Finish” button 
(see Figure 206) 

. 

Select “New”  
“Other…” from the 
File menu of eclipse 

Select “Arg Diagram to 
Repository” in the 
OpenCert category and click 
the “Next” button (see 
Figure 205) 

Select the folder 
to store the new 
diagram (see 
Figure 206) 
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9.2.2 Creating a diagram at the Project creation time 

When a new Assurance Project is created (See Section 6.1) a new argumentation is created by applying a 
transformation to the baseline. The rules that apply to the transformation are the following: 

• Every reference activity is transformed into a claim. The id, name and description of the reference 
activity become also the id, name and description of the claim.  

• Every reference requirement is transformed into a claim. The id, name and description of the 
reference requirement become also the id, name and description of the claim. 

• Every reference artefact is transformed into an information element with the property type marked 
as “solution”. The id, name and description of the reference artefact become also the id, name and 
description of the information element. 

• When a reference activity has sub activities, then an asserted inference relationship is created, the 
source is the claim transformed from the top activity and the target the claim transformed from the 
sub activity. 

• When a reference activity has reference requirements, then an asserted inference relationship is 
created, the source is the claim transformed from the reference activity and the target the claim 
transformed from the requirement. 

9.2.3 Opening a diagram 

In File Format 

Double click on the project folder on the “Package Explorer” tab in order to expand the folder. The stored 
diagrams will be shown. Double click on “Argumentation Diagram information file” (.arg_diagram) to open 
a diagram in the editing window. The diagram can then be edited (see Figure 207). 
 

 

Figure 207. Open File-based Argumentation Diagram 

In Database Format 
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Double click on the project folder on the “Repository Explorer” tab in order to expand the folder. The 
stored diagrams will be shown. Double click on “Argumentation Diagram information file” (.arg_diagram) to 
open a diagram in the editing window. The diagram can then be edited (see Figure 208). 

 

 

Figure 208. Open Database-based Argumentation Diagram 

9.2.4 Saving a diagram 

To save a diagram, select one of the following items in the “File” menu. 

1. “Save” item 

This utility is only available for file-based Argumentation Diagram. 

The contents of the selected editing window will be saved in the model information file and the 
diagram information file. 

2. “Save As...” item 

This utility is only available for file-based Argumentation Diagram. 

The contents of the selected editing window will be saved in the model information file and the 
diagram information file with a different name. 

3. “Save All” item 

The contents of all editing windows will be saved in the corresponding model and the diagram 
information files/database. 

9.3 Editing Functions 

9.3.1 Editing a diagram 

Nodes and relationships (or links) selected from Palette can be added to the canvas. Just select the node 
from the Palette (see Figure 209), go to the editing window and select the place and size of the element. 
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Figure 209. Argumentation Palette 

The palette is structured into three different sections. The “GSN core” section includes the main nodes for 
argumentation. These nodes implement the GSN graphical notation, however internally it uses the SACM 
metamodel. The “Relationships” section includes all the different links between the different nodes. Finally, 
the “GSN modular extensions” section includes those nodes specific for the modular argumentation.  

Table 3. Argumentation graphical notation 

Graphical notation GSN concept Extended SACM metamodel used in CACM 

 

 

Goal Claim 

 

Context InformationElementCitation 

Property type=”context” 

 

Strategy ArgumentReasoning 

 

Solution InformationElementCitation 

Property type=”solution” 

 SolvedBy AssertedInference, but only if the target is not a 
solution 

 SolvedBy AssertedEvidence, but only if the target is a solution 

   
InTheContextOf Asserted 
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Underdeveloped Property toBeSupported=”true” 

 To be 
instantiated 

Property toBeInstantiated=”true” 

 

AwayGoal ArgumentElementCitation 

Property type=”claim” 

 

AwayContext ArgumentElementCitation 

Property type=”context” 

 

AwaySolution ArgumentElementCitation 

Property type=”solution” 

 

Module Argumentation 

 

Contract Agreement 

 

Assumption Claim 

Property assumed=true 

 

Justification InformationElementCitation 

Property type=”justification” 

 

N/A AssertedCounterEvidence  

An AssertedCounterEvidence by Claim (A – the source 
evidence cited – and B – the target claim) denotes 
that the evidence cited by A is counter-evidence to 
the truth of Claim B (i.e., Evidence A suggests the 
conclusion that Claim B is false). 

 

N/A AssertedChallenge 

An AssertedChallenge by Claim A (source) to Claim B 
(target) denotes that the truth of Claim A challenges 
the truth of Claim B (i.e., Claim A leads towards the 
conclusion that Claim B is false) 

 

Public Goal Claim 

Property Public=”true” 

 Optionality AssertedInference 

Property multiplicity=optional 

 multiplicity AssertedInference  

Property multiplicity=multi 
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 Choice Choice 

In case of the links, just select the link from the palette, then on the editing window click on the source of 
the link and then release the click on the target of the link. 

A Popup menu opens when the mouse cursor is placed in the graphic-object editing area and is kept still for 
a moment. A node can be created by selecting the corresponding icon in the menu. 

On the other hand, the Properties View manages the properties of the current element under edition (see 
Figure 210). 

 

Figure 210. Claim properties 

Goal 

These elements have the graphical notation as Goals on GSN and are stored as Claim in CACM metamodel. 
The identifier property indicates uniquely the goal on the argumentation. Do not use the same 
identification on different elements on the same argumentation. 

“To be supported” property indicates that the claim will be further developed on a future. At the end of the 
assurance case development, this property should be false.  

Assumption 

In the palette, an Assumption is considered as a core element; however, in CACM it is stored as a Claim 
with assumed property as true. It references the assumption concept and has the same graphical notation 
as assumptions in GSN. This concept indicates an assumption in relation of a goal. 

Strategy 

This element has the same graphical notation as strategies on GSN but it is stored as Argument Reasoning 
in CACM. The identifier property indicates uniquely the element on the argumentation. Do not use the 
same identification on different elements on the same argumentation. 

“To be supported” property indicated that the argument reasoning will be further developed on a future. 
Similarly as the goals, when the assurance case is finished, this property should be false. 

Justification, Context and Solution 

The Information Element Citation concept stored in CACM, has different graphical notations depending to 
the concept which is referencing. The property “Type” could have the values: 
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• Justification: it references the justification concept and has the same graphical notation as 
justifications in GSN. It justifies the validity of a claim. 

• Context: it references the context concept and has the same graphical notation as contexts in GSN. 
It indicates the context of a claim. 

• Solution: it references the evidence concept and has the same graphical notation as solutions in 
GSN. It supports the validity of a claim. 

The identifier property indicates uniquely the element on the argumentation. Do not use the same 
identification on different elements on the same argumentation.  

Information elements references to a specific artefact. The URL property indicates the location of the 
artefact associated.  See section 9.3.3 for further information on these artefacts. 

Argumentation Modules 

This element has the same graphical notation as argument modules on GSN. They are used when the 
assurance argumentation is done in a composable way. The identifier property indicates uniquely the 
element on the argumentation. Do not use the same identification on different elements on the same 
argumentation. 

The Location attribute indicates where it is stored the argumentation diagram file with the content of the 
module. By default, is should be stored on the places indicated on the preferences. 

9.3.1.1 Copying and Pasting an Element 

Elements in a diagram can be copied and pasted. 

To copy an element, select the element and click “Copy” in the “Edit” menu. The copied element can be 
pasted by clicking “Paste” in the “Edit” menu without selecting any element. 

9.3.1.2 Deleting a Node or a Link 

Please, do not press the Del key. The element will not be completed deleted. 

To delete a node or a link, click to select the node/link and perform one of the following steps. 

1. Press the “BS” key. 

2. Right click the item and select “Delete from Model” from the context menu. 

Note: An argument can be deleted. But its child elements are also deleted and the argument cannot be 
edited any more. 

9.3.2 Create multi-diagrams from an Argumentation model 

The tool allows managing different views of a model through a set of diagrams. Once a model is available, a 
new diagram view can be created, and special edition functionalities are available as follows: 

1. Thanks to the Outline view, it is possible to drag and drop concepts from the model to the diagram. 

2. Once a concept has been selected, it can be hidden through the “Delete from diagram” option 
available in the contextual menu. This option does not delete the concept from the model. 

3. Once a concept has been selected, it can be deleted through the “Delete from model” option 
available in the contextual menu. This option deletes the concept from the model permanently. If 
this deleted concept is visible in another diagram files, this concept will be shown with a cross icon 
in the upper right corner to show that it does not exist anymore. 
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Create multi-diagrams in File Format 

Once a model is available, a new diagram view can be created by using the “Initialize arg_diagram diagram 
file” option in the contextual menu (see Figure 211).  

 

Figure 211. Initialize a diagram file 

This option launches a wizard that at the first step requires the folder and the name of the new diagram 
file. Next, the root element of the model (Case type) must be selected as the root element of the new 
diagram (see Figure 212). After that, the diagram is ready for edition.  
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Figure 212. Selection of the Case root element  

Create multi-diagrams in Database Format 

Once a model is available, a new diagram view can be created following the procedure below. 

 

 

 

 

 

Figure 213. Database-based Argumentation Diagram wizard (I) 

Type the name of the 
model created 
previously and click the 
“Finish” button (see 
Figure 215). 

Select “New”  
“Other…” from the 
File menu of 
eclipse 

Select “Arg Diagram to 
Repository” in the 
Opencert category and 
click the “Next” button 
(see Figure 213). 

Select the folder to store the new 
diagram. Then type the name of 
the diagram to be created and click 
the “Next” button (see Figure 214). 
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Figure 214. Database-based Argumentation Diagram wizard (II) 

 

Figure 215. Database-based Argumentation Diagram wizard (III) 

After that, the diagram is ready for edition.  

9.3.3 Connecting an Argument Diagram to Artefacts 

First, we need to load the Evidence Model to be linked with. This step is done differently depending if the 
argument diagram is file based, or databased stored. See the next subsections for more information. 
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Once the Evidence Model is loaded; context, solution or justification elements can be related to its 
artefacts. To carry out, select one of these elements in the diagram and in the Properties view press the “+” 
operator in Artefact section (see Figure 216).  

 

Figure 216. Artefact selection as solution  

A pop-up window will show the Artefacts Model at the “All Resources” tab. Finally, choose the required 
Artefact (see Figure 217). 

 

Figure 217. Artefact selection from resources 

In addition, it is also possible to launch the Artefact editor by double clicking on one Artefact instance as 
shown in Figure 218. 



 

         AMASS AMASS Platform User Manual V1.0 

 

H2020-JTI-ECSEL-2015 # 692474 Page 165 of 295 
 

 

Figure 218. Artefact edition form 

9.3.3.1 Load evidence models in a file based diagram  

Firstly, proceed to load the evidences model (.evidence) from the repository. So, press the Outline and 
select “Load Resource” in the context menu as shown in Figure 219.  

 

Figure 219. Load Resource to Argumentation Diagram 

Then, browse into the workspace to select the Evidences Model resource (see Figure 220). 
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Figure 220. Select Evidence model as resource 

9.3.3.2 Connecting a data based diagram to Artefacts 

In order to load CDO resources for the Artefact Model (.evidence), it is necessary to include them in the 
AssetsPackage of the Assurance Project. In the repository explorer, select the .assuranceproject model. In 
the tree view, select the AssetPackagage and in the Properties view, add the models, such as the Evidence 
Models or the Argument Models to the project (see Figure 221).  

 

Figure 221. Linking models to the Assurance Project's Assets Package 

Press the plus symbol (+) in the Artefacts model section and a pop-up window (see Figure 222) will appear, 
letting the user select in the All Resources Tab the evidences model previously created.  
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Figure 222. Selecting the evidence model to be included in the assets package 

9.4 Patterns 

9.4.1 Creating a new Pattern diagram 

According to the GSN standard [9] argument patterns are generic arguments which can be useful for 
reusable reasoning, akin to software development patterns. GSN creates an extension for these 
abstractions, and so the tooling also supports this extension.  

To create a new Argumentation Pattern diagram, follow the procedure of “Creating a New Diagram”. The 
only difference with other argumentation diagrams is that Patterns need to be stored on the places 
designed by the preferences.  

9.4.2 Editing a Diagram Using a Pattern or a Module 

In order to display the Template View (see Figure 223), follow the next steps: Go to “Window  Show 
View  Other”. 

On the Menu expand the “OpenCert” category and select the “Templates” view.  

Double click on a folder will expand the folder. Double click on an Argumentation Diagram file 
(.arg_diagram) will open the diagram in the editing window. 
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Figure 223. Argumentation Templates View 

Modules and Patterns are stored on places determined by the preferences (see previous section). 

The Patterns and Modules should be stored as ready to be reused. From the Template view, the drag and 
drop operation is activated in order to reuse the pattern or module on the actual argumentation. 

9.4.2.1 Editing a Pattern Diagram  

Proceed as explained in the 9.4.2 “Editing a Diagram” section.  

Remember that only Pattern Diagrams support structural and entity abstraction. Structural abstractions, 
such as multiplicity or optionality, are available through the “Multiextension” and “Cardinality” properties 
of relationships. In addition, structural options are addressed by a “Choice”10 relationship. 

An Entity abstraction can be accomplished by the “To Be Instantiated” and “To Be Developed” properties. 
While editing a claim one of the properties that can be changed is “To be instantiated”, when its value is 
“true” then the node will change its graphics (see Figure 224). 

 

 

Figure 224. Claim properties (To Be Instantiated) 

                                                             
10 At creation time the “Choice” link must be placed inside its source node 
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The “AssertedInference” has a property called “multiextension” with three different values (see Figure 
225): 

• Normal: is behaves as a regular connection. It has the “supported by” graphical notation. 

• Optional: it indicates that this connection is optional or alternative connections between the 
nodes. 

• Multi: it indicates the generalised n-ary relationships between the nodes. When this option is 
selected, the attribute “cardinality” should also be modified indicating the “n” value. 

 

Figure 225. Claim properties (Multiextension) 

The “choice” relationship is specific for patterns edition. For editing, select the Choice at the Palette and 
then place it inside its associated top Claim. The graphic for the choice relationship will appear affixed to it. 
Then add as many asserted inferences as number of possible choices (see Figure 226). 

 

Figure 226. Example of the software contribution safety argument pattern [10] 
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9.4.2.2 Adding Elements from Patterns to a Diagram (instantiating a Pattern) 

An Argument Pattern can be instantiated (thus all its content copied) into the diagram under edition.  

To proceed, drag and drop a Pattern Diagram file into the diagram under edition. Next, open the 
uncompleted Argumentation diagram that needs to include the pattern. Go to the templates view, select 
the pattern you are interested in, once selected drag and drop it into the editing part of the diagram. Once 
dropped, the new elements that have been copied into your argumentation diagram will be displayed. 

Once the drop is done, the “Arrange Selection” feature can be used to move to all the nodes and links. This 
feature can be found on the top menu as a button. 

9.4.2.3 Creating a New Module Diagram  

To create a new argumentation Pattern diagram, follow the procedure of 9.2.1 “Creating a New Diagram” 
but generating the new diagram into the Modules directories. The only difference with other 
argumentation diagrams is that Modules need to be stored on the places designed by the preferences. By 
default, preferences point to a project called “Modules” on the workspace.  

9.4.2.4 Editing a Module Diagram  

Proceed as explained in the 9.3.1 “Editing a Diagram” section. 

Remember that a Modules Diagram (“Argumentation”) allows representing interrelated modules of 
argumentations. An “Argument Element Citation” repeats an element presented in another argumentation 
module which is used to support the argument in the local module. The “Public” property indicates that an 
element is visible to other modules where it can be referenced. While an “Agreement” element represents 
the agreed relationship between modules.  

To indicate that a claim is Public, just state on the Claim properties view that the attribute “Public” is 
“true”. The Public activation is also noticed on the graphic notation (see Figure 227). 

 

 

Figure 227. Claim properties (declared as Public) 

Argument Element Citations can represent different concepts; they can reference a claim, a context or a 
solution. On the Properties view, an attribute called “cited type” should be informed and consequently the 
graphic notation might change (see Figure 228). 
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Figure 228. ArgumentElementCitation properties (reference to a claim) 

The “Argumentation Reference” property indicates the reference to the module in which this citation 
element is described. 

9.4.2.5 Adding Elements from Modules to a Diagram (instantiating a Module) 

An Argumentation Module can be instantiated (thus all its content copied) into the diagram under edition.  

To proceed, drag and drop a Module Diagram file into the diagram under edition. 

Once it is instantiated an “argumentation” graphic notation (see Figure 229) will appear on your diagram. 

 

Figure 229. Argumentation Module 

By double clicking on this Argumentation another diagram will appear with the argumentation context of 
this module. The URL property indicates the location of this diagram. 

9.4.3 Vocabulary 

The safety argumentation supports the usage of terms and term categories which have been defined in a 
vocabulary. The meaning of some terms and categories is specific to legislative regulations, standards and 
or the project they are used in. Vocabularies capture the meaning of such terms and categories by 
providing a definition. 

9.4.3.1 Defining vocabularies 

The simplest way to define a vocabulary is to create one in the project where it going to be used.  They can 
be stored either locally in a file or inside a remote repository (see Figure 230).  
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Figure 230. New Vocabulary wizard 

The vocabulary can be visualized in a diagram (see Figure 231) that shows how terms are related to each 
other. The diagram is a visualization of the vocabulary model but can also be used to edit the model. 

 

Figure 231. Example Vocabulary Diagram 

Writing vocabularies is a time-consuming process. To save some or all of that work, vocabulary data can be 
imported from files in a custom XML format (see Figure 232). In order to talk about elements of the model 
in the argumentation, it is not necessary to duplicate the model elements as vocabulary terms. Instead, 
they can be imported into a vocabulary.  
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Figure 232. Vocabulary Import 

9.4.3.2 Using vocabularies in the Argument Editor 

Terms and term categories from the vocabulary can explicitly be used in the argumentation. In order to do 
so, some mark-up is required. The mark-up is visible while editing text (see right side of Figure 233), 
otherwise it will not be (see left side of Figure 233).  

 

Figure 233. Mark-up Rendering 

One of the following mark-up variants can be used: 

• voc:term 

• voc:”term” – Usually for terms with spaces or when the sentence ends after the term. 

• voc:term|terms – Provide a natural language expression to be rendered instead of the term name, 
e.g. the plural form of the term. Add quotes if the term or the expression contains spaces. 

Categories use the “var” prefix instead of “voc”. 

Syntax highlighting and tooltips for vocabulary elements are available inside the argumentation editor (see 
Figure 234). 
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Figure 234. Tooltip 

While editing text, pressing Ctrl + Space will display a list of available vocabulary items (see Figure 235). The 
list gets smaller when the user types the starting letters of the searched item. Pressing “enter” inserts the 
item at the cursor. 

 

Figure 235. Term Suggestions 

9.5 Generating Argument Fragments 

The Argument Generator generates a set of argument-fragments from the selected CHESS model and 
stores them in the corresponding destination assurance case in the CDO repository stated in the OpenCert 
preferences. Two types of argument-fragments are generated: component contract argument-fragments 
and architectural design pattern argument-fragments. To generate the first type, the Argument Generator 
assumes that the CHESS model is enriched with contracts and that contract refinement has been 
performed such that the contract status is updated to indicate if the contract is validated in the given 
context or not. Moreover, Argument Generator assumes that the analysed model and the refinement check 
results are stored in the refinement analysis context. Furthermore, if there are any connections of CHESS 
model elements with OpenCert assurance information, as described in Section 7.28, the relevant 
information will be included in the argument-fragments based on the relevance of the CHESS elements for 
assurance. For the generation of the second type of argument-fragments, the information about the 
architectural pattern should be included in the CHESS model as well as the pattern application element. The 
architectural design pattern argument-fragment is generated for each pattern application in the CHESS 
model. 
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The attached screenshots (Figure 236 - Figure 240) illustrate how the generation of argument-fragments 
can be performed. First, select the OCRA refinement analysis context. Then, indicate to which assurance 
case on the corresponding CDO server should the argument-fragments be saved. The argument-generation 
is performed for each component and for each validated contract. The set of argument-fragments for each 
component and applied architectural pattern can be viewed in the selected assurance case. 

 

Figure 236. Initiating the argument-fragment generation (Step 1) 
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Figure 237. Selecting the source analysis context (Step 2) 
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Figure 238. Selecting the destination assurance case folder on the CDO repository (Step 3) 



 

         AMASS AMASS Platform User Manual V1.0 

 

H2020-JTI-ECSEL-2015 # 692474 Page 178 of 295 
 

 

Figure 239. Generation successfully completed with argument-fragments for each block 
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Figure 240. An example of the generated argument-fragment 

9.6 Printing 

The following operations regarding printing are available under the “File” menu. 

1. “Print Preview” item: Print preview 

2. “Print...” item: Print 

3. “Page Setup...” item: Print settings 

9.7 Export an Argument Model 

In order to export an argument model stored in the repository just select the “File → Export” menu option. 
A new window will appear to select under the OpenCert category the “Export argument model to File” 
option (see Figure 241). 
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Figure 241. Export wizard selection window 

A new window appears where the user can select any argument model stored in the repository and 
indicate the file destination location and name (Figure 242). 

 

Figure 242. Export argument model window 

Note: The user can import any argument model exported with this functionality using the steps described 
in section 6.11. 

9.8 Compliance via Automatic Generation of Process-based Arguments 

According to the vision of AMASS for compliance management, the process development plan needs to 
fulfil the standards and should provide the justification of compliance. In particular, the automatic 
generation of process-based arguments arguing about compliance of processes. For instance, work 
products (e.g., design documents and verification report) show/argue/prove that the plans comply with the 
requirements. In this context, the EPF Composer is used for modelling the definition and planning of 
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processes and OpenCert is used for visualizing the generated arguments (i.e., Argumentation Model and 
Diagram).  The standard requirements and process lifecycle are modelled as plugins in EPF Composer by 
following the guidelines mentioned by IBM approach [8]. For this reason, they recommend creating three 
separate plugins, in particular, capturing standard requirements, modelling process lifecycle (i.e., content 
elements and process) and mapping standard requirements. However, EPF Composer does not support the 
definition of a user-defined type. Therefore, the guidance type “Practice” has been customized with an icon 
and variability relationships. Figure 243 shows the standard requirement modelling. In case there are more 
than one requirement that needs to be fulfilled, a semicolon (;) is used to separate them in the “Brief 
description” field. The detailed guidelines for Standard Modelling and Process Compliance are presented in 
Appendix A. Standard Modelling and compliance in EPF.  

 

Figure 243. Modelling standard requirements 

The guidance for the creation of process elements are provided in Section 2.2, and is also available in the 
EPF Composer manual [6]. If there are more than one evidence or rationale that correspond to 
requirements, a semicolon (;) should be used to separate them. The properties/fields in EPF Composer used 
to model the evidences related to process elements are as follows: 

• “Skills” (Staffing Information) field is used to model the qualifications provided by a role who has 
the responsibilities to perform relevant tasks correctly and efficiently. Figure 244 shows the 
modelling of evidences corresponding to key competencies of a role.  

• “Key considerations” (Detail Information) field of Tools is used to specify certifications or rationales 
against required tool qualifications (see Figure 245). 

 

Figure 244. Modelling evidence for role 
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Figure 245. Modelling evidence for tool qualification 

Figure 246 shows the delivery process created in the Processes folder of the process_lifecycle plug-in, 
which opens a form for the modelling of the process with several tabs for definitions of tasks, work 
breakdown structure, team allocation, work product usage and consolidated view. The “Purpose” (General 
Information) field is used to specify context in which the process should be interpreted (see Figure 247). 

 

Figure 246. Modelling process 

 

Figure 247. Modelling process purpose 

In order to define the compliance mapping, standard requirements are copied in the 
mapping_requirements plugin. These copied requirements have a variability relationship “Contributes” 
with the original requirements. In addition, the links between requirements and lifecycle elements have 
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been established through the “References” tab, as shown in Figure 248. The detailed guidelines for Process 
Compliance are presented in A.2 Process Compliance. 

 

Figure 248. Mapping standard requirements 

9.8.1  Detecting fallacies in process models 

The process-based arguments cannot ensure that the evidences are sufficient to support the claim. If no or 
less evidences are provided to support the claim (i.e., at least one of the evidences has been omitted) or no 
valid reasons (rationales) are given for its omission; it means that process contains the omission of key 
evidence fallacies. These fallacies may result in a loss of confidence on system’s safety. It is thus crucial to 
prevent or detect fallacies specifically, “omission of key evidence” in process before generating the process-
based argumentations. 

To detect the omission of key evidence fallacy, the following steps need to be performed: 

1. Fallacy Detection plugin is invoked from a right-click menu on the ProcessComponent (Capability 
Pattern or Delivery Process), after modelling the standard requirements and process. In particular, 
select “Fallacy Detection → Detect Omission of Key Evidence” option, as shown in Figure 249.  

 

Figure 249. Initiating fallacy detection plugin 
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2. Select the target directory where you want to store the validation results (see Figure 250). Either 
select existing one or make a new folder (see Figure 251). If user pressed the “Cancel” button 
during the validation process, the error message “Do you really want to cancel the process” (see 
Figure 252) is shown. 

 

Figure 250. Selecting target directory for storing results 

 

Figure 251. Browse for folder 

 

Figure 252. Error message 

3. After selecting the target directory, the validation process starts. When the fallacies detection 
process finishes, click on the “Open File” button to open validation report in the form of TXT file 
(see Figure 253).  In case of more than one validation reports, the message in Figure 254 appears 
that allows to open the target folder by clicking at the “Open Folder” button. 
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Figure 253. Open File 

 

Figure 254. Open Folder 

4. Figure 255 shows the generated txt files. The “Tool Qualification Plan Report” shows the key-
evidence omission associated to MATLAB and Simulink tool. Figure 256 shows the validation results 
printed on the console including the list of roles and tools containing insufficient information (i.e., 
detected fallacies), recommendations, and the elements containing sufficient evidences. Based on 
the results, the user either modifies the process models or provide the rationale about omitted 
information by following the recommendations. 

 

Figure 255. Generated validation reports 
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Figure 256. Printed results on the console 

9.8.2  Generating process-based argumentation  

The Process-based Argument Generator plugin takes the ProcessComponent (Capability Pattern or Delivery 
Process) modelled in EPF Composer as an input and transforms it into arguments (model and diagram). The 
rules that apply for the transformation are described in AMASS D6.3 [5]. 

To generate the process-based arguments, the following steps need to be performed: 

1. Invoke the Argument Generator plugin by clicking on the (modelled or modified) Capability Pattern 
or Delivery Process, in particular, by selecting “Transformation → Generate Process-based 
Argument” option, as shown in Figure 257. 
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Figure 257. Initiating argument generator plugin 

2. Select the target Assurance Project from the CDO Repository using the “Browse” button (see Figure 
258). Then, click on the previously created Assurance Project folder to store the results of the 
transformation and press the “OK” button, shown in Figure 259. Please note that the CDO 
Repository should have already been configured (see Section 2.2.) and the Repository Explorer 
must be opened (see Figure 256). 

 

Figure 258. Browsing CDO repository 

 

Figure 259. Selecting the Assurance Project 

3. Click on the Assurance Project folder and press the “OK” button; the transformation process starts.  

4. A dialog window appears to inform that the transformation process has finished successfully, listing 
the locations where the generated files have been stored (see Figure 260). When pressing the “OK” 
button, the progress information monitor appears to inform that, the argumentation diagram is 
opening in the current workspace, as shown in Figure 261. 
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Figure 260. Transformation successfully completed 

 

Figure 261. Opening diagram 

5. The generated Argumentation Diagram is opened into the OpenCert Argumentation Editor (see 
Figure 262). The Argumentation Model (with diagram) is saved locally in a new project into the 
current Workspace under the name “Argumentation”, and can be found in the “Package Explorer” 
tab, highlighted in red. 

 

Figure 262. Locally generated argumentation diagram and model 
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6. The generated argumentation model and diagram are also stored in the corresponding destination 
assurance case in the CDO Repository under the “ARGUMENTATION” folder (see Figure 263). To 
open the repository explorer, click “Window → Show View → Other and under the OpenCert 
folder click on Repository Explorer”.  

7. For displaying elements in the Argumentation diagram editor, select the elements from the 
Navigation View and drag them to the editor, see Figure 263. In the argumentation diagram, 
Evidence (Solution in GSN) shows Id and Description of the role in the “Base” tab of the Properties 
view. 

 

Figure 263. Generated argumentation model and diagram in CDO repository 
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10. Evidence Management 

10.1 Define Artefact Repository Preferences 

The first step before creating an Evidence Model is to indicate the SVN Repository configuration 
information to store the artefact files using the menu option “Windows  Preferences” (see Figure 264). 

 

Figure 264. Preference menu 

Then, select the OpenCert “Artefact Repository Preferences” category and introduce the required 
information (see Figure 265). In order to use a local directory as Artefact Repository, check the “Use Local 
Repository” or uncheck it to use a SVN Server. Provide the path of the local folder used as Local repository, 
the URL of the remote SVN server, and the user and password of the SVN server. 

 

Figure 265. Artefact Repository Preferences 
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The management of Evidence must be made through the creation of a new model of the type “Evidence 
Model”.  

In order to generate a new Evidence Model, follow the next steps: 

• First, select the menu entry “File → New → Other…” (see Figure 266). 

 

Figure 266. New Evidence Model Menu  

• In the Wizard dialog, open the OpenCert category, select the “Evidence Model to Repository” and 
press the “Next >” button (see Figure 267). 

  

Figure 267. New Evidence Model (I) 

• Enter o select the parent folder, the resource name and press the “Finish” button (see Figure 268). 
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Figure 268. New Evidence Model (II) 

Once the Evidence Model has been created, the first item is presented to the user (see Figure 269). 

 

Figure 269. Evidence Model 

The “Copy Preferences” button will copy the Artefact Repository Preferences data to this model and will be 
saved in the model and used to store the Artefact files of this evidence model. If this information is empty, 
then the data specified in the Artefact Repository Preferences (see Figure 265) will be used to store the 
artefact files.  
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10.2 Artefact Definition 

10.2.1 Add an Artefact definition 

It is possible to add artefact definitions to an artefact model in two ways: 

• One way, select the artefact model and press the button  as shown in Figure 270. 

 

Figure 270. Add New Artefact Definition (I) 

• Another way, shown in Figure 271, click on the branch Artefact Model, press the right mouse 
button and select the contextual menu “New Child –> Artefact Definition”. 

 

Figure 271. Add New Artefact Definition (II) 

In the properties zone, the framework presents several fields to describe the new Artefact Definition 
divided in tabs (see Figure 272 - Figure 276): 
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Figure 272. Artefact Definition Description (I) 

 

Figure 273. Artefact Definition Description (II) 

1. “Artefact Definition” tab (base): 

• Id: Artefact Definition identifier 

• Name: Artefact Definition name 

• Description: Artefact Definition description 

2. “Artefact Definition Artefact” tab: 

• Name: Artefact name. This field is read-only 

• Version ID: Identifier of the artefact version 

• Date: Date of the artefact version 

• Last Version: This field shows what artefact is the version in use 

• File ID: Identifier of the file associated with the artefact 

• Name: Name of the file associated with the artefact 

• Description: Description of the file associated with the artefact 
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Figure 274. Description of Artefact Definition Artefact 

3. “Artefact Definition Evaluation” tab: 

• References to the assurance asset evaluations that specify the outcome of evaluating the 
artefact. 

 

Figure 275. Description of Artefact Definition Evaluation 

4. “Artefact Definition Events” tab:  

• References to the assurance asset events of which the lifecycle of the artefact consists. 

 

Figure 276. Description of Artefact Definition Events 

10.2.2 Delete an Artefact definition 

To delete an Artefact definition: 

• Select the artefact definition, press the right mouse button and select the contextual menu 
“Delete” (see Figure 277). 
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Figure 277. Delete Artefact Definition (I) 

• Or, select the Artefact model, select the Artefact definition model to delete and press the button 

 (see Figure 278). 

 

Figure 278. Delete Artefact Definition (II) 

10.3 Artefact 

10.3.1 Add an Artefact 

It is possible to add artefacts to an Artefact definition in two ways: 

• Select the Artefact definition, press the right button of the mouse and select the contextual menu 
“New Child –> Artefact” (see Figure 279). 
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Figure 279. Add New Artefact (I) 

• Or, select the Artefact definition, select the “Artefact Definition Artefact” tab Properties, and press 
the “Add” button (see Figure 280). 

 

Figure 280. Add New Artefact (II) 

When a user modifies one Artefact, the system automatically adds to it an AssuranceAssetEvent of type 
“Modification”. 

In the Properties zone, the framework presents several fields to describe the new Artefact divided in tabs 
(see Figure 281 - Figure 285): 

 



 

         AMASS AMASS Platform User Manual V1.0 

 

H2020-JTI-ECSEL-2015 # 692474 Page 198 of 295 
 

 

 Figure 281. Artefact Description 

1. Artefact Definition (“Base” tab): 

• Id: Artefact Definition identifier 

• Name: Artefact Definition name 

• Description: Artefact Definition description 

2. “Artefact Version” tab: 

• Version ID: Identifier of the artefact version 

• Date: Date of the artefact version 

• Changes: Changes make in the artefact version 

• Last Version: This field shows what artefact is the version in use 

• Is Template: Check if the artefact is a template 

• Is Configurable: Check if the artefact is configurable 

• Resource: List of resources associated to the artefact 
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Figure 282. Description of Artefact Version 

3. “Artefact Property Value” tab: 

• Property: Property name 

• Value: Property value 

 

Figure 283. Description of Artefact Property Value 

4. “Artefact Evaluation” tab: 

• Evaluation: References to the assurance asset evaluations that specify the outcome of 
evaluating the artefact. When a user introduces Evaluation information to an Artefact, and 
AssuranceAssetEvent of type Evaluation is added automatically to the Artefact. 

 

Figure 284. Description of Artefact Evaluation 
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5. “Artefact Events” tab: 

• LifecycleEvent: References to the assurance asset events of which the lifecycle of the artefact 
consists. 

 

Figure 285. Description of Artefact Events 

When adding a child Artefact to another Artefact, ArtefactRel information is automatically created with 
modificationEffect=MODIFY and revocationEffect=MODIFY with source=parentArtefact and 
target=childArtefact. 

10.3.2 Delete an Artefact 

To delete an Artefact: 

• Select the Artefact to delete, press the right mouse button and select the contextual menu 
“Delete” (see Figure 286). 

 

Figure 286. Delete Artefact (I) 

• Or select the Artefact Definition branch that contains the Artefact to delete, select the 
“ArtefactDefinitionArtefact” tab, select the Artefact and press the “Delete” button (see Figure 287). 
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Figure 287. Delete Artefact (II) 

10.4 Artefact Resource 

10.4.1 Add an Artefact Resource to an Artefact 

Once selected the artefact: 

• Press the right mouse button and select the contextual menu “New Child → Resource” (see Figure 
288) to bring up the Artefact File properties (see Figure 289). 

 

Figure 288. Add Artefact Resource (I) 
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Figure 289. Resource properties 

• Or, select the Artefact Version tab and press the button  as shown in Figure 290.  

 

Figure 290. Add Artefact Resource (II) 
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Figure 291. Resource dialog box 

In case of using a Local Repository (see 10.1) to add the file, press the button “Location” or “Assign” (see 
Figure 291), and select the file that will be added to the Artefact resource from the local drive (see Figure 
292). The URL of the repository will be displayed in bold.  

 

Figure 292. Select Artefact from the local drive. 

In case of using a Remote Repository to add the file, press the button “Location” to select the file that 
will be added to the artefact resource from the local drive and after press the “Commit” button to 
upload it to the SVN server.  If the file already exists in the SVN Server use the “Assign” button to select 
and assign it to the Artefact version (see Figure 293).  
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Figure 293. Select Artefact from the SVN Remote Repository 

Finally, the SVN history of the file will be displayed in the table shown in Figure 294. 

 

Figure 294. SVN History table of a File 

1. Clicking the “Open” button will launch the corresponding application to open de file. In case of 
remote repository, the file will be downloaded in a local temporally file. 

2. Clicking the “Delete” button will delete the file from the repository, local or remote. 

10.4.2 Delete an Artefact Resource 

To delete an Artefact Resource: 

1. Selecting the artefact resource to delete, press the right mouse button and select the contextual 
menu “Delete” (see Figure 295). 

 

Figure 295. Delete Artefact Resource (I) 
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2. Or, select the “Artefact Version” tab, select the Resource to remove, and press the icon button  
(see Figure 296). 

 

Figure 296. Delete Artefact Resource (II) 

10.5 Artefact Property Value 

Firstly, it’s necessary to load the CDO resource property model (.property). So, press the editing window 
and select “Load Resource” in the context menu as shows in Figure 297.  

 

Figure 297. Load Resource Property model 
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Then introduce the URI of the property model (see Figure 298). 

 

Figure 298. Select Property model. 

10.5.1 Add an Artefact Property Value to an Artefact 

Once the Artefact is selected, it is possible to add an Artefact Property in two ways: 

1. One way, selecting the “Artefact Property Value” tab and pressing the button “Add” (see Figure 
299) to bring up the Property Value dialog box  (see Figure 300). 

 

Figure 299. Add Artefact Property Value (I) 
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Figure 300. Artefact Value dialog box 

2. Another way, pressing the right mouse button and selecting the contextual menu “New Child → 
Value” (see Figure 301) to bring up the Artefact Property properties (see Figure 302). 

 

Figure 301. Add Artefact Property Value (II) 
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Figure 302. Artefact Property properties 

10.5.2 Delete an Artefact Property Value 

It is possible to delete an Artefact Property in two ways: 

1. One way, select the Artefact property in the tree, press the right mouse button and select the 
contextual menu “Delete” (see Figure 303). 

 

Figure 303. Delete Artefact Property Value (I) 

2. Another way, select the parent Artefact of the Artefact property to remove in the tree, select the 
“Artefact Property Value” tab, select the Artefact property to remove and click the “Delete” button 
(see Figure 304). 
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Figure 304. Delete Artefact Property Value II 

10.6 Artefact Assurance Asset Evaluation 

10.6.1 Add an Artefact Assurance Asset Evaluation to an Artefact 

Once the artefact is selected, it is possible to add an Assurance Asset Evaluation in two ways: 

1. One way, selecting the “Artefact Evaluation” tab and pressing the “Add” button (see Figure 305) to 
bring up the Assurance Asset Evaluation dialog box (see Figure 306). 

 

Figure 305. Add Artefact Assurance Asset Evaluation (I) 
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Figure 306. Artefact Assurance Asset Evaluation dialog box 

2. Another way, pressing the right mouse button and selecting the contextual menu “New Child → 
Assurance Asset Evaluation” (see Figure 307) to bring up the Assurance Asset Evaluation properties 
(see Figure 308). 

 

Figure 307. Add Artefact Assurance Asset Evaluation (II) 
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Figure 308. Artefact Assurance Asset Evaluation properties 

10.6.2 Delete an Artefact Assurance Asset Evaluation 

It is possible to delete an assurance assets evaluation in two ways: 

1. One way, select the assurance assets evaluation in the tree, press the right mouse button and 
select the contextual menu “Delete” (see Figure 309). 

 

Figure 309. Delete an Artefact Assurance Asset Evaluation (I) 

2. Another way, select the parent artefact of the assurance asset evaluation to remove in the tree, 
select the “Artefact Evaluation” tab, select the Assurance Asset Evaluation and click the “Delete” 
button (see Figure 310). 
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Figure 310. Delete an Artefact Assurance Asset Evaluation (II) 

10.7 Artefact Assurance Asset Events 

10.7.1  Add an Artefact Assurance Asset Event to an Artefact 

Once the Artefact is selected, it is possible to add an Assurance Asset Event in two ways: 

1. One way, selecting the “Artefact Events” tab and pressing the “Add” button (see Figure 311) to 
bring up the Assurance Asset Event dialog box (see Figure 312): 
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Figure 311. Add an Artefact Assurance Asset Event (I) 

 

Figure 312. Artefact Assurance Asset Event dialog box 

2. Another way, pressing the right mouse button and selecting the contextual menu “New Child → 
Assurance Asset Evaluation” (see Figure 313) to bring up the Assurance Asset Evaluation properties 
(see Figure 314). 
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Figure 313. Add an Artefact Assurance Asset Event (II) 

 

Figure 314. Artefact Assurance Asset Event properties 

10.7.2  Delete an Artefact Assurance Asset Event 

It is possible to delete an Assurance Asset Event in two ways: 

1. One way, select the Assurance Asset Event in the tree, press the right mouse button and select the 
contextual menu “Delete” (see Figure 315). 
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Figure 315. Delete an Artefact Assurance Asset Event (I) 

2. Another way, select the parent artefact of the assurance asset event to remove in the tree, select 
the “Artefact Event” tab, select the Assurance Asset Event and click the “Delete” button (see Figure 
316). 

 

Figure 316. Delete an Artefact Assurance Asset Event (II) 

10.8 Impact analysis 

This functionality informs to the user about the impact of the changes in one Artefact that affect to others 
considering the relations between the modified artefacts and the impacted ones. 
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When the user clicks the save button  to store the modifications made in an Evidence Model, for each 
Artefact modified with impact on another, the user will be asked in a confirmation dialog the agreement  
with the showed impact information in form of tree or not (see Figure 317 and Figure 318).   

 

Figure 317. Artefact modified with automatically generated events 

 

Figure 318. Artefact analyzer confirmation window 

If the user accepts the showed impact, new Assurance Asset Events will be generated in the modified and 
impacted Artefacts (see Figure 319). 
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Figure 319. Artefact events created by Impact Analyzer 

See also Impact Analysis described in section 11.3 Change Impact Analysis. 

10.9 Executing Process Management 

10.9.1 Create a new Executing Process 

Executing process models can be created by importing EPF information into OpenCert (see Section 6.7 for 
further details). Alternatively, it is possible to create a new model of the type “Process Model”.  

In order to generate a new Process Model, the following steps need to be done: 

• First, select the menu entry “File → New → Other…”. 

• In the Wizard dialog, open the OpenCert category, select the “Process Model” wizard and press the 
“Next >” button (see Figure 320). 

 



 

         AMASS AMASS Platform User Manual V1.0 

 

H2020-JTI-ECSEL-2015 # 692474 Page 218 of 295 
 

 

Figure 320. New Executing Process Model (I) 

• Enter o select the parent folder, name the model and press the “Finish” button (see Figure 321). 

 

Figure 321. New Executing Process Model (II) 

Once the Process Model has been created, the first item is presented to the user (see Figure 322). 
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Figure 322. Executing Process Model 

10.9.2  Creating Executing Process assurance data 

The Process Model allows defining activity, participant, person, tool, organization or technique objects. 

To create these objects, in the Model zone, click on the branch “Model”, press the right mouse button and 
select the contextual menu “New Child” (see Figure 323) or use its properties view (see Figure 324). 

 

Figure 323. Create a Process Model data using context menu 
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Figure 324. Create Process Model data using the Properties View 

10.9.3  Specify Compliance between Processes and Artefacts 

To link the process workproduct with the existing Evidences in the assurance Proeject, select the related 
Activity of the executed process, select the “Activity Artefacts” category from the properties view, and add 

them using the corresponding  buttom depending if they are requered or produced in the select 
activity (see Figure 325). 



 

         AMASS AMASS Platform User Manual V1.0 

 

H2020-JTI-ECSEL-2015 # 692474 Page 221 of 295 
 

 

Figure 325. Compliance between Processes and Artefacts 

10.9.4 Deleting Executing Process assurance objects 

To delete a Process Assurance Object, select the object to remove, press the right mouse button and select 
the contextual menu “Delete” (see Figure 326) or select the information to delete using the Properties view 
(see Figure 327). 
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Figure 326. Delete Executing Process Model data using context menu 

 

Figure 327. Delete Process Model data using properties view 
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10.10 Property Model Management 

10.10.1 Creation of a Property Model 

The management of Properties must be made through the creation of a new model of the type “Property 
Model”.  

In order to generate a new Property Model, the following steps need to be done: 

• First, select the menu entry “File → New → Other…” (see Figure 328). 

 

Figure 328. New Property Model Menu  

• In the Wizard dialog, open the OpenCert category, select the “Property Model to the Repository” 
wizard and press the “Next >” button (see Figure 329): 

 

Figure 329. New Property Model (I) 

• Enter o select the parent folder, the resource name and press the “Finish” button (see Figure 330). 
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Figure 330. New Property Model (II) 

Once the Property Model has been created, the first item is presented to the user (see Figure 331). 

 

Figure 331. Property Model 

10.10.2 Create a Property 

It is possible to add properties to a Property Model in two ways: 

• Select the model element, press the right button of the mouse and select the contextual menu 
“New Child –> Property” (see Figure 332). 
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Figure 332. Add New Property (I) 

• Or, select the model element, and press the icon button  in the “Base” tab (see Figure 333). 

 

Figure 333. Add New Property (II) 

After these actions, in the Properties zone, the framework presents several fields to describe the new 
property (see Figure 334): 

• Id: Property identifier. 

• Name: Property name. 

• Datatype: Property data type. Possible values: enumeration, string, integer and float. 

• Enum values: values of an enumeration data type property. To add this value, press the “Enum 
value” button (see Figure 335). 

• Unit: unit value. 
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Figure 334. Property properties 

 

Figure 335. Add Enum values 

10.10.3 Delete a Property 

To delete a Property: 

• Select the property, press the right mouse button and select the contextual menu “Delete” (see 
Figure 336). 
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Figure 336. Delete Property (I) 

• Or select the branch “Model” that contains the property to delete, select the Property and press 

the icon button  (see Figure 337). 

 

Figure 337. Delete Property (II) 
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11. Functionalities of the Polarsys OpenCert Tools Platform 
Server  

As already mentioned in chapter 2, the Polarys OpenCert Tools Platform consists of: 

• Polarsys OpenCert Tools Platform server - installed in a central host machine. 

• One or many Polarys OpenCert Tools Platform clients - each of which installed on specific user 
machines. 

The role of the central Polarsys OpenCert Tools Platform Server is double: 

• Host the CDO server, which facilitates a common storage for server applications and clients. 

• Provide a web interface for the OpenCert tool reports presenting common storage assurance data 
from different angles. 

This chapter describes the functionalities provided by the Polarsys OpenCert Tools Platform server web, 
which facilitate a server front-end for the platform users. If you want to use an own dedicated server, 
please check the Developers Guide [18]. 

11.1 Web Interface Layout 

The Polarsys OpenCert Tools Platform server web pages are served by default at 8080 port. If the 
navigation is done behind a proxy, the port 8080 must be open.  

In order to view the web pages, please run your web browser and go to the following location: 

  http://<AMASS-SERVER-HOST-NAME>:8080/  

 

Figure 338. Polarsys OpenCert Tools Platform server Web interface layout 

A typical Polarsys OpenCert Tools Platform server web page (see Figure 338) consists of the following 
panels: 
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• Top panel 

It contains links to the User Manual documents and links to Server administration pages. 

• Project and Menu panel 

It contains: 

o A select box with Assurance Projects that have been created in the platform.  

o Main menu with links to the server reports. 

There are several reports presenting analytical view from assurance data stored in the 
Polarsys OpenCert Tools Platform. 

Each of the reports is described in the subsequent chapters. 

• Main panel 

It presents the main content of the page - depending on the current report or page selected from 
the menu and the given assurance project. 

11.2 Compliance Report 

11.2.1  Goal of the report 

The Compliance report provides extensive functionality which helps the Polarsys OpenCert Tools Platform 
users to assess the current compliance of their project to the selected safety standard (i.e., baseline). 

The functionality is intended to be used by: 

• Project Team Members, for example developers, when the project is in progress, in order to have 
up-to-date insights into which of the baseline framework items are already satisfied and to what 
extent. 

• Project Safety Manager in order to monitor the project general compliance, observe the 
compliance details and add, assign, or un-assign specific evidence resources to/from the given 
requirement of the safety standard which is followed by the project. 

• Independent Safety Assessor, when the project draws to an end, in order to browse the assigned 
safety evidence, evaluate it and independently assess the actual project compliance to the specific 
safety standard. 

Two modes of the report can be distinguished: 

• An interactive mode, where user can actively browse the report, select the specific baseline items, 
view their properties, their compliance mapping, and the associated evidence, and add or remove 
the evidence resources mapped to the specific baseline element. 

• A printer friendly report - which is a textual output presenting all the information of the current 
compliance of the selected project. 

The Compliance report can be accessed via the following Polarsys OpenCert Tools Platform web server 
menu item shown in Figure 339. 
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Figure 339. Menu item directing to the “Compliance report” 

11.2.2  Viewing compliance data on the report 

The Compliance report allows users to see the overall compliance of the selected project to the specific 
safety standard. 

When a specific Assurance Project is selected in the top panel, its defined Baselines are presented in the 
middle panel select box (see Figure 340). 

 

Figure 340. Baseline Frameworks combo box for the specific project 

The report data section is divided into four panels (see Figure 341).  

 

Figure 341. "Compliance report" panels 

The “Project Compliance” table, which is placed in the left, presents base artefacts and base activities of 
the selected safety standard. The most important column is the “Compliance Status” one, which presents 
the overall compliance status of a project to the specific safety standard item. The column can be sorted by 
value, thus allowing user to assess the project compliance at one glance. 

In case base activities or base artefacts are defined to have a parent-child hierarchy, this relation is 
presented accordingly in a tree structure of the table. 

Note: “IA Status” column presents the current status of specific baseline element from Impact Analysis 
point of view. This functionality has been described in section 11.3.3 . 
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When a specific baseline element item (i.e. table row) is selected, its description and properties are 
presented in the bottom-left panel (see Figure 342). 

 

Figure 342. Description of the selected baseline element presented at the bottom panel 

Upon the selection of the specific safety standard item in the “Project Compliance” table on the left of the 
screen, the Compliance Mapping details are presented in the “Base Asset Compliance Details” panel at the 
right side of the page (see Figure 343).  

 

Figure 343. Details of Justification and mapped evidence 

The extensive compliance information (see Figure 344) is presented, including: 

• Compliance justification explanation (as specified in the OpenCert client editor or on this report). 

• For the specific justification: the associated artefact or activity. 

• For the specific artefact, its associated evidence resource files. These resource files are committed 
to the appropriate SVN repository. Users can press the “[Download]” link next to each resource 
tree node in order to download the specific file from the SVN and view it. 
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Figure 344. Compliance evidence of the specific baseline asset 

The above tree can be expanded or collapsed quickly to the desired level by pressing the buttons above it, 
allowing tailoring the presented details to the level needed by a user at a given moment. 

When any of the above tree levels is selected (justification, artefact, or resource), its description and 
properties are presented in the right-bottom panel of the report (see Figure 345). 

 

Figure 345. Specific evidence details description presented at the bottom of the report 

11.2.3  Adding evidence and compliance data  

Additionally, to browsing the project evidence pieces, the report allows users to add, modify and remove 
evidence resources and define a compliance mapping (see Figure 346). 

The “Base Asset Compliance Details” panel on the right-hand side of the report contains an Upload panel 
which allows users to add a specific file resource (containing the evidence), specify the associated artefact 
and define compliance justification text and its type. 

After user presses the “Upload” button or drag and drops the file resource to the panel, the following “New 
Resource Definition” dialog appears:  
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Figure 346. A window allowing to assign and describe evidence to the given baseline item 

The user can enter the desired compliance justification in the text area, change the names to be created 
(default names are suggested) and define the compliance mapping type. 

Additionally, it is possible to specify an SVN URL location where the evidence file will be committed. User 
has a possibility to add new location or select already defined one from the select-box. 

After pressing “Assign” button, the following actions are performed by the Polarsys OpenCert Tools 
Platform: 

• The resource file gets committed to the given SVN repository so that it is securely stored and can be 
retrieved on demand. 

• A resource object (associated with the above file) is created with the specific name. 

• An artefact object (associated with the specific resource) gets created. 

• A compliance justification, which maps the artefact to the selected baseline framework items, gets 
created in OpenCert storage. 

Additionally, the “Modify” and “Unassign” buttons allow to update or revoke the evidence file and 
compliance mapping created above (see Figure 347). 

 

Figure 347. Unassign button allowing to disassociate evidence from the given baseline item 
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11.2.4   Generation of the Summary textual report 

The interactive mode presented in the preceding chapters is very comfortable for users to browse and filter 
data and view their details. Upon each user selection, appropriate details are presented.  

However, there is often a need to generate an overall report, containing all the information visualized in 
one place. This can be easily done using the “Export to MS Word” button (see Figure 348). Upon pressing it, 
a default a docx template report gets filled with the all the Compliance report data presented for the 
specific safety project. 

Note for OpenCert administrators: The docx template used for textual report generation can be changed 
on the OpenCert server side in order to adjust it to the specific company standards. 

 

Figure 348. “Export to MS Word” button which generates textual overall detailed report of Project Compliance to the 
safety standard 

The textual report can then be printed to pdf or on paper, signed digitally or manually, and stored for 
future reference (see Figure 349). 
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Figure 349. First page of the generated textual report 

11.3 Change Impact Analysis 

The Polarys OpenCert Tools Platform provides the implementation of a Change Impact Analysis algorithm. 
It is triggered when any artefact stored in the OpenCert database is modified by the user. The algorithm 
traverses all the related artefacts in order to check if they should be marked as affected by the change, 
depending on the Artefact relation type. 

11.3.1 Change Impact Analysis in the OpenCert Tool Client 

The OpenCert Eclipse client editor is the main tool to add, modify, and remove artefacts and relations 
between them. Similarly, it is the place where Impact Analysis algorithm is triggered when any artefact is 
changed. Similarly, the IA results are presented there. This has been described in the 10.8 Impact analysis 
section. 

11.3.2  Change Impact Analysis algorithm 

This chapter presents technical details describing how the IA algorithm traverses relations between 
Artefacts. 

The main pieces of information used by the IA engine are relations between Artefacts objects stored in 
ArtefactRel entity (see Figure 350). 
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Figure 350. Artefact Model 

Two Artefacts are considered related when there is an ArtefactRel instance pointing to one of them as a 
source and to the other as a target. Please note that ArtefactRel has modificationEffect and 
revocationEffect attributes. 

Note:  An ArtefactRel object for two specific artefacts can be added in the following ways: 

• A user can add this entity manually in the Evidence Editor of OpenCert platform client 

• ArtefactRel entity is added automatically when a parent-child relation is established between 
two artefacts. When adding artefactPart to parentArtefact, a new ArtefactRel object is 
created, with modificationEffect=MODIFY and revocationEffect=MODIFY, source pointing to 
parentArtefact and target to artefactPart. 

It has been arranged that a direction of analysis flow is the following: ArtefactRel “target affects the 
source”.  When impact analysis is started: 

• It starts from artefactCDOId for the specific EventKind (either Modify or Revoke) 

• It looks into the related ArtefactRel (for which the artefactCDOId is a target) object  

• It traverses to the artefact pointed by ArtefactRel source 

• Depending on the initial EventKind (either Modify or Revoke), it takes the value of 
modificationEffect or revocationEffect from the ArtefactRel and assumes the appropriate 
AssuranceAssetEvent on the reached source artefact. 

For example, let’s assume that there are the following Artefact and ArtefactRel dependencies: 

ArtefactA  ---- ArtefactRelA(ModificationEffect:MODIFY, RevocationEffect:REVOKE) --→  ArtefactB 

ArtefactB  ---- ArtefactRelB(ModificationEffect:REVOKE, RevocationEffect:REVOKE) --→  ArtefactC 

ArtefactC  ---- ArtefactRelC(ModificationEffect:MODIFY, RevocationEffect:VALIDATE) --→  ArtefactD 

ArtefactD  ---- ArtefactRelD(ModificationEffect:MODIFY, RevocationEffect:REVOKE) --→  ArtefactE 

The engine starts with EventKind.MODIFICATION for ArtefactA and navigates via ArtefactRelA to ArtefactB 
and because ArtefactRelA:ModificationEffect equals MODIFY, it reaches ArtefactB with 
EventKind.MODIFICATION change effect. 

Note: this change effect event is not saved in storage yet. Now it is only used for further traversal, and 
will be returned as part of the result of listArtefactsRelationImpacts() method. 

The engine continues from ArtefactB with EventKind.MODIFICATION and navigates to ArtefactC and 
because ArtefactRelB:ModificationEffect equals REVOKE,  it reaches ArtefactC with EventKind.REVOKE 
change effect. 
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The engine continues from ArtefactC with EventKind.REVOCATION and traversal path ends here because of 
ArtefactRelC:RevocationEffect equals VALIDATE. 

Thus, the result is: 

• ArtefactRelA - ModificationEffect.MODIFY 

• ArtefactRelB - ModificationEffect.REVOKE 

The above algorithm affects the Artefact lifecycle. States of this lifecycle are presented on the Figure 351. 

 

Figure 351. Artefact lifecycle from the IA point of view 

Some of these states require action from the user, such as like “To validate” and “To modify”. To address 
some restrictions these two states are recognized by the presence of a given event date or lack of it. This 
signals that action from the user is required and after this action, the date of the event is set. 

11.3.3 Impact Analysis Result Presentation on the OpenCert Tool Server Reports 

IA-induced user actions that need to be performed in the Assurance Project are presented on the 
Compliance Estimation Report and the Compliance Report (see Figure 352).  

Hereafter is a description of Impact Analysis results being presented on these reports. 
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Figure 352. Web interface showing two IA-induced actions required to be taken by the user 

In the “Project Compliance” table on the left panel, the “IA Status” column presents the status of the 
specific baseline element from Impact Analysis point of view. The following information is presented: 

• Grey colour means that there is no artefact compliant to this baseline element, thus there is no 
entity on which IA can work. 

• Red colour means that some of the artefacts compliant with this baseline element where affected 
by AI and require attention from the user. The displayed number represents the amount of such 
affected artefacts. 

• Green colour means that there is no action required by IA from the user after IA traversed the 
associated artefacts. 

On the “Base Asset Compliance Details” panel the compliant artefacts and their details are presented. 

The information also includes IA results in case the IA algorithm detected that some action needs to be 
performed by a user. 

As it regards the above screenshot, the IA execution resulted in detection of two actions required by the 
user: “To validate” and “To modify”. This information is presented next to the respective artefacts. 

When the user takes the according measures (i.e. validates or modifies the respective artefacts) he can 
simply click on “Modified” and “Validated” action buttons to report that the requested activity has been 
performed. 

11.4 Gap Analysis Report - Compliance Assessment and Evidence 
Evaluation 

Gap Analysis report (see Figure 353) facilitates the following pieces of functionality: 

• Compliance Assessment by viewing a Gap Analysis  

• Viewing Evidence Evaluation results 
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In order to view Gap Analysis report, please go to the Polarys OpenCert Tools Platform web server page in 
your web browser at http://<AMASS-SERVER-HOST-NAME>:8080/. and select “Reports → Gap Analysis 
report” from the menu. 

 

Figure 353. Gap Analysis report 

11.4.1  Gap Analysis Report core functionality 

The Gap Analysis report presents summary and details regarding specific assurance project base artefacts 
and base activities and their compliance mapping to the actual evidence and activities. 

For the selected assurance project its baseline frameworks are presented in a select box (see Figure 354).  

 

Figure 354. Baseline frameworks for the specific assurance project 

After choosing the specific baseline framework, the following gap analysis data is presented: 

• In a left pane, called “Project Baseline Compliance”, base artefacts and base activities of the 
selected project baseline framework are shown. They are displayed in a tree structure to express 
the parent-child hierarchy of these items. For each base artefact or base activity, the total numbers 
of fully- and partially- compliant assets are presented. 

The “Project Baseline Compliance” table can be filtered to show only base artefacts or base 
activities and can be sorted by any column (see Figure 355). 
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Figure 355. Project baseline compliance table 

• When the user selects the specific cell in the left pane table (e.g. specific base artefact or the 
number of fully- or partially-compliant assets), the right panel is refreshed with the details 
regarding the selected item. 

• For specific base artefact or base activity selected in the left panel, the right details panel presents 
the following information (see Figure 356): 

o Summary of the specific base artefact or base activity compliance mapping. 

o For the given base artefact and base activity: Compliance Justification elements from its 
compliance mapping. 

o For each Compliance Justification: the actual assets i.e. artefacts or activities. 

o For each artefact or activity: its description and properties are presented on the tooltip. 

o For each artefact or activity: its evaluation is shown - in case the asset has been evaluated. 

 

Figure 356. Compliance details for the selected baseline element 

 The “Compliance Details” tree (see Figure 357) can be expanded to the specific level by pressing 
the links at the top of the panel. 
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Figure 357. Compliance details 

For example, if the user is interested only in justification or assets or their evaluation, the [Expand to 
Justification], [Expand to Asset] or [Expand to Evaluation] links can be pressed respectively. The details tree 
is expanded accordingly. 

11.4.2  Viewing Evidence Evaluation in the Gap Analysis report 

In case a specific evidence item has been evaluated in the OpenCert client tool, its evaluation data are 
shown on the Gap Analysis report. 

All the evaluation properties (Id, Criterion, Evaluation result, etc.), and the evaluation date and time are 
presented (see Figure 358). 

 

Figure 358. Evidence evaluation details 

11.5 Metrics Reports 

This chapter presents the implemented metric reports, their functionality and layout. 

11.5.1  Metrics Estimation report 

The Metrics Estimation Report can be accessed via the following Polarys OpenCert Tools Platform web 
server menu item shown in Figure 359: 
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Figure 359. Menu item directing to "Metrics Estimation report" 

When a specific safety project is selected in the top panel, its defined baselines are presented in the middle 
panel select box, as shown in Figure 360. 

The report data is divided into two panels. The first one, on the left, is a static menu panel in which the user 
can select a type of metrics to analyse. 

 

Figure 360. Metrics Menu in the top-left portion of the report 

Once a specific metrics is selected on the Metrics menu, the metrics menu details are presented in the right 
part of the report with a description of the main goal and all the different types of charts related to that 
metric.  

Also, the user has the option to export the selected metric to a Word document with more detailed 
information.  

As a small example, the Figure 361: 
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Figure 361. Description of the selected metric type presented at the left 

11.5.2  Equivalence Map report 

The Equivalence Map Report can be accessed via the following Polarsys OpenCert Tools Platform web 
server menu item as showed beforehand. 

In this case the equivalence metrics are between two Reference frameworks, no specific safety project 
needs to be selected in the top panel. The only possible configurations are between reference frameworks 
as shown in the Figure 362. 

 

Figure 362. Selection of reference frameworks 

After the selection, the metrics of the equivalence maps and a detailed description are showed on the 
screen (see Figure 363). There is also a possibility to export this information to a Word document. 
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Figure 363. Equivalence Map Report 

11.6 Administration Web GUI 

The Polarsys OpenCert Tools Platform server provides a few basic web pages for server administration. 

They are accessible through “Administration” menu (see Figure 364). 

 

Figure 364. Administration menu 

11.6.1  Projects Administration page 

This administration page (see Figure 365) facilitates editing some basic project actions. For more advanced 
project editing functionality, the Polarsys OpenCert Tools Platform  Client Editor should be used (see 
section 6 Assurance Project Management). 

The Project Administration page allows the following basic actions: 

• Project name and description editing. 

• Project baseline name editing.  

Note that only one baseline of the project is presented. 

• Project baseline element editing. 

The user can add, remove and modify baseline elements. 

For the specific baseline element, its name and description can be specified. 
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Figure 365. Project Administration web page on the Polarsys OpenCert Tools Platform server 

11.6.2  Create sample data 

The Polarsys OpenCert Tools Platform server administration web page provides a functionality that allows 
to generate sample data in the database (see Figure 366). The sample data can be generated for example in 
order to demonstrate the Gap Analysis report. 

A user can generate the following sample data for the selected Assurance Project: 

• Baseline framework 

• Base artefacts 

• Base activities 

• Artefacts and Activities being mapped with Compliance Mapping to the base artefacts and base 
activities. 

 

Figure 366. Create sample data page 

After pressing the “Generate Data” button, sample data will be created and inserted into the selected 
Assurance Project. 
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11.6.3  Configuration settings 

This web page presents the main configuration settings of the Polarsys OpenCert Tools Platform server (see 
Figure 367). 

These settings are stored and can be modified on the server host, in opencert-properties.xml file which is 
present in the operating system user home directory. 

 

Figure 367. Configuration Settings Window  
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12. Engineering of Process, Product and Assurance Case Lines 

12.1 Engineering of Process Lines 

The process modelling with EPF Composer is discussed in Section 4. The work breakdown structure of a 
delivery process is shown in Figure 368. The capability pattern software design and implementation 
engineering process hold process knowledge for a key area of interest, but the complete lifecycle is 
modelled as Delivery Process. The used capability pattern is constituted of design of software items, coding 
and testing, and integration phases. The integration, for instance, is composed of two tasks: develop 
software integration test plan, and integration and testing software units. 

 

 Figure 368. Process modelled in EPF Composer 

12.1.1  Importing Library and fixing the problems 

The EPF Composer has been integrated in the Polarsys OpenCert Tools Platform Client. The user can switch 
to the authoring, browsing or other available perspectives in the bundle. The EPF Composer persists the 
Method Library contents in their own folders and XMI files, in particular, method plugins, processes, 
content descriptions and configurations. So, when a new Capability Pattern or Delivery Process is created, 
the model.xmi and content.xmi files are created in a new directory, and the reference of new process is 
added to the plugin.xmi file. However, the XMI files produced by the EPF Composer cannot be directly 
opened, the UMA based exceptions have been raised, as shown in  Figure 369. 
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Figure 369. Persistence of method library contents 

The problems with XMI files needed to be resolved for mapping the elements of a target configuration and 
variability abstractions in BVR. For this reason, a dialogue wizard has been implemented, as shown in Figure 
370, where the recent/default path choice is automatically filled in the path text box otherwise the path 
containing a specific method library might be browsed. The dialogue wizard performs two tasks: (i) copies 
the contents of the Method Library in the target directory; and (ii) resolves problems with the XMI files. The 
error free models are made available in the project folder. All the model files can be opened, for example, 
method configurations, method plugins, method content descriptions and processes. 

 

Figure 370. The achievement of error free models 
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12.1.2  Creation of a BVR Model 

The wizard for creating a new BVR model can be located under the “Example EMF Model Creation” 
Wizards, as shown in Figure 371. 

 

Figure 371. Selecting a model creation wizard 

After giving a name and selection of model object, click the “Finish” button as shown in Figure 372. This 
creates a BVR model. 
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Figure 372. Selecting a file name and model object 

The created BVR model can be opened with the VSpec, Resolution and Realization editors, as shown in 
Figure 373. 

 

Figure 373. Opening a model with different editors 

12.1.3  Process Variability Management with the BVR Editors 

The generation of target configurations for a software process modelled in EPF Composer is performed 
with BVR VSpec, Resolution, and Realization editors. The detailed instructions are specified in the 
Deliverable 4.3 of VARIES (VARiability In safety-critical Embedded Systems) project [14]. 

Tailoring rules for the software design and implementation engineering process (Section 5.5 of ECSS-E-ST-
40C standard) are modelled in the VSpec editor, as shown in Figure 374. The VSpec model shows the tree 
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structure representing logical constraints to be considered during the resolution. The solid line indicates 
that the particular feature applies to all criticality levels, whereas the dashed line represents a variation 
point. The whole tree cannot be visualized due to space limitations; therefore, the minimize option (+) is 
used for hiding the features.  

The tasks associated with “Software integration test plan development”, and “Software units” and 
“Software component integration and testing” are marked as optional. The multiplicity xor (1..1) is assigned 
to the criticality; therefore exactly one out of A, B, C and D must be selected for the software product. As 
the choices are associated with multiple criticality levels, the constraints have been applied; valid tailoring 
is guaranteed if the constraints are properly specified. For instance, the constraint “(A or B) implies (not 
Software_integration_test_plan)” indicates that the Software_integration_test_plan must be excluded for 
processes with criticality A or B. Likewise, the constraint “C implies (Software_integration_test_plan and 
((not SUITP_K9) and (not SUITP_K10)))” enforces inclusion of Software_integration_test_plan, but also 
exclusion of SUITP K.9 and K10 for criticality C. 

 

Figure 374. VSpec editor 

The resolution models are automatically generated from the VSpec model (the “New” option in menu by 
right clicking is used), but the choices need to be included or excluded for individual processes. In this 
regard, multiple resolutions might be defined for the process with variability, as shown in Figure 375. The 
implemented editor supports error checking and validation of resolutions. 

 

Figure 375. Resolution editor 

The derivation process involves the substitutions in which elements of a placement fragment are removed 
and elements of a replacement are injected. To create the placements and replacements, the elements 
from the models are dragged and dropped on the Realization Editor, as shown in Figure 376. It is therefore 
possible to define the placements and replacements between multiple models. The placements are 
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visualized in red, while the replacements in blue colour. It might be noted that the error-free-models are 
opened with the Sample Reflective Ecore Model Editor. 

 

Figure 376. Creation of placements and replacements 

To create a fragment substitution, there is a need to select a placement and a replacement, as shown in 
Figure 377. As the requirements are either included or excluded based on the criticality of the system, the 
bindings specify the replacements with NULL elements. Otherwise the specific replacement elements need 
to be selected in the “Bindings” tab. The variation points also refer to the VSpecs. The execution of 
variation points is dependent on the true of assigned choices in the resolution. If an assigned choice is true 
in a executed resolution then the variation point is also executed. 

 

Figure 377. Fragment Substitution 

12.1.4  Deriving the Processes and Export Back 

In order to derive the configuration, the “Execute” menu option a in particular resolution is selected, as 
shown in Figure 378; the base model has been selected in the Navigator view. This generates the desired 
models that are automatically exported back to the EPF Composer. 
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Figure 378. Resolution execution 

The tailored models are automatically exported back to the desired locations, as shown in Figure 379. The 
changes for resolving problems in XMI files and supporting the communication with the Realization editor 
had been reverted back in the exported models. 

 

 

Figure 379. Tailored model 

12.2 Engineering of Product Lines 

To be able to engineer the intra and cross domain product lines, the integration between the CHESS Tool 
and the BVR Tool is achieved. 

12.2.1  System Modelling in CHESS 

The CHESS Tool is built on top of Eclipse Papyrus. Similar to the Papyrus, the CHESS model is stored in .di, 
.notation and .uml files. Section 7 discusses the system specification in the CHESS Tool. 

Let’s consider the four different variants/configurations of variable attitude and orbit control subsystem, as 
shown in Figure 380: (i) Sun Sensors Thrusters (SSTH); (ii) Sun Sensors Reaction Wheels (SSRW); (iii) Star 
Tracker Thrusters (STTH); and (iv) Star Tracker Reaction Wheels (STRW). 
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Figure 380.  SSTH, SSRW, STTH and STRW Configurations 

The software functional modules of attitude and orbit control subsystem are classified into five groups: 
sensor processing, estimation, guidance, control and command distribution. Besides that, the hardware 
components have been taken into consideration, as shown in Figure 381. 
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Figure 381. CHESS model 

A variant of attitude and orbit control system is illustrated in Figure 382. The sun sensors together with 
magnetometer are used to provide full attitude determination capability, the spacecraft attitude is 
modified using a thruster actuation system, which is able to provide a control torque in any direction. 

  



 

         AMASS AMASS Platform User Manual V1.0 

 

H2020-JTI-ECSEL-2015 # 692474 Page 256 of 295 
 

 

Figure 382. SSTH Variant 

12.2.2  Product Variability Management with the BVR Editors 

In a similar manner to the process lines, the generation of target product configurations is performed with 
three editors: VSpec, Resolution, and Realization. 

At first, the variability of attitude and orbit control subsystem has been modelled in the VSpec editor, as 
shown in Figure 383. The mandatory features are connected to the parent feature via solid lines, whereas 
the dashed lines represent optionality. The constraints have also been enforced in which the logical 
operators such as implication, alternative, negation might be used. 

 

Figure 383. VSpec editor 

Then, four different resolutions/configurations have been specified for the variable attitude and orbit 
control subsystem, as shown in Figure 384. 

 

Figure 384. Resolution editor 

Finally, the placements and replacements have been defined for the variations in .uml file, as shown in 
Figure 385. The execution of variation points is dependent on the true of assigned choices (VSpecs) in the 
resolution. If an assigned choice is true in the executed resolution, then the variation points are also 
executed. 
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Figure 385. Realization editor 

12.2.3  Deriving the Products and Export Back 

The execution of resolution generates the Product Model, which is automatically exported back to the 
CHESS Tool. In the final version of the Polarys OpenCert Tools Platform, the visualization of tailored models 
is supported. Figure 386 shows the generated product model for Star Tracker - Reaction Wheels (STRW). 

 

Figure 386. STRW Variant 

12.3 Engineering of Assurance Case Lines 

In a similar manner to the process and product lines, the OpenCert Tool and BVR Tool are integrated for the 
engineering of Assurance Case Lines. 

12.3.1  System Modelling in OpenCert 

Figure 387 shows a fragment modelled by using the Assurance Case editor of OpenCert. The interested 
reader might have a look at Section 9, which discusses the Assurance Argumentation Management. 
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Figure 387. Argumentation for FLEDS in OpenCert  

12.3.2  Assurance Case Variability Management with the BVR Editors 

Similar to the process and product lines, the generation of target assurance cases is performed with three 
editors: VSpec, Resolution, and Realization.  

The VSpec model is shown in Figure 388. It presents the tree structure with logical constraints to be 
checked during the resolution. G5 and G6 represent alternative argumentation fragments. For instance, the 
constraint “Truck implies G5” indicates that the choice G5 must be included in the resolution for Truck. 
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Figure 388. VSpec editor  

The Resolution Models, shown in Figure 389, represent the two possible argumentation configurations (one 
in case of Truck and the other in case of vehicle type different from Truck (Other)). 

 

Figure 389. Resolution editor  
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Figure 390 represents the Realization model. In this realization, the other configuration of the 
argumentation is realised. Based on the choices set within the Resolution Model, substitutions are specified 
and executed. Based on the specified substitutions, left part of Figure 390, elements of a placement 
fragment are removed, and elements of a replacement are injected. The placements are visualized in red.  

 

Figure 390. Realization editor  

12.3.3  Deriving the Assurance Cases and Export Back 

The execution of resolution generates the Assurance Case Model. The re-configured model and diagram are 
updated in the Assurance Case Editor of OpenCert. The new configuration, where G6 is present instead of 
G5, is shown in Figure 391. 

 



 

         AMASS AMASS Platform User Manual V1.0 

 

H2020-JTI-ECSEL-2015 # 692474 Page 261 of 295 
 

 

Figure 391. Re-configured argumentation fragment  
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13. Integration with External Tools 

This section explains how to connect to the Polarys OpenCert Tools Platform with third-party tools such as 
system modelling and V&V tools. 

13.1 V&V Tools (FBK) 

V&V activities of models can be performed by using some FBK Tools, specifically OCRA for contract-based 
verification and nuXmv for the behaviour verification. The integration with the Polarys OpenCert Tools 
Platform is done by means of adapters; currently two kind of tool adapters are available: the first one that 
invokes the FBK tools locally by passing the artefacts and the command via files. The second that does the 
same functionalities via the OSLC-Automation adapter. 

Integration to FBK Tools via files 

As mentioned before, the tools have to be installed locally to the Polarys OpenCert Tools Platform; once 
downloaded the tools from the FBK site11, we need to configure the adapter in the way explained in the 
section 7.17. 

Integration to FBK Tools via OSLC 

FBK exposes the OSLC service provider that allows the tool integration remotely. At the address 
http://docker-es.fbk.eu:8080 responds both the registry server and the automation server. Even in this 
case we need to configure the adapter in the way explained in the section 7.17. 

13.2 VERIFICATION Studio12 /OSLC-KM 

OSLC-KM standard allows exchanging artefact contents from different and heterogeneous sources. In this 
way, TRC has integrated some of the activities and functionalities of its VERIFICATION Studio application 
within the Polarys OpenCert Tools Platform platform. In the scope of the final version of the Platform, the 
integration has been done in two different ways:  

1. Inside the Polarys OpenCert Tools Platform, to import models as evidences for any Assurance 
Project.  

2. From VERIFICATION Studio to the Polarys OpenCert Tools Platform, to insert quality assessments of 
the model or requirement specification, as Evidences in any Assurance Project. 

Both ways will be described in the following sections. 

13.2.1 From the Polarsys OpenCert Tools Platform 

The idea is to retrieve meaningful information from any model in the scope of the project to be assured, 
scan it with TRC technology and populate the evidences for this project with the output information. 

Technically, it works in the following way: TRC has exposed a web service (available at 
http://authoring.reusecompany.com:9999/OslcKmService.svc/GetSrlFromContent) which receives the 
content of the model, scans it and returns an instance of the OSLC-KM standard to the Polarys OpenCert 
Tools Platform. Then, the platform receives and transforms it to an instance of an evidence. Finally, this 
evidence is saved in the current project. 

                                                             
11 http://es.fbk.eu/technologies 
12 VERIFICATION Studio is the new name of the formerly known as Requirements Quality Analyzer tool by TRC (or RQA 
for short) 

http://docker-es.fbk.eu:8080/
http://authoring.reusecompany.com:9999/OslcKmService.svc/GetSrlFromContent
http://es.fbk.eu/technologies
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From the user point of view inside the Polarys OpenCert Tools Platform application, the user can find a new 
menu option whose name is “OSLC-KM” with several submenus, the relevant one for this integration is 
“Import evidence model from file” (see Figure 392).  

 

Figure 392. New OSLC-KM menu option 

Click the menu entry “OSLC-KM → Import evidence model from file” (see Figure 393). Then select, for 
example, a Papyrus file (Figure 394).  

 

Figure 393. OSLC-KM Importing an Evidence Model from a model file 

 

Figure 394. Fragment of a Papyrus model to be imported 

A wizard will be shown to include all the parameters needed for this importation. This wizard comprises 
two steps.  

The first one is designed to gather all the inputs related to the OSLC-KM file to be imported (see Figure 
395):  

• the type of file to be parsed 

• the file itself 

• an additional transformation file to fine-tune the default OSLC-KM generation from the file type. 
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Figure 395. Step #1 of the OSLC-KM Evidence Manager Importer 

The second step is designed to gather all the inputs about the storage of the new Evidence data (see Figure 
396): its Assurance Project and the name it will have. 

As a result, the Evidence content is sent to a VERIFICATION Studio web service that works as an OSLC 
producer. The web method returns the OSLC-KM instance, then the Polarys OpenCert Tools Platform loads 
the model by the Java implementation of the OSLC-KM standards and maps its content to an Artefact 
Model inside the current Assurance Project (see Figure 397). 

 

Figure 396. Step #2 of the OSLC-KM Evidence Manager Importer 
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Figure 397. New evidence model from a Papyrus model 
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The location of the VERIFICATION Studio web service can be changed in the “Window → Preferences” 
menu entry. 

In the Preferences window there is an option with the name “OSLC-KM Preferences” where the URL of this 
web service is configured (Figure 398).  

This web service is publicly available at the following URL: 

http://authoring.reusecompany.com:9999/OslcKmService.svc/GetSrlFromContent 
 

 

Figure 398. OSLC-KM Preferences. Web Service URL 

This web service can transform files created from many different tools into OSLC-KM: 

• Microsoft Excel 

• Standard XMI (output from many UML tools) 

• SysML from Rhapsody 

• SysML from Papyrus 

• SysML from Magic Draw 

• SysML from Other tool providers 

• Simulink 

• ASCE 

• FMI/FMU 

• Pure Variance 

• Metadata 

• SQL 

http://authoring.reusecompany.com:9999/OslcKmService.svc/GetSrlFromContent
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• XML 

• SRL encoded in JSON format 

13.2.2 From SE Suite tools 

In the VERIFICATION Studio, the OSLC-KM standard can be the source to retrieve work-products from many 
different tools to assess its quality: 

1. The tools expect these work-products either directly (the source tool is also provider of the OSLC-
KM instance) via a web service or via an application API.  

2. Other possibility is to perform the parsing of the structured information from the source file to 
produce the instance of OSLC-KM, provided that the metamodel of the information is known, such 
as an XMI file coming out of a modelling tool. 

3. The last possibility is like the previous one, but the input is not a file, but the output of an SQL 
query to a database. 

This can be done in the VERIFICATION Studio connection window by selecting a new OSLC-KM connection 
(Figure 399) and then, in the new window, selecting a suitable source (Figure 400).   

 

Figure 399. VERIFICATION Studio Connection Window 
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Figure 400. OSLC-KM Connection (SysML Papyrus sub-type) 

In the OSLC-KM connection edition window, there are three different options to select the source of the 
information to match the input possibilities described at the top of this chapter. Once the input type source 
is selected, the window reconfigures automatically to ask for further parameters, depending on the source 
selected (see Figure 401 - Figure 404): 

• OSLC Service: this is a provider of OSLC-KM in the form of a web service. It can be the web service 
described in the integration from the Polarys OpenCert Tools Platform, where the input content of 
a file is transformed in OSLC-KM, or any other web service that offers it in its API.  

Extra parameters needed to be provided for this type:  

o The type of input.  

o The URL of the web service. 

 

 

Figure 401. OSLC-KM input type: Web Service 
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• File: when selecting a file input format, the transformation will be done using the default 
parameters in the OSLC-KM connector. These can be fine-tuned if necessary to add additional 
parameters or an extra XSLT transformation schema. 

Extra parameters needed to be provided for this type:  

o The type of input.  

o The location of the file. 

 

Figure 402. OSLC-KM input type: File 

• Database: with this source a user can describe all the parameters to connect to a database that can 

use OLEDB drivers (Access, SQL Server, Oracle) and provide a SQL query that will retrieve a set of 

rows. These rows will be parsed into OSLC-KM and loaded into the tool. 

Extra parameters needed to be provided for this type:  

o The connection parameters to the database. 
o The SQL query to be executed. 

 

Figure 403. OSLC-KM input type: Database 
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Figure 404. OSLC-KM input type: Database connection parameters window 

After selecting the type of the input and basic parameters to retrieve its contents, further refinement of the 
parsing of the content can be done; from the OSLC-KM connection window, the SRL Content selection 
window lets users specify the exact mappings between the inputs in the file and the SE Suite categories. It 
can be used an ad-hoc mapping (the green button shown in the Figure 405 will show the mappings edition 
window as in Figure 406) or an existing mapping file (the file selector on the right side of  Figure 406).  

 

Figure 405. OSLC-KM mappings selector 
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Figure 406. OSLC-KM mappings edition window 

After dealing with the input type, its basic parameters and mappings, an optional configuration can be 
specified to do the following (see Figure 407):  

• Include a work-product containing all the work products found in the OSLC-KM source to allow 
execution of completeness and consistency metrics over the whole source regardless the parts it’s 
divided into.  

• Include a “missing information” work product if the source of the OSLC-KM is not present in the 
given configuration. 

 

Figure 407. OSLC-KM connection window. Optional configuration 

Finally, the user can set rules based on the knowledge database which the SE Suite tools can use to 
distinguish work products that are useful for quality assessment from those that are not (see Figure 408). 
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Figure 408. OSLC-KM connection window. Custom-code filtering 

For example, a new connection to a CHESS model in a file will be created using this OSLC-KM connector: 

1. Create a new OSLC-KM connection in VERIFICATION Studio to reference the CHESS project (see  
Figure 409). 

 

Figure 409. VERIFICATION Studio Connection Window 

2. In the OSLC-KM Connection window select the project and complete the rest of configuration 
values (see Figure 410). In order to get detailed information of the different parameters see the 
AMASS deliverable D5.6 [3], section 2.2.3.5. 
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Figure 410. OSLC-KM Connection (SysML CHESS sub-type) 

3. When the configuration is created it is possible to connect to the project and the artefacts of the 
model are imported to VERIFICATION Studio tool (see Figure 411). 
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Figure 411. VERIFICATION Studio Connection Window 

4. In order to assess the quality of the model, it is necessary to select a template that stores the set of 
metrics. For further information of the metrics [17] (see Figure 412 and Figure 413). 

 

Figure 412. Information message to select a set of metrics 
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Figure 413. Window with the templates store in VERIFICATION Studio that contains the set of metrics 

5. When the template is selected, VERIFICATION Studio is ready to assess the quality of the model. It 
is possible to assess the quality for correctness, completeness and consistency metrics (see Figure 
414 and Figure 415).  

 

Figure 414. VERIFICATION Studio ready to assess the quality 
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Figure 415. Detail of the assessment options  

6. Once the model has been assessed, the quality of the different artefacts of the model is shown in 
the VERIFICATION Studio tool (see Figure 416). This quality measure can be exported as evidence to 
an AMASS repository. For this, it is necessary to include the location of the server and select the 
project (see Figure 417 and Figure 418).  

 

Figure 416. Quality information of the model in the VERIFICATION Studio 
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Figure 417. Connection window to export the evidence in an AMASS repository 

 

Figure 418. Information message of the stored process. 

7. Following, the detail with the evidence stored in the assurance project is shown (see Figure 419). 

 

Figure 419. Evidence stored in the assurance project 
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13.3 Safety & Security Co-Analysis Tool 

Safety and security co-analysis of models can be performed by using the integration of the Polarys 
OpenCert Tools Platform with ALL4TEC tools (Safety Architect and Cyber Architect). Safety Architect is 
integrated in the platform (CHESS tool) as external tool, to support safety and security co-analysis. Cyber 
Architect is not directly linked to the Polarys OpenCert Tools Platform, but it is indirectly linked via the 
interoperability between CHESS and Safety Architect, and the bridge between Safety Architect and Cyber 
Architect.  

ALL4TEC tools are commercial tools, but to evaluate its integration with the Polarys OpenCert Tools 
Platform, either the 30-days evaluation bundle can be downloaded in the tool website13 or an evaluation of 
the bundle can be asked to the tool support14.  

The integration plugin, described in the deliverable D5.6 [3], is integrated directly to the Safety Architect 
bundle, as depicted in Figure 420. 

 

Figure 420. Import from the CHESS tool to the Safety Architect tool 

The user manuals of ALL4TEC’s tools are directly integrated in the tools or can be found in the website15. 
The usage scenario of the safety and security co-analysis with the Polarys OpenCert Tools Platform and 
ALL4TEC tools is described in D4.8 [4] . 

13.4 SVN 

The current support for integration with SVN is part of the functionality for Evidence Management. It is 
presented in Section 10.1. 

  

                                                             
13 https://www.all4tec.com/safety-architect  

14 mailto: support@all4tec.net 

15 https://www.all4tec.net/safety-architect-help-and-user-manual  

https://www.all4tec.com/safety-architect
mailto:support@all4tec.net
https://www.all4tec.net/safety-architect-help-and-user-manual
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Abbreviations 

AMASS Architecture-driven, Multi-concern and Seamless Assurance and Certification of 
Cyber-Physical Systems 

API Application Programming Interface 

ARTA AMASS Reference Tool Architecture 

ASIL Automotive Safety Integrity Level 

BDD Block Definition Diagrams 

BVR Base Variability Resolution 

CDO Connected Data Objects 

CHESS Composition with Guarantees for High-integrity Embedded Software Components 
Assembly 

CM Compliance Map 

CSD Composite Structure Diagram 

EPF Eclipse Process Framework 

EPF-C EPF Composer 

FLA Failure Logic Analysis 

FMEA Failure Mode and Effects Analysis 

FMI Functional Mock-up Interface 

FMU Functional Mock-up Unit 

FPTC Failure Propagation Transformation Calculus 

FTA Fault Tree Analysis 

GSN Goal Structuring Notation 

HTML HyperText Markup Language 

HRELTL Hybrid Linear Temporal Logic with Regular Expressions 

IA Impact Analysis 

IBD Internal Block Diagram 

ISO International Organization for Standardization 

JSON JavaScript Object Notation 

LTL Linear Temporal Logic 

KM Knowledge Management 

MARTE Modelling and Analysis of Real Time and Embedded systems 

OCRA Othello Contracts Refinement Analysis 

OLEDB Object Linking and Embedding for Databases 

OSLC Open Services for Lifecycle Collaboration 

OSS OCRA System Specification 

ReqIF Requirements Interchange Format 

RF Reference Framework 

RMC Rational Method Composer 

RQA Requirements Quality Analyzer 

SIL Safety Integrity Level 

SPEM Software & Systems Process Engineering Metamodel 

SQL Structured Query Language 

SRL System Representation Language 

SSRW Sun Sensors Reaction Wheels 
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SSTH Sun Sensors Thrusters 

STRW Star Tracker Reaction Wheels 

STTH Star Tracker Thrusters 

SVN Subversion 

SW SoftWare 

SysML System Modelling Language 

UMA Unified Method Architecture 

UML Unified Modelling Language 

URI Uniform Resource Identifier 

URL Uniform Resource Locator 

V&V Verification & Validation 

XML eXtended Markup Language 

XSLT eXtensible Stylesheet Language Transformations 
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Appendix A. Standard Modelling and compliance in EPF-C 

Standard modelling and compliance have been approached in the commercial version of the EPF 
Composer, the IBM Rational Method Composer (RMC) [8]. This feature of the tool is based on the capacity 
of RMC to define new process elements. Specifically, in this solution, a new type of process element named 
Requirement is modelled and instantiated to define standard requirements. However, this functionality is 
not at disposal in the EPF Composer. In the following subsections, we describe how this solution can be 
adopted in EPF-C.  

A.1 Standard Modelling 

So, in order to define requirements in EPF-C, we exploit the Variability Mechanisms of SPEM 2.0 that are at 
disposal in this tool. Our idea is to define a customized Practice to represent requirements that will be 
extended and customized to define requirements contained in standards.  

The definition of the customized practice to represent the base requirement will be as follows. A new 
Practice with name “requirement” is defined in the plug-in (Section 7.2.2 of the EPF-C manual [8]). Then, in 
the Icon section of the “Description” tab, the icon of a target is included by clicking “Select…” in sections 
“Shape Icon Preview:” and “Node Icon Preview:” (see Figure 421). This step is optional, but it helps to 
distinguish better Requirements from regular Practices. In order to facilitate this initial step, in the context 
of the AMASS project a plug-in named compliance_modelling has been defined with the Requirement 
practice defined and customized, which can be imported (see Section 10.8 of EPF-C manual) in the method 
library that requires Standard Modelling. 

 

Figure 421. Icon customization of Requirement practice 

In order to define requirements of a specific standard, create a new plug-in and a content package. In the 
Guidance folder of this plug-in, create a regular Practice but in the “Content Variability” (see Figure 422) 
section of the “Description” tab, select “Extends” in the Variability Type field and click “Select…”. In the new 
dialog that appears, select the requirement practice that has been defined (or it is in the 
compliance_modeling plug-in). Then, give a name and an appropriate description for the requirement. 
Optionally, customize this new requirement using an Icon. Repeat the same method to define new 
requirements. 
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Figure 422. Definition of a new standard requirement. 

Requirements can be nested and composed to emulate the structure of the standard or define multi-part 
requirements. To include a requirement inside another requirement, right click and select “New → 
Practice” and follow the method described behind to define a new standard requirement. Using this 
procedure, a requirements structure such as the one depicted in Figure 423 can be obtained. 

 

Figure 423. Standard requirements modeled in the EPF Composer. 

A.2 Process Compliance 

Process compliance can be modelled in EPF-C using a similar procedure to those presented in [8]. In order 
to apply this step, first model the lifecycle contained in the standard as a process in the EPF Composer (see 
Section 4 of this manual) in a separate plug-in. Then, define a new plug-in that will be used just to map the 
compliance of the process with the standard. So, in this point, three plug-ins (at least) are available in our 
Method Library, one to model the standard, another to model the lifecycle and a third one, for the mapping 
(see Figure 424). This procedure makes possible to re-use processes and standards in different mappings 
for compliance. 
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Figure 424. Method library organization for standard mapping. 

In the plug-in for the mapping, make a copy of all the requirements that have been defined in the plug-in 
for the standard. To do so, select all the requirements, right click and select “Copy”. Then, in the Guidance 
folder of the plug-in for mapping, right click and select “Paste”. Then, modify each copied requirement in 
the plug-in for compliance in the following way. In the Content Variability section of the Description tab, 
replace “Extends” by “Contributes” and click “Select…” to select the original requirement which is in the 
plug-in for the standard. Figure 425 shows an example of the modification of the copied requirement.  
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Figure 425. Mapped Requirements in the EPF Composer. 

The next step to model the compliance is to link this requirement with the evidence of the accomplishment 
of this requirement. To do so, select the “References” tab in the copied requirement and click “Add…”. In 
the dialog that appears, select the process element that demonstrates the satisfaction of the requirement. 
In this case, the following types of process elements can be provided: Activity, Capability Pattern, Delivery 
Process and Guidance. The EPF Composer allows to add other kind of process elements such as work 
products, roles and tasks but the mentioned elements are the only ones that can be taken directly from the 
lifecycle of the standard to demonstrate its compliance. By instance, for the “Development of the 
Software” requirement the activity “Develop software” is provided as evidence (see Figure 426).  

 

Figure 426. “Preview” tab of the mapped requirement "Development of the Software". 

Three different situations of compliance can be modelled using this solution: full, no-compliance or partial 
compliance. The full compliance of a requirement is modelled providing evidence for the requirement or 
each sub-requirement in case of multi-part requirements such as “coding_and_testing” in Figure 423. The 
no compliance is modelled by not providing any kind of evidence. Finally, the partial compliance is 
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modelled by decomposing a requirement in sub-requirements. Then, for each part of the requirement 
which is accomplished, evidence is provided and for those sub-requirements not satisfied nothing is 
provided. This is the situation of the “Document sys requirements” requirement in Figure 427. The sub-
requirement “Detail a use case” is accomplished, while the sub-requirement “Identify and outline 
requirements” is not accomplished. 

 

Figure 427. Compliance situations in the EPF Composer. 

Mapped requirements can be grouped in Custom Categories to facilitate their visualization in the Browsing 
perspective. To do so, create a new Custom Category (Section 4.5.3 of EPF-C manual [6]) in the plug-in for 
the mapped requirements named “Mapped Requirements”. In the “Assign” tab of this Custom Category, 
assign all requirements of this plug-in.  

A.3 Recommendation Tables Modelling 

Using the same principles of the customization and extension of practices used for requirements, a method 
to model recommendation tables in the EPF Composer has been developed. These new concepts can be 
found in the compliance_modeling plugin in the content package named recommendation_tables (see 
Figure 428). In order to illustrate the modelling of the recommendation tables, we use portions of ISO 
26262. 

 

Figure 428. Customized practices to model recommendation tables 

The first step to model the recommendation tables is to extend practices of the compliance_modeling plug-
in to use the same notation for criticality and recommendation levels used in the standard. For instance, in 
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the case of ISO 26262, five specializations of criticality_level (ASIL A, ASIL B, ASIL C, ASIL D and ASIL QM) 
must be created, as well as three specializations of recommendation_level (highly recommended, not 
recommended and recommended). In order to accomplish this task, create a new practice (see Section 
7.2.2 of EPF-C Manual [6]) for each specialization that we want to model in the Guidance folder of the plug-
in. Give to these practices names that correspond to the criticality and recommendation levels considered 
in the standard. Additionally, these practices will be linked to the original criticality_level defined in 
compliance_modeling plug-in using variability relationships. So, in the Content Variability section of the 
Description tab of the Practice, select Variability type “Extends”. Then,  click the “Select..” button and in the 
dialog that appears, select criticality_level. The final result is depicted in Figure 429. Optionally, this 
practice can be customized with an icon, in this case a green helmet has been used. Repeat the same 
operation for the other criticality and recommendation levels. The case of the recommendation levels is 
the same but the base element in the Content Variability section of the practice is recommendation_level. 

 

Figure 429. Modelling of criticality level for ISO26262  

Once, the specializations of the criticality and recommendation levels have been defined, start the 
modelling of the recommendation tables. It is recommended to perform this task in a separate Content 
Package, to create a new Content Package follow the instructions depicted in Section 4.2.3 of the EPF-C 
Manual [6]. The plug-in will have a structure similar to the plug-in depicted in Figure 430. In this case, we 
have a separate content package for criticality and recommendation levels too. 

 

Figure 430. Recommended plug-in structure for modelling recommendation tables 
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Figure 431 illustrates the modelling of the recommendation table, which is part of ISO 26262. The starting 
point for the modelling of a recommendation table is the specialization of the practice 
recommendation_table (see Figure 428). To do so, create a new practice with the name of the table to 
model. In this case, create the practice with the name mechanisms_for_error_detection. Then, in the 
Content Variability section, select Extends and recommendation_table as base variability element. 
Optionally, use an icon to make easier to distinguish between recommendation tables and standard 
practices. 

 

Figure 431. Mechanisms for error detection at the software architectural level of ISO 26262. 

Each row of the table is modelled as a recommendation practice (see Figure 428). In order to attach 
recommendations, right click the table and select “New → Practice” (see Figure 432). In this way, 
recommendations will be nested inside the recommendation table. Then, customize this practice by linking 
it with the recommendation in the Content Variability section of the practice, selecting “Extends” in the 
variability type and optionally, adding a new icon.  

 

Figure 432. Adding recommendations to the table 

Recommendations must be linked with those process elements for which the recommendation is 
produced. For example, the first row of Figure 431 is recommendations on the use of the practice “Range 
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checks of input and output data”. In order to link both elements, the recommendation and the 
recommended process element, we go to the “References” tab of the recommendation and click the 
“Add...” button. In the dialog box that appears, select the practice 
range_checks_of_input_and_output_data. The final result is depicted in Figure 433. 

 

Figure 433. Link between recommendation and recommended element. 

In order to model the level of recommendation for each criticality level, use the pplicability practice (see 
Figure 428). Right click the recommendation and select “New → Practice”. Then, give an appropriate name 
to this practice, by instance for the first row of Figure 431 and ASIL A, we can use the name 
applicability_range_checks_asil_a. The content variability section of this practice is modified as follows, 
Variability Type is set to “Extends” and the Base (click “Select...” button) is applicability from the plug-in 
compliance_modeling. Optionally, customize using an icon such as a green tick. The last step is to link the 
applicability to the corresponding criticality and recommendation levels. To do so, use the “References” tab 
of the applicability practice. In this tab, we click the “Add..” button and in the dialog that appears select the 
corresponding criticality and recommendation levels. The final result should be similar to Figure 434, which 
models the recommendation for ASIL A of the first row of Figure 431. Repeat the same operation for each 
level of ASIL. 

 

Figure 434. Reference tab for applicability practice 

The best way to visualize the final result is to create a new custom category and to include practice 
corresponding to recommendation tables (Section 4.5.3 of EPF-C manual [6]). The final result in the 
browsing perspective can be seen in Figure 435. 
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Figure 435. Recommendation tables for ISO 26262 in the Browsing perspective 

A.4 Web-based Monitoring of Compliance Status 

EPF-C supports the web-based monitoring of the compliance status by means of its generated website. In 
order to generate a website that contains our mapped requirements, define a new Method Configuration 
(see Section 4.5.4 of EPF-C manual [6]) with a name of our election. In the Views of the Method 
Configuration form, click “Add view…” and in the dialog that appears, select “Mapped Requirements” that 
will be in the folder “Custom Categories” (see Figure 436). 
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Figure 436. Dialog to select Mapped Requirements. 

In order to generate the website (see Section 10.1 of the EPF-C manual [6]), click in the menu toolbar 
“Configuration” and select “Publish”. In the wizard that appears, select the Method Configuration that has 
been defined to include the Mapped Requirements and click “Next”. In the next screen, select “Publish the 
entire configuration”. In the next screen (see Figure 437), select different publishing options of the website 
such as to give a name or to add a banner. In the last screen, select the folder in which the generated 
website will be stored and “Static website”. Finally, click the “Finish” button. 
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Figure 437. Dialog for publishing options of the generated website. 

The generated website will open automatically in our browser, an example is depicted in Figure 438. In 
order to check which requirements have been accomplished, click “Mapped requirements” and expand the 
tree. Additionally, if clicking on one of the requirements, additional information about the requirement is 
shown at the right side of the generated website.  

 

Figure 438. EPF Composer generate website 
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Appendix B. OCRA Language to define Formal Properties and 
Contracts 

OCRA constraint language can be interpreted over discrete traces (in this case, it coincides with LTL) or over 
hybrid traces as described [8]. The relevant syntax of the language has been summarized in Figure 439 
together with the corresponding mathematical formulation in HRELTL. 

 

Figure 439. The OCRA language grammar 

In case of discrete time, der, time_until, and time_since are not allowed. 

Basic formulas are defined with linear arithmetic predicates over the variables or their derivatives. For 
examples, x-e<limit and der(x)<0 are well-defined formulas. Predicates can be combined with Boolean and 
temporal operators. For example, x-e<limit and der(x)<0 and always x-e<limit are well-defined formulas. 



 

         AMASS AMASS Platform User Manual V1.0 

 

H2020-JTI-ECSEL-2015 # 692474 Page 294 of 295 
 

In temporal logic, a formula without temporal operators is interpreted in the initial state. Thus, x=0 
characterizes all traces that start with a state evaluating x to 0, and then x can evolve arbitrarily. Instead, to 
express that a predicate holds along the whole evolution, one may use the always operator as in always 
x=0. 

Another classical example of properties is the response to a certain event. The formula always (p implies in 
the future q) defines the set of traces where every occurrence of p is followed by an occurrence of q. Note 
that q may happen with a certain delay (although there is no bound on such delay). The formula always (p 
implies q) instead forces q to happen at the instant of p. 

The above formulas do not constrain the time model of the traces. Therefore, they can be interpreted 
either as discrete traces or as hybrid traces. However, the logic is suitable to characterize specific sets of 
hybrid traces, constraining when there should be discrete events and how the continuous variables should 
evolve along continuous evolutions. 

The der(.) operator is used to specify constraints on the derivative of the continuous evolution of 
continuous variables. For example, the following OCRA constraint: 

always (train.location<=target implies der(train.location)>=0) 

characterizes the set of hybrid traces where in all states, if the train has not yet reached the target location, 
its speed (expressed as the derivative of the location) is greater than or equal to zero. 

The next(.) operator is used to specify functional properties requiring discrete changes to variables. For 
example, we can express the property that the warning variable will change value after the train’s speed 
passes the limit with the following constraint: 

10 always (speed>limit implies in the future next(warning)!=warning) 

The expression change(x) can be used instead of next(x)!=x. 

The expression fall(x) is an abbreviation for x and then(not x), i.e. a Boolean term x becomes false. 

The expression rise(x) is an abbreviation for (not x) and then x, i.e. a Boolean term x becomes true. 

In order to constrain the delay between two events, we use the time_until(.) and time_since(.) operators, 
which denote respectively the time that will elapse until the next occurrence of an event and the time that 
elapsed since the last occurrence of an event. For example, the formula always (p implies 
time_until(q)<max_delay) defines the set of hybrid traces where p is always followed by q in less than 
max_delay time units. 

The operator at next has a similar but more general purpose. It denotes the value of the left expression, 
known as the sample, at the next step in which the right expression, known as the trigger, will be true. For 
example, the formula always (p implies (((time at next q)- time)< max_delay)) is the discrete time 
equivalent of the previous example, using an explicit user defined time variable. There is also an at last. 
operator, which denotes the value of the sample at the last step in which the trigger was true. 

For further information see [12] and [16]. 
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Appendix C. CHESS Supported Basic Types 

The basic types that can be assigned to ports, local attributes, parameters, functions behaviour are: 

• Primitive types: the following types are available on the package “UML Primitive types” 

o Integer 

o Boolean 

o Real 

• Continuous: this type is available on the package “CHESS Contract - DataTypes”. If this type is not 
available, in the Model Explorer View, select the model – right click – import – import registered 
profile, and select “CHESS Contract” 

• Range: To create this type: 

o In the Model Explorer View, select the owner of the type to define. 

o Right click – New Child – DataType 

o Select the new DataType, in the Property View – Profile tab, Add Profile – BoundedSubtype 

o in the Property View – Profile tab, select the BoundedSubtype and set the minValue and 
maxValue 

• Enumerative: To create this type: 

o In the Model Explorer View, select the owner of the type to define. 

o Right click – New Child – Enumeration 

o Select the new DataType, in the Property View – UML tab – Owned literals, add the 
enumerative values 

• Event 

o  In the Model Explorer View, select the owner of the type to define 

o Right click – New Child – Signal 
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Executive Summary 

This document is the developers’ guide of the AMASS Platform implementation. In this guide, the developers 
can find the source code installing instructions, step by step, in order to set up their workspaces to improve 
and implement new functionalities to the OpenCert, CHESS, Papyrus, and EPF tools.  Also, some installing 
instructions for the Polarsys OpenCert Tools Platform Server are included. 

This document has been elaborated as a fast Developers’ Guide. Further questions can be directed to the 
AMASS implementation team. 
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1. Introduction 

1.1 Scope 

The objective of this document is to describe the steps needed to setup a developer environment in order to 
let the Open Source Community contribute to the source code that composes the AMASS platform.  

This document also explains how to generate the AMASS Tools Platform bundle to distribute the tool to the 
final users.  

1.2 Naming Conventions 

1.2.1 OpenCert 

The OpenCert code uses the following naming convention for its plugins: 

 org.eclipse.opencert.[module].[plugin-name] 

where [module] can be one of the following modules and it is not mandatory in every case: 

• arg: argumentation editors 

• chess: chess features related to assurance 

• org.eclipse.opencert.epf: OpenCert code related to EPF 
 

1.2.2 CHESS 

The CHESS code uses the following naming convention for its plugins: 

org.polarsys.CHESS.[module].[plugin-name] 

where [module] can be one of the following modules: 

• contracts: support for contract-based design and analysis 

• fla: support for failure logic analysis 

• sba: support for state-based analysis 
 
APIs with visibility limited to the owning plugin should be stored in a package named as “xxx.internal.yyy” 
(e.g. org.polarsys.chess.service.internal.utils); an internal package should not be exported to an external 
client (i.e. it should not appear in the runtime tab of the plugin.xml editor). 
 

1.2.3 EPF Composer 

EPF code uses the following naming convention for its plugins: 

org.eclipse.epf.[module].[plugin-name] 

where [module] can be one of the following modules: 

• library: provides the UI and services to manage a method library. 

• Export/Import: provides the UI and services to export and import method plug-ins and 
configurations packaged in XMI files. 



 

         AMASS AMASS Platform Developers’ Guide V1.0 

 

 
H2020-JTI-ECSEL-2015 # 692474 Page 8 of 68 

 

1.2.4 BVR 

BVR code uses the following naming convention for its plugins: 

no.sintef.bvr.[module].[plugin-name] 

where [module] can be one of the following modules: 

• constraints: provides support for constraint-based resolution. The logical operators such as 
implication, alternative and negation might be used. 

 

1.2.5 V&V Manager 

V&V Manager code uses the following name for its plugin: 

org.eclipse.opencert.vavmanager 
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2. Installation of the PostgreSQL Database  

The AMASS platform tools use a PostgreSQL database, so the first step in the installation of the AMASS 
Platform is to install this database. 

For user convenience, PostgreSQL installation on Windows has been described in section 2.1. 

2.1 Installation of the PostgreSQL Database Server on a Windows 
Machine 

The next steps must be followed to install the PostgreSQL Database Server: 

1. Download the PostgreSQL installer: 

a. Go to the download section for Windows http://www.postgresql.org/download/windows/ 

b. Click on download installer from EnterpriseDB 

c. Choose the 9.3.15 or 9.4.10 version and download it. 

2. Double click the installer file and follow the installation wizard. 

3. The installation may take a few minutes to complete. The most important steps during the 
installation process are (among others): 

a. Definition of a password for the database super-user (the login is “postgres”). 

b. Definition of a port for PostgreSQL (the default 5432 is recommended). 

c. If the installation wizard asks to launch Stack Builder to install additional tools, you may skip this 
step - no additional tools are needed. 

4. Verify the installation: 

a. The quick way to verify the installation is to use the pgAdmin application that has been installed 
together with the PostgreSQL server. Please run “pgAdmin III” (see Figure 1): 

 

Figure 1. Verify the installation of the PostgreSQL database server 

http://www.postgresql.org/download/windows/
http://www.enterprisedb.com/products/pgdownload.do#windows
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b. In the left panel, double click on PostgreSQL 9.3 tree node. The application will ask to enter a 
database super-user password. Please enter the password which has been defined during the 
PostgreSQL server installation. 

c. If the database objects are displayed, then the PostgreSQL Database server has been installed 
correctly. 

2.2 Creating a Server Database in PostgreSQL 

This section demonstrates how to create a database in PostgreSQL to store the data tables used by the 
AMASS Platform.  

First, launch the database administrator “pgAdmin III”. 

 

Figure 2. Launching the database administration application 

In the “pgAdmin III” application right-click the “Databases” tree node and choose the “New Database…” 
option.  

 

Figure 3. Create a new database (I) 

In the dialog that opens, provide the database name, such as “cdo-opencert”. The database will be created. 

 

Figure 4. Create a new database (II) 

In the “pgAdmin III” application right-click “Schemas” for “cdo-opencert” db tree node and choose “New 
schema…” option. 



 

         AMASS AMASS Platform Developers’ Guide V1.0 

 

 
H2020-JTI-ECSEL-2015 # 692474 Page 11 of 68 

 

 

 

Figure 5. Create a new Schema 

Provide a name for the schema, e.g. externaltools. The schema will be created. Then in the “pgAdmin III” 
application (or psql command line) execute the query: 

ALTER DATABASE "cdo-opencert" set search_path=externaltools, public 

An empty database is ready to be used by the AMASS Platform tools. 

2.3 Restoring a Server Database in PostgreSQL 

This section demonstrates how to restore a database in PostgreSQL to store data tables used by the AMASS 
platform tools. To do so, follow the next steps: 

1. Launch the database administrator (“pgAdmin III”). 

 

Figure 6. Restoring a PostgreSQL database (I) 

2. Create a non-existing database name, for example “cdo-amass”, by right clicking over the 
“Database” node and selecting the entry “New Database…”. 
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Figure 7. Restoring a PostgreSQL database (II) 

3. Right click over “cdo-amass” and select “Restore…”. 

 

Figure 8. Restoring a PostgreSQL database (III) 

4. Select the database backup file from the server local hard disk using the “…” button. 

 

Figure 9. Restoring a PostgreSQL database (IV) 
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5. Check that the process ends with the message “Process returned exit code 0” and click the “Done” 
button. 

 

Figure 10. Restoring a PostgreSQL database (VI) 

6. Finally, in the “pgAdmin III” application (or psql command line) execute the query: 

    ALTER DATABASE "cdo-amass" set search_path=externaltools, public 
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3. Installation of the Eclipse Development Environment 

To run the PolarSys OpenCert Tools Platform Client, it is required to have installed (at minimum) the Java 
Runtime Environment 1.8. 

Java JDK 8 (Java Development Kit) is required to compile and run the PolarSys OpenCert Tools Platform 
Server from the source code. Having JRE (Java Runtime Environment) only is not enough. 

To install the full PolarSys OpenCert Tools Platform development environment: 

• download the Eclipse Modelling Neon 3 for from: 
https://www.eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/neon
/3/eclipse-modeling-neon-3-win32-x86_64.zip, and  

• follow the steps described in the sections  3.1 to 3.7. 

3.1 Papyrus Installation 

To install the Papyrus tool, follow the next steps: 

1. Install Papyrus features from the menu “Help->Install Modelling components” (if this does not 
work, try installing Papyrus from the Eclipse Neon update site1 from “Help-Install new software” 
wizard, by having the “Contact all update sites during install to find required software” feature 
enabled; Papyrus can be found under the Modelling category). 

 

Figure 11. Installation of the Papyrus features 

2. Restart Eclipse. 

3. Install the CDO Model Repository from the menu option “Help->Install Papyrus Additional 
Components” (see Figure 12). 
 

 

                                                           
1 Eclipse Neon update site: http://download.eclipse.org/releases/neon  

https://www.eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/neon/3/eclipse-modeling-neon-3-win32-x86_64.zip
https://www.eclipse.org/downloads/download.php?file=/technology/epp/downloads/release/neon/3/eclipse-modeling-neon-3-win32-x86_64.zip
http://download.eclipse.org/releases/neon
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Figure 12. Installation of the CDO Model Repository 

4. Install SysML 1.1 from the following update site (from “Eclipse Help->Install new software”):  
http://download.eclipse.org/modeling/mdt/papyrus/updates/releases/neon 

 

Figure 13. Installation of SysML 1.1 

5. Install MARTE archive update site from: 
https://hudson.eclipse.org/papyrus/view/Marte/job/papyrus-marte-
neon/lastSuccessfulBuild/artifact/releng/org.eclipse.papyrus.marte.p2/target/repository/*zip*/repo
sitory.zip  

6. Install the MARTE features as shown in Figure 14 (required to fix issues with CDO). 

http://download.eclipse.org/modeling/mdt/papyrus/updates/releases/neon
https://hudson.eclipse.org/papyrus/view/Marte/job/papyrus-marte-neon/lastSuccessfulBuild/artifact/releng/org.eclipse.papyrus.marte.p2/target/repository/*zip*/repository.zip
https://hudson.eclipse.org/papyrus/view/Marte/job/papyrus-marte-neon/lastSuccessfulBuild/artifact/releng/org.eclipse.papyrus.marte.p2/target/repository/*zip*/repository.zip
https://hudson.eclipse.org/papyrus/view/Marte/job/papyrus-marte-neon/lastSuccessfulBuild/artifact/releng/org.eclipse.papyrus.marte.p2/target/repository/*zip*/repository.zip
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Figure 14. Installation of MARTE 

3.2 CHESS Installation 

3.2.1 Required Features 

To install the CHESS tool, follow the next steps: 

1. Install XText SDK 2.12. It can be installed from the following Eclipse update site 
http://download.eclipse.org/modeling/tmf/xtext/updates/composite/releases/. To see the version 
2.12 remember to uncheck the box “Show only the latest versions of available software”. Note that 
this will require to remove the EMF Parsley plugins. 

2. Install Operational QVT, Acceleo, ATL features from the menu “Help->Install Modelling 
components”. 

 

http://download.eclipse.org/modeling/tmf/xtext/updates/composite/releases/
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Figure 15. Installation of Operational QVT, Acceleo and ATL features (I) 

 

 

Figure 16. Installation of Operational QVT, Acceleo and ATL features (II) 
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3. The plugins2 that provide the graphical representation of fault trees, require Sirius. To install Sirius 
go to the following update site (from “Eclipse Help -> Install new software”): 
http://download.eclipse.org/sirius/updates/releases/4.0.0/neon (select the Sirius Category) 
 

 

Figure 17. Installation of Sirius 

4. The plugins that create the BDD and IBD diagrams, require ELK (Eclipse Layout Kernel). To install ELK 
(required version >= 0.4.0) go to the following update site (from “Eclipse Help->Install new 
software”):  http://download.eclipse.org/elk/updates/releases/0.4.0 and install the items as in 
Figure 18. 

                                                           
2 eu.fbk.eclipse.standardtools.faultTreeViewer, eu.fbk.eclipse.standardtools.faultTreeViewer.emfta,     

eu.fbk.eclipse.standardtools.faultTreeViewer.emfta.design 

http://download.eclipse.org/sirius/updates/releases/4.0.0/neon
http://download.eclipse.org/elk/updates/releases/0.4.0
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Figure 18. Installation of ELK 

5. CHESS plugins depend on a set of Eclipse plugins provided as external libraries but not implemented 
in the project. They can be installed from the following Eclipse update site http://es-
static.fbk.eu/tools/devel_sde. Do not install the “Xtext Redistributable” plugin because it is needed 
only to final users and not to developers. The available plugins are:  

• eu.fbk.tools.editor.*: plugins provided by FBK that enrich a text area with content assist for an 
LTL grammar. 

• eu.fbk.tools.adapter.*: plugins provided by FBK that enable the interaction with V&VTools 
such as OCRA, nuXmv and XSap. 

http://es-static.fbk.eu/tools/devel_sde
http://es-static.fbk.eu/tools/devel_sde
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Figure 19. Installation of FBK tools 

6. Install EST plugins from http://es-static.fbk.eu/tools/devel_est, unchecking the “Group by category 
option” (see section 3.2.2 for more information about EST plugins). 

 

Figure 20. Installation of EST plugins 

http://es-static.fbk.eu/tools/devel_est
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7. Download the GEF 5.0 update site archive from here: 
https://www.eclipse.org/downloads/download.php?file=/tools/gef/downloads/drops//5.0.0/R2017
06131249/GEF-Update-5.0.0.zip  and install the features showed in Figure 21. 
 

 

 

Figure 21. Installation of GEF 5.0 features 

8. Install the VIATRA framework from http://download.eclipse.org/viatra/updates/release/1.7.2, in 
particular the features showed in Figure 22. 
 

https://www.eclipse.org/downloads/download.php?file=/tools/gef/downloads/drops//5.0.0/R201706131249/GEF-Update-5.0.0.zip
https://www.eclipse.org/downloads/download.php?file=/tools/gef/downloads/drops//5.0.0/R201706131249/GEF-Update-5.0.0.zip
http://download.eclipse.org/viatra/updates/release/1.7.2
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Figure 22. Installation of VIATRA features 

3.2.2 Getting the CHESS Plugins 

The CHESS plugins, and related libraries, can be installed in the given Eclipse environment through update 
sites, or their source version can be imported in the current workspace; the latter option must be preferred 
in case of CHESS plugins development. Otherwise, to avoid having too much plugins in the workspace, the 
first option can be adopted. 

3.2.2.1 Install the CHESS plugins via update site 

To install CHESS plugins on the current Eclipse environment: 

1. Download the CHESS plugins from  
https://drive.google.com/file/d/1H7tymMYp5Vr8uwMXQ4XvX983hLk9oY0l/view?usp=sharing and 
install them from the downloaded zip file (unchecking the “Group by category option”). 
 

https://drive.google.com/file/d/1H7tymMYp5Vr8uwMXQ4XvX983hLk9oY0l/view?usp=sharing
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Figure 23. Installation of the CHESS plugins 

3.2.2.2 Import CHESS plugins in the current workspace 

The CHESS plugins are currently available at the Polarsys Git server: 
https://git.polarsys.org/c/chess/chess.git  

To import the CHESS plugins in the workspace, the CHESS git repository must be cloned first: 

1. Install the Git client for Eclipse (if the Git Team Provider feature selected in Figure 24 is not 
available, then it means that it is already available in the current environment, so you can skip this 
step). 

 

https://git.polarsys.org/c/chess/chess.git
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Figure 24. Installation of the Git client for Eclipse 

2. Restart Eclipse. 

3. Open the Git Repositories View. 

4. Select “Clone a Git Repository…” and fill the fields as in Figure 25. 
(URI http://git.polarsys.org/r/chess/chess). 

 

http://git.polarsys.org/r/chess/chess
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Figure 25. Clone a Git Repository (I) 

5. Select the “neon” branch. 
 

 

Figure 26. Clone a Git Repository (II) 

6. Choose a local destination and press the “Finish” button. 
7. Open the Chess repository, right click on the “WorkingTree\plugin” folder and select “Import 

Projects…”. 
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Figure 27. Import Projects from a Git Repository (I) 

8. Select the “plugins” folder and then click the “Next >” button. 
 

 

Figure 28. Import Projects from a Git Repository (II) 

9. Select all the plugins. 

IMPORTANT: org.polarsys.chess.instance.view will not compile due to some missing eclipse features 
that cannot be installed in the AMASS Eclipse environment. Just do not care of this, you can 
close/remove this project in the workspace. Moreover, errors in the chess.fla plugins shown in Figure 

27 are not an issue. 
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Figure 29. Selection of CHESS plugins 

10. Go to “Window → Preferences → Plug-in Development → API baselines → Missing API baselines” 
and change the value from “Error” to “Warning”. 

11. The aforementioned chess.contracts depend on a set of Eclipse plugins that are available at the 
following source code repository: https://gitlab.fbk.eu/CPS_Design/EST.git. Open the “Git 
Repositories” View. 

12. Select “Clone a Git Repository…” and fill the fields as shown in Figure 30. 
(URI: https://gitlab.fbk.eu/CPS_Design/EST.git) 

 

Figure 30. Clone a Git Repository (III) 

https://gitlab.fbk.eu/CPS_Design/EST.git
https://gitlab.fbk.eu/CPS_Design/EST.git
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13. The plugins to be imported in the development workspace are: 

• eu.fbk.eclipse.standardtools.contractEditor.core 

• eu.fbk.eclipse.standardtools.constraintEditor.core 

• eu.fbk.eclipse.standardtools.propertyEditor.core 

• eu.fbk.eclipse.standardtools.hierarchicalContractView.core 

• eu.fbk.eclipse.standardtools.refinementView.core 

• eu.fbk.eclipse.standardtools.xtextService 

• eu.fbk.eclipse.standardtools.nuXmvService 

• eu.fbk.eclipse.standardtools.ModelTranslatorToOcra 

• eu.fbk.eclipse.standardtools.ExecOcraCommands 

• eu.fbk.eclipse.standardtools.utils 

• eu.fbk.eclipse.standardtools.diagram 

• eu.fbk.eclipse.standardtools.diagram.ui 

• eu.fbk.eclipse.standardtools.faultTreeViewer 

• eu.fbk.eclipse.standardtools.faultTreeViewer.emfta 

• eu.fbk.eclipse.standardtools.faultTreeViewer.emfta.design 

• eu.fbk.tools.editor.contract.constraint.Constraint 

• eu.fbk.tools.editor.contract.constraint.Constraint.ide 

• eu.fbk.tools.editor.contract.constraint.Constraint.ui 

The CHESS plugins can then be executed as an Eclipse application, together with the other plugins available 
in the workspace (see next section). 

For further support, please contact stefano.puri@intecs.it.  

3.3 EPF Composer Installation 

The system requirements for running the EPF Composer are as follows: 

• Microsoft Windows XP SP3, 2003 SP2 (or later), Windows 7, Windows 10. 

• Red Hat Enterprise Linux Release 4 Update 5, Release 5 or later (Note: compat-libstdc++ is needed 

for RHEL5) SUSE Enterprise Linux v9 or v10. 

• Internet Explorer, Mozilla, or Firefox. 

• Java Runtime Environment 1.5, 1.6, 1.7, 1.8. 

For the development environment setup, the required software might be downloaded from the Neon 
software repository. Please locate the following URL as an update site (“Help menu → Install new 
software”) Neon: http://download.eclipse.org/releases/neon. After that, select the SDKs mentioned in 
Figure 31 and complete the installation. 

mailto:stefano.puri@intecs.it
http://download.eclipse.org/releases/neon
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Figure 31. Installation of EPF Composer 

3.3.1 Getting the EPF Composer Plugins 

To retrieve the EPF Composer plugins from the Git repository, the Git client for Eclipse needs to be installed. 
The installation of Git client for Eclipse is presented in Figure 24. The source code of EPF Composer is 
available at the link: https://git.eclipse.org/r/epf/org.eclipse.epf.composer.  

The cloning process requires the location of the source repository, as shown in Figure 32. After that, 
branches and local destination are selected.  

https://git.eclipse.org/r/epf/org.eclipse.epf.composer
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Figure 32. Installation of EPF Composer plugins 

The repository for EPF Composer might be located at the particular link: 
http://download.eclipse.org/technology/epf/composer/p2release/EPF-p2Repo-1.5.2/. However, we are 
working on the migration of PDE build to Tycho (https://www.eclipse.org/tycho/), which supports in building 
the plug-ins, features, update sites (based on p2), RCP applications and OSGi bundles.  

3.4 BVR Installation 

The BVR plugins should work on Linux as well as on Windows. Make sure to have Java 8 installed. In the 

context of the AMASS project, the support for Neon 3 is taken into consideration. 

3.4.1 Getting the BVR Plugins 

The BVR tool bundle, i.e., a set of plug-ins for Eclipse that implements and supports the BVR language can be 
cloned from the particular GitHub link: https://github.com/SINTEF-9012/bvr.git. The source code of the BVR 
Tool is imported into the workspace for development environment setup.  

The BVR update site https://bvr-tool.sintef.cloud/update/site.xml is also built from the BVR sources. To 
avoid having many source code plugins, the installation is done from the update site, as shown in Figure 33.  

 

https://emea01.safelinks.protection.outlook.com/?url=http%3A%2F%2Fdownload.eclipse.org%2Ftechnology%2Fepf%2Fcomposer%2Fp2release%2FEPF-p2Repo-1.5.2%2F&data=02%7C01%7Cmuhammad.atif.javed%40mdh.se%7C8c33559b17ce4d102dca08d618f56b8d%7Ca1795b64dabd4758b988b309292316cf%7C0%7C0%7C636723839714645287&sdata=%2FvUdfdBvFd9bNK1BIY%2FfWwb%2BN8kqj3KnPVE1kA3UW2k%3D&reserved=0
https://www.eclipse.org/tycho/
https://github.com/SINTEF-9012/bvr.git
https://bvr-tool.sintef.cloud/update/site.xml
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Figure 33. Installation of BVR Tool from the update site 

3.5 OpenCert Installation 

Follow the next steps to install the full OpenCert tool environment: 

1. In your Eclipse IDE, open the Git perspective and select the “Clone Git repository” option.  

2. Configure the data to connect with the OpenCert Repository as in Figure 34 replacing the user data 
with your Eclipse account user data. 

 

Figure 34. Installation of OpenCert (I) 
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3. Select the “master” branch in the next window. 

 

Figure 35. Installation of OpenCert (II) 

4. Select the local Repository directory; check “Import all existing projects after clone finishes” and 
click the “Finish” button. 

 

Figure 36. Installation of OpenCert (III) 

5. Change the perspective to “Plugin Development” to see all the plugins in your workspace. Your 
workspace will have all the source code but with errors, now you must install various Eclipse 
Frameworks to solve them. 

6. Install CDO from http://download.eclipse.org/modeling/emf/cdo/drops/R20160607-1209/ with the 
option selected in Figure 37. 

http://download.eclipse.org/modeling/emf/cdo/drops/R20160607-1209/
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Figure 37. Installation of CDO 

7. Install the Epsilon Framework from http://download.eclipse.org/epsilon/updates/ 

 

Figure 38. Installation of the Epsilon Framework 

http://download.eclipse.org/epsilon/updates/
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8. Install the Emfatic from http://download.eclipse.org/emfatic/update/ (uncheck Group items by 
category option). 

 

Figure 39. Installation of Emfatic 

9. Install the GMF tooling if you did not install the plugins explained in EPF Composer section (see 
section 3.3) http://download.eclipse.org/modeling/gmp/gmf-tooling/updates/releases/. 

 

Figure 40. Installation of the GMF tooling 

http://download.eclipse.org/emfatic/update/
http://download.eclipse.org/modeling/gmp/gmf-tooling/updates/releases/
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10. Uninstall the following features using the menu “Help → Installation Details” and clicking the 
“Uninstall…” button. 

 

Figure 41. Features to uninstall 

11. Install all the Ecore Tools features from 
http://download.eclipse.org/modeling/emft/ecoretools/updates/1.2/201306071421 

 

Figure 42. Installation of Ecore Tools features 

http://download.eclipse.org/modeling/emft/ecoretools/updates/1.2/201306071421
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12. Install the EEF (Extended Editing Framework) feature from the menu “Help → Install Modelling 
components”. 

 

Figure 43. Installation of EEF feature 

13. Install SVNKIT version 1.3.8. Since the newest version has errors with SSL, we have chosen the one 
shown on Figure 44 from http://eclipse.svnkit.com/1.3.x. 

 

http://eclipse.svnkit.com/1.3.x
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Figure 44. Installation of SVNKIT version 1.3.8 

If the update site is down, try downloading the code from 
https://www.svnkit.com/org.tmatesoft.svn_1.3.8.eclipse.zip and using the downloaded local archive 
to install it.  

Note: org.eclipse.opencert.chess.* depend on CHESS and Capra projects, so CHESS and Capra plugins 
must be available to be able to properly build the aforementioned org.eclipse.opencert.chess.* 
plugins. See section 3.6 about how to install Capra. 

 
14. Install Eclipse Amalgam from Neon (http://download.eclipse.org/releases/neon). 

 

https://www.svnkit.com/org.tmatesoft.svn_1.3.8.eclipse.zip
http://download.eclipse.org/releases/neon
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Figure 45. Installation of Eclipse Amalgam 

For further support about OpenCert, please contact angel.lopez@tecnalia.com. 

3.6 Capra Installation 

3.6.1 Required Features 

1. Install Mylyn from http://download.eclipse.org/mylyn/releases/latest/. 

 

Figure 46. Installation of Mylyn 

mailto:angel.lopez@tecnalia.com
http://download.eclipse.org/mylyn/releases/latest/
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2. Install CDT for Eclipse Neon: http://download.eclipse.org/tools/cdt/releases/9.2 

 

Figure 47. Installation of CDO for Eclipse Neon 

3. Uninstall the Acceleo feature. 

 

Figure 48. Uninstall the Acceleo feature 

4. Move the plugin com.google.guava_21.0.0.v20170206-1425.jar from the “plugins” folder to the 
“dropins” folder. 

 

http://download.eclipse.org/tools/cdt/releases/9.2
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3.6.2 Getting the Capra Plugin 

To install the Capra plugin, follow the next steps: 

1. Clone the Git Repository available at https://github.com/jmauersberger/TraceabilityManagement 
(see 3.5) 

2. Import all the available plugins. 

3.7  V&V Manager Installation 

The V&V Manager plugin (org.eclipse.opencert.vavmanager) works with the Eclipse NEON. 

It is required to have installed (at minimum) Java Environment 1.8. 

The plugin depends on the following packages: 

• javax.xml.xpath 

• org.eclipse.core.commands 

• org.eclipse.core.runtime 

• org.eclipse.emf.common.command 

• org.eclipse.emf.common.util 

• org.eclipse.emf.ecore 

• org.eclipse.emf.transaction.util 

• org.eclipse.gmf.runtime.common.core.command 

• org.eclipse.jface.dialogs 

• org.eclipse.jface.resource 

• org.eclipse.jface.text 

• org.eclipse.papyrus.infra.emf.gmf.command 

• org.eclipse.papyrus.infra.services.validation.commands 

• org.eclipse.papyrus.infra.services.validation.handler 

• org.eclipse.papyrus.infra.services.validation 

• org.eclipse.swt.custom 

• org.eclipse.swt.graphics 

• org.eclipse.swt 

• org.eclipse.swt.widgets 

• org.eclipse.ui.part 

• org.eclipse.ui 

• org.eclipse.ui.plugin 

• org.eclipse.uml2.uml 

• org.eclipse.uml2.uml.internal.impl 

• org.osgi.framework 

• org.polarsys.chess.contracts.profile.chesscontract 

• org.polarsys.chess.contracts.profile.chesscontract.impl 

• org.polarsys.chess.contracts.profile.chesscontract.util 
 

https://github.com/jmauersberger/TraceabilityManagement
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4. Debugging the Polarsys OpenCert Tools Platform Client  

To debug the Polarys OpenCert Tools Platform client code follow the next steps: 

1. Set more memory for running the code in the menu option “Run → Debug Configurations”. 

 

Figure 49. Debug Configurations window 

2. Run the CDO server from the code. For that, right click over the “org.eclipse.opencert.storage.cdo → 
src → StandaloneCDOServer.java” class and select “Run → As Java Application” option. 
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Figure 50. Run the CDO server 

3. Check the Console messages to control the CDO server start process. If you get an error, terminate 
the execution and modify the opencert-properties.xml content according to your installation. 

 

Figure 51. Console messages 

Stop the current execution, configure properly the generated file “opencert-properties.xml” and try 
again running the server from code (remember Step 2 to run it again). 

 
<?xml version="1.0" encoding="UTF-8"?> 
<!DOCTYPE properties SYSTEM "http://java.sun.com/dtd/properties.dtd"> 
<properties> 
   <entry key="dbHost">localhost</entry>  PostgreSQL host name or IP 
   <entry key="dbPort">5432</entry>  PostgreSQL Port 
  <entry key="dbName">cdo_amass</entry>  PostgreSQL database name 
  <entry key="dbUser">postgres</entry>  PostgreSQL database user name 
   <entry key="dbPassword">postgres</entry>  PostgreSQL database user password 
   <entry key="serverAddress">localhost:2036</entry> CDO Server Host and Port 
  <entry key="isCDOSecurityEnabled">false</entry>true to enable the CDO Security  
  <entry key="isSupportingAudits">false</entry>true to enable CDO audit to store 
historical changes in models. 
</properties> 
 

Note: The CDO Security feature has been included in the code but it’s under development and it is 
not explained in the user manual. We advise keeping this value to false. 

 
4. Right click over any plugin and select “Debug As  Eclipse Application”. The platform will be loaded 

with all the code deployed. 
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Figure 52. Polarsys OpenCert Tools Platform client in debug mode 

5. Open the Repository Explorer view to see the CDO server contents and open the Models by double 
clicking on them. 

 

Figure 53. Repository Explorer view 
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If you see the contents of Figure 54 in the Repository Explorer view or the view is not showing any 
data, something is wrong. Be sure that the CDO server is running and has been well configured. 

 

 

Figure 54. Error in the Repository Explorer view 
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5. Creation of the Polarsys OpenCert Tools Platform Client 
Bundle 

The procedure to create the Polarsys OpenCert Tools Platform Client bundle is as follows: 

1. Download the Eclipse platform version 4.6.2 from 
http://archive.eclipse.org/eclipse/downloads/drops4/R-4.6.3-
201703010400/download.php?dropFile=eclipse-platform-4.6.3-win32-x86_64.zip 

2. Install XSD - XML Schema Definition SDK 2.12.0.v20160526-0356 from Eclipse Repository 
(http://download.eclipse.org/releases/neon/) inside the Modelling category. 

 

 

Figure 55. Installation of XSD - XML Schema Definition 

3. Install the EPF+BVR after generating a local update site using the org.amass.epfbvr.usite plugin.  
Generate a zip file with the plugins folder, features folder, the file artifacts.jar, the file content.jar, 
and the site.xml file that are generated during the “Build All” operation. 

http://archive.eclipse.org/eclipse/downloads/drops4/R-4.6.3-201703010400/download.php?dropFile=eclipse-platform-4.6.3-win32-x86_64.zip
http://archive.eclipse.org/eclipse/downloads/drops4/R-4.6.3-201703010400/download.php?dropFile=eclipse-platform-4.6.3-win32-x86_64.zip
http://download.eclipse.org/releases/neon/
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Figure 56. Installation of EPF+BVR 

4. Install Papyrus and Papyrus SysML from 
http://download.eclipse.org/modeling/mdt/papyrus/updates/releases/neon 

 
 
 

http://download.eclipse.org/modeling/mdt/papyrus/updates/releases/neon
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Figure 57. Installation of Papyrus and Papyrus SysML 

5. Install MARTE archive update site from  
https://hudson.eclipse.org/papyrus/view/Marte/job/papyrus-marte-
neon/lastSuccessfulBuild/artifact/releng/org.eclipse.papyrus.marte.p2/target/repository/*zip*/repo
sitory.zip and install the features in Figure 58 (required to fix issues with CDO). 

https://hudson.eclipse.org/papyrus/view/Marte/job/papyrus-marte-neon/lastSuccessfulBuild/artifact/releng/org.eclipse.papyrus.marte.p2/target/repository/*zip*/repository.zip
https://hudson.eclipse.org/papyrus/view/Marte/job/papyrus-marte-neon/lastSuccessfulBuild/artifact/releng/org.eclipse.papyrus.marte.p2/target/repository/*zip*/repository.zip
https://hudson.eclipse.org/papyrus/view/Marte/job/papyrus-marte-neon/lastSuccessfulBuild/artifact/releng/org.eclipse.papyrus.marte.p2/target/repository/*zip*/repository.zip
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Figure 58. Installation of MARTE 

6. Install Eclipse Sirius from http://download.eclipse.org/sirius/updates/releases/4.1.4/neon. 
 

 

Figure 59. Installation of Eclipse Sirius 

http://download.eclipse.org/sirius/updates/releases/4.1.4/neon
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7. Install XText Complete SDK 2.12 from 
http://download.eclipse.org/modeling/tmf/xtext/updates/composite/releases/ (uncheck the show 
only latest versions of available software). 

 

Figure 60. XText Complete SDK 2.12 

8. Install ELK (required version >= 0.4.0 from http://download.eclipse.org/elk/updates/releases/0.4.0. 

http://download.eclipse.org/modeling/tmf/xtext/updates/composite/releases/
http://download.eclipse.org/elk/updates/releases/0.4.0
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Figure 61. Installation of ELK 

9. Install the FBK SDE tools from http://es-static.fbk.eu/tools/devel_sde. 
 

http://es-static.fbk.eu/tools/devel_sde
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Figure 62. Installation of the FBK SDE tools 

10. Install the FBK EST tools from http://es-static.fbk.eu/tools/devel_est (uncheck group item by 
category). 

 

Figure 63. Installation of the FBK EST tools 

http://es-static.fbk.eu/tools/devel_est
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11. Download the GEF 5.0 update site archive from 
https://www.eclipse.org/downloads/download.php?file=/tools/gef/downloads/drops//5.0.0/R2017
06131249/GEF-Update-5.0.0.zip and install the features shown in Figure 64. 

 

 

Figure 64. Download the GEF 5.0 update site archive 

12. Install VIATRA from http://download.eclipse.org/viatra/updates/release/1.7.2. 

https://www.eclipse.org/downloads/download.php?file=/tools/gef/downloads/drops//5.0.0/R201706131249/GEF-Update-5.0.0.zip
https://www.eclipse.org/downloads/download.php?file=/tools/gef/downloads/drops//5.0.0/R201706131249/GEF-Update-5.0.0.zip
http://download.eclipse.org/viatra/updates/release/1.7.2
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Figure 65. Installation of VIATRA 

13. Install the CHESS version for Neon from 
https://drive.google.com/file/d/1H7tymMYp5Vr8uwMXQ4XvX983hLk9oY0l/view?usp=sharing and 
install it from the downloaded zip file (uncheck group items by category). 

 

https://drive.google.com/file/d/1H7tymMYp5Vr8uwMXQ4XvX983hLk9oY0l/view?usp=sharing
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Figure 66. Installation of the CHESS version for Neon 

14. Install Mylyn Task List & Mylyn Builds Connector: Hudson/Jenkins from 
http://download.eclipse.org/mylyn/releases/latest 

http://download.eclipse.org/mylyn/releases/latest
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Figure 67. Installation of Mylyn Task List & Mylyn Builds Connector: Hudson/Jenkins (I) 

 

Figure 68. Installation of Mylyn Task List & Mylyn Builds Connector: Hudson/Jenkins (II) 
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15. Install CDT for eclipse Neon from http://download.eclipse.org/tools/cdt/releases/9.2. 

 

Figure 69. Installation of CDT for Eclipse Neon 

16. Install Capra after generating a local update site using the org.eclipse.capra.updatesite plugin. Same 
procedure than in step 3.  

17. Install the Elastic search after generating a local update site using the 
org.eclipse.opencert.elastic.site plugin. 

18. Add to the “Available Software Site” list the following sites (“Help -> Install new software”): 

• http://download.eclipse.org/epsilon/updates/  

• http://download.eclipse.org/modeling/emft/ecoretools/updates/1.2/201306071421  

• http://eclipse.svnkit.com/1.3.x  

• http://download.eclipse.org/modeling/emf/cdo/drops/R20160607-1209/ 

19. Install GIT from http://download.eclipse.org/releases/neon/. 

http://download.eclipse.org/tools/cdt/releases/9.2
http://download.eclipse.org/epsilon/updates/
http://download.eclipse.org/modeling/emft/ecoretools/updates/1.2/201306071421
http://eclipse.svnkit.com/1.3.x
http://download.eclipse.org/modeling/emf/cdo/drops/R20160607-1209/
http://download.eclipse.org/releases/neon/
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Figure 70. Installation of Git 

20. Install CDO Model Repository Client from 
http://download.eclipse.org/modeling/emf/cdo/drops/R20160607-1209 

http://download.eclipse.org/modeling/emf/cdo/drops/R20160607-1209
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Figure 71. Installation of CDO Model Repository Client 

21. Install Eclipse Amalgam from  http://download.eclipse.org/releases/neon 

http://download.eclipse.org/releases/neon
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Figure 72. Installation of Eclipse Amalgam 

22. Install OpenCert after generating a local update site using the org.eclipse.opencert.updatesite 
plugin. Same procedure than in step 3. 

23. Close the Eclipse platform. 

24. Copy the folders “epsilon” and “model” from the org.eclipse.opencert.apm.assurproj.wizards folder 
to the configuration folder of the Eclipse platform. 

25. Edit the file org.eclipse.emf.cdo.dawn_2.0.400.v20160301-1326.jar inside the “plugins” folder of the 
Eclipse platform. Delete the “org” folder of the .jar and replace it by the “org” folder inside the bin 
folder of the org.eclipse.emf.cdo.dawn plugin. Finally, replace the plugin.xml file of the .jar with the 
one in org.eclipse.emf.cdo.dawn plugin. 

26. Edit the file org.eclipse.emf.cdo.dawn.ui_2.0.300.v20160301-1326.jar inside the “plugins” folder of 
the Eclipse platform. Delete the “org” folder of the .jar and replace it by the “org” folder inside the 
bin folder of the org.eclipse.emf.cdo.dawn.ui plugin. Replace the plugin.xml file with the one in the 
org.eclipse.emf.cdo.dawn plugin. 

27. Edit the file org.eclipse.emf.cdo.dawn.ui_2.0.300.v20160301-1326.jar inside the “plugins” folder of 
the eclipse platform. Delete the “org” folder of the .jar and replace it by the “org” folder inside the 
bin folder of the org.eclipse.emf.cdo.dawn.util plugin. 

28. Replace the splash.bmp file in Eclipse platform plugins/org.eclipse.platform_4.6.3.v20170301-0400 
folder with the splash.bmp file in the “splash” folder of the org.eclipse.opencert.infra.general 
plugin. 
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29. Move com.google.guava_21.0.0.v20170206-1425.jar from the “plugins” folder to the “dropins” 
folder. 

30. Create a shortcut for the eclipse.exe file, edit its properties to add the “-clean” parameter. Start 
Eclipse using this shortcut. All the tools will be working now, and it is not necessary to use the 
shortcut again for the following bundle usages. 

 

 

Figure 73. Create a shortcut for the eclipse.exe file 
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6. Working with the Polarsys OpenCert Tools Platform Server 
Code 

The plugins needed to develop the Polarys OpenCert Tools Platform server are listed below (some of them, 
in bold, belong also to the Polarys OpenCert Tools Platform client): 

• org.eclipse.opencert.apm.assuranceassets 

• org.eclipse.opencert.apm.assurproj 

• org.eclipse.opencert.apm.baseline 

• org.eclipse.opencert.evm.evidspec 

• org.eclipse.opencert.externaltools.api 

• org.eclipse.opencert.impactanalysis 

• org.eclipse.opencert.infra.general 

• org.eclipse.opencert.infra.mappings 

• org.eclipse.opencert.infra.preferences 

• org.eclipse.opencert.infra.properties 

• org.eclipse.opencert.pam.procspec 

• org.eclipse.opencert.pkm.refframework 

• org.eclipse.opencert.sam.arg 

• org.eclipse.opencert.storage.cdo 

• org.eclipse.opencert.vocabulary 

• org.eclipse.opencert.webapp.cdo 

• org.eclipse.opencert.build 

• org.eclipse.opencert.webapp.reports 
 
If you wish to work just with the Polarys OpenCert Tools Platform Server part, you can close any other 
plugins not in the above list from the workspace. 

6.1 Running the Polarsys OpenCert Tools Platform Server in the Eclipse 
Debugger 

6.1.1 Setting up the Apache Tomcat Webserver 

Follow the next steps to setup the Apache Tomcat server: 

1. Download Apache Tomcat from http://tomcat.apache.org/download-70.cgi.  
Unpack it in your target folder. 

2. In Eclipse, define the tomcat_home variable by choosing:  
“Run -> Debug configurations -> Java Application -> org.opencert.webapps -> Arguments” 

 

http://tomcat.apache.org/download-70.cgi
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Figure 74. Setting up the Apache Tomcat server (I) 

Click on “Edit Variables…” button and then on the “New…” button (see Figure 75). In the dialog 
window that appears enter the following data:  

• Name: tomcat_home 

• Value: [path to your Apache Tomcat folder]. This value will be referred to as 
[TOMCAT_FOLDER] in the remaining part of this document. 

 

 

 Figure 75. Setting up the Apache Tomcat server (II) 
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Be sure that the VM Arguments content is: 
-Dcatalina.home=${tomcat_home} -Djava.endorsed.dirs=${tomcat_home}/endorsed -
Dcatalina.base=${tomcat_home} -Djava.io.tmpdir=${tomcat_home}/temp -Xms512m -Xmx1024m 

3. Override your [TOMCAT_FOLDER]\conf\server.xml  file with 
 org.eclipse.opencert.build\tomcat\conf\server.xml  file from your workspace. 

4. Edit this file and modify docBase and workDir attributes of <context> elements. 

• For docBase – please enter a path to webapp subfolder of your respective project location in 
workspace.  

• For workDir – please enter a path to work subfolder of your respective project location in 
workspace. 

For example: 

For cdo: 
<Context path="cdo" reloadable="true"  

docBase="/home/dariuszo/workplace/code-
staging/org.eclipse.opencert.webapp.cdo/webapp"    
workDir="/home/dariuszo/workplace/code-
staging/org.eclipse.opencert.webapp.cdo/work” 
 …  

</Context> 

After modifications: 
<Context path="cdo" reloadable="true" 

docBase="d:\home\john\OPENCERT_WORKSPACE/org.eclipse.opencert.webapp.cdo/webap
p"     
workDir="d:\home\john\OPENCERT_WORKSPACE/org.eclipse.opencert.webapp.cdo/work” 
 …  

</Context> 

For opencert-report: 
<Context path="opencert-report" reloadable="true" 

docBase="/home/dariuszo/workplace/code-
staging/org.eclipse.opencert.webapp.reports/webapp"    
workDir="/home/dariuszo/workplace/code-
staging/org.eclipse.opencert.webapp.reports/work” …  

</Context> 
 

After modifications: 
<Context path=" opencert-report" reloadable="true" 

docBase="d:\home\john\OPENCERT_WORKSPACE/org.eclipse.opencert.webapp.reports/w
ebapp"     
workDir="d:\home\john\OPENCERT_WORKSPACE/org.eclipse.opencert.webapp.reports/w
ork” …  

</Context> 

5. Define the Apache Tomcat user by adding the below XML section to <tomcat-users> node in 
[TOMCAT_FOLDER]\conf\tomcat-users.xml file: 

<tomcat-users> 
<role rolename="manager-gui"/> 
<user username="tomcat" password="tomcat" roles="manager-gui"/> 

</tomcat-users> 

User and password to your local Tomcat will be: tomcat/tomcat. 

6. Copy DevloaderTomcat7.jar from org.eclipse.opencert.build\devloader to [TOMCAT_FOLDER]\lib. 
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6.1.2 Setting up a Workspace to Run a Debugger 

Note: In this section the term “system user home directory” is used, that depending on your system might 
be: 

• In Windows XP:  c:\Documents and Settings\<username>\ 

• In Windows 7/8:  c:\Users\<username>\ 

• In Linux:  /home/<username>/ 

Follow the next steps to setup a workspace for running a debugger: 

1. Create devloaderWorkspaces file in your system user home directory and fill it with information 
about location of “workspace1” (being the OpenCert eclipse workspace root). This file content 
should look similar to this: 

<?xml version="1.0" encoding="UTF-8" standalone="no"?> 
<!DOCTYPE properties SYSTEM "http://java.sun.com/dtd/properties.dtd"> 
<properties> 
 <entry key="workspace1">D:\workspaceWeb</entry> 
 <entry 

key="workspace2">D:\workspaceWeb\org.eclipse.opencert.webapp.cdo</entry> 
 <entry 

key="workspace3">D:\workspaceWeb\org.eclipse.opencert.webapp.reports</entry> 
</properties>> 

2. Adjust the OpenCert server configuration file settings: 

Go to org.eclipse.opencert.build/conf-opencert folder and move opencert-properties.xml file from 
this location to the operating system user home directory. This is the location from where the 
OpenCert server reads the opencert-properties.xml settings file. 

Edit the opencert-properties.xml settings file. The most important entries in this file are: 

• "dbUser" / “dbPassword”  

These are PostgreSQL user credentials. Please specify a valid user and password for your 
PostgreSQL server. 

• “serverAddress” 

This is a CDO repository name which is broadcasted by the CDO server. The “localhost” 
default value should be replaced with the specific server machine host name so that the 
Polarays OpenCert Tools Platform clients are able to connect to this server repository from 
other hosts. Please modify the following entry: 

  <entry key="serverAddress">localhost:2036</entry> 

 by replacing “localhost” with the specific server host name, e.g.: 

  <entry key="serverAddress">host-name.acme.com:2036</entry> 

3. Run the project in debug mode. 

 

Figure 76. Run the OpenCert project in debug mode 
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4. The following messages should be displayed at the console. 

 

Figure 77. Console messages in debug mode 

5. Run the web browser and enter http://localhost:8080. The Apache Tomcat home page should be 
presented. 

The Reports web page of the Polarsys OpenCert Tools Platform server should be accessible at 
http://localhost:8080/opencert-reports/.  

6.2 Building the OpenCert Web Server Application war Files 

The OpenCert Tools Platform server source code comes with an automation script that supports the building 
of web application war files from the code projects. This script has been developed in Gradle technology. 
The procedure to configure, build and execute the Gradle scripts to generate the “war” files to be deployed 
in PolarSys OpenCert Tools Platform Server (Apache Tomcat Server) is described below. 

6.2.1 Installation of the Gradle Framework 

To install the Gradle framework follow the next steps: 

1. Download the Gradle version 1.12 bundle from http://gradle.org/gradle-download/, inside Previous 
Releases part. 

2. Unzip the downloaded Gradle package to the target folder, e.g. “C:\Program Files”.  

3. A gradle-x.x subdirectory will be created from the archive, where x.x is the version number. 

4. Add the location of your Gradle “bin” folder to your operating system PATH variable.  

For example, on Windows this can be done by opening the system properties window (WinKey + 
Pause), selecting “Advanced system settings” tab, clicking the “Environment Variables” button, and 
then adding the bin folder path (e.g. “C:\Program Files\gradle-x.x\bin”) to the end of your PATH 
variable. Please make sure not to use any quotation marks for the path value even if it contains 
spaces.  

5. In the same dialog, make sure that JAVA_HOME exists in the user variables or in the system variables 
and it is set to the location of your JDK, e.g. C:\Program Files\Java\jdk1.8.0_06 and that 
%JAVA_HOME%\bin is in your PATH environment variable. 

6. Open a new command prompt (on Windows type “cmd” in the Start menu) and run “gradle –
version” to verify that the framework has been installed correctly. 

http://localhost:8080/
http://localhost:8080/opencoss-reports/
http://gradle.org/gradle-download/
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Figure 78. Check Gradle installation 

6.2.2 Configuration of the Gradle Environment 

To configure the Gradle environment follow the next steps: 

1. Go to org.eclipse.opencert.build/gradleCopyToWorkspaceRoot folder and copy build.gradle and 
settings.gradle files from this location to your Eclipse workspace. 

2. Edit build.gradle file and adjust tomcatHome variable to your local Apache Tomcat location: 

tomcatHome='/home/john/workplace/tools/[TOMCAT_FOLDER]'  

6.2.3 Building Web Application war Files 

To build the web application war files follow the next steps: 

1. In the command prompt, go to your workspace folder. 

2. Run the “gradle clean” command (ensure that 17 projects are loaded by gradle). 

 

 

Figure 79. Results of the “gradle clean” command 
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3. Run the gradle command. 

 

Figure 80. Results of the “gradle” command 

4. The web application war files should be created in the “\build\libs” output folders on the following 
projects: 

org.eclipse.opencert.webapp.reports 
org.eclipse.opencert.webapp.cdo 
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Abbreviations 

AMASS Architecture-driven, Multi-concern and Seamless Assurance and Certification of 
Cyber-Physical Systems 

API Application Programming Interface 

ATL ATL Transformation Language 

BDD Block Definition Diagrams 

BVR Base Variability Resolution 

CDO Connected Data Objects 

CDT Eclipse C/C++ Development Tooling 

CHESS Composition with Guarantees for High-integrity Embedded Software Components 
Assembly 

EEF Extended Editing Framework 

ELK Eclipse Layout Kernel 

EPF Eclipse Process Framework 

EST Eclipse Standard Tools 

GEF Eclipse Graphical Editing Framework 

GMF Graphical Modelling Framework 

GUI Graphical User Interface 

IBD Internal Block Diagram 

LTL Linear Temporal Logic 

MARTE Modelling and Analysis of Real Time and Embedded systems 

OCRA Othello Contracts Refinement Analysis 

QVT Query/View/Transformation 

SDK Software Development Kit 

SQL Structured Query Language 

SSL Secure Sockets Layer 

SysML System Modelling Language 

UI User Interface 

URI Uniform Resource Identifier 

V&V Verification & Validation 

XMI XML Metadata Interchange 

XML eXtended Markup Language 

XSD XML Schema Definition 
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